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This tutorial presents an overview of how to use
3D Studio MAX to create and render a 3D scene.
Subsequent tutorials detail many of the tools
you’ll discover in this chapter.

The Basics

Tutorial
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Learning the Screen
Layout 2

Begin by examining the 3DS MAX screen.

Start the program, and look at the screen:

1. Start 3D Studio MAX.

2. Examine the screen.

Compare the various areas on the screen with
the previous illustration. By taking the time
now to look over the basic arrangement of the
3DS MAX interface, you’ll feel a lot more secure
as you move through the beginning tutorials.

In the remainder of this chapter, you’ll look at
each of the eight basic work areas on the
3DS MAX screen.

Menus
The menus across the top of the screen are stan-
dard Windows menus that should be familiar to
you. Instructions in 3DS MAX documentation
use a right angle bracket (>) to refer to com-
mands in the menus.

Load a file:

1. Choose File>Open.

A file dialog appears listing several sample
files.

2. Select and load tut1_1.max.

A scene appears with two birds playing on a
teeter-totter.

Toolbar
The collection of buttons and list fields immedi-
ately below the menus is the toolbar. It holds
the tools that you use most frequently in
3DS MAX. Unlike some Windows applications,
many of these tools are found only in the tool-
bar, and are not duplicated in the menus.

Throughout the tutorials, the buttons you’re
asked to click are displayed at the beginning of
each step. In addition, if you hold the mouse
cursor over a button, a tooltip appears describing
the button.

Select an object:

1. Point the mouse cursor over any of the but-
tons in the toolbar, and then leave it there.

After a moment, a tooltip appears labeling the
button. An extended description also appears
in the prompt line at the bottom of the
screen.

2.  Click the Select by Name button (in the
area below the Help menu).

The Select Objects dialog appears.

3. Click to highlight Duck in the list window.

4. Click Select.

menus toolbar command panels

status line prompt line
viewport navigation controls

time controls
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The Duck turns white in the viewports, to indicate that it’s
selected.

Command Panels
The panel along the right side of your screen
contains the command panels. This is the core
of 3D Studio MAX, containing most of the tools
and commands that you use to create, model,
and edit the objects in your scene.

You use the six tabs at the top of the command
panels to select one of each type of panel. Tool-
tips show you the names of each of the panels.

The left-most panel is the Create panel  ,
which is open as a default. You use the seven
buttons at the top of the Create panel to create
geometry, shapes, lights, cameras, and more.

Examine the remaining command panels:

1.  Open the Modify command panel by
clicking its tab.

The name of the currently selected object
appears at the top, and a collection of object
modifier buttons appears below. These are
tools you use to modify and edit the selected
object.

2.  Open the Hierarchy command panel.

Use these buttons and controls to work with
functions related to hierarchically linked
objects. From here, you can access the inverse
kinematics system.

3.  Open the Motion command panel.

Use these controls to access the animation
key values for transforms, such as position,
rotation, and scale.

4.  Open the Display command panel.

These controls affect the way in which objects
are displayed in the viewports. For example,
you can hide and then unhide the current
selection.

5. Click Hide Selected.

The Duck disappears.

6. Click Unhide All.

The Duck reappears.

7.  Open the Utilities command panel.

The Utilities panel contains general, plug-in
utilities that work with MAX.

Using Rollouts
The controls in the command panels are orga-
nized into subpanels, called rollouts. You can
spot a rollout by the panel-wide button with the
plus (+) or minus (–) sign beside it.

You use rollouts to collapse or expand portions
of the command panels when there’s too much
information to fit into the command panel.

Collapse and expand the rollouts:

1.  Open the Display command panel.

The rollouts in this panel are Display Color,
Hide by Category, Hide by Selection, and so
on. The minus sign (–) means the rollout is
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open, and the plus sign (+) means that it’s
closed.

2. Click the Hide by Category rollout button.

The Hide by Category rollout collapses, and
its minus sign changes to a plus.

3. Click the Hide by Category rollout button
again.

The rollout expands.When there are more
controls than can fit in the length of the com-
mand panel, you can scroll it.

Scroll the command panel:

1. Click to expand the Freeze rollout.

2. Move the mouse over any blank area where
there’s no control—or move it to the right
side of the command panel.

The mouse cursor becomes a hand.

3. While the mouse cursor displays a hand, drag
the panel up and down.

The panel scrolls. At right, a light gray line
within a dark gray line shows you the active
window area of the command panel.

Note: On display resolutions higher than 1024 x
768, all the controls in the Display branch fit in
the command panel, and scrolling isn’t neces-
sary.

Status Line and Prompt Line
The status line is at the bottom of the screen,
and below it is the prompt line.

The status line tells you what your current selec-
tion consists of, lets you lock the current selec-
tion so that you don’t accidentally select a dif-
ferent object, provides coordinate readouts for
your current action, and tells you the current
grid measurement for the active viewport.

The prompt line displays an expanded descrip-
tion of the current tool that you’re using, or
pointing at. The remaining buttons set several
modes, including the various snap modes.

In addition to letting you turn the snap modes
on and off, you can right-click on the snap but-
tons as a shortcut to the Grid and Snap Settings
dialog.

Use the snap shortcut:

1.  Right-click the 2D Snap Toggle button.

The Grid and Snap Settings dialog appears.
Look over the various controls and settings,
and then exit the dialog.

Time Controls
The time controls include the time slider imme-
diately below the viewports, the large Animate
button to its right, and the eight controls to the
right of the Animate button.

These controls let you move through the anima-
tion and set the number of frames in your cur-
rent active time segment.
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Explore the time controls:

1. Drag the time slider back and forth.

The teeter-totter moves up and down, while
the ball rolls along the top of it.

2.  Click Play, to the right of the Animate
button.

The animation plays in a continuous loop,
but only in the active viewport.

3. Right-click in a different viewport to make it
active.

The animation plays in the newly activated
viewport.

4.  Click Stop to stop the animation.

You can set 3DS MAX to play the animation in
all viewports, but because that slows the play-
back, the default playback is in the active view-
port only.

Viewports
The four large windows that take up most of the
screen are the viewports. You use viewports to
look at your scene from different angles, using
various display methods and arrangements. The
default setup is four viewports, equally divided.
At the lower right, is a perspective view that
shows the scene from any angle. The remaining
viewports are currently set to orthographic views,
which means that you see the scene directly
along one of the X, Y, or Z world axes, from the
front, top, left, and so on.

Configuring the Viewports

The type of viewport, and the division of the
viewports is set in the Viewport Configuration
dialog.

Look at the Viewport Configuration dialog:

1. Choose Views>Viewport Configuration.

2. Click each of the tabs at the top of the dialog.

You can see that there are several controls
that affect the viewports. You can adjust vari-
ous rendering options that alter the way the
viewports display the scene. You can change
the layout of the viewports, display safe
frames, and set methods of adaptive degrada-
tion for when you’re working on complex
scenes.

3. Click Cancel to exit the Viewport Configura-
tion dialog.

Many of the most popular viewport settings are
also available through shortcuts.

Use some viewport shortcuts:

1. Right-click the label Left in the lower-left
viewport.

A menu appears.

2. Choose Views>Right.

The view changes to a Right view.
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The keyboard shortcuts that change view are
easily remembered: T=Top, B=Bottom, L=Left,
R=Right, F=Front, K=BacK, P=Perspective, and
C=Camera (assuming a camera exists in the
scene).

3. Press L.

The Right viewport becomes a Left viewport
again.

You can also use the shortcut menu to change
the rendering mode in a viewport.

Change the viewport rendering display:

1. Right-click the Perspective viewport label.

2. Choose Smooth + Highlight.

The scene is now displayed in Gouraud
smooth-shaded mode.

Activating Viewports
You can model in any viewport in 3DS MAX. As
you adjust objects in one viewport, the remain-
ing viewports update in real time. You can
adjust objects in the Perspective viewport and
observe their change in the three orthographic
viewports, or you might want to manipulate
them in each of the orthographic viewports to
control their transforms precisely. It’s entirely
up to you.

The viewport you work in becomes the active
viewport, and there is only one active viewport
at any time. The active viewport is surrounded
by a white (or red) border. A viewport becomes
active as soon as you click within it.

There are three ways to activate a viewport:

• Click or drag in the viewport. This both acti-
vates the viewport, and performs any action
the click or drag might trigger. For example, it

might select another object, or begin the cre-
ation of a new object.

• Click the viewport label. This only activates
the viewport. Use this method when you
want to activate a different viewport without
affecting anything in the scene.

• Right-click in the viewport. This is another
method of only activating the viewport. How-
ever, if you right-click over the viewport label,
you’ll also display the viewport options
menu.

Activate some viewports:

1.  Click Select Object (in the toolbar, above
the center of the Top viewport).

2. Activate different viewports using clicks,
drags, left-clicks, and right-clicks, as described
in the previous bullets.

Viewport Navigation Controls
Use the controls in the lower-right corner of the
3DS MAX screen to navigate the viewports.
These controls alter your view of the scene, but
not the objects in the scene.

Most of the viewport navigation controls
involve various forms of zooming and panning.
The buttons themselves change, depending on
the type of viewport that’s active.

Toggle the viewport size:

1. Activate the Perspective viewport.

2.  Click the Min/Max Toggle.

The Perspective viewport enlarges to the size
of all the other viewports.

You’ll use this command frequently, so it’s
good to remember the keyboard shortcut.
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3. Press W several times to toggle between the
two window sizes.

4. Press W a last time to enlarge the Perspective
viewport.

You can work in a maximized window and
switch viewports by using shortcut keys.

Switch views:

1. Press T.

The Perspective view switches to the Top
view.

2. Press F.

The view switches to Front.

If you switch between the four existing views,
when you next minimize, the views return to
their original positions.

3. Press W to minimize the view.

The original Top, Front, Left, and Perspective
views appear; the Front viewport is now
active.

If you switch to a view that doesn’t yet exist,
it replaces the maximized view.

4. Press W to maximize the Front view.

5. Press R to switch to a Right view.

6. Press W to minimize the view.

The Front viewport has been replaced by the
Right viewport.

7. Press F to restore the Front viewport.

Explore the Zoom controls:

1.  Click Zoom.

The Zoom button turns green. This color sig-
nifies the currently active tool.

2. Drag the mouse vertically in the Front view-
port.

The view zooms in and out.

3. Zoom out the Front view.

4.  Click Zoom Extents.

The view zooms so that all objects just fill the
viewport.

Notice that the Zoom button is still green.
This means that you’re still in Zoom mode.
You can get out of this mode either by click-
ing another button, or by simply right-click-
ing in the viewport.

5. Right-click in the viewport.

The Zoom button is turned off, and the Select
Object button  in the toolbar becomes
active. (This was the mode you were in before
you clicked Zoom.)

Zoom multiple viewports:

1.  Click Zoom All, and drag downward in
the Front viewport.

All four views zoom out.

2.  Click Zoom Extents All.

All four views zoom to the extents of the
objects in the scene.

Pan the view:

1.  Click Pan.

2. Drag in any direction in the Front viewport.
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The view moves in the direction you drag the
mouse.

3.  Click Zoom Extents.

Use the Arc Rotate tool:

1. Activate the Perspective viewport.

2.  Click Arc Rotate.

A green circle appears in the Perspective view-
port.

3. Drag the mouse inside the circle, in various
directions.

The view rotates around the X or Y axis,
depending on the direction you drag.

4. Release the mouse, and then drag it outside
the green circle.

The view rolls around the Z axis.

The four tabs constrain the rotation to one or
the other axis.

5. Point the mouse at the top or bottom tags on
the circle, and then drag the mouse.

Dragging the mouse vertically rotates the
view about X, but dragging it horizontally has
no effect.

6. Drag the mouse on the side tags.

The rotation is constrained around the Y axis.

Orthographic, User, and Perspective
Views

The orthographic views, such as Top, Front, and
so on, are defined by their fixed angle, which
looks along one world axis. Therefore, if you use
Arc Rotate to alter an orthographic view, it’s
automatically converted to a User view.

A User view is an angled view of space, in which
parallel projection displays the objects on the
screen. It’s like a Perspective view without the
feeling of depth.

Switch between Perspective and User views:

1. Make sure the Perspective viewport is active.

2. Press U to switch to User view.

The view appears to “flatten.”

3.  Use Arc Rotate to rotate the view.

The view rotates, but the objects appear flat,
like a medieval painting.

4. Press P to restore the Perspective view.

You can convert a view from orthographic, to
User, to Perspective.

Convert the Front view:

1. Activate the Front viewport.

2.  Use Arc Rotate to rotate the view.

The viewport label changes to User.

3. Press P to switch the new User viewport to
Perspective.

The angle of the view remains the same, but
there’s suddenly a sense of depth.

4. Press F to switch back to Front view.

You’re now back to your orthographic view.

5. Right-click in the viewport to exit Arc Rotate
mode.

6.  Click Zoom Extents.
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Creating Objects 2

Now that you have a feel for the interface, you
can look at object creation. This is a warm-up for
the next tutorial, in which you’ll create a com-
plete scene.

Creating Primitives
For the rest of this tutorial, you’ll create and
modify various geometric primitives. You don’t
have to concern yourself with accuracy, or
worry about making mistakes. Just explore the
tools.

Reset and select Cylinder:

1. Use File>Reset to reset 3DS MAX (don’t save
the changes).

All of the standard primitives are available in
the Geometry branch of the Create command
panel.

2. Click Cylinder in the Object Type rollout of
the Create command panel.

The Cylinder button turns green. This means
that the command is waiting for additional
input, and that you can continue entering
cylinders without having to return to the
command panel.

You’re now ready to create a cylinder. You can
perform the creation in any of the viewports.
Notice that the grid in each viewport is crossed
by two heavy black lines. These show you the
center of world space.

The grids themselves are called home grids.
They’re also referred to as construction planes
because objects are created on one of these three
intersecting grids that are 2D planes.

In the Perspective viewport, you see one of the
three grids. It’s the same one that you see in the
Top viewport, and it’s referred to as the ground

plane because its orientation in space is parallel
to what would usually be the ground.

The other two planes are parallel with the Front
viewport and the Left viewport. You can see
their grids in those two viewports. In the Per-
spective and Top viewports, the heavy black
lines are the edges of those planes.

The viewport in which you choose to create a
cylinder determines the object’s orientation.

Create a cylinder in the Front viewport:

1. Point the mouse above the horizontal, heavy
black line in the Front viewport.

2. Drag outward to define a circle that will
become the base of the cylinder.

front

left

top
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3. Release the mouse and move it up and down.

The Radius was set by your mouse drag. As
you move the mouse now, the cylinder grows
in one direction or the other, and the value in
the Height spinner varies between positive
and negative numbers.

4. Move the mouse to create a positive Height
value of about 100 units, and then click.

The cylinder is created, and the mouse
released.

You can now do one of four things:

• Click again in any viewport to begin creating
another cylinder.

• Adjust the parameters of the cylinder you just
created.

• Adjust the viewport navigation controls.

• Choose another tool, and exit cylinder cre-
ation mode.

Create more cylinders:

1. Drag in the Left viewport, and repeat the
same series of steps to create another cylinder.

This cylinder grows in a horizontal direction
in the Front and Top viewports.

2. In the Perspective viewport, drag somewhere
on the ground plane, and create a third cylin-
der on the ground plane.

Immediately after having created a cylinder, you
can adjust its parameters.

Adjust the parameters of the third cylinder:

1. In the command panel, drag the Radius, and
then the Height spinners to various values.

The dimensions of the cylinder change in the
viewports.

2. Adjust some of the other cylinder values.

3.  Adjust Arc Rotate in the Perspective view-
port to get a better angle on the scene.

4. Continue adjusting the cylinder’s parameters
in the command panel.

5. Right-click the Perspective label, and choose
Smooth + Highlight.

6. Clear the Smooth option in the command
panel.
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The sides of the cylinder become faceted.

7. Reduce the number of sides on the cylinder.

8. Play around with the various cylinder set-
tings.

9. Right-click in a viewport to exit Arc Rotate
mode.
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Modifying Objects 2

So, now you have a scene that’s jam-packed with
primitives. What do you do with them? You can
select them and modify them.

Select and modify an object:

1.  Click Select Object in the toolbar.

2. Move the mouse over the objects in the view-
ports.

When the mouse is over a selectable object,
its cursor changes to a cross.

3. Click to select any object in the scene.

The selected object turns white in wireframe
displays, and white brackets appear around it
in the smooth-shaded Perspective viewport.

The Modify command panel holds the tools
that let you modify an object.

4.  Open the Modify command panel.

The creation parameters for the selected
object appear in the lower portion of the
panel. These are the same parameters you saw
when you created the object.

5. Adjust any of the parameter spinners.

The selected object is altered accordingly.

The important thing to understand is that, once
you’ve left a newly created object for another
function (or to create another object), you use
the Modify command panel to access that
object’s creation parameters.

You can adjust the creation parameters of any
object at any time by simply selecting it.

Adjust the parameters of other objects:

1. Click to select a different object.

That object’s creation parameters appear in
the Modify command panel.

2. Adjust the creation parameters, and then
select another object, and do the same.

Perhaps the most extreme form of modification
is to delete the object from the scene.

Delete an object:

1. Click to select an object.

2. Press DEL.

The object is removed.

3. Select another object.

4. Press DEL.

5.  Click Undo (toward the left end of the
toolbar.)

The last deleted object is restored.

6. Click Undo twice.

The selection of the object is undone, and the
previously deleted object is restored.

Note: In the previous step, it took two undo’s to
restore the last object because selection is consid-
ered an action that’s stored in the undo buffer.
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This tutorial presents an overview of how to use
3D Studio MAX to create and render a 3D scene.
Subsequent tutorials detail many of the tools
you’ll discover in this chapter.

Using the creation and modeling tools, you’ll
create objects for your scene and position them
in 3D space. The process will provide hands-on
practice with the interface you studied in the
previous tutorial.

After creating your scene, you’ll set up a camera
and some lights, and then assign materials to
your objects before rendering a still image.

Finally, you’ll add a bit of animation, and create
an animated preview file.

Creating a Simple Scene

Tutorial
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Making the Objects 2

You’re going to create a scene consisting of a
table that is reminiscent of the 1950’s. You’ll add
some appropriate items to the top of the table,
set up a camera and some lights, assign materi-
als, and render the scene. By the time you’re
through, you should have a pretty good idea of
what’s involved in creating a basic scene in 3DS
MAX.

Set things up:

1. Reset 3DS MAX.

2. Right-click the Perspective viewport label,
and choose Smooth + Highlight.

Creating the Table Base
You’ll begin by building a table with a futuristic
look. You’ll create the base of the table by apply-
ing two modifiers to a cylinder.

Create and modify a cylinder:

1. Click the Cylinder button in the Create com-
mand panel.

2. Create a cylinder near the center of the
ground plane, using the following dimen-
sions:

• Radius: 20

• Height: 50

• Height Segments: 10

Note: The easiest method is to first create a
cylinder of any size with your mouse, and
then adjust the spinners for precise dimen-
sions.

3. In the Modify command panel, click the
Taper button.

Note: The previous step is usually worded:
“Apply a Taper modifier.”

4. Set the Amount spinner to –0.6.

5. Set the Curve spinner to –1.6.

6. Click the More button to display a list of addi-
tional modifiers.

7. Select Skew from the list, and click OK.

8. Set the Amount to 60.

It’s always a good idea to name your objects. You
can do this at any time while they’re selected.

Name the base:

1. Click in the name field at the top of the Mod-
ify command panel, and highlight the exist-
ing name.

2. Type Table Base, and press ENTER.
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Making the Table Top
You’ll make the table’s top by extruding a shape.
A shape is an object created from one or more
Bezier splines. In this case, you’ll create an
ellipse spline, extrude it, and then edit its verti-
ces.

Create an ellipse:

1.  Click Shapes in the Create command
panel.

2. Click the Ellipse button.

3. In the Top viewport, drag diagonally, to create
an ellipse that surrounds the base. (It doesn’t
have to be perfect; you can adjust it later.)

4. Set the Length to 100 and the Width to 200.

5. In the Name and Color rollout, type Table
Top.

Now that you have the general shape of the
table top, you can extrude the shape for some
depth.

Extrude the ellipse:

1. Click Extrude in the Modify command panel.

2. Set the Amount spinner to 4.

Since everything is created on the construction
planes, the table top is on the floor, along with
its base. In the next steps, you’ll position the
table top correctly.

Position the table top:

1.  Click Select and Move in the toolbar (near
the Help menu).

Note: Throughout this and other tutorials, feel
free to use the Restrict To buttons (X, Y, Z, XY)
in the toolbar to restrict transformations (move,
rotate, scale) to a specific axes.

2.  Click Zoom Extents All among the view-
port navigation controls.

3. In the Front viewport, move the mouse over
the table top, so that the cursor changes to a
move icon, and then drag the table top to just
above the top of the base.

For more precise placement, you can zoom in.

4.  Click Region Zoom.

5. In the Front viewport, drag a zoom region
around the top of the base.

The Front viewport zooms in to the defined
region.

6. Right-click in the viewport to exit Region
Zoom mode.

7. Adjust the height of the table top.
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8. In the Top viewport, move the table top so
that its axis icon (the lines labeled X, Y, and
Z), is centered over the smaller circle that’s
the top of the table base.

9.  Click Zoom Extents All.

This is probably a good place to save. If you
make a mistake later, you can return to this
point by reloading your file.

Save the scene:

1. Choose File>Save As.

2. Save the scene as mytut2.max.

The filename appears in the 3DS MAX title
bar.

Editing the Spline
In the following steps, you’ll access the Modifier
Stack to edit the spline that forms the ellipse.
The Stack is a complex subject that’s covered in
great detail in subsequent tutorials.

The current table top is an object that consists of
an ellipse, to which you’ve applied an Extrude
modifier. 3D Studio MAX maintains the entire
construction history of its objects in a Modifier

Stack. By going back into the Stack you can
adjust the original creation parameters, or you
can apply modifiers at any point in the con-
struction.

For the table top, you want to apply an Edit
Spline modifier to the originally created spline
that’ll let you edit its vertices. To do this, you’ll
go back in the Stack to the original spline, and
apply the Edit Spline modifier at that point.

Edit the spline:

1. Make sure the table top is still selected.

In the Modifier Stack rollout in the Modify
command panel, the top of the Stack list
reveals the Extrude modifier.

2. Click the arrow beside the Stack list to open it.

3. Choose Ellipse from the Stack list.

The panels below switch to the creation
parameters for the ellipse.

4. Apply the Edit Spline modifier.

The table top reverts to its original spline, and
displays four vertices, as well. Among the new
parameters are a yellow Sub-Object button,
and a list displaying Vertex as the current
object editing level.

5. In the Top viewport, click to select the vertex
centered on the lower curve of the ellipse (at
the 6 o’clock position).

Green Bezier handles appear on either side of
the vertex, along with an axis tripod at the
vertex itself.

6.  Using Select and Move, drag either of the
green Bezier handles to rotate the handle
counter-clockwise and create a kidney-shaped
spline.
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7. counterclockwise and create a kidney-shaped
spline.

8. Open the list under the Modifier Stack roll-
out, and select Extrude at the top of the list.

Having returned to the top of the Stack, the
extruded table top is displayed again, but it’s
now kidney shaped.

If everything appears the way you think it
should, you can save your scene again, overwrit-
ing and updating the previous version.

Update the saved scene:

• Choose File>Save

Setting Up a Grid Object
So far, you’ve created an object on the home
grid. What if you wanted to create an object
directly on the table top? Of course, you could
create it on the home grid, and then move it
into position, but when you need to create an
object in a specific place in the scene, you can
use a grid object.

Grid objects are helper objects that aid in the
construction of your scene but don’t appear in

the rendering. They include items like tape mea-
sures, dummy objects, and so on.

A grid object is nothing more than a 2D grid
that you can activate to become a construction
grid. You can have as many grid objects in your
scene as you want, switching from one to the
other as you need them.

In the following steps, you’ll create a grid object,
and align it to the table top.

Create the grid object:

1.  Click Helpers in the Create command
panel.

2. Click the Grid button.

3. In the Top viewport, drag a grid that’s about
100 units in Length and Width, centered
around the left end of the table top.

Align the grid object:

1.  Click Align in the toolbar. (It’s above the
middle of the Front viewport.)

You’re now in a mode where you can select
the object to which you want the current
object aligned. Notice that the mouse cursor
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has changed its shape, and the prompt line
says “Pick Align Target Object.”

2. In the Top viewport, click the edge of the
table top. The Align Selection dialog appears.

3. Choose Z Position.

4. Choose Center under Current Object, and
Maximum under Target Object.

The grid moves along Z to the top surface of
the table.

5. Click OK. Now that the grid is where you
want it, the last step is to activate it.

Activate the grid object:

1. Right-click the grid object.

2. Choose Activate Grid.

The home grids are reduced to only the center
lines, and the grid object becomes active.

Tubular Tumbler
For the object on the table, you’ll create a drink-
ing glass—or tumbler—from a tube primitive.
But first, you’ll take advantage of one of the vari-
ations of the Zoom Extents buttons.

Both Zoom Extents (for one viewport) and
Zoom Extents All (all viewports) act on all geom-
etry in the scene. Both of these buttons are fly-
outs, which means that you can select from
more than one option. The additional options
let you zoom to the extents of whatever is
selected in the scene.

Zoom in on the grid object:

1. Make sure the grid object is still selected.

2.  Hold the mouse down over Zoom Extents
All until the flyout reveals both buttons.

3.  Drag upward, and select Zoom Extents All
Selected.

The four viewports zoom in to the extents of
the grid object.

4.  If necessary, use Arc Rotate to adjust the
angle of the Perspective viewport so you’re
looking down slightly at the grid.

Now, you can make your tumbler:

1.  Click Geometry in the Create command
panel.

2. Click Tube.

3. In the Perspective viewport, drag to define a
radius of any size.

4. Release the mouse, and then move it to define
a second radius.

5. Click to complete the second radius, and then
move the mouse up, and click to define the
height and create the tube.

6. Adjust the Tube parameters to the following:

• Radius 1: 8

• Radius 2: 7.5
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• Height: 30

• Height Segments: 10

The tube is on the table top, it looks like a tum-
bler, but could be improved by tapering.

Taper the tubular tumbler:

1. Open the Modify command panel.

2. Apply a Taper modifier.

3. Set the Amount to 0.35, and the Curve to
-1.25.

4. In the name field at the top of the Modify
command panel, type Tumbler1.

And, while you’re at it, make a second tumbler.

Create a clone:

1.  Click Select and Move (if it isn’t already
selected).

2. Point the mouse at the tumbler in the Top
viewport.

3. Hold SHIFT, and drag the tumbler up and to
the left.

The Clone Options dialog appears.

4. Choose Instance, and then click OK.

You now have two tumblers. Because they’re
instanced objects, any modifications you per-
form to one will be duplicated in the other.

You’ve probably noticed that there’s no bottom
to the tumblers. Luckily, the shot in this scene
will remain at an angle where you’ll never see
the bottom of the glasses.

Tip: When you’re working on a scene, create
only the geometry that’s needed. You’ll save
yourself a lot of time.

Save your scene:

• Choose File>Save (or press CTRL+S).

Creating a Goblet
You’ve created a table using a primitive and an
extruded spline. You’ve created two tumblers
from a modified tube. In the following steps,
you’ll use the Lathe modifier to spin a spline
profile into a goblet.

You won’t need the grid object anymore. But,
rather than deleting it, you can simply hide it
from the viewport display. If you need it again,
you can unhide it.

Activate the home grid, and hide the grid
object:

1. Choose Views>Grids>Activate Home Grid.

The detailed home grid reappears.
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2. Open the Display command panel.

The grid object is the only helper object in the
scene, so you can hide its category.

3. Check Helpers in the Hide by Category roll-
out.

The grid object is hidden from view.

Drawing the Profile
You’ll use the Line creation tool to draw the pro-
file for your goblet. To set things up, you’ll
enlarge the Front viewport, turn on Snap for
more accurate vertex placement, and adjust the
grid.

Zoom in on the view:

1. Activate the Front viewport, and then press W
to maximize it.

2.  Using Region Zoom, drag a region that
includes a portion of the rightmost tumbler,
an area to the right of the tumbler, and a por-
tion of the table top.

Compare your zoomed view with the follow-
ing figure. If it’s not the way you want it,
choose Views>Undo View Zoom to revert to
the previous zoom level, and then try again.

Set up the grid and the snap:

1.  Right-click 3D Snap Toggle in the prompt
line to access the Grid and Snap Settings dia-
log.

2. On the Snaps panel, make sure Vertex is
unchecked to prevent the Line tool from
snapping to vertices—including its own.

3. Click the Home Grid tab and uncheck Inhibit
Grid Subdivision Below Grid Spacing.

Sub-grid lines appear in the viewport. This
option, when on, prevents sub-grid lines from
appearing when you zoom in below the set
grid spacing size.

4. Exit the dialog.

5.  Turn on 2D Snap Toggle on the Snaps fly-
out.

In the following steps, you’ll create a profile sim-
ilar to that in the accompanying figures. You’ll
be able to edit the profile later, so it doesn’t have
to be exact. However, because you’ll spin the
profile with the Lathe modifier, you’ll want the
core line that makes the center of the goblet to
be perfectly vertical. The finished profile should
look something like the following figure:

1 7 8

2 6

5

4

3

make
core
vertical
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Create the goblet profile

1.  Click Shapes in the Create command
panel.

2. Click Line.

3. Vertex #1: Click to set a vertex near the upper
surface of the table top and to the right of the
tumbler.

4. Vertex #2: Move the mouse straight up until
the attached line is about half the distance of
the height of the tumblers, and click.

5. Vertex #3: Click diagonally up and to the
right to create the third vertex. This will be
the inside of the bowl.

6. Vertex #4: Click above the last vertex to create
the rim.

7. Vertex #5: Click to the right of vertex #3 to
create the outside of the bowl.

8. Vertex #6: Click to the right of the vertical
line to create the outside of the upper stem.

9. Vertex #7: Move the mouse vertically down,
and click to create the base of the stem.

10.Vertex #8: Click to the right, and at the same
level as vertex #1 to create the rim of the base.

11.Last Vertex: Click again at vertex #1 to com-
plete the profile.

12.Click Yes, to close the spline.

Restore the original grid and snap settings:

1.  Right-click 2D Snap to display the
Grid and Snap Settings dialog.

2. On the Snaps panel, check Vertex.

3. On the Home Grid panel, check Inhibit Grid
Subdivision Below Grid Spacing.

4. Exit the dialog.

5.  Turn off 2D Snap.

6. Press CTRL+S to update your scene file.

Editing the Profile
Now, you’ll edit your spline to curve portions
that will become the sides of the goblet. This
involves right-clicking the vertices to change
them to Bezier types with editable handles.

Apply an Edit Spline modifier:

1. In the Modify command panel, click Edit
Spline.

The Edit Spline controls appear in Sub-Object
vertex mode, and vertices appear in the pro-
file.

2.  Click Select and Move in the toolbar.

3. Right-click vertex #3.

A pop-up menu presents you with several
choices. Choose Bezier.

The spline becomes curved, and green Bezier
handles appear.

4. Right-click vertex #5, and choose Bezier.

Handles appear on the second vertex.

You can drag the vertex itself to position it,
and drag the handles to rotate them, or
change their length.

5. Select one and then the other vertex, adjust
their positions, and the positions of their
handles to get the curvature you want on the
inside and outside of the goblet bowl.
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Spinning the Goblet on the Lathe
Use the Lathe modifier to spin any shape around
an axis. You can then adjust the position and
angle of the axis for any effect.

Use the Lathe modifier:

1. Press W to minimize the viewport.

2.  Click Zoom Extents All Selected to zoom
in on the shape.

3. In the Modify command panel, apply Lathe.

The shape is spun around a centered axis.

4. Click the Min button below the Align area.

The Lathe axis is aligned with the left edge of
the profile, producing a goblet.

Editing the Goblet
You can easily go back in the Modifier Stack and
edit the spline to change the shape of your gob-
let.

Access the Stack and alter the stem:

1. Open the Modifier Stack list, and choose Edit
Spline.

The spline and its vertices are again displayed.

2.  Use Region Zoom in the Front viewport
to zoom in on the lower portion of the shape
profile, representing the stem of the goblet.

3. Right-click vertex #7, and choose Bezier Cor-
ner.

The vertex maintains its corner, but Bezier
handles appears. A Bezier Corner has “bro-
ken” handles, so they can be adjusted inde-
pendently of one another.

4. Drag the upper Bezier handle slightly to the
right to create a bulge in the stem.

5. Drag the upper Bezier handle slightly to the
right to create a bulge in the stem.
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6. Drag the upper Bezier handle slightly to the
right to create a bulge in the stem.

7.  Press the mouse button over Show End
Result, and then release it.

While the button is down, you see the end
result of the Stack, and the goblet is displayed.
The goblet now has a decorative stem, but
there aren’t enough segments for a smooth
roundness.

Increase the segments in the Lathe modifier:

1. Open the Stack, and choose Lathe.

2. Set the Segments spinner to 30.

Name your object, and save your scene:

1. In the name field at the top of the Modify
command panel, type Goblet.

2.  Click Zoom Extents All to view all geom-
etry in the scene.

3.  Use the Select and Move tool to move the
goblet to the narrow end of the table. (Use
either the Perspective or the Top viewport to
keep it on the table top.)

4. Press CTRL+S to update your scene.

Goblet to Carafe
A carafe would seem a logical companion to a
goblet. In 3DS MAX, it’s often as easy to alter
existing objects as it is to create new ones.

Clone the goblet, and edit its spline:

1.  Using the Select and Move in Top view-
port, hold SHIFT and drag a copy of the goblet
to the center of the table.

2. In the Clone Options dialog, choose Copy,
type Carafe in the Name field, and then click
OK.

You now have a copy of the goblet in the cen-
ter of the table.

3.  Click Zoom Extents All Selected to zoom
in on the new goblet.

4. Open the Stack list in the Modify command
panel, and choose Edit Spline.

Vertex #7 is still selected from your previous
session with the other goblet. (If it’s not, then
select it.)

5. Press DEL to delete vertex #7.

6. Right-click vertex #2, and choose Bezier.

7. Right-click vertex #6, and choose Bezier.

8. Adjust the position of the various vertices and
their handles to create a profile similar to that
in the following figure.

During the editing process, click Show End
Result  regularly to view your progress. At
some point, you’ll have to zoom out a bit, and
move the vertices up so the new profile is
almost twice as tall as the goblet. Note that
you don’t need to duplicate the carafe in the
figure. Use your imagination.



3t2tut02.fm    12  Thu Oct  2 14:19:07 1997

Tutorial 2

2 
– 

12
C

re
at

in
g

 a
 S

im
p

le
 S

ce
n

e

9. Open the Stack and choose Lathe to return to
the top.

10.  Click Zoom Extents All.

Tumbler to Bowl to Lamp
You decide to create a popcorn bowl out of a
copy of one of the tumblers. Here’s how to do it.

Clone a tumbler, and make it into a bowl:

1. Select one of the tumblers.

2.  Using Select and Move in the Top view-
port, hold SHIFT, and move the tumbler in
front of the table.

3. In the resulting Clone Options dialog, choose
Copy, type Bowl in the Name field, and then
click OK.

4.  Click Zoom Extents All Selected.

5. Open the Stack list in the Modify command
panel, and choose Tube.

The original creation parameters appear.

6. Set the Radius 1 spinner to 12.5, and the
Radius 2 spinner to 12.0.

7. Open the Stack list, and choose Taper.

8. Set the Amount spinner to 1.0, and the Curve
spinner to 1.5.

9.  Click Zoom Extents All Selected.

You decide the bowl might make a better lamp-
shade. All you need do is turn it upside down,
and make a few minor adjustments.

Make the bowl into a lampshade:

1.  Click Mirror Selected Objects.

2. Choose Z under Mirror Axis, and No Clone
under Clone Selection. Then click OK.

3.  Click Zoom Extents All Selected.

4. Open the Stack list, and choose Tube.
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5. Set the Tube parameters as follows:

• Radius 1: 20

• Radius 2: 19.5

• Height: 15

• Sides: 10

• Smooth: Unchecked

6. Rename the object Lampshade.

7.  Click Zoom Extents All .

8.  Use Select and Move to position the
lampshade over the table, as in the following
figure.

9. Choose File>Save to save your updated scene.
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Using a Camera 2

Although the Perspective view provides much
the same view as a camera might, it doesn’t have
the flexibility of a camera, and you can’t ani-
mate the view. With few exceptions, when
you’re ready for serious rendering you use a
camera.

Cameras are objects in your scene. The steps
involved in setting up a camera are simple:

• Create the camera.

• Assign a viewport to the camera.

• Adjust the camera.

Create a camera in the Top viewport:

1.  Use Zoom to zoom out in the Top view-
port, until the table occupies about one-quar-
ter of the view.

2.  Click Cameras in the Create command
panel.

3. Click Target.

4. Drag from the lower-right corner of the Top
viewport to the lamp in the center of the
viewport.

In the preceding steps, the camera is in the
lower-right corner of the viewport, and its target
is in the center of the viewport.

Turn on the Camera viewport:

1. Activate the Perspective viewport.

2. Press C (the keyboard shortcut for camera).

The view changes to that of the camera look-
ing toward its target.

You can adjust the camera view either by mov-
ing the camera in the scene, or by using the
viewport navigation controls.

Move the camera in the viewports:

1.  Click Zoom Extents All.

The orthographic views zoom to extents. The
camera viewport does not change, because
Zoom Extents All doesn’t affect it.

2.  Click Select and Move, and move the
selected camera in any of the viewports, right-
clicking to cancel each time.

As you move the camera, the view changes in
the camera viewport.

It’s much easier to adjust the camera using the
viewport navigation controls. They become
controls specific to the camera when you acti-
vate the camera viewport.

Use the camera navigation controls:

1. Activate the camera viewport.

2.  Click Truck Camera, and then drag in the
camera viewport to center the objects in the
view.

Trucking moves both the camera and its tar-
get, as if they’re locked. The effect in the view-
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port, however, is the same as panning a regu-
lar viewport.

3.  Click Orbit Camera, and then drag in the
camera viewport to orbit the view so that
you’re looking down, slightly, on the objects.

The Orbit Camera function rotates the cam-
era in an “orbit” about the target. It’s similar
to the Arc Rotate command.

4.  Click Dolly Camera, and drag in the view-
port to dolly in on the objects.

When you dolly the camera, you move it
toward or away from its target. The effect is
similar to zooming a regular viewport.

5.  Use Truck, Dolly, and Orbit to
adjust the camera until you have a view simi-
lar to that in the next figure.

A Fast Render
The renderer used by smooth-shaded viewports
is designed for speed. As a result, it can’t show
the same details with the same accuracy as the
3DS MAX scanline renderer. When you want to
see exactly how your scene will look, take the
time to render it.

Render the scene:

1. Make sure the camera viewport is active.

2.  Click the Render Scene button.

The Render Scene dialog appears.

3. Make sure Single is chosen.

4. Click the 320x240 button in the Output Size
area.

5. Click Render.

The scene is rendered.

There are a number of details and effects
revealed by the scan-line renderer that don’t
show in shaded viewports. One of these is the
circle cast by a spotlight, as you’ll see in the next
section.
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Setting Up Lights 2

When there are no lights in your scene (as now),
3DS MAX provides a couple of invisible omni
lights. One light is positioned in front of the
scene, above and to the left, while the second is
on the opposite side of the scene, below, to the
right, and at the back. As soon as you create a
light in your scene, these two lights are turned
off. If you later delete all the lights in your
scene, the two default lights are turned on
again.

The default lights are handy when you’re first
putting a scene together, but since you can’t
move them or adjust their color or intensity,
you’ll soon want your own lights.

In the following steps, you’ll create and position
a couple of omni lights, and then place a spot-
light in the scene.

Omni Lights
An omni light is a point source of light that
shines in all directions. You can’t focus it, and it
doesn’t cast shadows, but you can make it any
color, and use it for accents and other general
lighting effects.

Like cameras, omni lights are objects that usu-
ally don’t appear in the rendered scene. Instead,
you see the effect of their illumination on the
surfaces of the other objects in the scene.

You’ll place two omni lights in your scene, at
diagonally opposing locations.

Set up your viewports:

1.  Click the exit button to dismiss the render-
ing window.

2. Activate the Top viewport.

3.  Click Zoom All.

4. Drag downward in the Top viewport to zoom
out the orthographic viewports until the
objects fill about one-third of the view.

5.  Make sure Degradation Override is
on in the prompt line.

The Degradation Override option, when off,
allows the display of geometry in the viewports
to degrade to specified settings (such as box or
wireframe) when the viewports can’t redraw fast
enough. When you’re positioning lights, how-
ever, you want to be able to see their effect on
shaded objects, which you can’t if the viewport
degrades to wireframe.

In the next steps, you’ll create the omni lights.
You can either click or drag to create an omni
light. If you click, it’s created at that point. If
you drag, you can perform some initial position-
ing during the creation process.

Create and position the omni lights:

1.  Click Lights in the Create command
panel.

2. Click Omni.

3. In the Top viewport, in the lower-left quad-
rant, drag the mouse to both create and posi-
tion an omni light. Release the mouse button
while the omni light is still somewhere in the
lower-left quadrant.

As soon as you create the first omni light, the
shaded camera view grows dark, as the default
lights are turned off. As you drag the light,
you can see the effect of its movement on the
surfaces of the objects in the camera view-
port.

4. Drag in the upper-right quadrant of the Top
viewport to create and position a second
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omni light. Leave this light in the upper-right
quadrant.

The new light adds to the illumination, but
the table top remains dark because both light
were created on the ground plane, below the
table.

Position the first light:

•  Using Select and Move in the Top view-
port, drag the first omni light you created to
the right until it’s just to the left of center at
the bottom of the viewport.

Specular highlights from that light appear
along the front edge of the table top, and at
the left of the items on the table.

Using Place Highlight
You can use the position of the specular high-
lights to place your lights by taking advantage of
a toolbar function called Place Highlight.

Use Place Highlight on the second omni:

1. Select the second omni light.

2.  Click Place Highlight in the Align flyout
on the toolbar.

3. In the camera viewport, drag the mouse con-
tinually over the surface of various objects in
the scene.

As you drag the mouse, a blue arrow displays
the face normal of the point under the cursor,
and the light moves about the scene to place
its specular highlight at the specified location.

4. Release the mouse when the specular high-
light is over the upper surface and right side
of the carafe.

Note: If you released too soon, simply make
sure the light is still selected, click Place High-
light, and drag again in the camera viewport.

5.  Click Render Last to render the camera
viewport.

Spotlights
Spotlights provide an adjustable, focused beam
of light, and can cast shadows. Creating a target
spotlight is similar to creating a camera. You drag
the mouse to create the spot and its target.

For this scene, you’ll use a spotlight to represent
the light coming from the overhead lamp.

Create and adjust a spotlight:

1. Activate the Front viewport.
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2.  Use Region Zoom to zoom in on the area
that includes the table top and the lamp-
shade.

3. Click Target Spot in the Create command
panel.

4. In the Front viewport, drag from the top of
the lampshade, straight down to the top of
the table.

A target spotlight appears in the scene.

The light in the viewport doesn’t change dra-
matically, because there are already two other
lights in the scene, and also because the view-
port renderer uses Gouraud shading, which
can’t properly display the circle of the spotlight.
However, you can definitely see the effect in the
scanline renderer.

Render the scene:

•  Click Render Last.

A sharp circle of light appears on the top of
the table.

The circle is harsh because of the default settings
for the spotlight. The hotspot (the brightest area
of light) is almost the same size as the falloff (the

area between the hotspot and the outer edge of
the light effect). By widening the falloff, you can
both soften the light, and illuminate more of
the table.

Adjust the Falloff:

1. Make sure the spotlight is selected.

2. Open the Modify command panel.

3. Scroll the command panel until you find the
Spotlight Parameters rollout.

4. Set the Falloff spinner to 70, and the Hotspot
spinner to 50.

5.  Click Render Last.

The pool of light now has a soft edge to it.

Shadows add realism to your scene. They add to
the rendering time, but they’re worth it.

Add shadows:

1. Check Cast Shadows in the Shadows Parame-
ters rollout.

2.  Click Render Last. The shadows appear
across the carafe, and on the table top.

Update your file:

• Choose File>Save to update the scene file.
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Assigning Materials
Now you will use the Material Editor to make
the surfaces of your objects a little more than
just some randomly assigned colors.

Straighten up the screen:

1.  Click Exit to dismiss the rendering win-
dow.

2. Open the Display command panel, and check
Lights and Cameras to hide the lights and the
camera.

3.  Click Zoom Extents All.

4.  Click Material Editor in the toolbar.

The Material Editor appears.

At the top of the Material Editor are six sample
slots containing sample spheres. You select a
sample slot by clicking in it. The controls below
the sample slot affect the sample in the active
slot.

In the following procedure the sample slots are
numbered one through six, beginning with the
upper-left slot, and numbering across the top
row, and then from left to right across the bot-
tom row. As an example, the middle sample slot
on the bottom row is number five.

Carafe—A Dull Clay

You’ll first assign a default material to the carafe,
and then adjust its color for a clay-like appear-
ance.

Assign a material to the carafe:

1. Select the carafe.

2. The first sample slot should already be
selected and bordered by a white outline. If
it’s not, click in the sample slot to select it.

3.  Click Assign Material to Selection (in the
row of buttons below the sample slots).

The carafe changes color to match the mate-
rial in the active slot.

Notice the four white triangles in the sample
slot. They indicate that this is a hot material. A
hot material is one that appears in the scene and
is directly bound to the material in the sample
slot. When you change the settings of a hot
material in the Material Editor, the material
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changes wherever it is in the scene—regardless
of the current selection in the scene.

Materials can get very complex in 3DS MAX. It’s
a good idea to always name your materials
rather than relying on the default names.

Name and adjust the material:

1. Type Carafe in the material name field.

The name Carafe also appears in the title bar
of the Material Editor.

2. Click the color swatch to the right of Diffuse.

The Color Selector appears. Its title tells you
that it represents the Diffuse color.

3. Use the controls in the Color Selector to find
a clay-brown color.

The colors change in the sample sphere and
on the carafe.

Note: To find a color, drag your mouse around
in the large color box. Increase the level of the
vertical Whiteness ramp to increase the satu-
ration of the color. A suggested color might be
RGB 160, 120, 80.

4. Set the Shininess spinner to 20.

The sample sphere is not as shiny.

The sample spheres use the scanline renderer,
whereas the viewports use the faster Gouraud
renderer. As a result, effects such as shininess are
correctly represented in the sample slots, but
not in the viewport. When adjusting material,
always watch the sample sphere, and render
your scene every so often.

Render the scene:

1.  Click Render Last.

The surface of the carafe in the rendered scene
is subtly different than the one in the view-
port.

2. When the rendering window appears, drag it
above the upper-right viewport, so it will
appear there the next time you render.

Goblet—Transparent Plastic

You’ll repeat much the same process with the
goblet, except that you’ll reduce its opacity as
well.

Assign a material to the goblet:

1. Select the goblet.

2. Select the second sample slot.

3.  Click Assign Material to Selection.

4. Name the material Goblet.
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It’s often easiest to use the same color for both
the diffuse and the ambient properties of a
material. Briefly, the diffuse is the color that’s
reflected in direct light (the large, upper-left area
of the sample sphere), and the ambient is the
color of the material in shadow (the dark cres-
cent in the lower-left area of the sample sphere)
You lock both colors together, and then adjust
either property.

Lock the Diffuse and Ambient colors:

1.  Click the lock button between the Diffuse
and Ambient labels, and answer Yes at the
prompt.

The two swatches now contain the same
color.

2. Click the Diffuse or the Ambient color swatch
and choose any color you like. (Suggested:
RGB 80, 200, 130.)

As you choose your color, it’s displayed in
both color swatches.

Make the material shinier and transparent:

1. Set the Shininess spinner to 55, and the Shin-
iness Strength spinner to 85.

2.  Turn on Checkered Background among
the buttons along the right side of the sample
slots.

3. Set the Opacity spinner to about 50.

The sample sphere becomes transparent, and
the goblet appears dithered and transparent
in the viewport.

4.  Click Render Last to see your progress.

The goblet is now transparent and shiny in
the scene.

The transparency in the viewport is a “cheat”
that lets you see the effect of transparency, but
maintains the fast response needed in the view-
ports. Again, always judge your materials by the
sample slots or the rendered scene.

Table Base—Chrome

For the base of the table, you’ll make a reflec-
tion-mapped material.

1. Select the table base.

2. Select the third sample slot.

3.  Click Assign Material to Selection.

4. Rename the material Table Base.

Reflection maps are assigned in the Maps roll-
out.

Assign a reflection map:

1. Open the Maps rollout at the bottom of the
Material Editor.

2. The rollout displays several rows of buttons
and check boxes.
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You can see by the check boxes, that no maps
are currently assigned to any of the compo-
nents of the material.

3. Click the Map button in the Reflection row.
(Don’t click the Refraction button by mis-
take.)

The Material/Map Browser dialog appears.

This dialog lets you browse and select either
materials or maps. Since you’ve just entered it
to select a map, it currently only displays
maps.

In the Browse From area in the upper-left corner
of the dialog, you can see the various categories
from which you can browse. In this case, you’re
going to choose a new map (one that doesn’t
exist in the Material Editor or the Scene).

Select a bitmap:

1. Choose New in the Browse From area (if it’s
not already chosen).

2. Click Bitmap in the window at the right, and
then click OK.

The lower panel changes in the Material Edi-
tor.

Diving into the Material Editor

You’re now at a different level in the Material
Editor—that of the reflection map. You can see
this in several ways:

• The contents of the name field below the
sample slots has changed.

• The label beside the name field is now Reflec-
tion.

• If you click the arrow beside the name field,
you’ll see two entries: Tex #1 and Table Base.

• The rollup panels are different, containing
controls specific to the reflection map.

You’re one level below the current material.
Keep in mind, however, that the name of the
current material is always displayed in the title
bar of the Material Editor.

As with naming materials, it’s a good idea to
name the levels that you’re on.

Name the new level, and assign a map:

1. Type Base Reflection in the Reflection field.

2. Click the Bitmap button in the Bitmap
Parameters rollout, and choose sunset90.jpg
from the resulting file selector.

The sample sphere appears as a reflecting ball.

You’ve assigned the specific map as a reflection
map, but the results look cloudy because the
reflection is affected by the diffuse and ambient
colors. For a perfect reflection, you set these col-
ors to black.

The Diffuse and Ambient color controls are up
with the surface material, so you need to move
up one level.

Adjust the Ambient and Diffuse colors:

1. To return to the top material level, do one of
the following:

•  Click Go to Parent.

• Click the arrow beside Base Reflection to
open the list, and then choose Table Base.

2. Close the Maps rollout.

3.  Turn on the Lock button between the Dif-
fuse and Ambient labels, and answer Yes at
the prompt.
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4. Click the Diffuse color swatch, and change
the color to black.

Reflections can’t be seen as such in the Viewport
renderer, so re-render the scene to see the effect.

Render the scene to see the reflection:

•  Click Render Last.

The table now has a shiny, gold base.

Tumblers—Choose from the Library

You can store all of the materials you create in a
material library, and you can create and save
any number of material libraries. For the two
tumblers, you’ll simply choose a material in the
Browser, after first loading the Tutorial material
library.

Choose a material from the library:

1. Select the two tumblers. (Click to select one,
and then press CTRL, and click the other tum-
bler to add it to the selection.)

2. Select the fourth sample slot.

3.  Click Get Material.

The Material/Map Browser appears.

4. Choose Material Library in the Browse From
area.

The window now lists all of the material and
maps in the current material library. The
materials are represented by blue sphere
icons, and the maps by green parallelograms.

5. Click Open in the File area, and then load
tutorial.mat \MatLibs directory.

The window list changes to display the mate-
rials from the Tutorial library.

6.  Click View Small Icons.

The window at right now displays all materi-
als and maps as small spheres or circles. As
you run the mouse over the icons, tooltips
display their names.

7.  Click View Large Icons.

The icons fill the screen.

8. Drag the mouse along the right side of the
window to scroll the view.

9. Find the material labeled Old Gold.

10.Double-click the Old Gold icon to select it.

The fourth sample slot now contains the
selected material.

Assign the material to the goblets:

1.  Click Assign Material to Selection.

The goblets are assigned the new material.

2.  Click Render Last to see the result.

Table Top—Ash Wood

You’ll assign a diffuse-mapped material to the
table top. A diffuse map is what used to be called
a texture map in 3D Studio for DOS. The term dif-
fuse map is more accurate, because you’re actu-
ally mapping the diffuse (and ambient) portion
of the material.
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Get and assign the material:

1. Select the table top.

2. Select the fifth sample slot.

3.  Click Get Material.

4. Select Ashwood from the material library.

5.  Click Assign Material to Selection.

The table top turns blue, because that’s the
diffuse color of the material. The map is not
currently seen.

Because this material uses a diffuse map, you
need to assign mapping coordinates to the table
top for the renderer to properly place the map.

Display the map in the viewport:

1. Open the Maps rollout.

2. Click the button in the Diffuse row.

The Diffuse level of the material appears, and
Diffuse appears beside the name field. In addi-
tion, the Show Map in Viewport button below
the sample slot is enabled.

3.  Turn on the Show Map in Viewport but-
ton.

The table top turns white, but the map
doesn’t appear on its surface because no map-
ping coordinates are assigned to the object.

4. Open the Modify command panel, and apply
the UVW Map modifier.

The woodgrain appears on the table top.

5.  Click Render Last.

Lamp—Procedural Checkers

The last object to receive a material is the lamp-
shade. For this, you’ll create your own diffuse-
mapped material, and you’ll use a procedural
map.

Create a new material:

1. Select the lamp shade.

2. Select the sixth sample slot.

3.  Click Assign Material to Selection.

4. Name the material Lampshade.

In previous steps, you used the Maps rollout to
access the map levels. There’s a shortcut you can
use for any material component that can use a
map. Instead of clicking the button in the Dif-
fuse row of the Maps rollout, you can click the
blank map button beside the Diffuse color
swatch.

Assign a diffuse map:

1. Click the blank map button to the right of the
Diffuse color swatch.

The Material/Map Browser appears.

2. Choose New, select Checker, and then click
OK.

3.  Turn on the Show Map in Viewport but-
ton.

4. Apply a UVW Map modifier.

The checkers appear on the lampshade.
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5. In the Parameters rollout of the Modify com-
mand panel, set Spherical, and then click Fit.

The woodgrain you used for the table top came
from a bitmap image of wood. The checkers, on
the other hand, are procedurally generated. As a
result, you can change things, such as the tiling,
the angle, the color, and so on.

Adjust the Checker parameters:

1. In the Material Editor, set the U and V Tiling
spinners to 10.

2. Set the Angle spinner to 45.

The checkers are now small diamonds on the
lampshade.

3. Click the Color #1 swatch. In the Color Selec-
tor, choose any color you like.

4. Click the Color #2 swatch, and choose
another color you like.

Note: You’ll need to slide the arrow up in the
Whiteness ramp of the Color Selector to pro-
vide saturation for the second color.

5.  Click Render Last.

The scene appears with all materials assigned.

Now that you’ve completed your scene, you’ll
add some animation. This is a good time to save
the scene.

Save your scene:

• Press CTRL+S to update your scene.
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Adding Animation 2

Animation can be as obvious as flying logos
through snowflakes, or it can be as subtle as a
change in lighting. To complete the scene,
you’ll animate the overhead spotlight so that it
brightens, and then dims again. To complete the
illusion of real light, you’ll also animate one of
the material properties of the lampshade.

The first step is to turn off the spotlight. You do
this not by actually turning it off, but by setting
its color value to black.

Select and turn down the light:

1. Open the Display command panel, and
uncheck Lights under Hide by Category.

The spotlight and the omni lights appear.

2.  Click Select by Name in the main toolbar.

3. In the Select by Name dialog, click Spot01,
and then click Select.

The spotlight is selected.

4. Open the Modify command panel.

5. In the General Parameters rollout, set the
V(alue) spinner to 0.

The spotlight no longer illuminates the table.

Animate the spotlight:

1. Go to frame 50.

2. Turn on the Animate button.

3. Set the V(alue) spinner to 200.

4. In the Material Editor, make sure the Lamp-
shade sample slot is active. (Its title should
appear in the title bar of the Material Editor.)

5.  Click Go to Parent to return to the top
level of the material.

6. Set Self-Illumination to 100.

The sample sphere grows “brighter.”

7. Go to frame 100.

8. Set Self-Illumination to 0.

9. Set the spotlight’s V spinner in the Modify
command panel to 0.

10.Turn off the Animate button.

11.Press CTRL+S to save your scene.

You used a combination of two effects to
achieve the illusion of translucency in the lamp-
shade. Often, when you work with light in 3D
rendering, you need to think through the light-
ing effects in the real world, and then use the
tools at hand to produce an illusion of that
effect.
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Rendering Your
Animation 2

Congratulations! You’ve completed your first
scene. Now it’s time to render an animation.

In the following steps, you’ll render an .avi file
of the scene. You won’t use the Renderer>Make
Preview command, because that uses the view-
port renderer, which isn’t accurate enough for
this scene. Instead, you’ll use the Render Scene
command, and output to .avi format.

Render the animation:

1.  Click Render Scene.

The Render Scene dialog appears.

2. Choose Active Time Segment in the Time
Output area.

3. Set 320x240 in the Output Size area.

4. Click Files in the Render Output area, and
choose AVI file under List files of type.

5. Enter a filename, such as mytut2.avi, and then
click OK.

6. Make sure that Save File is checked.

7. Click Render.

8. The scene is rendered, frame by frame.

9. When the rendering is completed, use
File>View File to play your animation.
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The transform tools let you position and adjust
your objects in space. Using them, you can
move, rotate, and scale any object or selection
of objects.

The transforms are the workhorse tools in your
3D scene. Because any transform can be key-
framed, they also become the foundation for
your animations.

This tutorial explores the nine transform tools
on the 3DS MAX toolbar. Three select-and-
transform tools let you move, rotate, or scale
your selection. Six controls to their right, called
the transform managers, modify the effect of the
three select-and-transform buttons.

Select and
Move

axis
constraints

Select and
Rotate

Select and
Scale

coordinate
system list

transform
managers

coordinate
 center

Transforms

Tutorial
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Using Axis Constraints 2

You’ll begin at the right-hand side of the trans-
form managers with the axis constraint buttons.
Quite simply, these constrain the current trans-
form to one or two axes.

In 3DS MAX, although you operate in 3D space,
you never transform your objects along all three
axes, or you have no control. You always trans-
form along a single axis, or along a 2D plane
consisting of two axes.

In this lesson, you will concentrate on how the
axis constraints affect the Select and Move tool.

Set up the scene:

1. Using File>Open, load tut3_1.max.The scene
includes several primitives and a ramp.

2.  Click Select and Move.

3. In the Perspective viewport, click to select the
purple octagon.

An axis tripod appears in the scene.

The X and Y vectors of the axis tripod are red,
while the Z is black. This shows you the avail-
able axes along which you can move the octa-
gon.

Move the object:

1. Drag the octagon in the Perspective viewport
and observe its movement in all viewports.

The octagon can move anywhere on the
ground plane because the X and Y axes are
parallel to the ground plane. You cannot
move the octagon above or below the ground
plane because the Z axis is locked out.

2. Click the X axis constraint button.

3. Drag the octagon in the Perspective viewport.
The octagon is constrained to the X-axis.

4. Click the Z axis constraint button.

5. Drag the octagon in the Prespective viewport.
The octagon moves up and down through the
ground plane.

The XY constraint button is a flyout that lets
you switch between three pairs of axes, repre-
senting 2D planes: XY, YZ, and ZX.

Switch planes and move the object:

1. Open the XY flyout, and click ZX.

2. Move the octagon.

You can now move the octagon up and down,
or right and left, in relation to the ground
plane, but you can’t move toward the front or
back.

3. Open the ZX flyout, and switch back to XY.
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There are several keyboard alternates for the axis
constraint buttons. The F5 through F8 keys are
directly mapped to the axis constraint buttons,
from left to right: F5=X, F6=Y, F7=Z, and F8=XY.
Pressing F8 repeatedly switches among the pairs
of axes.

Now that you’re accustomed to moving an
object around in the Perspective viewport,
watch what happens when you switch to an
orthographic viewport.

Try moving in a nonperspective view:

1. While XY constraint is active, activate the
Top viewport by clicking its label and drag the
octagon.

Because the Top viewport looks directly down
on the ground plane, moving in the Top view
is the same as moving in the Perspective view.

2. While watching the axis tripod, activate the
Front viewport. The axis coordinates sud-
denly switch orientation in all viewports.

3. Drag the octagon in the Front viewport.

The octagon moves parallel to the Front view-
port.

While you’re in the Front viewport, X is still
the horizontal direction, but Y has become
the vertical direction. If you watch the move-
ment in the Perspective viewport, you see the
octagon moving vertically off the ground
plane. You couldn’t do that using XY con-
straints while the Perspective view was active.
Read the next section for an explanation.
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Using Coordinate
Systems 2

The type of coordinate system you use affects
the orientation of your axes. As a default, 3DS
MAX uses a View coordinate system that is actu-
ally a hybrid of two other coordinate systems,
World and Screen.

The View coordinate system is the default
because it’s often the most useful. To best under-
stand it, first examine the coordinate systems
with which it’s made up.

World Coordinate System
The World coordinate system uses the orienta-
tion of the world coordinates. In 3DS MAX, as
seen from the front of the world, the X world
axis runs horizontally, the Z axis runs vertically,
and the Y axis runs in depth.

When you use the World coordinate system, the
orientation of the axes remains the same as the
construction grids, regardless of the viewport
you’re in.

Try out the World coordinate system:

1. Open the coordinate system pop-up list, and
select World.

The axis tripods in all views reorient them-
selves to match the World coordinate system.

2. With the XY axis constraint button active,
drag the octagon in the Perspective viewport.

The octagon moves along the XY axes of the
ground plane.

3. Try to move the octagon in the Front or Left
viewports.

When the axis constraints define a 2D plane
that’s edge-on to the viewport, you can’t
move along that plane. You can, however,
move along a single axis

4. Click the X axis constraint button.

5. Move the octagon in the Front viewport.

The octagon moves along the X axis. Notice,
also, the tripod labeling while different view-
ports are active.

6. Click each of the viewport labels while watch-
ing the axis tripod display.

The tripod labeling remains the same, regard-
less of the active view, because you’re working
in world coordinates, which don’t change.

Screen Coordinate System
The Screen coordinate system reorients the axis
tripod to the active viewport—or screen. The X
axis is always horizontal to the active viewport,
the Y axis is always vertical, and the Z axis is
always perpendicular. As you switch active view-
ports, the axes remain constant to the active
viewport, but change relative to world space.

Switch to the Screen coordinate system:

1. Open the coordinate system pop-up list, and
select Screen.

2. Click the XY axis constraint button.

3. Drag the octagon in the Front viewport.

The object moves parallel to the screen in the
Front viewport. The axis tripod displays X
horizontal and Y vertical in the Front view-
port
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4. Switch to the Left viewport and drag the octa-
gon.

As soon as you click in the Left viewport, the
tripod flips in that viewport so that X is hori-
zontal and Y vertical. The octagon, again,
moves parallel to the active viewport.

The tripods in the inactive viewports represent
the orientation of the axes in the currently active
viewport. As soon as you switch viewports, the
axes will change to represent the newly active
viewport.

Try switching viewports:

1. While the Left viewport is active, observe the
orientation of the tripod in the Top viewport.

The red X and Y axes in the inactive Top view-
port seem to indicate that the octagon can
only move vertically in that viewport.

2. Drag the octagon in the Top viewport.

As soon as you click the octagon, the Top
viewport becomes active, and the axis tripod
changes so you can again drag along the X
and Y axes in the Top viewport.

The Screen coordinate system is usually best for
orthographic viewports, but becomes problem-
atic in nonorthographic displays, such as the
Perspective viewport.

Use the Perspective viewport:

• Drag the octagon in the Perspective viewport
while watching its movement in all four view-
ports.

The octagon moves parallel to the Perspective
viewport, but at odd angles in the other view-
ports.

The reason the octagon moves at angles is
because the Perspective viewport is at an oblique
angle to the world, whereas the orthographic
viewports are aligned with world coordinates.
Notice also that the axis tripod is parallel with
the screen in the Perspective view, but at angles
in the orthographic views.

View Coordinate System
The View coordinate system uses Screen coordi-
nates for orthographic viewports, where it
makes the most sense. It switches to the World
coordinates system for nonorthographic views,
because that’s usually what you want when
you’re viewing your scene from an oblique
angle.

Switch to the View coordinate system:

1. Click View in the coordinate system list.

2. Drag the octagon in the Perspective viewport.

The octagon moves along the ground plane.

3. Drag the octagon in the Front viewport.

The axis tripod reorients itself to the Front
view, and the octagon moves parallel with the
Front screen.

You can easily move an object around on the
ground plane in the Perspective viewport. When
you want to move the object above or below the
plane, either switch to a Front or Left viewport,
or change the axis constraints.
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Local Coordinate System
A type of coordinate system that makes sense for
both perspective and orthographic views is the
Local coordinate system. This system uses the
local coordinates of the selected object. It’s par-
ticularly helpful when an object’s orientation is
no longer the same as the World coordinate sys-
tem.

For example, notice the ramp in the scene. If
you wanted to adjust the ramp by sliding it up
or down along its angle, you’d have to use local
coordinates.

Access the Local coordinates system:

1. Select the ramp object.

2. While watching the axis tripod, choose Local
in the coordinate system list.

The axis tripod tilts to match the orientation
of the ramp.

3. Click the X axis constraint button.

4. In the Perspective viewport, drag the ramp.
Then click Undo.

The ramp slides along its angle, moving
through the ground plane.

Pick Coordinate System
Perhaps the most versatile coordinate system in
3DS MAX is the Pick system. It lets you use the
coordinate system of any object you pick in the
scene. For example, here’s how to move that
blue torus along the ramp.

Access the Pick coordinate system:

1. Select the torus.

2. In the coordinate system list, click the Pick
item.

The prompt line instructs you to pick an
object.

3. In any viewport, click the ramp object.

The Ramp object name appears in the coordi-
nate system list, and the axis tripod is reori-
ented to match the angle of the ramp.

4. Make sure the X axis constraint button is still
active.

5. Drag the torus in any viewport, and then click
Undo.

The torus moves along the surface of the
angled ramp.

You can place up to four pick objects in the coor-
dinate system list. Each object you select, using
the Pick item, adds the object name to the bot-
tom of the list, where you can select it at any
time.

Parent Coordinate System
The Parent coordinate system works exactly the
same as the Pick system, except that it uses the
hierarchically linked parent of the selected
object. If the object has no parent, the world
coordinates are used, because an unlinked
object is a child of the world, as a default.
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Grid Coordinate System
In addition to the home grid system, 3DS MAX
lets you create any number of custom grid
objects, which can be placed anywhere in the
scene, activated, and used in place of the home
grid.

When you choose Grid as your coordinate sys-
tem the orientation of the axes automatically
matches that of the currently active grid system.
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Using Coordinate
Centers 2

You’ve seen coordinate systems; now you’ll look
at coordinate centers. These affect the center
about which a transform takes place, and only
affect scale and rotation transforms.

The Center flyout is to the right of the coordi-
nate system list. It lets you specify the center of
your transform. You have a choice of three cen-
ters:

 Pivot Point—Uses the local pivot point of
the object.

 Selection Center—Uses the center of the
current selection.

 Coordinate Center—Uses the center of the
current coordinate system.

Pivot Point Center
The default transform center is the pivot point
of the selected object, or objects. The pivot
point is what you’ve been using throughout
these tutorials. When you select an object, you
see the axis tripod located at the pivot point of
the object.

Rotate about a pivot point:

1.  Click Select and Rotate in the toolbar.

2. Turn on the Y axis constraint.

3. In the Perspective viewport, select one of the
orange cylinders.

The axis tripod appears at the base of the cyl-
inder.

4. Drag to rotate the cylinder, and then click
Undo.

The cylinder rotates about its base.

When you make a cylinder, its local pivot point
is placed at the base of the cylinder. (You can
change the position and orientation of an
object’s pivot point by using the Pivot tool in
the Hierarchy command panel.)

Selection Center
The Selection Center uses the center of the cur-
rent selection.

Rotate about the center of the selection:

1.  Click Use Selection Center in the Coordi-
nate Center flyout.

The axis tripod jumps to the center of the cyl-
inder.

2. Rotate the cylinder, and then click Undo.

The cylinder rotates about its center.

Coordinate Center
The Coordinate Center uses the center of the
current coordinate system. As you’ve already
seen, the current coordinate system can be any
number of places, and can change depending
on the viewport.

Rotate about the current coordinate system:

1. Make sure the Perspective viewport is active.

2.  Click Use Transform Coordinate Center
in the Coordinate Center flyout.

The axis tripod jumps to the origin of world
space, at the center of the ground plane.

3. Click the Z axis constraint.

4. Rotate the cylinder, and then click Undo.

center
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The cylinders swings in an arc about the ori-
gin of world space.

5. Rotate the cylinder in the Front viewport, and
then click Undo.

As soon as you activate the Front viewport,
the axis tripod jumps to the center of the
viewport, and the octagon rotates about the
center of the viewport.

Because you can use any object as a coordinate
system, it follows that you can specify any point
in space as your center.

Change to another coordinate system:

1. Choose Pick in the Coordinate System list.

2. Pick the teal pole at the back of the ramp.

The axis tripod jumps to the base of the pole.

3. In the Perspective viewport, rotate the cylin-
der, and then click Undo.

The cylinder rotates about the pole.

Using a Point Object
3DS MAX provides a helper object, called a point
object, that’s especially helpful as an adjustable
transform center.

The point object is simply a nonrenderable
object that provides a single point in space, plus
its own coordinate system. Once you’ve created
a point object, you can place it anywhere when
you need a “portable” transform center, or you
can position several point objects in a scene and
then switch between them.

Create a point object:

1.  Click Helpers in the Create panel.

2. Click the Point button.

3. Click anywhere in the Perspective view to cre-
ate a point object. (You can drag the mouse to
both create the point object and position it.)
The point object appears as a small yellow X.

4.  Click the Select and Move tool.

5. Click the XY button.

6. Position the point object anywhere you want.

Assign the point object as the center of your
transform:

1.  Click Select and Rotate.

2. Click Pick in the list, and select the point
object.

The name Point01 appears in the coordinate
system list.

3. Make sure the Z axis constraint button is still
active.

4. Rotate the cylinder in the Perspective view-
port. Then click Undo.

The cylinder swings around the point object.

Using Centers with Multiple Objects
3DS MAX stores a different type of center
depending on whether a single object is
selected, or two or more objects are selected.
Although the pivot point is the logical center
when you’re rotating a single object, you usually
want to use the Selection Center when you’re
rotating (or scaling) multiple objects. Watch the
Center flyout in the following procedure.

Rotate multiple cylinders:

1. Hold CTRL, and click on a second cylinder to
add it to the selection set.

The Center flyout switches to Use Selection
Center. The tripod moves to the center of the
two selected cylinders.
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2. Hold CTRL, and add the third cylinder to the
selection set.

3. Click the Y axis constraint button.

4. Rotate the cylinders, and then click Undo.

The three cylinders rotate as one object about
the center of their selection.

As a default, Selection Center is used when two
or more objects are selected. Now, look what
happens when you rotate multiple objects
around their pivot points.

Rotate a selection set around a pivot point:

1.  Click Use Pivot Point in the Coordinate
Center flyout.

Tripods appear at the base of each cylinder.

2. Rotate the cylinders, and then click Undo.

Each of the cylinders rotates about its own
pivot.
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Using Scale 2

You’ve sampled every transform tool in the tool-
bar, with one exception—Scale. So, let’s look at
that now.

Use Uniform Scale with default settings:

1.  Click Uniform Scale.

View becomes the current coordinate system.

2.  Click Use Pivot Point in the Coordinate
Center flyout.

Note: The axis constraints have no effect on
Uniform Scale, since it always scales the
object in all directions.

3. Drag the octagon to scale it up and down, and
then click Undo.

The octagon grows and shrinks in size.

Use Non-Uniform Scale:

1.  Click Non-Uniform Scale in the Select
and Scale flyout. Then click Yes for the warn-
ing message.

2. Click the XY constraints.

3. Scale the octagon in the Perspective viewport,
and then click Undo.

The octagon grows and shrinks along the X
and Y axes, but doesn’t change size along the
Z axis.

4. Click Z constraints.

5. Scale the octagon, and then click Undo.

The octagon grows and shrinks only along
the Z axis. Notice also that it scales to and
from the pivot point, at its base.

6.  Click Use Selection Center in the Coordi-
nate Center flyout.

7. Scale the octagon, and then click Undo.

This time the octagon scales in both direc-
tions from its center. There’s one more type of
Scale, called Squash, that’s particularly useful
in animation. It lets you scale an object along
one axis in one direction, while scaling in the
opposite direction along the remaining axes.

Squash the Octagon:

1.  Click Squash in the Select and Scale fly-
out. Then click Yes for the warning message.

2. While the Z constraint is active, scale the
octagon, and then click Undo.

As the Z-axis of the octagon scales up, the X
and Y axes scale down, and vice-versa.

3. Click the XY constraints.

4. Scale the octagon, and then click Undo.

The effect is exactly the same, except the
mouse movement is reversed.

The effect is the same because, in the first case,
you’re scaling the Z axis, and the XY axes are
responding, while in the second case, you’re
scaling the XY axes, and the Z axis is respond-
ing.
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Animating Transforms 2

Take a moment to animate the transforms
you’ve learned in this chapter.

Animate a squash:

1.  Click Use Pivot Point in the Coordinate
Center flyout.

2. Go to frame 50, and turn on the Animate but-
ton.

3.  Turn on the Percent Snap button (left of
the Animate button).

With Percent Snap on, the scaling will snap in
10 percent increments.

4. Squash the octagon down 50 percent on Z.
(Watch the status line.)

5. Go to frame 100, and squash the octagon up
300 percent on Z.

6.  Click playback in the time controls.

The octagon squashes down and back up.

7.  Click playback again to stop the anima-
tion.

Now, animate the torus so it rolls down the
ramp from the top.

Position the torus:

1. Turn off the Animate button.

2. Click Select and Move.

3. Select Ramp using the Pick coordinate system.

4. Click the X axis constraint.

5. Move the torus up to the top of the ramp.

6. Turn on the Animate button.

7. Go to frame 100.

8. Drag the torus to the bottom of the ramp.
Then turn off the Animate button.

9. Play, and then stop the animation.

The torus glides down the ramp while the
octagon squashes and stretches.

Animation and Transform Centers
Because of the nature of keyframing, all trans-
forms must occur about the object’s pivot point.
That means that you can use the Selection Cen-
ter and Coordinate center for modeling opera-
tions, but you can’t use them for animation.

As an example, look at what happens if you
attempt to animate the rotation of a cylinder
about the pole.

Try rotating about a coordinate center:

1. Select one of the cylinders.

2.  Click Select and Rotate.

3. Select Pole using the Pick coordinate system.

4.  Click Use Transform Coordinate Center
in the Coordinate Center flyout.

5. Click the Z axis constraint.

6. Drag the cylinder, and then click Undo.

The cylinder swings around the pole.

7. While watching the Coordinate Center fly-
out, turn on the Animate button.

The Coordinate Center flyout switches to Use
Pivot Point, and the axis tripod moves from
the pole to the base of the cylinder. While the
Animate button is on, you can’t change the
Coordinate Center flyout.

How do you get the animation you want? The
easiest way is to link your cylinder to another
object, such as a dummy object, and then rotate
the dummy. This is an advanced animation
topic that is covered in Tutorial 18, “Hierarchy
and Forward Kinematics.”
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Transform Type-Ins 2

You now know all about the transform tools in
the toolbar. There are two more methods of
transforming objects in 3DS MAX. One is the
Xform modifier, which lets you transform
objects in any order in the Modifier Stack. The
Xform modifier is introduced in Tutorial 4, “The
Modifier Stack.”

Another method of transforming objects pro-
vides precise control. It’s the Transform Type-In
dialog.

Access the Transform Type-In dialog:

• Choose Tools>Transform Type-In.

The Transform Type-In dialog appears.

You can use this dialog either to apply a trans-
form, or to simply view the current transform
values of any object in the scene.

The display in the dialog changes, depending on
the current transform settings in the toolbar,
and the current selection. With the Transform
Type-In dialog, you can apply a transform using
either absolute or relative values. The absolute
values, in the fields at left, use world coordi-
nates, while the relative values use the current
coordinate system.

Here’s how to move one of those cylinders
exactly 10 units back along the world’s Y axis.

Move one cylinder:

1. Turn off the Animate button.

2.  Click Select and Move, and select View in
the coordinate system list.

The title bar of the Transform Type-In dialog
reads Move Transform Type-In. The axis con-
straints don’t matter because the Transform
Type-In spinners let you access any single
axis.

3. In the Perspective viewport, click one of the
orange cylinders.

The Absolute:World spinners display the cur-
rent location of the cylinder in world coordi-
nates. (The Offset spinners are also labeled
World because the Perspective view is active,
and it uses world coordinates in the View
coordinate system.)

4. In the Y Offset spinner, type 10, and press
ENTER.

The cylinder moves back 10 units, the Abso-
lute Y value increases by 10, and the Offset
spinner returns to 0.

The Offset spinners always return to 0 after
they’re adjusted, because they represent the off-
set value of the transform.

You could use the mouse to move the torus side-
ways to the edge of the ramp, but the spinners
might give you more control.

Move the torus up the ramp:

1. Click the torus.

2. In the coordinate system list, choose Ramp.

The axis tripod tilts to match the ramp’s coor-
dinate system.

3. While watching the Top viewport, drag the Y
Offset spinner until the torus is at the front
edge of the ramp (about -15).
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The Modifier Stack is the central storage loca-
tion for most modeling operations in 3D Studio
MAX. Each object you create carries its own
Stack, and the Stack lets you access the com-
plete construction history of every object.

Using the Stack, you can access, alter, and ani-
mate the original parameters that went into the
creation of an object. You can add modifiers to
the Stack to bend, twist, or otherwise distort an
object, and then return and adjust—or ani-
mate—those distortions.

This tutorial examines the Stack, and the four
components that make up the construction his-
tory of an object. It shows you how to add items
to the Stack, and how to edit the Stack.

The tutorial also covers creation parameters,
standard object modifiers, and space warps.

Using the Modifier Stack

Tutorial
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A First Look at the Stack 2

In the following exercises, you’ll examine the
Stack and its relationship to changes you make
in a pair of simple, parametric primitives.

Load a sample scene:

• Using File>Open, load tut4_1.max.

The scene consists of a cube and a sphere. No
modifiers or other changes have been made to
the two primitives.

You might recall that, immediately upon creat-
ing an object, you can adjust its creation param-
eters in the Create panel. Once you proceed
with other functions, however, you access an
object’s creation parameters through the Modify
panel.

Examine the Modify panel:

1. Open the Modify command panel.

2.  Click Select and Move.

3. Select the sphere.

The sphere’s creation parameters appear at
the bottom of the panel. Above them, in a list
field in the Modify Stack rollout, appears the
word “Sphere.”

4. Select the box.

The creation parameters change to those of
the box, and the name in the list field changes
to Box.

5. Click the arrow beside the Stack list to open it
up.

Only the Box item, representing the creation
parameters, is in the Stack.

Currently, your selected object consists only of
creation parameters and transform values.
(Transforms are applied upon creation to place
the object in the scene.) As a result, the Stack list
displays only the creation parameters, as speci-
fied by the name of the type of object (Box, in
this case).
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Applying Modifiers 2

You’ll now apply an object modifier. Modifiers
are a form of object themselves that are applied
to other objects and stay with them, altering, or
modifying, the object’s local geometry.

As you’ll see, you can manipulate the object
modifiers themselves, apply several to an object,
and, at any time, go back and either adjust or
delete the modifier.

Modify Command Panel Layout

The Modify command panel is arranged in four
general areas.

At the top of the Modify panel is the name of
the selected object. This appears in all command
panels and, as always, you can edit this field at
any time to rename the object. To the right of
the field is the wireframe color button. Clicking
this displays the Object Color dialog, in which
you can change the wireframe color of the
object.

Below the object name is the Modifiers rollout,
containing a check box and three buttons, fol-
lowed by two columns of modifier buttons.
Only modifiers that are valid for the current
selection are enabled.

Next comes the Modifier Stack rollout. You’ll be
examining that in detail throughout these exer-
cises.

The last panel currently contains the creation
parameters for the box. This panel contains
parameters for whichever item is current in the
Stack.

Customizing the Button Set
Because you can’t fit all available modifiers in
the command panel, 3DS MAX provides meth-
ods that let you access additional modifiers. For
example, if there are more available modifiers
than those displayed in the rollout, the More
button is enabled. When you click the More but-
ton, a list of all additional modifiers appears,
and you can select one from the list.

In addition, you can create your own custom
button sets. In the following steps, you’ll create
a custom set, called Tutorial 4 Modifiers, contain-
ing four modifiers that you can use during this
tutorial.

object name and
wireframe color

object modifiers

Modifier
Stack

creation /modifier
parameters
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Create a custom button set:

1.  Click the Custom Button Sets button.

The Configure Button Sets dialog appears.

2. Set the Total Buttons spinner to 4.

Four buttons remain in the Modifiers area.
You can assign modifiers one at a time, but it’s
easier to select them all from the list, and
then assign them all at once.

3. Hold CTRL, and click Bend, Taper, Twist, and
XForm in the Default Deformations section of
the Modifiers list.

4.  Click the right-arrow button to assign
the selection to the four buttons.

5. Click in the Sets field, and type Tutorial 4
Modifiers.

6. Click Save.

7. Click OK.

The new set of buttons is displayed in the
Modifier rollout. You can switch between but-
tons sets by clicking the Sets button.

Applying a Taper
You’ll apply a Taper modifier, but first, notice
the name in the Modifier Stack field is Box.
That’s because you’re at the very bottom of the
Stack, at the creation parameter level.

Apply a Taper modifier:

1. Select the box.

2. Click the Taper button.

An orange, wireframe box surrounds the
object. The field in the Modifier Stack rollout
now reads Taper, and the Parameters rollout
changes to display the appropriate parame-
ters for the Taper modifier.

Although the box has not apparently changed
(it isn’t tapered), you have applied the Taper
modifier. It’s been added to the Modifier Stack
(above the creation parameters), and all that’s
left for you to do is adjust its parameters to taper
the box.

3. Click the arrow beside the Stack list.

The Stack contains the current Taper, and the
creation parameters (Box).

4. Adjust the Amount and Curve spinners and
watch their effect on the box.

5. Set the Amount to -0.7, and the Curve to -1.5

6. Right-click the Perspective viewport label,
and choose Smooth + Highlight.
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The box is now an inward curved column.

Animating the Taper Parameters
Almost everything in 3DS MAX can be ani-
mated, including modifier parameters. The
Taper Axis settings are absolute and cannot be
animated, but the spinner values can.

Animate the Taper parameters:

1. Turn on the Animate button.

2. Go to frame 50.

3. Change the Amount spinner to whatever you
like.

4. Go to frame 100.

5. Change the Curve to whatever you like.

6. Play the animation and watch the box change
shape over time.

Adjusting the Gizmo
An object modifier is a kind of object. The
orange wireframe you see represents the struc-
ture of the Taper modifier, called the gizmo. You
can use any transform to alter the position, rota-
tion, or scale of the gizmo relative to the object.

This changes the relationship of the Taper effect
to the box. When the Animate button is on, the
effect is animated.

Since the gizmo is a part of the modifier, you
access it by turning on the Sub-Object button.

Animate the Gizmo:

1. Click the Sub-Object button.

The list field at right becomes active, and the
gizmo wireframe turns from orange to yellow.
(If you look in the Sub-Object pop-up list,
you’ll also see a Center item. This is the center
of the modifier. By selecting it, you can trans-
form the center of the modification effect.)

2. Click the Animate button to turn it on.

3. Go to frame 30.

Tip: To go directly to a frame, enter its number
in the current frame field, to the right of the
Animate button, and press ENTER.

4. Making sure the Select and Move tool is still
active, drag over the yellow wireframe to
move the gizmo. As you move the yellow
gizmo, the box is distorted.

5. Go to frame 60, and move the gizmo in a dif-
ferent direction.

6. Go to frame 100 and move the gizmo again.

7. Play, and then stop the animation.

The box changes its tapering shape, and dis-
torts as the gizmo moves in relation to it.

Adding Modifiers to the Stack
Each time you apply a modifier, it’s added on
top of the current modifier in the Stack.
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Add a Twist modifier:

1. With the box selected, click the Twist button.

The Stack field now contains a Twist item.
The controls in the Parameters rollout change
to those of the Twist modifier, and the Sub-
Object button is turned off.

2. Make sure the Animate button is still on, and
move to frame 30

3. Adjust the Angle spinner to approximately
180 degrees.

The box is twisted.

Accessing the Creation Parameters
The edges of the twist are not smooth because
the box, as created, doesn’t have enough seg-
ments along its height. Go back to the creation
parameters at the bottom of the Stack and
increase the number of segments.

Move back in the Stack:

1. Right-click the Perspective viewport label,
and choose Wireframe.

2. Click to open the list in the Modifier Stack
rollout.

Twist
Taper
------------
Box

The list shows you the current modification
history of the object. At the top is the latest
modifier, the Twist. Below that is the Taper
you applied. At the bottom is “Box,” repre-
senting the creation parameters.

3. Select Box from the list.

The box’s creation parameters appear in the
Parameters rollout.

4. Increase the Height Segs spinner until the
twist is smooth (about 30–40 segments).

Note: Don’t confuse the Height Segs spinner
with the Height spinner.

Because you’ve adjusted the segments at
frame 30, with the Animate button active,
you’ve actually animated the increase in seg-
ments.

5. Drag the time slider between frame 0 and 30.

You can see the segments increase over the
range of frames.

6. Right-click the viewport label, and choose
Smooth + Highlight.

7. Play the animation.

The box twists and writhes over 100 frames.

8. Stop the animation.

Thus, you can actually change the topology of
your objects over time. At frame 0, where you
don’t need the extra segments, the object is rel-
atively simple. At frame 30 where you need the
segments, the complexity is there.

Deleting a Modifier
If you apply a modifier and it just doesn’t work
out, or you apply a modifier to the wrong place
in the Stack, you can simply delete it.

Each item in the Stack is applied to the geome-
try from the bottom of the Stack, upward.
Therefore, the effect of any modifier on your
object depends on where in the Stack you apply
it.

A typical mistake is to go back and adjust the
creation parameters, and then apply another
modifier, forgetting to first move up to the top
of the Stack. Here’s an example of how this error
might occur:
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Adjust creation parameters, and then apply a
Bend:

1. Choose Box from the Stack list to display the
creation parameters.

At this point, you might adjust the parame-
ters, but then, forgetting to go back to the top
of the Stack, apply another modifier.

2. Apply a Bend modifier.

3. Adjust the Angle spinner.

The result is strange because you’re actually
bending the box before the Taper and Twist
modifiers are applied.

You decide you’ve made a horrible mistake, but
you can easily fix it by removing the Bend and
reapplying it at the top of the Stack.

Delete the Bend and apply it again:

1.  Click Remove Modifier below the Stack
field.

The Bend is removed from the Stack.

2. Choose Twist from the Stack list.

You’re now at the top of the modifier list.

3. Click the Bend button.

4. Adjust the Angle spinner.

The tapered, twisted box bends over.

5. Turn off the Animate button.

6. Use File>Save As to save your scene as
mytut4.max.
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Using Space Warps 2

From the bottom up, the box’s Stack now con-
sists of creation parameters, a Taper, a Twist, and
a Bend. Although you can’t see it in the Stack
list, the object’s transforms follow the modifiers.

Now, you’ll add the last type of item to the
Stack—the space warp binding.

Space warps, as their name implies, warp space.
They affect an object based on the relative posi-
tion of the object to the space warp.

The space warp itself is an object in the 3D
Scene. It can be transformed, but it’s not ren-
dered.

Creating a Ripple
Because a space warp is an object, you create it
like any other object. In the following, you’ll
create a Ripple space warp, adjust it, and then
bind the box to the Ripple.

The Ripple space warp generates a circular sine
wave from its center outward. Objects that are
bound to it are distorted by the generated wave.

Adjust the viewports and create the Ripple:

1.  Click Min/Max Toggle in the navigation
controls to display all four viewports.

2.  Use Zoom to zoom out the Front view-
port so there’s some room around the two
objects.

3.  Click Space Warps in the Create com-
mand panel.

4. Click the Ripple button.

5. In the Front viewport, to the right and
slightly above the box, drag the mouse to
define the Wave Length of the ripple (about
30 should be fine).

6. Release the mouse, move it to define the
amplitude (about 5 for Amplitude 1 and
Amplitude 2), and then click to create the Rip-
ple.
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Binding the Object
The space warp object only affects those objects
in the scene that you bind to it. You can bind
any number of objects to a single space warp, or
bind a single object to any number of space
warps.

Bind the box to the space warp:

1.  Click Bind to Space Warp in the toolbar,
and select the box.

2. Point the mouse over the box.

The cursor changes to a bind cursor. Watch
the box during the next step.

3. Drag the mouse from the box over the space
warp, and then release the mouse.

As you drag the mouse, a dashed line appears
from the pivot point of the box to the cursor.
When the cursor is over the Ripple (or any
valid space warp in your scene), the cursor
changes shape. When you release the mouse
button, the Ripple flashes, the box is bound to
the Ripple, and it’s immediately affected by it.

Adjusting the Warp Effect
There are three basic ways you can change (and
animate) the effect of a space warp on a bound
object:

• Alter the relative position between the space
warp and the bound object.

• Adjust the parameters of the space warp.

• Adjust the parameters of the space warp bind-
ing.

In the following steps, you’ll look at the first
method.

Adjust the position between the two objects:

1. Activate the Perspective viewport.

2. Click Min/Max Toggle to enlarge the Per-
spective viewport to full size.

3. Go to any frame of your animation.

4.  Click Select and Move.

5. Drag the box around, watch the effect of the
Ripple on it.

As you move the box, it wriggles, depending
on its position, relative to the Ripple.

You can either animate the box flying past the
ripple, or you can leave the box stationary and
animate the movement of the Ripple object.
Another method is to animate the space warp
parameters.

Animate a Ripple Parameter:

1. Go to frame 100.

2. Turn on the Animate button.

3. Open the Modify panel, and select the Ripple
object (if it’s not already selected).

4. Set the Phase spinner to about 0.5.

5. Turn off the Animate button.

6. Play the animation.

The box writhes and twists from the modifi-
ers, and wriggles because of the Ripple. You
can also see the animated phase shift in the
wireframe Ripple.

7. Stop the animation.



3t2tut04.fm    10  Thu Oct  2 14:21:17 1997

Tutorial 4

4 
– 

10
U

si
n

g
 t

h
e 

M
o

d
ifi

er
 S

ta
ck

Another Look at the
Stack 2

Now that you’ve added the final type of item,
the space warp, to the box’s Modifier Stack, take
another look.

1. Select the box.

2. Click to open the Stack list.

Ripple Binding
=======
Bend
Twist
Taper
................
Box

You can see that the elaborately complex object
in your scene starts with a box (the creation
parameters). Above this are three object modifi-
ers that are distorting the creation parameters—
a Taper, followed by a Twist, followed by a Bend.
Above the three modifiers, a double-dashed line
(=====) represents the ever-present transforms,
and above the transforms is the binding to the
space warp, in this case, a Ripple.

As with the modifiers, you can deactivate, or
even delete the space warp bindings at any time.

Changing the Stack Order
The order of the items in the Stack can alter the
end effect on the object. Although you can’t
change the order of modifiers already in the
Stack, you can specify where a new modifier will
be inserted when you first apply it. Modifiers are
inserted just above your current location in the
Stack.

See what happens to two identical cylinders
when you apply a Taper and a Bend in different
orders.

Start fresh, and create a cylinder:

1. Reset MAX, and answer Yes to save your
changes.

2. Create a cylinder with a Radius of 10, a Height
of 50, and 12 Height Segments.

3.  Click Select and Move, and XY axis con-
straints.

4. In the Perspective viewport, hold SHIFT, and
drag the cylinder to the right.

The Clone Options dialog appears.

5. Make sure Copy is selected, and then click
OK.

Two identical cylinders are in the scene.

6.  Click Zoom Extents All.

7. Set the Perspective viewport to Smooth +
Highlight.

8. Choose Edit>Hold to store the current 3DS
MAX scene and its settings in a restorable
buffer.

You’ll now apply a Taper followed by a Bend to
the first cylinder, and the same two modifiers in
reverse order to the second.

Taper and bend the cylinders:

1. Select the first cylinder.

2. In the Modify command panel, click Taper,
and set the Amount to –0.5.

3. Click Bend

4. Set the Angle to 90.

5. Select the second cylinder.

6. Apply a Bend with an Angle of 90.

7. Apply a Taper with an Amount of –0.5.

8.  Click Zoom Extents All.
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The two cylinders are distorted differently.

The cylinders are different because, in the first
case, you bent a tapered cylinder, while in the
second, you tapered a bent cylinder.

Using the XForm Modifier
You can specify the order of the object modifiers
in the Stack, but what do you do about trans-
forms, which are always applied after modifiers?

The following steps show you a typical problem
you might run into when using non-uniform
scaling transforms.

Apply Non-Uniform Scale and a Bend:

1. Choose Edit>Fetch, and answer Yes at the
prompt.

The original two cylinders are restored.

2.  Click Non-Uniform Scale in the Scale fly-
out.

3. Click the Z axis constraint button.

4.  Turn on Percent Snap in the prompt line.

5. In the Perspective viewport, select and scale
the second cylinder up 150 percent along the
Z axis.

6. Select the first cylinder.

7. Apply a Bend, and set the Angle to 90.

8. Select the second cylinder.

9. Apply a Bend, and set the Angle to 90.

The two cylinders are bent differently.

Because transforms are always applied after
modifiers, the non-uniform scale, applied to an
already bent cylinder, distorts the bend effect.
To get the bend you want, you need to apply the
scale before the bend, which is something you
can’t do directly using the transform tools in the
toolbar.

The solution is to use a transform modifier. Actu-
ally, the modifier is called the XForm modifier. It
lets you apply transforms to an object as part of
the modifier list. You apply the XForm modifier
wherever you want in the Stack, and then trans-
form the modifier’s gizmo, which, in turn, trans-
forms the geometry.

Use the XForm modifier:

1. Choose Edit>Fetch, and answer Yes at the
prompt.
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2. Select the second cylinder.

3. Click the XForm button in the Modify com-
mand panel.

The XForm modifier appears in Sub-Object
mode with its gizmo already selected.

4.  In the Perspective viewport, use Non-Uni-
form Scale to scale the gizmo 150 percent
along the Z axis.

The cylinder is scaled along with the gizmo.

5. Turn off Sub-Object

6. Select the first cylinder, apply a Bend, and set
the Angle to 90.

7. Select the second cylinder, and apply a Bend
with an Angle of 90.

Both cylinders are bent in the same way.

Examine the Stack list of the second cylinder,
and you’ll see that the XForm modifier carrying
the non-uniform scale comes before the Bend.
This is the reason the bend is working properly.

You can duplicate the previous scaling problem
by changing the order of the Bend in the Stack.

Change the order of the Bend:

1.  Turn off the Active/Inactive modi-
fier toggle to turn off the Bend in the second
cylinder.

2. Move down the Stack to the creation parame-
ters (Cylinder.)

3. Apply a Bend, and set the Angle to 90.

The cylinder is bent strangely as it was at the
beginning of this exercise.

XForm is an extremely valuable modifier. Not
only does it let you specify exactly where in the
Stack you want a transform, but you can also use
it to transform sub-object geometry, as you’ll see
in the next tutorial.
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Modifying Multiple
Objects 2

Now that you know how to navigate the Stack,
and the difference between a modifier and a
space warp, it’s time to look at what happens
when you apply modifiers to a selection set of
objects.

There are two things to remember when you
apply a modifier to two or more objects at once:

• You can modify each object in the selection
individually, or modify the selection set as a
whole.

• Regardless of which method you choose, an
instance of the same modifier is applied to all
of the objects in the selection set.

Use Pivot Points
Begin by loading a sample file, selecting several
objects, and applying a modifier.

Load a sample file and apply a Taper:

1. Using File>Open, load tut4_2.max.

2. Choose Edit>Hold.

3. Select all three objects in the scene.

4. Open the Modify command panel, and make
sure that Use Pivot Points is not checked.

5. Apply a Taper modifier.

6. Adjust the Amount to about –0.7.

All three objects are tapered as though they
were one object. In other words, the selection
set as a whole is tapered.

When Use Pivot Points is turned off, the entire
selection set is treated as if it were a single
object, and modified accordingly. This is the
effect you might want if you had several 3D let-
ters forming a word, and you wanted to bend
the word.

You’ll return to this effect later, but note that
you must select your pivot point option before
you apply the modifier. You can’t go back and
change it after the fact. Luckily, if you make a
mistake, you can simply delete the modifier
from the Stack, switch the option, and then
reapply the modifier.
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Say you want to taper each object individually.

Delete the modifier and apply again:

1.  Click Remove Modifier to remove the
Taper from the Stack.

2. Select Use Pivot Points.

3. Apply a Taper.

4. Adjust the Amount to about –0.7.

Each object is individually tapered.

Instanced Modifiers
Although you see a Taper gizmo around each of
the selected objects, only one Taper actually
exists in the scene. Moreover, the Stack for each
object contains the same Taper modifier. When
you apply a modifier to a selection of objects,
each object receives an instance of the same
modifier.

An instance is something that appears more
than once in a scene. It can be in different loca-
tions, but when you adjust one instance, all
other instances are affected identically.
Although you see different modifiers, they’re
actually the same modifier in two or more
places.

Look at what happens when you adjust the
Taper modifier in only one of the objects.

Adjust the Taper for the sphere:

1. Deselect the objects.

2. Select only the sphere.

Taper gizmos appear around the cylinder and
box as well as the sphere.

3. Adjust the Amount spinner.

All three objects are modified.

Change the selection and add a Bend:

1. Select the cylinder and the box.

2. Apply a Bend.

Gizmos surround the cylinder and the box.

3. Adjust the Angle to about 50 degrees.

The cylinder and box bend, the sphere
doesn’t change.

You now have a single Taper applied to all three
objects, and a single Bend applied to the box
and the cylinder. The modifiers available in the
Stack depend on the current selection.

Change selections and observe the Stack:

1. Select the sphere.

The Taper appears in the Stack, and the Taper
gizmo surrounds all three objects.

2. Adjust the Amount spinner.

All three objects are modified.

3. Select either the cylinder or the box.

The Bend modifier appears in the Stack.

4. Adjust the Angle spinner.

Only the cylinder and box are modified.
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5. Select all three objects.

The Stack is blank.

The Stack is blank because there is no longer
commonality among the three objects. The
sphere doesn’t share the Bend with the box and
cylinder. As a result, when you select all three
objects, there’s nothing to display.

Commonality is only maintained in the Stack
when each object in the selection set shares a
common modifier at the top of the Stack. When
the last modifier in the Stack is not shared by
every object in the selection set, the Stack is no
longer common to all.

You can, however, always access modifiers that
were previously common by selecting a single
object, and then going down in its stack to the
instanced modifier. When you adjust the
instanced modifier, all objects that share it will
be affected, regardless of the state of the selec-
tion.

Show Dependencies
Objects that share instanced modifiers (or
objects that are themselves instanced) are
dependent on each other. 3D Studio MAX pro-
vides a function that helps you determine
which objects in your scene are dependent on
each other because of instancing. It’s called
Show Dependencies.

Display Dependencies:

1. Choose Views>Show Dependencies.

2. Select only the sphere.

The wireframe displays and the brackets of
the box and cylinder turn bright green.

3. Adjust the Taper parameters.

The current selection and the green objects
are all affected.

When Show Dependencies is on, deselected
objects that are dependent on the current func-
tion applied to the current selection turn bright
green.

In the previous example, when the sphere is
selected, its last modifier is the Taper, instanced
between all three objects. As a result, the box
and cylinder turn green.

Select the cylinder; then the box:

1. Select the cylinder.

Only the box turns green.

2. Select the box.

Only the cylinder turns green.

The box and cylinder share their Bend modifier,
which is currently at the top of their stacks.
Because the sphere doesn’t share this modifier, it
doesn’t turn green.

The green display is completely dependent on
the current modifier in the Stack, as you’ll see in
the following steps.

Change the Stack location:

1. While the box is selected, move down in its
Stack list to the Taper.

The cylinder and sphere turn green.

2. Move down to the creation parameters (Box).

None of the objects are green.

When you move to the Taper modifier, it’s
instanced in all three objects, so both the cylin-
der and sphere turn green. However, the cre-
ation parameters of the box are shared by no
other objects, so none of the objects is green
when you’re at that position in the Stack.
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Make Unique
Applying modifiers to selection sets is a fast way
to place the same modifier on a collection of
objects. After applying the modifier, you might
want each object to be modified in a unique
manner.

Make the Taper Unique:

1. With the box selected, move to the Taper
modifier in its stack.

The cylinder and sphere turn green.

2.  Click Make Unique in the Modifier Stack
rollout.

The green highlighting is turned off and the
gizmos disappear around the cylinder and
sphere.

3. Adjust the Amount spinner.

Only the box is affected.

4. Select the sphere.

The cylinder turns green, but not the box.

5. Adjust the Amount spinner.

Only the sphere and cylinder are affected.

As soon as you clicked Make Unique, the Taper
in the box’s Stack became unique, and was no
longer instanced. The Taper applied to the cylin-
der and sphere, however, remains instanced,
unless you make it unique as well.

You can make all instanced modifiers in a selec-
tion set unique with a single click of the button,
but there’s an interesting side effect you should
be aware of.

Make a selection set unique:

1. Select all three objects.

2. Apply a Twist.

3. Adjust the Angle a bit.

All three object twist.

4.  Click Make Unique.

The Stack becomes blank.

The Stack becomes blank because, once you’ve
made the Twist for each object in the selection
unique, the selected objects no longer have
commonality in their Stacks. Thus, to access
each Twist, you must now select each object
individually.

Modifying the Selection Set
At the start of this exercise, you saw the effect of
applying a modifier while Use Pivot Points was
off. Look at that again.

In the original scene, apply a modifier:

1. Choose Edit>Fetch, and answer Yes at the
prompt.

2. Select all three objects.

3. Uncheck Use Pivot Points.

4. Apply a Taper, and adjust the Amount to
about –0.6.

All three objects are tapered as if one.
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Judging from the gizmo, it looks as if a single
modifier is affecting the three objects. But you
still have three instances of that single modifier.
When you first apply the modifier to the selec-
tion, the gizmo for each object is overlaid and
looks like one, but look what happens when you
move the objects.

Move the objects:

1.  Click Select and Move.

2. Select only the sphere, and move it back and
away from the box.

A separate gizmo surrounds the sphere.

3. Move the cylinder forward and away from the
box and sphere.

Each object has its own gizmo.

4. While the cylinder is selected, adjust the
Amount spinner.

Each object is affected.

5.  Click Make Unique, and adjust the
Amount spinner.

The gizmo now surrounds only the cylinder,
and only the cylinder is modified.

As you can see, the rule for instanced modifiers
is the same whether you apply the modifier with
or without Use Pivot Points checked.
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The Cylinder Table 2

In this exercise, you’ll pull together the concepts
of applying modifiers to single and multiple
objects by creating an animated table made up
entirely of five cylinders. You’ll also get your
first taste of instanced objects.

Making the Top and Legs
Begin by resetting 3DS MAX, and then creating
the necessary geometry.

Create the table top:

1. Reset 3DS MAX (but don’t save your changes).

2.  Turn on 2D Snap in the prompt line.

3. Set the Perspective viewport to Smooth +
Highlight.

4. In the Create command panel, click the Cyl-
inder button.

5. In the Top viewport, create a cylinder in the
center of the ground plane with a radius of
150 units, and a height of 10 units.

6. Set the Sides spinner to 40 to smooth out the
edge of the table top.

7. In the Name field, type Table Top, and press
ENTER.

8.  Click Zoom Extents All.

Create the first leg:

1. Make sure the Cylinder tool is still selected.

2. In the Top viewport, point the mouse inside
the table top toward the lower-left quadrant,
and drag to define a radius of 20 units.

3. Release the mouse, and then move it to define
a height of 160 units.

You’ll use square legs for the table, so adjust
the cylinder’s parameters accordingly.

4. In the Parameters rollout, change the number
of sides to 4.

5. Uncheck Smooth.

6. In the Name field, type Leg, and press ENTER.

7.  Click Zoom Extents All.

Instancing the Legs
To create three more legs, you’ll make instanced
copies so you can easily modify all four legs by
adjusting any one of them.

As with the instanced modifiers, demonstrated
earlier, three instanced objects in your scene, are
the same object in three different locations. Any
modifications you make to one of the objects
affects the others.

Make instances of the leg:

1.  Click the Select and Move button in the
toolbar.
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2. Click the X axis constraint button (or press
F5).

3. In the Top viewport, hold SHIFT, point the
mouse at the leg, and drag to the right until
the copy is about same distance from the
opposite edge of the table top.

When you release the mouse, the Clone
Options dialog appears.

4. Choose the Instance option, and then click
OK.

An instance of the table leg is created.

Although it looks like you have two leg objects,
both are the same object displayed in two places
in the scene.

Make a total of four instances:

1. Drag the mouse to region select both legs. (Or,
hold CTRL and click the deselected leg to add
it to the selection.)

2. Click the Y axis constraint button (or press
F6).

3. Hold SHIFT and drag the two legs up to the
opposite side of the table top.

4. In the Clone Options dialog, make sure that
Instance is still selected, and click OK.

You now have four instanced table legs.

Moving the Table Top
Before you do anything else with the legs, you’ll
raise the table top. Since Y axis constraint is
active, the Front viewport is the logical place to
do this.

Position the table top:

1.  Turn off 2D Snap.

2. In the Front viewport, drag the table top up
until it barely overlaps the tops of the legs.

3. Turn on XY axis constraint and, in the Top
viewport, move the table top so it appears
centered over the table legs.

4.  Use the Arc-Rotate button in the Perspec-
tive viewport to adjust the viewing angle on
the table.
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Modifying a Leg
Because the legs are all instances, you adjust any
single one to modify all of them.

Taper the legs:

1. In the Perspective viewport, click to select one
of the legs.

2. In the Modify command panel, click the
Taper button to apply a taper to the leg, and
all of the instances.

3. Set the Taper Amount spinner to 0.36.

Adjusting the creation parameters on one leg is
the same as adjusting them for all the legs.

Increase the segments, and curve the legs:

1. Open the Stack list, and go down to the cre-
ation parameters (Cylinder).

2. Set the Height Segments spinner to 14.

3. In the Stack list, return to the Taper modifier
and set the Curve spinner to –2.5.

All four legs are identically tapered and
curved.

Taper the Selected Legs
You now have an opportunity to apply what
you learned in the previous exercise about mod-
ifying selection sets.

You decide you want all four legs to curve out-
ward from the table. To achieve this, you’re
going to taper and curve the four legs as if they
were a single object.

Taper the four legs:

1. Select all four legs.

2. Make sure that Use Pivot Points is not
checked.

3. Click the Taper button to apply another taper
to the legs—this time to their selection.

The Taper gizmo surrounds the four legs.

4. Set the Taper Amount spinner to 0.17, and the
Curve spinner to –0.85.

The four legs now have a pronounced curve.
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Changing Your Mind
In 3DS MAX, it’s easy to change your mind. Say
you no longer like the effect of square legs.
Because they’re instances, what you do to one,
you can do to all. Here’s how make them into
cylinders.

Circle the squares:

1. Select any one of the legs.

2. Open the Modifier Stack list, and click Cylin-
der to access the creation parameters.

3. Increase the Sides to 20.

4. Check Smooth.

5. Decrease the Radius to 12.

The legs are now slender, curved cylinders.

A Bit of Animation
The table could use some animation to bring it
to life. Twist the legs and animate the result.

Twist the legs:

1. Select all four table legs.

2. Click the Twist button.

The orange Twist gizmo surrounds the legs.

You’ll want the tops of the legs to remain where
they are, while the rest of them twist. To do this,
you move the center of the Twist gizmo.

Adjust the Gizmo Center:

1. Click the Sub-Object button.

2. Choose Center in the Sub-Object list.

The gizmo center appears as a yellow axis tri-
pod.

3. Click the Y axis constraint button.

4. In the Front viewport, move the center of the
Twist gizmo to the top of the legs.
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Animate the Twist:

1. Turn on the Animate button.

2. Go to frame 50.

3. Set the Angle spinner to 180. The legs twist
around themselves.

4. Go to frame 100.

5. Set the Angle spinner to 0. The legs straighten
out.

6. Turn off the Sub-Object button.

7. Turn off the Animate button.

8. Activate the Perspective viewport.

9. Play, and then stop the animation. The table
legs twist around and then return to their
original position.

Grouping the Table
Assume you’re finished with this table, but you
want to treat it as a single object in your scene.
That is, you want to be able to click on any part
of the table and drag it around the room. If you
did that right now, you’d come away with the
table top, or a spare leg.

In 3DS MAX, you can use grouping to hold
things together. Here’s how to do it.

Group the table:

1. Choose Edit>Select All.

All objects are selected.

2. Choose Group>Group.

The Group naming dialog appears.

3. Type Table in the Group dialog, and click OK.

The table top and the four legs are grouped
into a single “object,” called Table.

4. Go to frame 100, and turn on the Animate
button.

5. Click the XY axis constraint button, and
make sure Select and Move is still selected.

Just to prove that you can select any part of
the table:

6. Click outside of the table to deselect every-
thing.

7. Click on any part of the table.

The entire table is selected.

8. In the Perspective viewport, drag the table
across the floor toward the back of the ground
plane.

9. Play the animation.
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The table moves across the floor on twisting
legs.

Before you leave this tutorial, remove your cus-
tom button set. You won’t need it for the
remaining tutorials.

Remove the custom button set:

1.  Click Configure Button Sets in the Modify
command panel.

2. Make sure that Tutorial 4 Modifiers is dis-
played in the Sets list.

3. Click Delete.

4. Open the Sets list, and choose Default 10.

5. Click OK.
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Sub-Object Selection
Using the Edit Mesh
Modifier

Tutorial

In this tutorial, you’ll perform sub-object selec-
tion, and use a different class of modifier—the
edit modifier.

The edit modifier provides access to the compo-
nents that make up an object. You can push,
pull, add, and delete vertices and faces, and you
can modify and animate subsections of your
objects.

There are several edit modifiers available in 3D
Studio MAX. Each works on a different type of
geometry. This tutorial concentrates on the Edit
Mesh modifier, which lets you edit triangular
mesh objects, as well as parametric objects.

In the exercises, you’ll learn the various ways an
edit modifier combines with other modifiers to
provide unlimited modeling and animation
capabilities.
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Editing a Cylinder 2

In the following steps, you’ll edit a parametric
cylinder to see how Edit Mesh interacts with the
Stack and other deformation modifiers.

Create and taper a cylinder:

1. In the center of the ground plane in the Per-
spective viewport, create a cylinder with a
Radius of 30, and a Height of 90. Increase the
Height segments to 12, and leave the rest of
the settings at their default values.

2. In the Modify command panel, apply a Taper,
setting the Amount to 0.5.

The cylinder tapers outward.

3.  Click Zoom Extents All.

4. On the Modifiers rollout, click the More but-
ton, then select Edit Mesh.

The item Edit Mesh appears in the Stack field,
with an asterisk beside it. Sub-Object mode is
activated and set to Vertex, and an Edit Vertex
panel appears. In addition, each vertex in the
cylinder is displayed with a tick mark (a small
cross).

The moment you clicked to apply the Edit Mesh
modifier, you converted the cylinder from a
parametric object to a mesh object. The para-

metric creation parameters are still available,
however, at the bottom of the Stack.

Selection Levels
In the previous tutorial, when you used defor-
mation modifiers, such as Taper and Bend, you
accessed the gizmo and the Center of each mod-
ifier through the Sub-Object list. The same is
true of edit modifiers, except that you access the
different levels of geometry selection. By
default, the Edit Mesh modifier appears in sub-
object selection mode.

There are three sub-object selection levels, corre-
sponding to the three sub-object components in
a mesh object:

• Vertex

• Face (which includes element)

• Edge

Each is discussed in the following sections.

Selecting Vertices

Begin by selecting the smallest of the compo-
nents—the vertex.

Select some vertices:

1.  Click Select Object (if it’s not already
selected).

2. Click any vertex in the cylinder.

An axis tripod appears at the selected vertex.

3. Drag a region box around a portion of the cyl-
inder.

All vertices in the region turn red.

Notice that white indicates object selection, and
red indicates sub-object selection.
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Tip: When you select a single vertex, it’s hidden
by the axis tripod. When necessary, you can
turn off the axis icon display, using Views>Show
Axis Icon.

Selecting Faces

The next editable component, the face, hangs
on three triangular vertices, like the facet on a
geodesic dome. The face provides the visible sur-
face of your object, as lit in the rendered scene.

Within face selection mode are three more selec-
tion modes—face, polygon, and element.

Select polygons of faces:

1. Choose Face in the Sub-Object list.

The vertex ticks—both red and white—disap-
pear. New tools appear in the rollouts below.

2. In the Front viewport, click anywhere in the
middle of the cylinder.

A square turns red.

3. Drag a region around several faces.

The selected faces appear as squares.

4. In the Perspective viewport, click the top of
the cylinder.

In the other viewports, you can see that the
entire top of the cylinder is selected.

The three icons in the Selection area let you
determine how you select your faces. As a
default, you use a polygon selection method,
which selects the coplanar faces in the mesh,
such as the top of the cylinder.

Although you can’t see them, all faces in a mesh
object are triangular. The hidden edges are
called construction lines. When you want to
select faces at the triangular level, you switch to
face selection mode.

Change face selection mode:

1.  Click the Face Selection button.

The selected top of the cylinder displays its
triangular faces.

2. Click any face on the side of the cylinder.

A triangular face turns red.

3. Drag a region around several faces.

Several triangular faces turn red.

4. Check By Vertex, beside the three face-selec-
tion buttons.

5. Click a vertex.

All faces shared by the vertex are selected.

6. Uncheck By Vertex.

7.  Click Polygon selection.

The third face-selection mode icon lets you
select elements, which are a discrete collection of
connected vertices and faces within an object.
An example might be 3D letters in a word
object. In the case of this cylinder, there is only
one element in the object—the cylinder itself.

Selecting Edges

The third editable component of a mesh is the
edge of each face.

faces

elements

object
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Select some edges:

1. Choose Edge in the Sub-Object list.

2. Click to select any edge, then drag a region to
select several edges.

The selected edges turn red.

You’ve seen that you can use the Edit Mesh
modifier to select various components of mesh
geometry. With each of the three selection
types, a different set of tools appears in the pan-
els below the Modifier Stack rollout. Each of
these tools is specific to the type of sub-compo-
nent you’re working on.

Transforming Vertices
For any selection you can use the transform
tools in the toolbar. Thus, you can move, rotate,
or scale any selection, just as you can with
whole objects. There are three things to remem-
ber when you’re performing sub-object editing:

• If you’re going to use region-drag selection in
the middle of a mesh, use the Select Object
tool rather than one of the Select Transform
tools. If you attempt to drag a region of faces
using, say the Select and Move tool, you’ll
end up dragging a single face instead.

• Once you’ve selected the sub-object compo-
nents, lock your selection to prevent acciden-
tal deselection. This is particularly important
in sub-object editing, where it’s easy to miss
that tiny vertex.

• You can’t select other objects, or deselect the
current object while in Sub-Object selection
mode. When you want to move on to other
objects, turn off Sub-Object selection.

Do some sub-object editing by squeezing the
vertices in the center of the cylinder.

Select and scale some vertices:

1. Choose Vertex in the Sub-Object list.

2. In the Front viewport, drag a region to select
a “belt” of three rows of vertices, just below
the upper five rows of vertices (see the follow-
ing illustration).

3. Press the SPACEBAR to lock the selection.

4. Do one of the following to select the Scale
tool:

• Right-click and select Scale from the menu.

•  Click Select and Uniform Scale in the
toolbar.
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5. Drag anywhere in the viewport to scale down
the vertices about 70 percent.

You’ve just performed your first sub-object edit-
ing. This is the first of the two types of selection
functions provided by Edit Mesh.

Applying a Modifier to Sub-Object
Selection
The second type of selection function is apply-
ing a modifier to the selection. You’ll select a set
of vertices, and then apply a deformation mod-
ifier to the Stack. At that point, the selection
that remains in the Edit Mesh modifier deter-
mines how the subsequent modifier affects the
cylinder.

Taper the top part of the cylinder:

1. Press the SPACEBAR to turn off selection Lock.

2. Select the top five rows of vertices.

3. Click the Taper button to apply a Taper mod-
ifier.

The Taper gizmo surrounds only the previ-
ously selected vertices.

4. Examine the Stack list.

*Taper
*Edit Mesh
Taper
---------
Cylinder

Before you begin adjusting the Taper, look at
what the Stack list is telling you.

The creation parameters (Cylinder) establish the
dimensions and the topology (segments and
sides) of the parametric cylinder. After that, you
applied a Taper modifier to taper the entire cyl-
inder outward.

You then applied the Edit Mesh modifier,
selected vertices, and scaled in the middle of the
cylinder. Next, you selected a new set of vertices
before applying the second Taper modifier.
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Thus, you used the Edit Mesh modifier for two
functions:

• Selecting and scaling the middle of the cylin-
der

• Providing a selection set of vertices for the
second taper.

As you can see from the gizmo box of this Taper,
it only affects the vertices you selected in the
previous Edit Mesh modifier.

The asterisks beside Edit Mesh and the second
Taper indicate that these items of the Stack are
at sub-object level. In other words, you left the
Edit Mesh modifier at Sub-Object level, and
therefore the second Taper is applied at the sub-
object level (as would be any subsequent modi-
fier).

Later, you’ll see how to return the Stack to
object level. Meanwhile, adjust the Taper.

Adjust the Taper:

1. Adjust Amount to about –0.15.

You notice that, as a default, the taper occurs
about the center of the selected vertices,
changing the size of the lower and upper por-
tion of the selection set. You decide the effect
would be better if the center of the taper was
at the bottom of the gizmo.

2. Select Sub-Object, and then click Center in
the list.

3.  Click Select and Move, and the Y axis
constraint.

4. Drag the yellow Center cross down to the bot-
tom of the Taper gizmo.

5. Adjust the Curvature to -2.0, and set the
Amount at –0.5.

Show End Result in Edit Mesh
This second Taper in the Stack is completely
dependent on the vertex selection left by the
previous Edit Mesh modifier. Because of this,
one of the deformation modifier functions,
Show End Result, works a bit differently in the
Edit Mesh modifier.

Just as a reminder, look at the way Show End
Result usually works.

Use Show End Result:

1. Go back to the first Taper in the Stack.

2.  Turn off Show End Result.

Only the full Taper is displayed. All remaining
modifiers are not used. Therefore, the scale
vertices of the Edit Mesh and the vertex selec-
tion and second Taper don’t appear.

3.  Turn on Show End Result.

The fully modified object returns.

4. Move to Edit Mesh in the Stack.
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The upper portion is not displayed as tapered.
Also, the Show End Result button is dese-
lected.

5.  Hold the mouse button down on
Show End Result, and then release.

While the button is held down, the end result
is displayed, but the button pops back up as
soon as you release the mouse.

What’s going on here?

The second Taper is entirely dependent on the
previous selection in the Edit Mesh modifier.
Thus, the upper taper that you see changes if
you alter the vertex selection while in the Edit
Mesh modifier. You can see this by simply
changing your selection and clicking Show End
Result.

Change the vertex selection:

1. Select the middle section of scaled vertices.

2.  Press Show End Result to see what
happens.

The selected vertices move way out.

3. Select all vertices on the right half of the
object.

4.  Press Show End Result.

5. Try various other vertex selections and
observe Show End Result.

Depending on the selected vertices, the cylin-
der is deformed differently.

6. Reselect the top five rows of vertices.

7.  Press Show End Result to make sure
the top part of the cylinder is tapered and
curved as it originally was.

Can you imagine what would happen if Show
End Result remained active while you’re work-
ing in Edit Mesh mode? As you altered the selec-
tion of your vertices, the vertices themselves
would jump all over the place because of the
modifiers applied later in the Stack. Thus, while
in an Edit Mesh modifier, you can temporarily
view the end result, but while working with the
Edit Mesh modifier, you only see the object up
to that point in the Stack.

Modifying a Second Selection Area
You’ve decided that you want to twist the base
of the cylinder by applying a Twist modifier to
vertices in the lower part of the object.

To do this, you apply another Edit Mesh modi-
fier, and change the selection pattern.

Add a second Edit Mesh:

1. Open the Stack and examine it.

*Taper
*Edit Mesh
Taper
---------
Cylinder
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The asterisk beside the Edit Mesh modifier
indicates the sub-object vertex selection,
which the second Taper is using. To change
the sub-object selection without affecting the
second Taper, you need an Edit Mesh modifier
following that Taper.

2. Go to the top Taper in the Stack.

3. Apply another Edit Mesh modifier.

4. Select the bottom three rows of vertices.

5. Apply a Twist modifier, and then set the Angle
to 50.

The bottom portion of the cylinder is twisted

Returning to Full Object Modification
You applied the second Edit Mesh modifier for
no other purpose than to switch sub-object
selection before the next deformation modifier.

You need only use additional Edit Mesh modifi-
ers when you want to switch the selection for
additional modifiers in the Stack. If you simply
want to edit the mesh of the object itself, you
can go to any Edit Mesh modifier in the Stack
and use its tools to alter the object.

If subsequent modifiers in the Stack depend on
the selection pattern of that Edit Mesh modifier,

simply restore the selection before you move
on.

For example, if you want to move some vertices
in the cylinder, you can go to the first Edit Mesh
modifier, select and move any of the vertices,
and then reselect the upper vertices for the
Taper. Your cylinder looks correct at the end of
the Stack.

But, once you’re through with all this sub-object
editing and modification, how do you apply a
modifier, such as a Bend, to the entire object?

The Stack contains the following:

*Twist
*Edit Mesh
*Taper
*Edit Mesh
Taper
---------
Cylinder

Again, the asterisks indicate that everything
above the first Taper is applied at a sub-object
level. To return to object level requires one more
Edit Mesh modifier.

Return to object level:

1. Make sure you’re at the Twist, at the top level
of the Stack.

2. Apply an Edit Mesh modifier.

3. Turn off Sub-Object.

The vertices on the cylinder are no longer dis-
played as tick marks. The asterisk no longer
appears beside Edit Mesh in the Stack field.

4. Apply a Bend, and then adjust the Angle as
you wish.
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Renaming Modifiers
When you build a complex Stack, the duplicate
modifier names can become confusing. It helps
to rename your modifiers so, if you return to the
object two months later, you can figure out
what you did.

The current Stack looks like this:

Bend
Edit Mesh
*Twist
*Edit Mesh
*Taper
*Edit Mesh
Taper
---------
Cylinder

Here’s how to rename your modifiers:

Edit the Stack:

1.  Click Edit Stack.

The Edit Modifier Stack dialog appears.

2. Click Taper at the bottom of the list.

3. In the Name field, place the cursor before the
word Taper, and type Full, so that the new
name reads “Full Taper.”

4. Change the first Edit Mesh to read EM:scale
verts & sel top.

Note: Don’t bother typing the asterisks.
They’ll be restored when you exit the dialog.

5. Rename the rest of the items in the Stack, so
it looks like the following:

Full Bend
EM: revert to full
*Twist base verts
*EM: sel base verts
*Taper top verts
*EM: scale verts & sel top
Full Taper
---------
Cylinder

6. Click OK.

The Stack list is now more descriptive.

7. Use File>Save to save your scene as
mytut5.max.

Warning: Be sure and save your cylinder at this
point. The following steps will destroy it, and
you’ll need to reload it later.

Altering the Creation Parameters
When you apply an Edit Mesh to a parametric
object, you convert the object to a polygonal
mesh. The creation parameters of the original
object, however, remain at the bottom of the
Stack. See what happens if you go back and
change those parameters.

Access the creation parameters:

1. Open the Stack and choose Cylinder to move
to the creation parameters.

A warning message appears:

A modifier exists in the Stack that
depends on topology.
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Changing the parameters may have
undesirable effects.
The dependent modifier is: Edit Mesh.

2. Click OK.

The creation parameters appear.

This warning message appears when an Edit
Mesh modifier is in the Stack, and you attempt
to access the creation parameters.

Most parametric objects carry two types of cre-
ation parameters:

• Those that affect the dimensions of the object.

• Those that affect the topology of the object.

For example, in a cylinder, the dimensions are
its radius and height, while its topology is the
number of segments and the number of sides.
Changing the dimensions has no effect on the
topology of the cylinder, but if you change the
number of segments or sides, you also change
the number of vertices and their arrangement in
the object.

The first Edit Mesh modifier and all modifiers
above it in the Stack, depend on the location
and the number of vertices in the object. Thus,
any changes to the topology of an object affect
everything in the Stack from the Edit Mesh
upward.

To see the effect, first alter the dimensions, and
then alter the topology.

Change the dimensions:

1. Drag the Radius spinner up and down, and
then right-click.

The cylinder changes radius with no prob-
lems.

2. Drag the Height spinner up and down, and
then right-click.

As the height of the cylinder moves through
the modifiers, it changes shape, but it returns
to its original shape when it’s back to the
same setting.

Change the topology:

• Drag the Height Segments spinner up to 20,
down to 1, and then right-click to cancel.

As you drag the spinner, the cylinder loses
portions of its modification, but doesn’t
regain them when you restore the original
values.

Once you reduce the number of vertices in the
object, that reduction is passed along the Stack,
permanently dissolving any modifications that
rely on those vertices.

For a clearer example, try this:

1.  Click Edit Stack.

The Edit Stack dialog appears.

2. Drag to select all items in the Stack list, except
the Cylinder.

3. Click Cut, and then click OK.

All modifiers except the original cylinder are
removed from the Stack, and the plain cylin-
der is restored.

4. Choose Edit>Hold.

5. Apply an Edit Mesh modifier.
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6. In the Front viewport, region-select all verti-
ces except those in the last row at the base of
the cylinder.

7. Apply a Taper modifier, and adjust the
Amount spinner to approximately –0.500.

The selected vertices are tapered into a cone.

8. Open the Stack and select Cylinder to return
to the creation parameters.

The warning message appears.

9. Click OK.

10.Slowly increase the number of Height Seg-
ments.

As you increase the segments, the selected
vertices move downward and the Taper is
maintained because you haven’t lost any ver-
tices.

11.Slowly decrease the number of Height Seg-
ments, until there is only 1, and then increase
them again to about 12 or so.

The segments with selected vertices disappear
off the end of the cylinder until there are only
selected vertices at the top of the object.
When you then increase the segments again,
the cylinder becomes a hopeless mess.

Once the vertices are gone, it does you no good
to change direction and add vertices again. The
Edit Mesh modifier has no way of knowing
which vertices to select.

Here’s the rule. If you have an Edit Mesh modi-
fier in the Stack, don’t change the creation
parameters that affect topology.

Using the Select Modifier
3D Studio MAX provides a second sub-object
selection method that avoids the problem
you’ve just seen. It’s called the Volume Select
modifier, and rather than depend on the topol-
ogy of an object, it floats a volume around the
object. Anything within that volume is passed
along the Stack as a selection. Thus, if you alter
the number of vertices in an object, it really
doesn’t matter, because subsequent modifiers
will affect any part of the geometry that’s within
the specified volume.

Apply a Vol. Select modifier:

1. Choose Edit>Fetch, and answer Yes at the
prompt.

The original cylinder is restored.

2. Select the cylinder.

Because the Vol. Select modifier is not
included in the ten default modifier buttons,
you can access it by clicking the More button.

3. Click the More button in the Modify com-
mand panel.

A list of all available modifiers appears.

4. Choose Vol. Select from the list, and click OK.

5. A gizmo surrounds the cylinder, and a num-
ber of new parameters appear.

6. Choose Vertex under Stack Selection Level.



3t2tut05.fm    12  Thu Oct  2 14:22:43 1997

Tutorial 5

5 
– 

12

All vertices in the cylinder are selected.

7. Click Sub-Object to activate the gizmo.

8.  Use Select and Move with the XY axis
constraints to drag the gizmo around, and
then right-click to cancel.

As you drag the gizmo, only the vertices
inside it are selected.

Although there are a number of parameters in
the Vol. Select modifier, its entire purpose is to
create a selection pattern that’s passed up the
Stack. You do this by using the transform tools
to scale and position the gizmo so it surrounds
the geometry you want selected.

See what happens if you apply a Taper using vol-
ume selection, and then change the topology.

Adjust the selection:

1.  Use Select and Move with Y axis con-
straints to move the gizmo up in the Front
viewport so that all vertices but the bottom
row are selected.

2. Apply a Taper modifier, and adjust the
Amount to about –0.500.

Only the previously selected vertices are
tapered.

3. Open the Stack and select Cylinder.

No warning appears.

4. Increase the Height Segments to about 20.

The tapered area remains the same.

5. Slowly reduce the Height Segments to 1, and
then increase them again to 12.

Until you reach 1, the taper remains. When
you return to 12 segments, the taper is exactly
the same as it was when you started.

There are other advantages to volumetric selec-
tion. You can go back in the Stack and change
the selection area while watching the effect.

Move the selection area:

1. Go up to the Vol. Select modifier in the Stack.

2. Click Sub-Object to access the gizmo.

3.  Use Select and Move in the Front view-
port to move the gizmo up and down, and
then right-click to cancel.

The selected vertices within the gizmo are
tapered.
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Creating a Jet Plane 2

So far, this tutorial has concentrated on the sub-
object selection properties of the Edit Mesh
modifier, along with volumetric selection meth-
ods. In this exercise, you focus instead on the
editing features in the Edit Mesh modifier.

There are a huge number of features in the Edit
Mesh modifier—far more than can be covered in
a few short tutorials. In this exercise, you’ll learn
how you can use just a couple of editing tools to
create a jet plane.

Begin by creating a box:

1. Reset 3DS MAX.

2. Activate the Perspective viewport, and choose
wireframe display.

3. In the Create command panel, click the Box
button.

4. Create a box near the center of the ground
plane with a length of 60, a width of 120, and
a height of 30.

5.  Use Arc Rotate to angle the Perspective
view so you’re looking slightly down on the
box, at a three-quarter angle.

Create a jet plane out of this box.

Apply Edit Mesh, and begin editing:

1. Open the Modify command panel, and click
the Edit Mesh button.

The Edit Vertex tools appear.

2. Choose Face in the Sub-Object list.

3. Click to select the long side of the box facing
you in the Perspective viewport.

The side of the box turns red to signify that its
faces are selected.

Using Face Extrusion
In the following modeling procedure, you’ll use
the face extrusion tool with scale transforms to
build your jet. The face extrusion tool moves the
selected faces outward (or inward) along their
normals, adding new side faces to provide con-
nections with the original geometry.

Note: You can use the mouse or the spinner to
extrude selected faces. Each time you extrude,
however, a new set of faces is created. For accu-
racy, in the following steps you’ll enter the
extrusion amounts directly into the Extrude
spinner field.

click here
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Extrude the selected face:

1. Press the SPACEBAR to lock the selection.

2. Click Extrude.

3. Type 50 in the Amount spinner, and press
ENTER.

The side of the box pushes outward.

4.  Click Zoom Extents All.

Now, scale the result:

1. Place the mouse over the viewport, right-
click, and select Scale from the menu.

2.  Click Percent Snap in the prompt line.

While Percent is active, scaling operations
snap to the default 10 percent.

3. Drag downward in the viewport to scale the
face down 50 percent (watch the readout in
the status line).

Extrude and scale again:

1. Click Extrude, type 50 in the Amount spin-
ner, and press ENTER.

2. Right-click in the viewport, choose Scale, and
scale the face down 50 percent.

3.  Click Zoom Extents All.
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Now repeat the process on the other side.

Extrude the other side of the box:

1.  Use Arc Rotate to view the other side of
the box.

2. Press the SPACEBAR to turn off selection lock.

3. Click the other side of the box to select its
face.

4. Press the SPACEBAR to lock the selection again.

5. Click the Extrude button, and set the Amount
to 50.

6. Right-click in the viewport, choose Scale, and
scale the face down 50 percent.

7. Click Extrude and extrude the face 50 units.

8. Choose Scale and scale the face 50 percent.

9.  Click Zoom Extents All.

You’ll use the same steps for the tip of the plane.

Create the tip:

1.  Use Arc Rotate to swing the plane around
so the selected face at the wing tip is to your
left.

2.  Unlock the selection, click the face near-
est you, and then lock the selection.

3. Extrude the face 50 units, and then scale it 30
percent.

4. Extrude again 70 units, and then scale 30 per-
cent.

5.  Click Zoom Extents All.

select this face
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Sweeping the Wings
A simple selection and move will give your jet a
more streamlined appearance.

Select and move some faces:

1.  Unlock the selection.

2.  Click Select and Move.

3.  In the prompt line, click the Win-
dow/Crossing button to switch to Window
Selection mode.

4. In the Top viewport, select the faces at the
extremes of the wing tips:

• Drag a region around the face at one wing
tip.

• Hold CTRL, and drag a region around the
other wing tip.

5.  Lock the selection.

6. Click X axis constraint in the toolbar.

7. Drag the faces about 80 units along X.

The box has become a jet plane.

drag a region to select this tip

...then hold CTRL, and drag a region to
select this tip
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Shapes are the foundation for many of the more
complex objects you create in 3D Studio MAX.
With shapes, you can create 2D and 3D splines
that range from simple geometric circles to
sweeping curves of subtle complexity.

Shapes are the basis for extrusions and spun
objects, and the components that make up Loft
objects. Text objects begin their life as shapes, as
well. You can also use shapes to animate objects
along a precise path, or to create intricate
inverse kinematic linkages.

This tutorial examines several of the shape-cre-
ation tools in 3D Studio MAX. You’ll learn how
to combine shapes, and how to alter their
appearance through editing. You’ll look at the
Line tool, and examine several of the options
provided by the Edit Spline modifier.

During the tutorial, you’ll learn about the
spline components that make up a shape—the
vertices, the segments, and Bezier controls.

Shapes
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Creating Shapes 2

Because all shapes are created on the construc-
tion grid, and most are 2D, you usually work
with shapes in a single, maximized viewport. By
working in the Top viewport, all your shapes are
placed on the home grid. This isn’t necessary,
but it keeps them from blocking the view when
you’re looking at your scene from the front.

In the following exercise, you’ll create a few
shapes just to get a feel for it. First, you’ll change
the object creation color, so it’s easier to see the
shapes.

Changing the Object Creation Color
Shapes consist of thin lines that can be difficult
to see. Rather than accept the random wire-
frame colors used by 3DS MAX as a default,
change the object creation color to a single, eas-
ily seen color.

Set the object creation color:

1. Click the object color swatch in the Create
command panel.

The Object Color dialog appears.

2. Select the light yellow color swatch (third
down in the first column of basic colors).

3. Uncheck Assign Random Colors.

4. Click OK.

From now on, all created objects will be
assigned light yellow.

You can change the object creation color at any
time by repeating the previous procedure. Make
sure that no objects are selected when you click
the color swatch. When you want to return to
random color assignment, re-enter the Object
Color dialog, and check Assign Random Colors.

Create two shapes:

1.  Click Shapes in the Create command
panel.

2. Click Rectangle.

3. In the upper-left area of the Top viewport,
drag the mouse diagonally to create a rectan-
gle, approximately 100 by 150 units. (Size
doesn’t really matter.)

4. Click Circle.

5. In the upper-right area of the Top viewport,
drag to create a circle approximately 50 units
in radius.

You can see by looking in the other viewports
that both shapes are two-dimensional.

6.  Maximize the Top viewport.
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The two shapes you’ve created are very much
alike, except that one contains vertices that cre-
ate corners and straight segments, while the
other contains vertices that create curved seg-
ments. To view vertices, you apply an Edit
Spline modifier.

Another type of shape contains a creation
parameter that lets you switch back and forth
between curved and straight vertices.

Create an n-gon:

1. Click N-Gon, and drag in the lower-right area
of the viewport to create an n-gon that’s
about 50 units in radius.

A six-sided n-gon appears.

2. Set the Sides spinner to 4.

The n-gon becomes a square (rotated 45
degrees).

3. Check Circular.

The n-gon becomes a circle.

4. Uncheck Circular.

5. Set Sides to 6.

The n-gon is again a six-sided polygon.

Extruding a Pencil
Because shapes are primarily used as the founda-
tion of other objects, here’s how you might use
the n-gon shape to create a pencil.

Extrude the n-gon:

1. Make sure the n-gon shape is selected.

2.  Minimize the Top viewport.

3.  Click Zoom Extents All.

4. Apply an Extrude modifier from the Modify
command panel.

5. Set the Amount spinner to about 300.

6.  Click Zoom Extents All.

7. Turn on Smooth + Highlight in the Perspec-
tive viewport.

Now that you’ve extruded the n-gon, you can
add some segments, and then use an Edit Mesh
modifier to make the tip of a stubby pencil.

Sharpen the pencil:

1. Set Segments to 3.

2. Apply an Edit Mesh modifier.

3. Choose the Face sub-selection mode.

4.  Make sure Polygon face selection is active.

5. Select the top (capping) face of the pencil.
(Use Arc Rotate to tilt the Perspective view, if
necessary.)

6. Scroll the Edit Mesh panel up until you can
see the Miscellaneous area.

7. Click Collapse.

The capping faces collapse into a single ver-
tex, producing a point.

click here
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If you were to continue with this, you’d adjust
the smoothing, assign different materials for the
tip and the sides, and so on. You now know how
to create an object, starting with a shape.

Multi-Spline Shapes
A shape can consist of one or more splines.
There are three ways to create a multi-spline
shape:

• Use either the Donut or the Text tools, which,
in themselves, create multi-spline shapes.

• Use Edit Spline to append splines to an exist-
ing shape.

• Turn off the Start New Shape mode.

Take a look at Start New Shape mode first.

Set things up:

1.  Maximize the Top viewport.

2. Open the Create command panel.

At the top of the Object Type rollout is a check
box that defaults to on. While this box is
checked, you’re in Start New Shape mode, and
every shape you create becomes a new shape. By
unchecking this box, every shape is added to the
currently selected shape.

Turn off the Start New Shape mode:

1. Uncheck the Start New Shape box.

2. Deselect all objects.

3. Click Ellipse.

4. In the lower-left area of the viewport, drag
diagonally, as if you’re creating a rectangle.

An ellipse appears.

5. Click Rectangle.

6. Create a rectangle inside the ellipse.

The second shape is added to the first, which
you can see because both shapes are still
selected.

7. Click Star.

8. Inside the rectangle, drag outward to make a
small star, release the mouse, and move to
create a second radius. Click to create the star.

While you’re at it, add a star outside the three
nesting shapes.

9. Create a star outside the ellipse.

10.Set the Points spinner to 15.

You’ve now created a shape consisting of several
other shapes. When you want to start a new
shape, you click the Start New Shape button,
and start anew.

Start another shape:

1. Click Start New Shape.

The selected shape splines become deselected.

2. Click Donut.

3. Drag elsewhere in the viewport to create a cir-
cle, release the mouse and move to create a
second, concentric circle. Click to complete
the donut.
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The Donut tool lets you create two splines at
once.

4. Click Ellipse.

5. Drag anywhere to create an ellipse.

The ellipse is added to the donut.

6. Check the box beside Start New Shape.

The button is deactivated, and you’re back in
Start New Shape mode.

You get the idea. Now, extrude your multi-spline
shape to see what you’ve got.

Extrude the shape:

1.  Click Select and Move.

2. Select the shape consisting of the two stars,
the rectangle, and the ellipse.

3. Press P to switch to the Perspective view.

4. Apply Extrude in the Modify command
panel.

5. Set the amount to 40.

6.  Adjust Arc Rotate for a good angle.

You now have an extruded object consisting
of three elements: an ellipse with a rectangu-

lar hole, a six-pointed star inside the hole,
and a 15-pointed star outside of the ellipse.

Attaching Shapes
There are times when you have separate shapes
that you want combined into one. Perhaps, for
example, you forgot to turn off Start New Shape
mode. To combine separate shape objects into
one, you use the Edit Spline modifier.

Here’s how to attach a shape to one you’ve
already created.

Apply an Edit Spline modifier:

1. Press T to switch back to the Top view.

2. Select the original rectangle shape (in the
upper-left of the viewport).

3. Apply Edit Spline.

There are four component levels to a shape.
When the Sub-Object button is off, you’re deal-
ing with the object itself—the shape. At the sub-
object level, you can access the splines within
the shape, then the segments within the splines,
and finally, the vertices themselves.

To attach shapes to the existing shape, you need
to be at the shape level.
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Use the Attach function:

1. Turn off the Sub-Object button.

2. Click Attach.

3. Select any other shape.

The selected shape becomes part of the rect-
angle shape.

4. Select another shape.

5. The selected shape is added to the first two.

That’s the basic method. You can also use Edit
Spline to detach shapes. To do this, you need to
select the splines within the shape, so you switch
to the spline sub-object level.

Detach a shape:

1. Turn on Sub-Object.

2. Choose Spline in the Sub-Object list.

3. Click to select any spline in the shape. (Hold
CTRL, and click to select more than one
spline.)

4. Click Detach.

5. Enter a name in the dialog, and then click OK.

The detached spline is now an independent
shape from the original, and a new object.

6. Turn off Sub-Object.

7. Click to select the detached shape.

Creating Text
All text in 3DS MAX begins as a shape. In addi-
tion, the text shapes are procedural, so you can
alter the font, size, and other characteristics
after creating your object.

Here’s how to combine the Text shape tool with
the Attach function to create a plaque with
indented text.

Delete the objects, and create text:

1. Choose File>New, answer No and click OK to
delete the objects in the scene.

2. Click Text in the Shapes branch of the Create
command panel.

You can enter and adjust your text either
before or after creation. For this exercise,
enter the content, and you can adjust the rest
later.

3. Enter your initials (two or three letters) in the
Text field in the command panel.

4. Click in the center of the Top viewport.

Your initials appear as shapes in the viewport.

5. Adjust the Size spinner to shrink or enlarge
the text.

6.  Click Zoom Extents.

Now that you have the text, you can make some
changes:

Adjust the text shapes:

1. Choose from various font styles in the pop-up
list.

When you choose a different style, the text
shapes change accordingly.

2.  Click the I or U buttons, turning them
on or off.
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These buttons let you apply italics or an
underline to the shape text.

Use the Ellipse tool to create the outline of the
plaque.

Create the plaque shape:

1.  Zoom out slightly so there’s room around
the text shape.

2. Click the Ellipse button.

3. Beginning outside of the upper-left corner of
the text shape, drag down and to the right to
surround the text with an ellipse.

4. Adjust the Length and Width spinners until
the ellipse seems the right proportion for a
plaque surrounding the text.

5. On the General rollout under Interpolation,
check Adaptive to smooth the curves in the
ellipse.

Align the text:

1. Make sure the Ellipse shape is still selected.

2.  Click Align in the toolbar.

3. Click the text shape.

The Align Selection dialog appears.

4. Check X position and Y position (leave Z
position unchecked).

5. Make sure that Center is chosen in both the
Current Object and Target Object areas.

6. Click OK.

The ellipse is now centered around the text.

In the following steps, you’ll create two shapes
for extrusion. One shape will consist of both the
ellipse and the text, resulting in an object with
a text-shape hole. The other shape will consist
of only the text, which will fill the hole to a dif-
ferent depth. The result will be an engraved
look. First, create an additional text shape for
the second extrusion.

Create the additional shape, and extrude it:

1. Select the text shape.

2. Choose Edit>Clone.

3. Choose Copy, and click OK to create a Text02
object.

4. Press P to switch to the Perspective viewport.

5. Apply Extrude in the Modify command
panel, and set the amount to 10.

The Text02 object is extruded 10 units.

Attach the remaining shapes, and extrude the
result:

1.  Click Select by Name, choose Text01, and
click Select.

2. Apply Edit Spline.

3. Turn off the Sub-Object button.

4. Click Attach, and then click the ellipse shape.

5. Apply Extrude, and set the amount to 15.

6.  Click Quick Render to render the view-
port. (Adjust the view angle first, if necessary.)
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Tip: To make an embossed rather than an
engraved plaque, simply change the amount of
extrusion in the text.
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Adjusting Vertices 2

Now that you’ve seen how to create and com-
bine shapes, you should examine the compo-
nents from which they’re made.

When you work with shapes, creation is just a
small part of the process. You seldom get very far
without applying an Edit Spline modifier. This is
where you can adjust the vertices and segments,
and change the very curvature of the splines.

When you use an Edit Spline modifier to adjust
a shape, the vertices do all of the work. It is their
values that affect the curvature of the segments
on either side of them.

You can best see the effect of spline editing by
working with a simple shape, such as a rectan-
gle.

Create a rectangle:

1.  Exit the render window.

2. Press T to switch back to the Top viewport.

3. Choose File>New, click No, and then click OK
to erase all objects in the scene.

4.  Click Zoom Extents.

5. Click Rectangle.

6. Create a rectangle that fills about three-
fourths of the viewport.

7. On the General rollout under Interpolation,
check Adaptive.

Vertices appear when you create a shape, and
then remain invisible until you apply an Edit
Spline modifier.

Apply Edit Spline, and examine the vertices:

1. Apply Edit Spline in the Modify command
panel.

Tick marks reveal the vertices at each corner
of the rectangle. One corner displays a white
square, representing the “first” vertex.

2. Select the vertex in the upper-left corner.

Two green squares appear, along with the axis
tripod of the vertex.

The axis tripod display might obscure your
view, so turn it off.

3. Choose Views>Show Axis Icon to shut off the
axis tripod display.

You can now see the red tick mark of the cor-
ner vertex, along with the two green squares.
The sides of the rectangle between the tick
mark and the green squares are gray.

Vertex Types
The green squares are vector handles that let you
adjust the value of the vertex. Each vertex in a
shape can be one of four types:

• Smooth forces the segments into a smooth
curve tangent to the vertex.

• Corner allows the segments on either side of
the vertex to be at any angle.
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• Bezier provides handles, but forces the seg-
ments into a tangent through the vertex.

• Bezier Corner provides handles, and allows the
segments on either side of the vertex to be
any angle.

As you might guess by the green handles and
the angle of the segments on either side of the
vertex, the currently selected vertex is a Bezier
Corner type.

You can switch vertex types at any time by right-
clicking the selected vertex.

Change the vertex type to Smooth:

1. Right-click the selected vertex, and choose
Smooth.

The top and left segments of the rectangle
become curved, and are now tangent to the
vertex.

Notice that the effect of the curve travels out-
ward from the selected vertex toward the ver-
tices at the upper-right and lower-left corners.
Those vertices carry their own values and
attempt to hold their end of the segment in
check.

2. Drag the vertex around. No matter where you
move the vertex, the spline remains tangent
through the vertex.

3. Click Undo to cancel.

Switch to Corner:

1. Right-click the vertex, and choose Corner.

The straight lines of the rectangle return.

2. Drag the vertex around, and then click Undo
to cancel.

The meeting of the segments at the selected
vertex can be at any angle, like a hinge. The
curvature of the two segments is caused by
the other two vertices maintaining their val-
ues.

Adjusting the Bezier Spline

The remaining two types of vertices are Bezier,
and because they provide handles for adjust-
ment, you’ll probably use them most of the
time.

Switch to Bezier Corner:

1. Right-click the vertex, and select Bezier Cor-
ner.
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Except for two green vector handles, the rect-
angle is unchanged. This is because neither
type of Corner vertex is forced to maintain a
tangent. As a result, they can adapt to what-
ever angle is present when you choose them.

When you work with Bezier vertices, you can
transform either the vertex itself, or the han-
dles.

2. Drag the vertex around, and then right-click
to cancel.

The Bezier Corner vertex acts differently than
the Corner vertex. It locks its corner angle in
place, whereas the Corner vertex was like a
loose-pin hinge, allowing any angle neces-
sary.

3. Drag one of the green handles around, and
then click Undo to cancel.

You can drag the handle in two ways: either by
rotating the handle around the vertex, or by
moving the handle to and from the vertex. As
you rotate the handle, you change the angle at
which the segment approaches the vertex. As
you move the handle to or from the vertex, you
change the tension in the segment. The longer
the handle, the less tension, and the greater the

curvature; the shorter the handle, the greater
the tension, and the more linear the segment. If
the handle is shortened to the point where it
meets its vertex, the segment becomes a straight
line.

Now that you know what to look for, try it
again.

Adjust a handle:

1. Drag a handle around again, and examine the
difference between rotation and tension.

2. Click Undo to cancel.

The plain Bezier vertex is similar to the Smooth
vertex, except that it provides handles. As with
the Bezier Corner, you can rotate or change the
length of the handle to affect the angle or the
tension in the segments. Unlike Bezier Corner,
however, the segments remain tangent to the
vertex.

Switch to Bezier:

1. Right-click the vertex, and choose Bezier.

2. The two vector handles become a straight
line, forcing one of the segments into a curve.
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3. Drag the vertex around, and then click Undo
to cancel.

The tangent handles remain straight, no mat-
ter where the vertex moves.

4. Drag either of the handles around, both rotat-
ing and changing their length. Click Undo to
cancel.

The segments remain tangent to the vertex,
no matter how you adjust the vector handles.
If you lengthen one handle, the other length-
ens as well, reducing the tension in both seg-
ments and increasing their curvature. If you
reduce the length to the point where the
green squares are at the vertex, the segments
become straight.

While adjusting a Bezier, you can “break” the
tangent, and convert it into a Bezier Corner.

Break the tangent:

1. Drag one of the green handles until both seg-
ments are curved.

2. Press SHIFT, continue dragging the handle,
and then release SHIFT.

As the tangent breaks, the unselected handle
remains where it is, and you’re now affecting

only the segments associated with the
selected handle.

3. Adjust both handles until both segments are
curved.

Locking the Bezier Handles

Before learning the Lock Handles functions, you
should understand that splines are created with
a direction that flows from the first vertex to the
last. In a closed spline, such as the n-gon, the
direction might be clockwise or counterclock-
wise, but it really doesn’t matter.

The important point is that the handles on
either side of each vertex are different. One han-
dle adjusts the incoming vector, and the other
adjusts the outgoing vector. You don’t need to
know which handle is which, as long as you
understand that the handles on one side of each
vertex are the one type, and the handles on the
other are the opposite type.

With this in mind, you have three Lock Handles
options:

• Lock Handles. When handles aren’t locked,
only the selected handle is affected.
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• Alike. When handles are locked, only those
handles in the selection set that are the same
as the adjusted handle are affected. If you
adjust an incoming handle, only selected
incoming handles are adjusted.

• All. When handles are locked, all selected
handles are affected—both incoming and
outgoing.

Because the lock options affect multiple-vertex
selection as well, perhaps a different shape
would provide a better example.

Delete the rectangle, and make an n-gon:

1. Turn off the Sub-Object button.

2. Delete the rectangle shape.

3. Click N-Gon in the Create command panel.

4. Create an n-gon in the middle of the view-
port, approximately 100 units in radius.

5. On the General rollout under Interpolation,
check Adaptive.

6. Make sure the Sides are set to 6.

7. Check Circular.

8. Apply Edit Spline in the Modify command
panel.

The six vertices of the n-gon appear.

9. Drag a region around the upper half of the n-
gon to select four of its vertices.

Bezier handles appear at each selected vertex.

Each vertex in a circular n-gon is a Bezier vertex.
You can probably guess what happens if you
switch to a noncircular n-gon.

Explore the Lock Handles options:

1. Select all of the vertices in the n-gon.

2. Drag one of the handles, and then right-click
to cancel.

As before, only the chosen handle moves.

3. Check Lock Handles and Choose Alike.

4. Drag one of the handles, and then right-click
to cancel.

All handles on one side of each vertex change,
while all others are unaffected.

5. Drag a handle on the other side of the vertex,
and then right-click to cancel.

The opposite handles are affected.

6. Choose All.

7. Drag any handle.

All handles move.
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Typically, you might switch between Alike
and All to achieve the effect to want.

8. Choose Alike.

9. Adjust the incoming and then the outgoing
handles to get an angle that provides an inter-
esting shape.

10.Choose All, and adjust any handle to further
alter the n-gon.

Straight Segments
You’ve seen that a shape segment can be curved
or straight. There are three ways of creating a
straight segment:

• Apply Corner values to the vertices on either
end of the segment.

• Apply Bezier Corner values to the two vertices
so that the incoming handle on one side, and
the outgoing handle on the other are directly
over the segment.

• Change the segment value to Line.

Look at each of these in turn, using a circle
shape.

Create a circle:

1. Uncheck Lock Handles.

2. Turn off the Sub-Object button.

3. Delete the n-gon.

4. Click Circle in the Create command panel,
and create a circle that fills most of the view-
port.

5. Apply an Edit Spline modifier.

6. Region select the vertices at the 12 o’clock
and 3 o’clock positions.

The two vertices appear, along with their Bez-
ier handles.
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to change its vertices to Corner.

Change the vertices to Corner:

1. Right-click over either selected vertex, and
choose Corner.

Both vertices become Corner types. The seg-
ment between the vertices becomes straight,
but the shared segments on the other sides of
the vertices are affected as well.

2.  Click Undo to restore the curved seg-
ment.

The first method is easy enough, but you might
want to affect only the one segment. The second
method is to use Bezier Corner vertices, and
align their handles with the segment.

Change the vertices to Bezier Corner:

1. Choose Edit>Hold.

2. Right-click over either selected vertex, and
choose Bezier Corner.

3. Drag the handles associated with the segment
between the two vertices. Move them toward
the center of the circle, until both handles are
aligned directly over the segment. The seg-
ment becomes straight, and the other seg-
ments are not affected.

This method requires some extra effort, but
works well. However, it might not be as precise
as you’d like.

The third method should give you exactly what
you’re looking for.

Change the segment value:

1. Choose Edit>Fetch, and answer Yes.

2. Reselect the shape.

3. Choose Segment in the Sub-Object list.

4. Click to select the segment in the upper-right
quadrant of the circle.

The segment turns red.

5. Right-click the segment, and choose Line.

The segment becomes a straight line.
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A segment that’s been assigned a Line value can-
not be curved. It ignores the vertex values on
either side of it, and forces a straight segment.

Adjust the Bezier handles:

1. Choose Vertex in the Sub-Object list.

2. Drag both Bezier handles to alter the curve of
the shape. (Don’t right-click to cancel, this
time.)

The Line segment remains straight, while the
other segments change their curvature.

When you remove the Line value, see what
happens.

3. Choose Segment in the Sub-Object list.

4. Right-click the segment, and choose Curve.

The segment curves, responding to the new
positions of the Bezier handles.

Keep in mind that the Line segment value is
never placed in a shape by any of the shape cre-
ation tools. It’s a special type of segment value
that can only be assigned using the Edit Spline
modifier. While a segment is assigned as Line,
it’s locked in a straight line until you restore its
Curve value.
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Line Tool 2

Up to this point, you’ve created your shapes
using the 2D equivalent of primitives. The Line
tool, on the other hand, lets you create custom
shapes vertex by vertex, and segment by seg-
ment.

Creating Lines
In the following steps, you will examine the var-
ious options available in the Line tool.

Create a line:

1. Turn off the Sub-Object button.

2. Delete the current shape.

3. Click Line in the Create command panel.

4. Click anywhere in the viewport, and then
move the mouse.

The spot you clicked becomes a vertex, and a
rubber line attaches to the mouse.

5. Click elsewhere in the viewport.

You now have two corner vertices and a single
segment. A rubber line is still attached to the
mouse.

6. Point the mouse elsewhere in the viewport,
and drag the mouse.

As you drag the mouse, the third vertex
becomes a Bezier vertex. Your drag action sets
the rotation and tension on either side of the
vertex.

7. Release the mouse (if you haven’t already).

8. Click to create another corner vertex.

9. Right-click to release the mouse.

You’ve just created an open spline. An open
spline is one that has two end vertices. All of the
other splines you’ve created in this tutorial have

been closed splines because they form a closed
loop.

The Line tool can create a closed spline as well.
In fact, while using the Line tool, there are four
actions you can perform:

• Click to create one type of vertex.

• Drag to create a second type of vertex.

• Press BACKSPACE to undo the last vertex you
created.

• Complete the spline by either right-clicking
for an open spline, or clicking the first vertex
for a closed spline.

This time, create a closed spline.

Create a closed spline:

1. Click to create a first vertex and begin another
shape.

2. Click or drag to create three more vertices.

3. Press BACKSPACE.

The last vertex you created is deleted.

4. Press BACKSPACE again.

Another vertex is deleted.

You can use this method to back up as far as
you want, short of deleting the first vertex.

5. Create two or three more vertices.

6. Point the mouse over the first vertex you cre-
ated, and click.

A dialog asks if you want to close the spline.

7. Click Yes.

The mouse is released, and a closed spline is
created.
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Changing the Line Creation Method
A mouse click creates a corner vertex; a drag cre-
ates a Bezier vertex. You can change the default
settings to create different vertex types.

Change the creation method:

1. Choose Smooth under Initial Type.

2. Choose Corner under Drag Type.

3. Create a line with a combination of clicks and
drags.

When you click the mouse, a smooth vertex
is created. When you drag the mouse, a cor-
ner vertex is created.

4. Right-click, or click the first vertex to com-
plete the spline.

5. Reset the default methods by choosing Cor-
ner under Initial Type, and Bezier under Drag
Type.

Tip: A handy combination is to use Corner for
both Initial Type and Drag Type. This forces a
clean, corner vertex for each point in the spline.
You don’t have to worry about accidentally cre-
ating a nonlinear vertex by “clicking” a little too
long, and you can later use Edit Spline to add
curves where you want them.

Doodling
The Line tool is primarily used to sketch in your
spline. After you have the general form, you use
the Edit Spline tool to adjust the vertices and
segments in the same way that you adjusted
them in previous shapes.

Before moving on, take some time now to create
and edit some line shapes. See what kind of doo-
dles you can create.
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Connecting Splines 2

You’ve seen how to uncheck Start New Shape to
combine splines into a single shape, and how to
use Attach in the Edit Spline modifier for the
same purpose. In both cases, the splines remain
as separate components within the shape. In the
following exercise, you’ll see some of the ways
in which you can connect the splines in a shape.

Begin by editing the shape in a sample file so it
contains two open splines.

Load a sample file, and edit the shape:

1. Use File>Open to load tut6_1.max.

A top view appears, displaying a rectangle and
circle. They are actually two splines in a single
shape.

2. Select the shape.

3. Open the Modify command panel to access
the existing Edit Spline modifier.

4. Turn on the Sub-Object button, and choose
Segment in the Sub-Object list.

5. Drag a region across the right side of the rect-
angle, and the left side of the circle.

The right side of the rectangle and the entire
left half of the circle are selected.

6. Click Delete.

The shape now consists of two open splines.

Using the Close Function
Assume, first of all, that you simply want to
close the semicircle spline. One way to do that is
at the Spline selection level.

Use Spline/Close:

1. Choose Spline in the Sub-Object list.

2. Click to select the semicircle.

3. Click the Close button.

A curved segment connects the end vertices.
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4.  Click Undo.

5. Select the open rectangle.

6. Click Close.

A straight segment closes the rectangle.

7.  Click Undo.

The Close function creates a segment between
the two end vertices of an open spline, retaining
whatever values the end vertices held. In the
case of the semicircle, the end vertices were Bez-
ier, forcing a curvature to the added segment.
The end vertices of the rectangle were Bezier
Corner, so the added segment was straight.

Insert and Connect
At the Vertex selection level are two functions
you can use to close an open spline.

Close the splines at the Vertex level:

1. Chose Vertex in the Sub-Object list.

2. Click the Insert button.

3. Click either end vertex of the semicircle.

A segment is attached between the chosen
vertex and the mouse. You can see by the cur-
vature of the new segment that it’s affected by
the Bezier vertex values of the vertex you
clicked.

4. Click the remaining end vertex of the semicir-
cle.

5. Click Yes at the prompt.

The added segment looks the same as when
you used the Close function.

The Insert function is a relative of the Line tool
that you’ll explore further a little later. Like the
Close function, it doesn’t change the value of
the end vertices to which you apply it.

When you want to connect end vertices with
straight segments, it’s best to use the Connect
tool.

Close the splines using the Connect tool:

1.  Click Undo.

2. Click Connect.

3. Point the mouse at one end vertex in the
semicircle, and drag away from the vertex.

A dashed line is drawn between the vertex
and the mouse.

4. Continue dragging the mouse until it points
at the other end vertex in the semicircle.

The cursor icon changes.

5. Release the mouse.

The semicircle is closed with a straight line.

You don’t have to limit yourself to closing
splines. You can use the Connect tool to con-
nect any end vertices in a shape.

Connect the semicircle to the open rectangle:

1.  Click Undo to reopen the semicircle.

2. Choose Edit>Hold.

3. With Connect still active, drag from one of
the semicircle’s end vertices to an end vertex
of the rectangle.

A straight segment connects the two end ver-
tices.

4. Repeat the operation with the remaining end
vertices.

The two splines have become one spline.

You can use the Connect tool to connect any
two end vertices. It converts end vertices into
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Bezier Corner vertices, regardless of their previ-
ous value.

Making One Spline from Two
You’ve progressed from closing an open spline
to connecting two open splines. In addition to
the Connect tool, you can use other methods to
connect two open splines.

Connect two open splines:

1. Choose Edit>Fetch, and answer Yes.

2. Reselect the shape.

3.  Click Select and Move (if necessary).

4. Drag one of the rectangle’s end point over the
semicircle’s end point, and release the mouse.

5. Answer Yes at the prompt.

The two vertices are welded into one.

All you have to do is move two end points into
coincident positions to weld them together. You
can do this at the spline level as well.

Weld the two splines together:

1.  Click Undo twice to restore the two
splines.

2. Choose Spline from the Sub-Object list.

3. Move the semicircle to the left so that both of
its end points are coincident with the rectan-
gle’s end points, and then release the mouse.

4. Answer Yes at the prompt.

The two splines have become one.

Insert and Create Line Tools
The Line tool you used in the Create command
panel is available in two levels of the Edit Spline
modifier, as well. At the Object level, you can
use the Create Line button to create lines as sep-

arate splines within the shape, or connect end
vertices to the line you create.

In the Vertex selection level, the Insert function
provides a special version of the Line tool. Here,
you can use Insert to append a line to an open
spline, as you did in previous steps, or to insert
additional vertices and segments within an
existing spline.

When you use the Insert tool to insert a line, the
direction of the spline comes into effect. Earlier,
this tutorial discussed the directional flow of all
splines. Using the Insert tool, you can only
insert a line in the direction of the spline’s flow.
A closed spine might flow clockwise or counter-
clockwise. The flow in an open spline is deter-
mined by which of its end vertices is the first
vertex.

Insert vertices:

1.  Click Undo twice to restore the two
splines.

2. Choose Vertex from the Sub-Object list.

3. Click the Insert button.

4. Notice which of the end vertices in the open
rectangle contains the small white square.
This is the first vertex.

5. Point the mouse at the segment attached to
the first vertex.

The cursor icon changes.

6. Click to insert the mouse.

A vertex is attached to the segment.

7. Click to place a vertex, and then move the
mouse.

A vertex is inserted in the segment. You can
now move along the spline away from the
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first vertex. If you move toward the first ver-
tex, the line doubles up on itself.

8. Drag the mouse to create a curved Bezier ver-
tex.

9. Click or Drag to insert two or three more ver-
tices.

10.Right-click to release the mouse.

If you want to add vertices in the opposite direc-
tion, you can reverse the flow of an open spline
by switching the first vertex.

Change the first vertex and try again:

1.  Click Select and Move.

2. Select the end vertex of the rectangle that’s
not the first vertex.

3. Click Make First.

The selected vertex becomes the first vertex.

You can use Make First to make any vertex in a
closed spline the first vertex, but you can’t spec-
ify a direction of flow for closed splines.

The Insert tool is useful when you want to use
something like the Line tool to add segments to
a spline, and edit the curvature values on the fly.
On the down side, it’s hard to control because of
existing Bezier values in the spline.

The Refine tool is another approach to editing a
spline. It lets you insert vertices without altering
the existing curvature of the spline. You can
then use the Select and Move tool to adjust the
position of the new vertices.

Try out the Refine tool:

1. Click the Refine button.

2. Click over any of the new curves that you
made in the rectangular spline.

A vertex is inserted where you clicked, but the
curve remains the same.

3. Insert two or three additional vertices.

The Refine tool is also handy when you want to
increase the resolution of a spline at specific
points to smooth out the curves.

Spline Resolution
Because splines are the foundations of objects
created by modifiers such as Extrude and Lathe,
the complexity of the spline naturally affects
the complexity of the end object.

You can quickly see the relationship between a
spline and the end object by applying an
Extrude modifier.

Extrude the spline:

1. Press P to switch to Perspective view.

2. Apply an Extrude modifier.

3. Set Segments to 1.

4. Set the Amount to about 50.

5.  Click Zoom Extents.

6. Uncheck Backface Cull in the Display com-
mand panel.
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Notice the number of vertical segments in the
object around the curved portions as compared
to those in the straight sections. Since the shape
this object is based on is a hybrid of two edited
splines, only the Refine tool can be used to
change the resolution.

Change the resolution:

1. Choose Edit Spline from the Stack list in the
Modify command panel.

2. Use Refine to add additional vertices in the
spline.

3.  Click Show End Result to view the end
object.

The additional vertices add vertical segments
to the object.

4.  Click Select and Move.

5. Select several vertices in the spline.

6. Click the Delete button to remove the verti-
ces.

7.  Click Show End Result.

Vertical segments are missing where the verti-
ces are deleted.

When you create a single shape from the Create
command panel, there are parameters that
affect the resolution of the spline.

Create a new shape:

1. Reset 3DS MAX.

2.  Maximize the Top viewport.

3. Click Line in the Create command panel.

4. Create a line that consists of several straight
and curved segments. It can be opened or
closed.

5. Switch to Perspective view.

6. Apply an Extrude modifier with an Amount
of 50.

7. Uncheck Backface Cull in the Display com-
mand panel.

Notice that there are vertical lines where the
curved segments of the spline are, but no verti-
cal lines in the corresponding straight segments
of the spline. The vertical lines are generated
from a combination of the spline’s vertices and
its steps.

Each segment in a spline is actually made up of
small, straight lines connected by invisible
hinges, called steps. The vertical lines you see in
the extruded object correspond to the steps (and
vertices) in the foundation spline.

As a default, splines are created with six steps in
each curved segment, and no steps in each
straight segment. The controls for the number
of steps are in the creation parameters for the
spline.

Access the steps controls:

1. Choose Line in the Modifier Stack list.
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2. Examine the controls in the Interpolation
rollout.

Currently, Optimize is checked, which means
that steps are only generated for curved seg-
ments. If you want the same number of steps for
every segment of a shape, you turn off Opti-
mize.

Turn off Optimize:

1. Uncheck Optimize.

The straight segments now have six steps,
along with the curved segments.

2. Check Optimize.

The straight segments again have no steps.

The default number of steps is 6. If you want
smoother curves, you can increase the number
of steps.

Change the number of steps:

1. Set the Steps spinner to 10.

As the steps increase, the curves grow
smoother.

2. Set the steps to 0.

The curved segments become straight lines.

3. Set the steps to 6.

The Adaptive option sets the shape steps auto-
matically, based on the curvature of the spline at
any point.

Turn on Adaptive:

1. Check Adaptive.

Optimize and the Steps spinner become dis-
abled. The number of steps increase at sharp
curves, and decrease at flatter curves. There
are no steps in the linear segments.

2. Uncheck Adaptive.

Adaptive automatically provides smooth curva-
ture, regardless of the complexity of the spline
curves.

Note: Don’t use Adaptive or Optimize if you’re
morphing between extruded or lathed objects.
Morphing requires two or more objects with the
same number of vertices. Adaptive will alter the
number of vertices, depending on the curvature
in the base shapes, while Optimize will alter the
number of vertices, depending on the number
of straight and curved segments.
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Shape Booleans 2

Booleans are a method of combining two over-
lapping splines to produce a new spline. In this
tutorial, you’ll use the Boolean function in the
Edit Spline modifier to create a cross section of
molding for a picture frame.

Create a rectangle:

1. Choose File>New, select No, and click OK to
delete the object.

2. Switch to the Top viewport.

3.  Click Zoom Extents.

4. Click Rectangle in the Shapes branch of the
Create command panel.

5. Create a rectangle that’s 200 units in length
by 170 units in width.

Convert the rectangle to a triangle:

1. Apply an Edit Spline modifier.

2. Select the vertex in the lower-right corner,
and click the Delete button.

3. Select the vertices in the upper-right and
lower-left corners.

4. Right-click either vertex, and choose Corner.

You now have a triangle of three straight seg-
ments.

Edit the Triangle:

1. Click the Refine button.

2. Click in the center of the long, diagonal seg-
ment to insert a vertex.

3.  Click Select and Move.

4. Select the new vertex, and rotate its handles
to create an S-shaped segment.

Now, you’ll turn off Start New Shape, and add
some splines to your shape.

Add additional splines:

1. Open the Create command panel.

2. Uncheck Start New Shape.

3. Make sure your current shape is still selected.

4. Add three rectangles and a circle, as in the fol-
lowing figure:

5. Open the Modify command panel.

When you added new splines to your original
shape, its Edit Spline modifier was collapsed,
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creating a new object. At this point, you can add
a new Edit Spline modifier to access the Boolean
functions.

Note: During the following steps, if you see a
message reporting that the Boolean can’t be per-
formed, use the Select and Move  tool to
reposition one of the objects slightly, and then
click the Boolean button and try again.

Use Booleans:

1. Apply an Edit Spline modifier.

2. Choose Spline in the Sub-Object list.

3. Select the curved triangular spline.

You can first use Booleans to add the circle
and two of the rectangles to the triangle.

4.  Make sure that Union is selected under
the Boolean button.

5. Click the Boolean button.

6. Click the circle spline.

The circle is added to the triangle so that only
its right half remains.

7. Click the horizontal rectangle at the top of
the triangle, and then click the small rectan-
gle at the bottom of the triangle.

The triangle becomes more complex.

Finally, you’ll use Boolean subtraction to trim
the left side of the molding.

Trim the molding:

1.  Click the Subtraction button below the
Boolean button.

2. Click remaining vertical rectangle.

The single spline shape remains.

3. Turn off the Sub-Object button.
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Using the Lathe Tool
In addition to the Extrude modifier, the Lathe
modifier can be used to convert shapes into
objects. It’s often used to create turned table legs
and vases. Here, you’ll use it to create a picture
frame.

Apply the Lathe modifier:

1.  Minimize the viewport.

2.  Click Zoom Extents All.

3.  Click Zoom All, and zoom out in all view-
ports so the shape is about one-third the size
of the view.

4. Turn on Smooth + Highlights in the Perspec-
tive viewport.

5. Apply a Lathe modifier.

6. Set Segments to 4.

7. Turn on the Sub-Object button to access the
axis.

8. In the Top viewport, drag the yellow axis to
the right until the object looks like a square
picture frame. (Use Zoom Extents All, when
necessary, to zoom out, and then continue
adjusting the axis.)

Adjust the orientation and size of the frame:

1. Turn off the Sub-Object button.

2.  Click Select and Rotate.

3.  Turn on Angle Snap.

4. Rotate the frame 45 degrees about the Z axis,
in the Front viewport.

5.  Turn off Angle Snap.

6.  Click Zoom Extents All.

7. Apply an Edit Mesh modifier.

8. In the Front viewport, drag a region selection
around the right half of the frame to select all
of the vertices in the upper-right and lower-
right corners.

9.  Turn on Lock Selection Set.

10.  Click Select and Move, and the X axis
constraint button.

11.In the Front viewport, drag the selected ver-
tices to the right to create a rectangular frame.

12.Turn off the Sub-Object button.

13.  Turn off Lock Selection Set.

14.Adjust the zoom and angle of the Perspective
viewport to get a good view of the frame.
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Helix Tool 2

The Helix tool is a pleasant way to end this tuto-
rial. It’s fun, easy to use, and different than all
the other shape tools because it creates a 3D
shape rather than a 2D shape.

Create a helix:

1.  Maximize the Perspective viewport.

2. Adjust the view so there’s a visible area of
ground plane in front of the picture frame.
This is where you’ll build your helix.

3. Click Helix in the Shapes branch of the Create
command panel.

4. In the area in front of the picture frame, click
and drag outward to define a circle. This is the
first radius of the helix.

5. Release the mouse, and move upward to
define the height of the helix. Make it any
height that visually fits in the viewport.

6. Click, and then move the mouse to define the
second radius.

7. Click to complete the helix.

8. Increase the Turns spinner to about 3.

9. Play with the Bias spinner.

The Bias value changes the distance between
the coils.

10.Adjust all the other spinners, to create an
interesting spiral.

The helix is typically used for loft objects and
animation paths, but you can extrude a helix for
an interesting effect.

Extrude the helix:

1. Apply an Extrude modifier.

2. Adjust the Amount spinner until you see one
side of a spiral ribbon. Make it as wide as you
want.

Because Backface Cull is on, only the front face
normals are displayed. Rather than turn off
Backface Cull, you can assign a double-sided
material to the object.

Assign a double-sided material:

1.  Click Material Editor.

2.  Click Get Material to open the Mate-
rial/Map Browser.

3. Choose Mtl Library, and click Open.

4. Select and load Tutorial.mat.

5. Double-click 2-Sided: Yellow/Blue. Then close
the Material/Map Browser.

6. On the Modify panel on Parameters rollout,
check Generate Mapping Coordinates.

7.  On the Material Editor, click Assign Mate-
rial to Selection.

8.  Exit the Material Editor.

9.  Click Quick Render to render the scene.
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A loft object is created by combining two or
more shapes. In the previous tutorial, you used
an Extrude modifier to add depth to a shape by
extruding it along a straight path. You also used
a Lathe modifier to extrude a shape along a cir-
cular path to create an object.

Imagine what you could create if your path
wasn’t limited to a straight line or a circle, but
could be any spline in the scene. That’s the con-
cept behind a loft object.

You can place more than one cross-sectional
shape along the path of a loft object, and inter-
polate the geometry between cross sections.
One shape becomes the core of your object, and
the other shapes define the contour of the
object’s perimeter.

This tutorial shows you how to combine the
various shapes that create a loft object, and how
to edit the result.

Loft Objects, Part 1
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Components of a Loft
Object 2

In 3D Studio MAX, a loft object consists, at min-
imum, of two shapes. One shape is the path. It
defines the “depth” of the object. The other
shape is the cross section of the object. The sec-
ond shape is usually called a shape or a cross sec-
tion. You can have any number of cross sections
in a loft object, but only a single path.

The path can be an open or closed shape, but it
can consist of no more than a single spline. The
cross-sectional shapes, on the other hand, can
consist of open, or closed splines, and can con-
tain single or multiple splines.

You follow these general steps to create a loft
object:

• Create a shape to be used as a path.

• Create one or more shapes to be used as cross
sections.

• Select either a path or a cross-sectional shape.

• Choose Loft Object in the Geometry branch
of the Create command panel.

• Click the Loft button.

• Do one of the following: If your selected
shape is a path shape, click the Get Shape but-
ton, and then click a cross-sectional shape. If
your selected shape is a cross-sectional shape,
click the Get Path button, and then click a
path shape.

Whether you use Get Shape or Get Path, the
shape you first select remains in place, while the
shape you get moves to the currently selected
shape.
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Getting Shapes 2

For your first loft object, you’ll use Get Shape to
create a cylinder.

Make shapes for a cylinder:

1. Make sure all viewports are in wireframe dis-
play mode.

2.  Turn on 2D Snap Toggle.

3. Click Line in the Shapes branch of the Create
command panel.

4. In the Top viewport, click once to set a vertex
in the center of the grid, move the mouse
straight up about 100 units toward the back
of world space, and click again to create a sec-
ond vertex.

5. Right-click to complete the line.

6. Click Circle.

7. Make a circle anywhere in the Top viewport
with a radius of 20.

8.  Click Zoom Extents All.

9.  Turn off 2D Snap Toggle.

Creating a Loft Object
The line will be your path, and the circle will be
your cross-sectional shape. Because you’ll be
using the Get Shape function to place a shape
on the path, you select the path first.

Make a loft object:

1.  Click Select and Move, and select the line.

2.  In the Geometry branch of the Create
command panel, choose Loft Object from the
list.

3. Click the Loft button.

The loft creation parameters appear.

4. Click Get Shape.

5. Make sure that Instance is chosen.

6. Click the circle.

An instance of the circle shape is moved to
the first vertex of the path, creating a loft
object.

The created loft object consists of instances of
both the circle and the line, which you can see
if you move the loft object aside.

Move the loft object aside:

•  Use Select and Move to drag the loft
object slightly to the right on the ground
plane.

You can now see the original line, the loft
object, and the original circle.

Skinning the Loft Object
In the wireframe viewports, the loft object looks
like a line linked perpendicularly to a circle. If
you were to render a viewport, you’d see the sur-
face of the loft object. Two options let you dis-
play the skin of the loft object in the viewports.
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Display the skin:

1. Switch to Smooth+Highlight in the Perspec-
tive viewport.

The skinned loft object appears as a cylinder.

2. Open the Modify command panel to display
the loft object creation parameters.

3. Open the Skin Parameters rollout.

The controls in the Skin Parameters rollout
affect the display of the skin in various ways.

Adjust the Skin Parameters:

1. Uncheck and then check Cap Start.

This setting determines if the ends of the loft
object are capped.

2. Uncheck and then check Skin in Shaded.

This option (on by default) displays the skin
only in shaded viewport displays.

3. Check and then uncheck Skin.

This option displays the skin, regardless of the
viewport display.

4. Close the Skin Parameters rollout.

You might think this is a lot of trouble to go to,
just to make a cylinder. You could have simply
created a cylinder primitive, or extruded a circle.
True, but a loft object isn’t limited to one type of
cross section. You can add any number of shapes
along its path, and each shape can be different.

Adding Shapes
You can add as many shapes as you want while
you’re creating a loft object. Once you interrupt
the creation process, as you have in this case,
you use the Modify branch to continue adding
shapes.

Create a second shape:

1.  Click Shapes in the Create command
panel.

2. Click Rectangle.

3. Hold CTRL, and drag in the Top viewport to
create a square approximately 35 units in
length and width.

When you add shapes, you specify on which
level of the path you want the shape placed. The
path levels can be specified in percentage or in
distance. You’ll use percentage for this exercise.

Choose a level, and get a shape:

1.  Use Select and Move to select the loft
object.

2. Open the Modify command panel, and check
On in the Path Parameters rollout.

The Snap spinner and path level snapping are
enabled.

3. Set the Path (level) spinner to 50 by clicking
the spinner arrows.

A small X, representing the path level, moves
to the middle of the path in the unshaded
viewports.

4. Click Get Shape, and then click the square.

The back half of the cylinder is now square,
but there’s a twist between the two shapes.



3t2tut07.fm    5  Thu Oct  2 14:26:25 1997

Tutorial 7

Lo
ft

 O
b

je
ct

s,
 P

ar
t 

1
7 

– 
5

Adjusting Orientation
When you get a shape, its local Z axis is placed,
in a positive direction, along the path of the loft
object. The orientation of the shape will vary,
depending on the orientation of the path. You
can always adjust the rotation of the shapes
after placing them on the path.

When two or more shapes are on a loft path, the
skin of the loft object is aligned based on the
first vertex of each shape. To avoid twists, you
rotate the shapes so their first vertices line up.

Straighten the twist:

1. Turn on Sub-Object to access Shape selection
level.

2. Click Compare.

The Compare window appears.

3.  Click Pick Shape in the Compare window.

4. Point the mouse at the circle in the loft
object.

The mouse cursor displays a plus sign.

5. Click to select the circle.

The circle appears in the Compare window,
and the cursor displays a minus sign.

Pick Shape is a toggle mode. Each time you
click the same shape, it either appears or dis-
appears in the Compare window, and the
mouse cursor switches between a plus and
minus sign.

6. Click the square in the loft object.

The square appears with the circle.

The black plus in the center represents the
path. The small squares in the two shapes are
the first vertices.

7.  Using Select and Rotate, click the square
in the loft object.

The square turns red, the transform coordi-
nate system turns to Local, and becomes dis-
abled.

8. Click the Z axis constraint (if it’s not already
selected).

9.  Turn on Angle Snap.

10.Rotate the square in the loft object –45
degrees so its first vertex lines up with the cir-
cle.

The twist is gone.
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Moving Shapes
When transforming shapes in sub-object selec-
tion mode, all transforms are performed in Local
coordinates, relative to the path. That is, the
shape is perpendicular to the path, regardless of
the path’s orientation in space. Thus, a Z rota-
tion rotates the shape around the path, no mat-
ter what level it’s on and how twisted the path
spline.

The same is true when you move a shape. An X
or Y movement translates the shape perpendic-
ular to the path, while a Z movement translates
the shape along the path.

Move the shapes:

1.  Click Select and Move, and then click the
XY axis constraint button.

2. Drag the square cross section away from the
loft path.

The loft object becomes skewed.

3. Click Center in the Shape Commands rollout.

The square is again centered on the path.

4. Click the Z axis constraint button, and move
the square to the end of the path.

It takes the entire length of the loft path for
the object to change from a circle to a square.

5. Move the square to the other end of the path,
so it’s close to (but not on top of) the circle.

The loft object begins as a circle, but immedi-
ately changes to a square.

6. Use the Path Level spinner to move the square
to 50 percent along the path.

You can move any selected shape along the
path.

Cloning Shapes
An object is lofted from the first to the last ver-
tex of the path. The profile of the last shape
along the path carries through to the end of the
loft object, even if there’s no shape at the end of
the path. Currently, the square shape at the cen-
ter of the path is projected to the end of the loft
object.

If you wanted to return to a circular shape at the
end of the loft object, you could set the Path
level spinner at 100, and use Get Shape to
retrieve the circle again. You would have three
instances of the circle in the scene, and if you
adjusted one radius, they’d all react identically.
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To create an independent shape in the loft
object, you can clone the shape.

Clone a shape:

1. Select the circle loft shape.

2.  Use Select and Move to drag the circle
along the path.

You can move it from the front of the path to
the square, but it’s blocked by the square
shape.

3. Drag the circle to the front of the loft object.

4. Hold SHIFT, and drag the circle all the way to
the back of the path.

5. Choose Copy in the Copy Shape dialog, and
click OK.

A copy of the shape is now at the end of the
path. The loft object tweens from a circle, to a
square, and back to a circle.

When you’re moving a shape, it can’t go beyond
the barrier of the other shapes on the path, but
when you use SHIFT to clone shapes, you can
place the clone anywhere on the path.

Because the new shape is a copy rather than an
instance, you can independently change the
radius of the end of the loft object. Here’s how
to access the new shape’s creation parameters.

Change a shape’s parameters:

1. Select the new circle, located at the end of the
loft path.

2. Open the Stack list, and choose Circle.

The circle’s creation parameters appear.

3. Increase the Radius to about 50.

The back of the loft object is larger in diame-
ter. Because the new circle is a copy, the other
circles are not affected.

Working with Shape Instances
Because you chose the Instance option when
you first used Get Shape, you can alter the other
circle inside of the loft object. You can also edit
the original circle that’s floating outside of the
loft object. Often, it’s easier to work with an
instanced shape that’s separate from the loft
object.

Edit the original circle:

1. Click to select the original circle shape that’s
outside of the loft object.

2. Activate the Top viewport.

3.  Click Zoom Extents Selected.

The circle fills the viewport.

4. Apply an Edit Spline modifier.

5.  Use Select and Move with XY axis con-
straints to move the rightmost vertex to the
right.

The vertex in the instanced circle at the front
of the loft object moves to the left.



3t2tut07.fm    8  Thu Oct  2 14:26:25 1997

Tutorial 7

7 
– 

8
Lo

ft
 O

b
je

ct
s,

 P
ar

t 
1

The orientation of the shape, as seen in the
viewport, might not always match that of the
related portion of the loft object. To simplify
editing, you can either reorient the shape in the
loft object (as you did earlier with the square), or
you can reorient the instanced shape. Because
transforms are not shared by instanced objects,
you can rotate the original shape without affect-
ing the instance in the loft object.

Rotate the original shape:

1. Turn off the Sub-Object button.

2.  Click Select and Rotate, View coordinate
system, and Z axis constraints.

3. In the Front viewport, rotate the circle 180
degrees.

4. Turn on the Sub-Object button.

5.  Click Select and Move, and continue edit-
ing the vertices.

For the smoothest possible surface on a loft
object, you should use shapes that each have the
same number of vertices. Typically, this is
achieved by creating one shape, and then clon-
ing it and editing the copies. However, you can
use shapes with completely different vertex
counts, and 3DS MAX will interpolate between
the levels.

Interpolate between dissimilar shapes:

1. Click Star in the Shapes branch of the Create
command panel.

2.  Click Zoom Extents with the Top view-
port active.

3. Create a star in the Top viewport with a
Radius 1 of 35, and a Radius 2 of 15.

4. Select the loft object and open the Modify
command panel.

5. Turn off the Sub-Object button.

6. Use the Path spinner to go to level 0.

7. Click Get Shape, and click the star.

The circle is replaced by the star. The loft
object now tweens from a star, to a square, to
a circle.

Editing the Path
The ability to add and edit varied cross-sectional
splines is only part of the power of a loft object.
You can also edit the spline that forms the path.

Edit the path:

1. Turn on the Sub-Object button.

2. Choose Path from the Sub-Object list.

3. Choose Line in the Stack list.

4. Apply an Edit Spline modifier.

5.  Using Select and Move in the Left view-
port, drag the rightmost vertex (the first ver-
tex) in the spline to the right to lengthen the
loft object.

6. Right-click over the vertex you just moved,
and choose Bezier.

A handle appears.
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7. Adjust the handle to alter the angle of the ver-
tex and the curvature and tension of the
spline.

As you adjust the handles, the loft object
bends.

8. Click the Refine button.

9. Click somewhere toward the center of the
path.

A new vertex is inserted.

10.  Use Select and Move to select and adjust
the new vertex.

Animating the Path
You can animate the position of the vertices in
a spline by using the Xform modifier. You can
use this technique to animate the path of the
loft object.

Apply an Xform and animate the path:

1. Make sure the new vertex is selected.

2. Click the More button, choose Xform from
the modifier list, and click OK.

3. Make sure the Sub-Object button is on.

4.  Turn on Lock Selection Set.

5. Turn on the Animate button.

6. Go to frame 50.

7. Drag anywhere in the Left viewport to move
the center of the path.

8. Go to frame 100.

9. Drag again to change the center of the path.

10.Play, and then stop the animation.

The loft object writhes up and down.

After editing the path, perhaps you want to
adjust the placement of the shapes. Here’s how
to get back to the shapes.

Get back to the loft object shapes:

1. Turn off the Animate button.

2.  Turn off Lock Selection Set.

3. Choose Loft from the Stack list.

4. Choose Shape from the Sub-Object list.

5. Click the square shape in the loft object, and
then use the Path Level spinner to adjust its
position along the path.

6. Choose File>Save, and save your scene as
mytut7.max.



3t2tut07.fm    10  Thu Oct  2 14:26:25 1997

Tutorial 7

7 
– 

10
Lo

ft
 O

b
je

ct
s,

 P
ar

t 
1

Getting a Path 2

The opposite method of creating a loft object is
the Get Path function. You use this function
when you don’t want to change the position or
orientation of your cross-sectional shape.

In the following procedure, you’ll use 3D Snap
to create a shape directly on the surface of an
object, and then loft a path outward from the
shape.

Make a dodecahedron:

1. Reset 3DS MAX.

2. On the Create command panel, click Geome-
try, then choose Extended Primitives from the
list.

3. Click Hedra in the Object Type rollout.

4. On the Parameters rollout, in the Family area,
choose Dodec/Icos.

5. Create a polyhedron in the Front viewport
that’s approximately 50 units in radius.

6.  Click Zoom Extents All.

Create a shape snapped to a facet:

1.  Turn on 3D Snap Toggle in the Snap fly-
out.

2. Right-click 3D Snap Toggle to open the Grid
and Snap Settings dialog, check Vertex, and
then exit the dialog.

3.  Click Shapes in the Create command
panel.

4. Click Line.

5. In the Front viewport, click each of the five
vertices surrounding the upper-center penta-
gon. (If you make a mistake, press BACKSPACE

to undo the last vertex.) Answer Yes to close
and complete the shape.

6.  Turn off 3D Snap Toggle.

Before proceeding, check all four viewports to
make sure the shape is on the front facet of the
polyhedron. If not, delete it, and repeat step 4.

Making the Path
Next, you’ll use the Arc tool to create the path
shape. It doesn’t matter which viewport you cre-
ate it in. When you perform Get Path, the first
vertex of the path is placed in the center of the
shape, and grows perpendicularly from the
shape. From that point, you can adjust the ori-
entation of the path.

Create a path:

1.  Zoom out a bit in the Left viewport,
and pan the view to the left, to leave room to
the right of the polyhedron.

2. Click Arc.

3. Make sure End-End-Middle is chosen in the
Creation Methods rollout.

4. Drag a diagonal line (approximately 45
degrees) that’s about as high as the polyhe-
dron, release the mouse, and then move
upward to create an arc. (See the following
illustration.)
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Create the loft object:

1.  Click Geometry in the Create command
panel, and then choose Loft Object from the
list.

2. Select the pentagon shape (using Select by
Name, if necessary).

3. Click Loft, click Get Path, and click the arc
shape.

4.  Click Zoom Extents All.

The loft object grows from the polyhedron.

When you perform a Get Path or a Get Shape,
you can flip the orientation 180 degrees,
depending on whether you hold CTRL when you
click Get Path or Get Shape. Beyond this, you
can rotate the path (or shape) around the other
axes using sub-object selection.

For example, if the path is growing from the
shape through the center of the polyhedron,
you would click Get Path again, hold CTRL, and
click the arc shape again to replace the path
with one growing in the opposite direction.

Once you correct the path’s perpendicular direc-
tion, you can proceed to correct the rest of its
orientation. You can only rotate the path about
its local Z axis.

Rotate the path:

1. Open the Modify command panel.

2. Turn on the Sub-Object button.

3. Choose Path from the Sub-Object list.

Of the three transform buttons, only Select
and Rotate is enabled, and only the Z axis
constraint is enabled.

4.  Click Select and Rotate.

5.  Turn on Angle Snap.

6. Rotate the path 90 degrees.

Adding Shapes to the Path
Now that you have the loft object where you
want it, use Get Shape to add cross sections.

Add a shape:

1.  Click Shapes in the Create command
panel.

2. Click N-Gon.
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3. Set the Sides spinner to 5, and make sure Cir-
cular is unchecked.

4. Make an n-gon in any viewport with a radius
of about 10.

5. Open the Modify command panel.

6. Select the loft object.

7. On the Path Parameters rollout, set the Path
spinner to 100.

8. Click Get Shape, and click the n-gon.

The loft object tapers at the end, but also
twists.

Use the Compare window to adjust the rotation
of the new shape.

Straighten the twist:

1. Turn on Sub-Object, and make sure Shape is
selected in the list.

2. Click Compare to display the Compare win-
dow.

3.  Click Pick Shape.

4. Pick the pentagon and the n-gon shapes.

5. Rotate the n-gon shape 270 degrees about the
Z axis.
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Recognizing Valid
Shapes 2

A valid path shape contains a single spline
which can be open or closed, 2D or 3D.

A valid cross-sectional shape can contain one or
more closed splines, which can be nested, or
crossing, 2D or 3D. Crossing splines, however,
can result in unusual topology, so use them at
your own risk.

When you loft more than one shape with mul-
tiple splines, each shape must have the same
arrangement of splines. That is, if one shape
consists of two circles inside a square, plus one
ellipse outside of the square, every shape on the
path must consist of two splines inside another
spline, with yet another spline outside.

Lofting Shapes with Multiple Splines
The following procedure shows you one result
of using a shape with multiple splines.

Loft crossing splines:

1. Choose File>Open to load tut7_1.max.

The scene contains an arc shape, and a shape
consisting of an overlapping rectangle and
circle.

2. Select the arc.

3. In the Geometry branch of the Create com-
mand panel, choose Loft Object, and click the
Loft button.

4. Click Get Shape, and click the rectangle-circle
shape.

The capped ends of the loft object are solid.

This is an example in which the crossed shapes
are treated as a single, solid shape. See what hap-
pens when you change the position of the
splines.

Adjust the splines in the shape:

1.  Using Select and Move with the View
coordinate system and XY constraints, select
the rectangle-circle shape.

2. Open the Modify command panel.

3. Apply an Edit Spline modifier.

4. Choose the Spline sub-object selection level.

5. In the Front viewport, click the circle spline
and drag it into the center of the rectangle.

When the circle is within the rectangle, the
loft object has a hole running through its
core.

6. Drag the circle completely outside of the rect-
angle.

The loft object now consists of two curved
extrusions—one circular, and the other rect-
angular.
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Making a Curved Logo
One reason you want to loft shapes with more
than one spline is to loft text. Here’s a quick way
to create a logo of your initials in an arc shape.

Loft your initials:

1. Turn off the Sub-Object button.

2. Delete the rectangle-circle shape.

3. Select and delete the loft object.

Only the arc shape remains.

4. In the Shapes branch of the Create command
panel, click Text.

5. Type your initials into the Text window.

6. Click anywhere in the Front viewport.

The initials appear as a shape.

7. Select the arc shape.

8. Switch to the Geometry branch, and click the
Loft button.

9. Click Get Shape, and click the text shape.

Your initials appear in a half-circle.

Using Text as a Path
One lofting trick is to use a letter of text as a
path. Because a path can consist of only a single
spline, you do this one letter at a time.

Make the letter:

1. Choose File>New, click No, and click OK to
New All.

2. Click Text in the Shapes branch of the Create
command panel.

3. Enter M in the Text window, and then click in
the Front viewport.

A shape of the letter M appears.

4.  Click Zoom Extents All.

Create the shape, and loft it:

1. Create a small circle in the Front viewport
that’s about 2 units in radius.

2. Select the M shape.

3. In the Geometry branch of the Create com-
mand panel, click the Loft button.

4. Click Get Shape, and select the circle.

A tubular M appears.
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Using Open Splines
You can use open splines as well as closed
splines as cross sections. Open splines are good
for making landscapes and fabric. The following
procedure shows how to make curtains.

Create the shapes for the folds:

1. Reset 3DS MAX.

2.  Open the Shapes branch of the Create
command panel.

3. Click Line.

4. In the Top viewport, create a wavy line by
dragging each vertex you create. It should
look something like the illustration following
the next step.

This first line provides the tighter pleats at the
top of the curtain.

5. Create a second wavy line that’s longer and
not as wavy as the first.

The second line provides the looser folds at
the bottom of the curtain.

Create the path:

1. Beginning at the top of the Front viewport,
click once to create the first vertex of a line.

2. Move the mouse below the vertex to about
the middle of the viewport, and drag down
and at a slight angle to create a curve in the
line.

3. Move the mouse toward the bottom of the
viewport, click to create a third vertex, and
then right-click to complete the line.

Loft the curtains:

1. Make sure the line you just created is selected.
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2. Choose Loft Object from the list in the Geom-
etry branch of the Create command panel.

3. Click Loft.

4. Click Get Shape.

5. Click the smaller of the two wavy lines.

You don’t see any shading in the Perspective
viewport because you’re looking at the back
faces. You’ll take care of that in a moment.

6. Set the Path spinner to 100.

7. Click the larger of the two wavy lines.

8. Open the Display command panel, and
uncheck Backface Cull.

The skinned surface of the loft object appears.

9.  Click Zoom Extents All.

Now that you have curtains, you can rotate the
shapes to level them off.

Adjust the curtains:

1. Open the Modify command panel.

2. Turn on the Sub-Object button, and make
sure you’re in Shape selection level.

3.  Click Select and Rotate with Y axis con-
straint.

4. In the Front viewport, select the wavy shape
at the end of the path (the bottom of the cur-
tains).

5. Rotate the shape to make it nearly level with
the ground plane.

6. Rotate the shape at the top of the curtains to
get the angle you want.

The last task is to create a print fabric for the cur-
tains.

Assign a material:

1. Turn off the Sub-Object button.

2.  Click Material Editor.

3.  Click Assign Material to Selection.

4. Check 2-Sided.

5. Click the map button beside the Diffuse color
swatch.

6. Choose Bitmap from the Browser, and click
OK.

You’re now in the Diffuse map level of the
material.

7. Click the wide button labeled Bitmap.

8. Select and load PAT0003.tga.

9. Click Show Map in Viewport.

The map doesn’t show up because the mapping
coordinates aren’t turned on in the loft object.

Apply mapping coordinates:

1. Open the Surface Parameters rollout in the
Modify command panel.

2. Check Apply Mapping.
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The map appears on the curtains.

3. Set Length Repeat and Width Repeat to 10.

4. Activate the Perspective viewport.

5.  Click Quick Render.

6. Choose File>Save As, and save the file as
mytut7b.max.

Tip: Later, you can reload the curtains and ani-
mate them. Rather than accessing the shapes in
the loft object, you can apply Edit Spline modi-
fiers to the instanced shapes that make up the
path and the cross-sectional pleats. Apply an
Edit Spline and an Xform modifier for each set
of vertices you want to animate.

Splitting a Cylinder

Although you’re limited to a single shape per
level when you use open splines, you can use
open splines on some levels, and closed splines
on others to get some unusual effects. In the fol-
lowing procedure, you’ll create a cylinder that’s
split open along the side.

Load the sample file:

1. Close the Material Editor.

2. Choose File>Open, and load tut7_2.max.

The scene consists of three circular n-gons
and a straight line.

The two camera viewports provide identical
views in smooth-shaded display on the right,
and wireframe display on the left.

Tip: When working with a loft objects, it’s
handy to use the same camera with two view-
ports displaying smooth and wireframe. You can
adjust the camera navigation controls to alter
the identical views. One provides the skinned
display, while the other lets you see the struc-
ture of the loft model.

In the next steps, you’ll edit two of the circular
n-gons to open them up.

Edit the circles:

1.  Activate and maximize the Front view-
port.

2. Select the three circles, and apply an Edit
Spline modifier.

3. Select the top vertex in the middle and the
rightmost n-gons.

4. Click Break.

Each vertex is broken into a pair of coincident
vertices. The second and third N-gons now
form open circles.

5.  Use Select and Move to move the new
end vertices, opening the two n-gon circles.
Adjust the Bezier handles and the positions of
the vertices until the circles look something
like the following illustration.
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Notice the position of the first vertices for each
of the circles. When you broke the top vertices
of the second and third circles, their first vertices
become one of the end vertices. The first vertex
of the first circle is still on the right, which will
cause a twist in the loft object. Rather than fix
the twist later, you can avoid it now by chang-
ing the position of the first vertex.

Change the first vertex:

1. Select the top vertex in the first circle.

2. Click Make First.

The top vertex is now the first vertex.

3. Turn off the Sub-Object button.

4.  Minimize the viewport.

Now, you’ll create the loft object, adding the n-
gons along the path so they go from closed, to
open, and back to closed.

Create the loft object:

1. Select the line shape.

2. Choose Loft Object in the Geometry branch
of the Create command panel

3. Click Loft, and then click Get Shape.

4. Click the closed, circular n-gon shape on the
left.

The right camera viewport displays a shaded
cylinder, while the left displays the structure
of the loft object.

5. Check On in the Path Parameters rollout.

6. Set the Path spinner at 10.

The start of the path is at the back of the
scene, and the higher levels are toward the
front.

7. Click the first n-gon circle again.

8. Set the Path spinner to 30.

9. Click the middle n-gon.

The skin of the loft object opens up.

The backfaces are invisible. You can take care of
that later with a double-sided material.

Get the remaining shapes:

1. Set the Path spinner to 50, and click the third
n-gon shape.

2. Set the Path spinner to 70, and click the sec-
ond n-gon shape.

3. Set the Path spinner to 90, and click the first
n-gon shape.

The opening closes up.
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This is the perfect object for a double-sided
material.

Add a material:

1.  Click Material Editor.

2.  Click Get Material.

3. Choose Material Library from the Browser.

4. Click Open, and load tutorial.mat.

5. Choose the Double Trouble material from the
list.

6.  Click Assign Material to Selection.

Assign mapping coordinates, and render:

1. Open the Surface Parameters rollout in the
Modify command panel.

2. Check Apply Mapping.

3. Make sure the Camera viewport is active.

4.  Click Quick Render.
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This second tutorial about loft objects focuses
on the deformation tools.

The deformation tools provide spline-based
graphs that alter the relationship of the loft
cross sections to the path. There are five defor-
mation tools:

• Scale

• Twist

• Teeter

• Bevel

• Fit

Each tool is accessed in the Deformations roll-
out that appears in the Modify command panel
when a loft object is selected.

Loft Objects, Part 2
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Deforming Loft Objects 2

You’ll begin your exploration of the deforma-
tion tools with a simple loft object that’s already
been created.

Load the sample file:

1. Choose File>Open, and load tut8_1.max.

A pale, green loft object floats in the Perspec-
tive viewport.

2. Change the Perspective viewport to
Smooth+Highlight.

The loft object is nothing more than a square
shape lofted along a straight line.

Although the deformation tools are part of a loft
object’s creation parameters, they’re only avail-
able in the Modify command panel.

Access the Deformations rollout:

1. Select the loft object.

2. Open the Modify command panel.

3. Open the Deformations rollout at the bottom
of the panel.

There are five methods of deforming the loft
object. You can apply one, or any combination
of the five to the same loft object.

Scale Deformation
The Scale deformation lets you scale the cross
sections of a loft object along their local X or Y
axes. As with all deformations, you apply Scale
by editing a spline in a graph that represents the

path horizontally, and the deformation verti-
cally.

Open the Scale Deformation dialog:

• Click the Scale button in the Deformations
rollout.

The red horizontal line is an editable spline that
represents the path of the loft object. The loft
object in this scene has been arranged so that its
position, as seen in the Left viewport, corre-
sponds with the Scale grid. However, the loft
object could be in any orientation, with a
curved, twisted, or closed path, and the Scale
grid would still represent the path as a straight,
horizontal line.

The left end of the line is the first vertex of the
path. The numbers in the ruler mark the length
of the path in percentages. The vertical location
of the line specifies the scale percentage of the
loft object along the local X or Y axes of the
cross-sectional shapes. At present, the red line is
at 100 percent, because the loft object hasn’t
been scaled.

Currently, the Move Control Point button  is
active, so you can adjust either of the two
default end points on the red line.

Adjust the control points:

1. Drag the end point on the right side of the red
line down to about 50 percent. (The scale per-



3t2tut08.fm    3  Thu Oct  2 14:28:21 1997

Tutorial 8

Lo
ft

 O
b

je
ct

s,
 P

ar
t 

2
8 

– 
3

centage appears in the second edit field at the
bottom of the dialog.)

The corresponding end of the loft object is
reduced by 50 percent.

2.  Click the Insert Corner Point button.

3. Click in the red line at about 60 percent along
the path (as indicated by the ruler).

A corner vertex is added in the line. The two
edit fields at the bottom of the dialog display
the path percentage and the cross-sectional
scale of the added control point.

4.  Right-click to revert to Move Control
Point mode.

The system Snap affects the deformation dia-
logs.

5.  Turn on the 2D Snap Toggle in the main
prompt line at the bottom of the screen.

6. Move the new control point straight up to the
100 mark.

As you move the control point, it snaps to the
horizontal scale lines. When you release it,
the loft object tapers to a cone, beginning
about 60 percent along its path.

7. Click in the left edit field, type 60, and press
ENTER to place the control point precisely.

The new control point is exactly 60 percent
along the path.

Changing the Topology
Several options affect the topology of a loft
object. You’ll find most of them in the Skin
Parameters rollout.

Display the skin:

1. Open the Skin Parameters rollout in the Mod-
ify command panel.

2. Under Display, check Skin.

The surface geometry of the loft object
appears in the wireframe viewports.

3. Under Options, uncheck Optimize Shapes.

The geometry grows more complex around
the perimeter of the loft object.

4. Check Optimize Shapes again.

The simplicity returns.

When Optimize Shapes is checked, the steps in
the straight segments of the cross-section shapes
don’t generate vertices and segments. In an
object such as this, where the shape is a square,
Shape Optimization greatly reduces the geome-
try around the perimeter of the loft object.

The complexity of the loft object along its length
depends on the complexity of the path, the
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number of control points in the deformations,
and settings in the Skin Parameters rollout.

See what happens when you add control points
to the Scale deformation.

Insert control points:

1.  Click Insert Corner Point in the Scale
Deformation dialog.

2. Add control points at approximately 20, 30,
and 40 percent along the path.

As you add the control points, the surface
geometry grows more complex because Adap-
tive Path Steps is active.

3. Uncheck Adaptive Path Steps under Options
in the Skin Parameters rollout.

As seen in the Left viewport, there are now
only five path steps (displayed as cross sec-
tions) between the start and end path verti-
ces.

4. Check Adaptive Path Steps.

The complexity returns.

If you count the cross sections in the Left view-
port, you’ll see five cross sections between every
control point in the scale line. Cross sections are
created at every vertex in a path spline, and at
every step between vertices. The number of
steps is set by the Path Steps spinner. When
Adaptive Path Steps is checked, the control
points in the deformations are taken into
account. When Adaptive Path Steps is
unchecked, only the vertices in the path spline
are used to generate cross sections.

Adjust the new control points:

1.  Click Move Control Point.

2. Drag the control point at the 30 percent loca-
tion down to 60 percent scale.

3. Right-click the control point, and choose Bez-
ier Smooth.

The Bezier handles appear.

4. Adjust the handles to create a curved indenta-
tion.

Twist Deformation
Another type of deformation you can use is
Twist. As its name implies, it twists the cross sec-
tions of the loft object around the axis of the
path.



3t2tut08.fm    5  Thu Oct  2 14:28:21 1997

Tutorial 8

Lo
ft

 O
b

je
ct

s,
 P

ar
t 

2
8 

– 
5

Open the Twist Deformation dialog:

1. Close the Skin Parameters rollout.

2. Click the Twist button in the Deformations
rollout.

The Twist Deformation dialog appears.

This dialog is identical to the Scale Deformation
dialog, except that the first five buttons in its
tool bar are disabled. These buttons deal with
switching between the X and Y axes, a subject
covered later. Because Twist affects a single axis,
the buttons aren’t needed.

The red line in this dialog represents degree of
rotation instead of percentage of scale. You’ll
adjust the line to twist only the tapered portion
of the loft object, from the 60 percent point in
the path to the end of the path.

Twist the tip:

1.  Click Insert Corner Point.

2. Click near the 60 percent region of the red
line to insert a control point.

3. Type 60 in the first edit field, and press ENTER.

4.  Right-click in the grid window to revert to
Move Control Point mode.

5. Move the rightmost control point (at 100 per-
cent) down to –180 degrees.

The tapered portion of the object twists like
an auger, but hasn’t enough detail in the
mesh to provide a smooth twist.

6. Open the Skin Parameters rollout.

7. Increase the Path Steps setting to 10.

The twist is now smooth.

Teeter Deformation
The Teeter deformation rotates the cross sec-
tions about the X or Y axes. You’ll use it to slant
the cross section at the start of the loft path.

Apply a teeter:

1. Close the Skins Parameters rollout.

2. Click the Teeter button.

The Teeter Deformation dialog appears.

As a default, the Make Symmetrical button is
active, and anything you do to the grid line
affects both axes identically. To teeter only
the X axis, you turn off Make Symmetrical.
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3.  Turn off Make Symmetrical.

4.  Click Insert Corner Point, and insert a
point 20 percent along the line.

5. Type 20 in the percent field, and press ENTER.

6.  Click Move Control Point, and then
move the first control point up to the 30
degree mark.

The start end of the loft object is tilted 30
degrees.

Animating Deformations
You can animate your deformations by turning
on the Animate button and moving the control
points. You can’t animate Bezier handles, but
you can animate the position of the vertices.

Animate the Teeter:

1. Turn on the Animate button.

2. Go to frame 50.

3. Move the first control point down to –30.

4. Drag the time slider to 0, and then back to 50.

The start end of the loft object teeters back
and forth.

Animate the Twist:

1.  Exit the Teeter Deformation dialog.

2. Make sure you’re at frame 50.

3. In the Twist Deformation dialog, move the
last control point up, from –180 to 180
degrees.

The twist changes direction.

4. Drag the time slider to 0, and then back to 50.

Animate the Scale:

1.  Exit the Twist Deformation dialog.

2. In the Scale Deformation dialog, move the
Bezier control point (at the center of the
curve) up to about 140 percent.

The indented area now bulges.

3. Drag the time slider to 0, and then back to 50.
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Lofting an Arch 2

In this exercise, you’ll learn how to manipulate
the X and Y Scale axes independently.

Open the sample scene:

1. Choose File>Open, and load tut8_2.max.

A loft object appears, consisting of a square
shape on an arched path.

2. Switch the Perspective viewport to
Smooth+Highlight.

3. Select the loft object.

4. In the Modify command panel, open the Skin
Parameters rollout, and check Skin.

Open the Scale Deformation dialog:

1. Close the Skin Parameters rollout.

2. Open the Deformations rollout, and click
Scale.

When you first enter the dialog of a deformation
that can affect two axes (such as Scale and Tee-
ter), both axes are locked to symmetry. That is,
the Make Symmetrical button is on, and any-
thing you do to the deformation line affects
both axes equally.

For example, you can reduce the central portion
of the arch by simply adding a control point and
moving it. In this case, you might want a
smooth, Bezier point instead of a corner point.
Instead of changing the control points after
inserting them, you can change the type of
point you insert using the Control Point flyout.

Scale the center of the arch:

1.  Click Insert Bezier Point in the Insert
Point flyout.

Inserted points will now be Bezier vertices
instead of Corner.

2. Insert a Bezier point in the middle of the red
line, at about 50 percent.

3.  Right-click to revert to Move Control
Point mode.

4. Move the new control point down to about
50 percent.

The peak of the arch is narrower than the
base.
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You might want to scale the top of the arch so
that it’s wider as seen from the Top viewport,
but narrow as seen from the Front viewport.
First, you’ll need to know which axis is X and
which is Y.

The X and Y axes in the Scale deformation refer
to the local axes of the shape. You can see which
is which by going to Shape selection level.

View the local shape axes:

1. Turn on the Sub-Object button.

You’re placed in Shape selection mode, and
the coordinate system is automatically
changed to Local.

2. Select the shape (at the left base of the arch).

You can see by the axis tripod that the X axis in
this object will affect the scale of the arch as
seen in the Front viewport, and the Y axis will
affect the scale of the arch as seen in the Top
viewport.

To scale the axes separately, you turn off Make
Symmetrical, choose the grid line for the spe-
cific axis, and edit it.

Change the Y axis scale:

1. Turn off Sub-Object.

2. Click the Scale button to display the Scale
Deformation dialog.

3.  Turn off Make Symmetrical.

While Make Symmetrical is off, the three tool
buttons to its right turn on the display of the
X grid, the Y grid, or both. The title bar of the
dialog shows you which axis is currently dis-
played. You see the X axis, but you want to
adjust the Y axis.

4.  Click Display Y Axis.

The line turns green because the Y axis line is
green, and the X axis line is red.

5. Drag the center control point up to about 250
percent, and adjust the Bezier handles to cre-
ate a smoother curve.

The arch now has a broad “overhang” along
the Y axis.
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With symmetry turned off, you have two differ-
ent curves. You can switch between the two
curves, or display them both at once.

Edit both curves:

1.  Click Display XY Axes.

The green and red lines both appear over the
grid.

2.  Click Zoom Extents in the Scale Deforma-
tion toolbar.

3.  Click Insert Bezier Point.

4. Click to insert two points in the red (X) line,
at about 10 and 90 percent of the path.

5.  Right-click to revert to Move Control
Point mode.

6. Select the two new control points, and then
drag them down to about 20 percent scale.

The foundations of the arch appear flared.

When control points for both lines are on top of
each other, clicking one selects both. For exam-
ple, if you click either of the end points, the
points for both lines are selected. To select
points for a specific line, display only that axis.

Move the Y-axis end points:

1.  Click Display Y Axis.

Only the green line remains.

2. Drag a region to select the two end points of
the green line.

3. Move the end points up to 500 percent scale
(adjusting the scroll bar, as necessary).

The arch becomes a tunnel.



3t2tut08.fm    10  Thu Oct  2 14:28:21 1997

Tutorial 8

8 
– 

10
Lo

ft
 O

b
je

ct
s,

 P
ar

t 
2

Sometimes, you can create interesting objects by
simply switching the deformation axes.

Swap the deform curves:

•  Click Swap Deform Curves.
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Creating a Beveled,
Metallic Logo 2

The Bevel deformation is similar to Scale in that
it changes the size of the cross sections, but
there the similarity ends. Bevel operates on the
X and Y axes equally, and uses unit measure-
ment instead of percentage.

Shiny, flying logos of beveled text are a mainstay
of computer graphics. The following exercise
shows how to create beveled, metallic text.

Load the sample file:

1. Choose File>Open, and load tut8_3.max.

The word “Logo” floats in the scene.

2. Select the logo, and open the Modify com-
mand panel.

You’ll use a straight bevel. The Path Steps for
this object have already been set to 0 to reduce
the complexity of the geometry.

The trick to beveling text is to find a font that
avoids acute angles. Again, you need to set a
bevel amount that’s small enough to fit into the
tightest portions of the capped ends of the loft
object.

Bevel the text:

1. Open the Deformations rollout, and click the
Bevel button.

This object was lofted from the front to the
back, so the left end of the red line represents
the front of the logo.

2.  Click Insert Corner Point.

3. Click to insert a point at about 10 percent
along the path.

4. Type 10 in the percent field, and press ENTER.

5.  Click Move Control Point, and select the
leftmost end point of the red line.

6. Type 10 in the units field (the second field),
and press ENTER.

The front of the logo is beveled.

Bevel the back of the logo:

1.  Click Insert Corner Point, and insert a
point near the right end of the line.

2. Right-click to revert to Move Control Point
mode.

3. Type 90 in the percent field, and press ENTER.

4. Select the rightmost end point of the control
line.

5. Type 10 in the units field, and press ENTER.

The back of the logo is beveled.

6.  Exit the Bevel dialog.
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To provide a hard edge to the logo, you can turn
off smoothing along the length of the loft
object. Turn off length smoothing:

1. Open the Surface Parameters rollout.

2. Uncheck Smooth Length.

Finally, you’ll add a reflective material to create
a shiny gold logo.

Create a shiny, gold material:

1.  On the MAX toolbar, click Material Edi-
tor.

2.  Click Assign Material to Selection.

3. Set the Ambient and Diffuse color swatches to
black.

4. Set Shininess to 70, and Shin. Strength to 90.

5. Open the Maps rollout, and click the Reflec-
tion map button.

6. Choose New, choose Bitmap, and click OK.

7. Click the wide Bitmap button, and then select
and load sunset90.jpg.

8. Set Blur Offset to 0.1.

9.  Exit the Material Editor.

10.Make sure the camera viewport is active.

11.  Click Quick Render.

The logo object is animated to rotate 360
degrees. Render the animation to best see the
metallic effect on the logo.
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Fit Deformations 2

Imagine a deformation tool that lets you use
your own custom shapes, instead of the hori-
zontal lines you’ve been editing. That’s the idea
behind Fit deformation. You create one or two
shapes, and then use them to fit the cross sec-
tions of the loft object within the perimeters of
the shapes.

A fit shape must be a single, closed spline. You
can use a single fit shape to affect both the X and
Y axes of the cross sections, or one fit shape for
one axis, and a second fit shape for the Y axis.

Load a sample file, and create a fit shape:

1. Choose File>Open, and load tut8_4.max.

A cylinder loft object appears, consisting of a
circle and a straight line path.

2. Click the N-gon button in the Shapes branch
of the Create command panel.

3. In the lower-right area of the Top viewport,
create an n-gon that’s 80 units in radius, with
5 sides, and make sure Circular is unchecked.

4. Select the loft object.

5. Open the Modify command panel, open the
Deformations rollout, and click Fit.

The Fit Deformation dialog appears.

The Fit Deformation dialog begins with no grid
line, because it uses the shapes you choose. For
this exercise, you’ll use the n-gon as your fit
shape.

Get the fit shape:

1. Drag the Fit Deformation dialog over to the
right, so you can see the n-gon in the Top
viewport.

2.  Click Get Shape in the toolbar of the Fit
Deformation dialog.

3. Click the n-gon in any viewport.

4.  Click the Zoom Extents button in the Fit
Deformation dialog.

The loft object is formed into the n-gon pro-
file.

Notice that the n-gon appears in the Fit Defor-
mation dialog in the same orientation as it
appears in the viewport in which it was created.
As with the other deformation grids, the left side
represents the first vertex of the path. As a result,
the flat side on the left of the n-gon scales the
first cross sections of the loft object, while the
single vertex at right scales the end of the loft
object.
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The n-gon fit shape in the Fit Deformation
dialog is the same aspect ratio as the original
n-gon shape. That’s because the Lock Aspect
button  is on by default, forcing the Fit grid
to maintain the original aspect ratio of the orig-
inal shape, no matter how you zoom the grid.

The loft object itself, however, is not the same
aspect ratio because the length of the path is
longer than the width of the n-gon. The fit
shape has forced the sides of the loft object to
conform to the fit shape along the local X and Y
axes, but not along the Z axis. You can use the
Generate Path command to resize the length of
the path to conform with the fit shape.

Generate a new path length:

•  Click Generate Path.

The path is now the same length as the fit
shape, and the object matches the aspect ratio
of the original n-gon in both the Top and
Front viewports.

Turning Off Symmetry
By turning off Make Symmetrical and using a
second fit shape, you can affect the profile of the
loft object differently along the X and Y axes.

Create a second fit shape:

1. Click Ellipse in the Shapes branch of the Cre-
ate command panel.

2. In the Front viewport, create an ellipse that’s
80 units in length, and 300 units in width.

3. Select the loft object.

4. Click Fit in the Modify command panel to
display the Fit Deformation dialog.

As with all double-axis deformations, the X and
Y axes are based on the local axis of the cross-
sectional shapes. Rather than going into sub-

object shape selection, you can quickly deter-
mine which axis is which by altering one of the
fit points while watching the viewports.

Determine which axis to change:

1.  Click Zoom Extents in the Fit Deforma-
tion toolbar.

2.  Turn off Make Symmetrical.

The current axis is X, according to the title
bar.

3.  Click Move Control Point, and move one
of the control points slightly.

The loft object changes in the Top viewport.

4.  Click Undo to restore the object.

You’ve now determined that the X axis repre-
sents the profile seen in the Top viewport.
Therefore, the Y axis represents the profile seen
in the Front viewport.

Assign the ellipse to the Y axis:

1.  Click Display Y Axis.

2.  Click Get Shape, and then click the
ellipse.

The loft object becomes rounded as viewed in
the Front viewport.

3.  Click Display XY Axes to display both fit
shapes.
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Viewing both fit shapes in the dialog, you can
see that the ellipse has been rescaled to match
the length of the n-gon, because both fit shapes
must be the same length as the path. When you
use Generate Path, the length of the new path is
changed to fit that of the first fit shape you
brought into the Fit Deformation dialog, regard-
less of when you click Generate Path. In addition,
when you get a shape into the Fit Deformation
dialog, the shape in the grid is a copy of the orig-
inal shape.

If you want to generate a path to match a differ-
ent fit shape, you must get that shape while
symmetry is on, and click Generate Path again.

To change your loft object to be the length of
the ellipse rather than the n-gon, do this.

Generate the path to match the ellipse:

1.  Turn on Make Symmetrical.

Because both axes are displayed, a prompt
asks you which you want to keep. It doesn’t
really matter; you’ll be replacing both fit
shapes anyway.

2. Click the Y button.The loft object becomes
elliptical on both axes. The ellipse is assigned
to both axes, replacing the n-gon shape.

Since the ellipse in the dialog has already
been scaled, you need to get the original
ellipse shape again.

3.  Click Get Shape, and click the ellipse.

The new ellipse replaces the scaled fit shape.

4.  Click Generate Path.

The path of the loft object is lengthened to
match the new fit shape.

The final step is to restore the n-gon for the
other axis.

5.  Turn off Make Symmetrical.

6.  Click Display X Axis.

7. While Get Shape is still active, select the
n-gon.

The loft object is now the length and profile
of the ellipse in the Front viewport, and the
profile of the n-gon in the Top viewport.

Note: The Generate Path function converts any
path into a straight line. If you have a curved
path and want to maintain it, design your fit
shape for the path rather than using Generate
Path to force the path to the fit shape.
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Editing the Fit Shapes
Once you’ve established your fit shapes, you can
edit them like any other deformation spline.
There must be at least one control point at each
end of the edit window, and the spline can’t
“back up” on itself and create undercuts.

Change the n-gon shape:

1. Make sure the n-gon fit shape is still dis-
played.

2. Region-select the two control points midway
along the n-gon (at about 60 percent of the
way along the path).

The handles appear for both of these Bezier
Corner vertices.

3. Rotate each of the handles so they’re outside
rather than inside the shape, creating bulges
in the four segments.

The loft object bulges in the same way.

Display both fit shapes, and edit the ellipse:

1.  Click Display XY Axes.

You can now view and edit both fit shapes.

2. Select the two middle control points in the
ellipse fit shape, and rotate them to bulge one
end of the ellipse and narrow the other.
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Creating a Phone 2

In this exercise, you’ll use the Fit tool to create a
telephone handset. All the necessary shapes are
in the sample file.

Load the sample file, and create a loft object:

1. Choose File>Open, and load tut8_5.max.

The scene consists of a red path, two optional
cross-sectional shapes, and two fit shapes.

2. Select the red path.

3. Choose Loft Object from the Geometry
branch of the Create command panel.

4. Click the Loft button, click Get Shape, and
then click the square shape.

You now have a box.

The purpose of this exercise is to show you how
to properly orient fit shapes. When you bring a
shape into the Fit Deformation dialog, its orien-
tation will be exactly the same as the orienta-
tion of the shape as you created it. It doesn’t
matter which viewport you use to create the
shape because the shape’s local axis is used for
orientation.

The Fit Deformation grid represents the path
horizontally, with the first vertex of the path on
the left, and the last on the right. In the current

scene, the path is vertically oriented, with its
first vertex on the ground plane. The fit shapes
for the phone were created as you see them in
the Top viewport, and that’s how they’ll come
into the Fit Deformation dialog.

Rather than try to figure out what’s going to
happen, you can simply get one of the fit
shapes, and adjust the orientation to achieve
the result you want.

Get a fit shape:

1. In the Modify command panel, open the
Deformations rollout, and click the Fit but-
ton.

2.  Click Get Shape in the Fit Deformation
dialog, and select the rightmost handset
shape.

The loft object becomes a large, flat box.

The loft object is incorrect because the fit shape
isn’t properly oriented. This problem is easily
fixed.

Rotate the fit shape:

1.  Click Zoom Extents in the Fit Deforma-
tion dialog to see all of the fit shape.

The fit shape is oriented as it appears in the
Top viewport, where it was created.

2.  Click Rotate 90 CCW (counter-clockwise).

The loft object is beginning to look like a
phone, but is too short because the path isn’t
the right length.

3.  Click Generate Path.

The path lengthens to match the fit shape,
and the phone is almost complete.
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Before getting the second fit shape, you need to
turn off Make Symmetrical, and switch to the Y
axis display.

Get the second fit shape:

1.  Turn off Make Symmetrical.

2.  Click Display Y Axis.

3.  While Get Shape is still active, click the
phone shape that looks like a dumbbell.

The loft object is incorrect because this shape
must also be rotated.

4.  Click Rotate 90 CCW.

You now have a phone handset.

It’s easy to adjust your loft objects once you cre-
ate them. For example, the phone uses a simple
square as its cross-sectional shape. By using a
rounded square instead, you can achieve a sub-
tle difference.

Change the cross-sectional shape:

1. Make sure the Path spinner is set at 0 in the
Path Parameters rollout.

2. Click the Get Shape button in the Modify
command panel, and then click the rounded
square.

The phone handset now has curved edges.
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Compound objects are objects that you create
by combining existing objects. (You already
know about loft objects that you create by com-
bining shapes.)

This tutorial examines Boolean objects, which
you create by adding or subtracting the geome-
try of two or more objects.

Compound Boolean
Objects
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Boolean Objects 2

Boolean algebra deals with the possible results
of combining two values. In 3D Studio MAX,
you can create a Boolean object that consists of
two overlapping objects. The two objects are the
operands and the Boolean object is the result of
the operation.

When you combine two operands, there are
three possible results:

• Subtraction is what’s left when one operand is
subtracted from the other. (There are actually
two possible results, depending on which
operand is subtracted from which.)

• Union is the combination of both operands,
minus the overlapping portion.

• Intersection is only the overlapping portion.

In the following exercise, you’ll create a Boolean
object from two operands—a box and a sphere.
You’ll then examine the three different types of
result, along with the various controls in the
Boolean creation tool.

Load the sample file:

• Use File>Open to load tut9_1.max.

An overlapping box and sphere appear.

In this exercise, the box will be operand A, and
the sphere operand B. The Boolean object itself
will display the result of combining operand A
and operand B.

Note: When you create a Boolean object, both
of the objects are joined to become one, and the
original objects no longer exist. Make sure
you’ve made copies of your original objects if
you want to use them as they were.

Subtraction
As a default, when you first make a Boolean
object, the result is the difference between oper-
and A and operand B.

Create the Boolean object:

1. Select the box.

2. Open the Create command panel and click
the Geometry button.

3. Choose Compound Objects from the list, and
click the Boolean button.

A panel appears with a number of controls.

Note: The moment you click the Boolean but-
ton, your selected object becomes a Boolean
object, even if you don’t select a second oper-
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and. If you accidentally convert an object to a
Boolean when you don’t mean to, click Undo
to reverse the process and restore your origi-
nal objects.

4. Click the Pick Operand B button.

5. Make sure Move is chosen.

6. Click the sphere.

The sphere disappears, and the box now has a
curved scoop in its corner.

Union
Changing the result of the Boolean operation is
as simple as clicking an option button.

Switch to Union:

• Choose Union in the Operation area.

The geometry in the overlapping area disap-
pears. You can only see this effect in the Left
viewport.

Union is seldom used, because the geometry in
the overlapping area usually won’t show in the
rendered scene. However, you might find a situ-
ation in which you’re using uncapped geometry
and can see inside an object. In this case, a
Union will remove the geometry you’d other-
wise see.

Intersection
It should be obvious what Intersection will do.

Switch to Intersection:

• Choose Intersection.

Only the overlapping area remains.
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Switching Subtraction
You can get two results from Subtraction,
depending on which operand is subtracted from
which.

Sample the Subtractions:

1. Choose Subtraction (A-B).

The sphere is subtracted from the box.

2. Choose Subtraction (B-A).

3.  Use Arc Rotate Selected in the Perspective
view to look at the other side of the result.

The sphere now has a corner of the box sub-
tracted from it.

Restore the original result:

1. Choose Subtraction (A-B).

2. Choose Views>Undo View Rotate to restore
the previous Perspective view, so you can see
the spherical scoop in the box.

Adjusting and Animating the Operands
Move over to the Modify command panel, and
examine some of the creation parameters in the
Boolean object.

Change the display:

1. Open the Modify command panel.

2. Choose Operands in the Display area of the
Parameters rollout.

The sphere appears. You can display your
Boolean object either as a result, or as the
operands that create the result.

3. Choose Result.

Once again, the box with the circular chunk
appears.

4. Check Show Hidden Ops.

The sphere appears as a wireframe in the Per-
spective viewport.

The Show Hidden Ops. check box displays the
hidden operand as a wireframe only in a shaded
viewport. Use this display to see the hidden
operands if you want to select and adjust them.

You can perform transforms or modifications on
either of the operands in the Boolean object.
The two operands are now sub-object compo-
nents of the object, so you enter Sub-Object
mode to select them.

Note: Because Sub-Object mode is available
only in the Modifier Stack, you must be in the
Modify command panel to edit the operands in
a Boolean object. You can’t access them from
the Creation command panel.

Select and move the sphere operand:

1. Turn on the Sub-Object button.

2. Select the Sphere in the viewport.

3.  Turn on Lock Selection Set in the status
line.
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4.  Click Select and Move, set the transform
coordinate system to View, and click the XY
axis constraint button.

5. Move the sphere by dragging in any viewport.

As you move the sphere, the chunk in the box
moves as well.

You don’t need to see the operands to select
them.

Select using the Operands list:

1. Uncheck Show Hidden Ops.

The wireframe sphere disappears.

2.  Make sure that Lock Selection Set is still
on.

3. Choose A: B_Box01 in the Operands window.

4. Drag the mouse in the viewport, and then
right-click to cancel.

The box moves, leaving the sphere indenta-
tion behind.

You can easily animate these adjustments.

Animate the operands:

1. Turn on the Animate button.

2. Go to frame 50.

3. Choose B: B_Sphere01 in the Operands list.

4. Move the sphere operand a bit.

5. Go to frame 100.

6. Move the sphere some more.

7. Turn off the Animate button.

8.  Turn off Lock Selection Set.

9. Play the animation in the Perspective view-
port.

The scoop moves across and through the box.

10.Stop the animation.

Navigating Booleans
You can also adjust or animate the creation
parameters of either of the operands. The trick is
to find their creation parameters.

Of course, the creation parameters for an object
are in the object’s Modify Stack. When you
select one of the operands in a Boolean object,
it’s the same as if you selected the object itself,
and the Stack list changes accordingly.

Access the creation parameter of the sphere
operand:

1. Make sure the sphere operand is selected.

2. Open the Stack list, and choose Sphere.

The Modify panel displays the sphere’s cre-
ation parameters.

3. Turn on the Animate button.

4. Go to frame 30, and adjust the radius of the
sphere.

5. Go to frame 60, and adjust the radius again.

6. Go to frame 100, and adjust the radius once
more.

7. Turn off the Animate button.

8. Play, and then stop the animation.

The indentation moves across the box,
changing size as it goes.

If you wanted to add, say, a Bend modifier to the
box, here’s how you’d do it:

Bend the box operand:

1. Choose Boolean in the Stack list, to return to
the Boolean level.
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2. Choose A: B_Box01 from the Operands win-
dow.

3. Choose Box from the Stack list.

You’re now at the creation parameters for the
box.

4. Increase the Height Segments to 20.

The Boolean operation automatically adjusts
to the change in the topology.

5. Apply a Bend modifier.

6. Turn on the Animate button.

7. Go to frame 100.

8. Set the Bend Angle spinner to 90.

9. Turn off the Animate button.

10.Play, and then stop the animation.

The box bends over while the spherical
indent moves through it.

Nested Booleans
You can use a Boolean object as an operand in
another Boolean operation. The result is a
nested Boolean, which is even more interesting
to navigate.

Apply a Boolean to the Boolean:

1. Create a cylinder with a radius of 10, a height
of 60, and 10 height segments.

2. Go to frame 0.

3. Position the cylinder so it runs through the
boolean object—both the box and the scoop
of the sphere.

4. Select the box (the Boolean object).

5. Choose Compound Objects from the pop-up
list in the Create command panel.

6. Click Boolean.

7. Click Pick Operand B.

8. Select the cylinder.

You now have an object consisting of a box
with a scoop cut out of it and a cylindrical
hole.
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Looking at the Operands list, you can see that
your new Boolean object consists of operand A,
the box, and operand B, the cylinder. In addi-
tion, operand A consists of the original box, and
the sphere.

If you want to taper the cylinder, go to the Mod-
ify command panel to access the Stack.

Taper the cylinder operand:

1. Open the Modify command panel.

2. Choose B: B_Cylinder01 in the Operands win-
dow.

3. Choose Cylinder from the Stack list.

4. Apply a Taper modifier.

5. Turn on the Animate button

6. Go to frame 100.

7. Set the Amount to 1.5, and the Curve to 1.25.

8. Turn off the Animate button.

9. Play, and then stop the animation.

The cylindrical hole changes shape while all
the other Boolean changes are occurring.

Notice that the animation playback is starting to
get chunky (depending on the power of your
system). That’s because the calculations
required to animate Boolean operations are
complex.

How would you find the original creation
parameters for the sphere operand? Because the
sphere is part of the box, you first select the box
operand from the current Boolean, and then
open the Stack to access the original Boolean.
Once you access the original Boolean, you open
the Stack again to access the sphere.

Find the sphere:

1. Choose Boolean from the Stack list to return
to the latest Boolean level (the box and cylin-
der).

2. Choose A: B_Box01 in the Operands window.

You can now access the box’s Stack, which
contains both Booleans.

3. Open the Stack list, and choose the lower (the
first) Boolean in the list.

The Operands window displays the box and
sphere, so you know you’re headed in the
right direction.

4. Choose B: B_Sphere01 in the Operands win-
dow.

5. Open the Stack, and choose Sphere.

6. Adjust the Radius spinner.

The scoop changes size while you adjust it,
proving that you’re at the right level.

7. Choose File>Save As, and save the current
scene as mytut9a.max.

Important: Be sure to save the scene; you’ll use it
later in this tutorial.
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Applying Materials
With a little planning, you can set up objects so
that the materials from two operands are
merged in the resultant Boolean object.

Begin by loading a new scene:

1. Choose File>Open, and load tut9_2.max.

2. Play the animation.

A twisting, spiral torus moves up a cylinder.

Theorizing
When an object is created in 3DS MAX, material
ID numbers are assigned its faces. For most
objects, ID #1 is assigned to all faces. Two excep-
tions to this rule are the polyhedron and the
box. The polyhedron is assigned three different
ID numbers so you can easily assign three differ-
ent materials to its complex geometry. Likewise,
the box is assigned six different ID numbers, one
for each side.

Using either the Edit Mesh modifier, or the
Material modifier, you can assign different ID
numbers to the faces of the geometry. Then,
using a Multi/Sub-Object material, you can
assign different materials according to the ID
number.

If you want one operand to be one material, and
the other operand to be another, use the Mate-
rial modifier to assign different ID numbers to
both objects, and then assign a Multi/Sub-
Object material to the Boolean objects.

In the following steps, you’ll assign ID 2 to the
cylinder, assign ID 3 to the torus, create the
Boolean, and then assign the material.

Assign material ID numbers:

1. Select the cylinder.

2. Open the Modify command panel.

3. Click the More button, choose Material from
the list of modifiers, and click OK.

4. Set the ID spinner to 2.

5. Select the torus.

6. Apply a Material modifier.

7. Set the ID spinner to 3.

Create the Boolean:

1. Select the cylinder.

2. Click Boolean in the Create command panel.

3. Make sure you’re at frame 0 of the animation.

4. Click Pick Operand B.

5. Select the torus.

The cylinder now has a spiral “bite” taken out
of it.

You can now apply a Multi/Sub-Object material
to the Boolean object.

Apply the material:

1.  Click Material Editor.

2.  Click Get Material to display the Browser.
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3. Choose Material Library, and then click
Open.

4. Select and load tutorial.mat.

5. Choose Multi-Plastics, and click OK.

6.  Click Assign material to Selection.

The Cylinder turns red, while the spiral scoop
turns green. In the Material Editor, you can
see Material 2 is red and Material 3 is green,
matching the ID numbers you assigned the
operands.

You can use any of the techniques described in
the Material Editor tutorials to edit the two
materials. If you want to apply mapped materi-
als, you’ll need to first apply a UVW Map modi-
fier to the Boolean object.

Note: Don’t apply UVW Map modifiers at the
sub-Boolean level. They must be applied at the
top level in order to work.

Optimizing Speed
Animated Booleans require additional calcula-
tion time, and depending on their complexity,
can slow down screen redraws and other opera-
tions.

The Update area of the Boolean parameters lets
you set the following options for the display of
animated Booleans.

• Always. Updates the Booleans when you drag
the time slider and when you render the
scene. (This is the option you’ve been using.)

• When Selected. Updates the animation of
Boolean objects that are selected.

• When Rendering. Updates the Booleans in the
rendered scene (using the scanline renderer).

• Manually. Updates the Booleans when you
click the Update button.

The Update button is available when the Always
option is not used. You can click Update at any
time to update the Boolean at the current frame.
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A material is data that you assign to the sur-
face—or faces—of an object so that it appears a
certain way when rendered. Materials affect the
color of objects, their shininess, their opacity,
and so on.

This tutorial introduces the Material Editor,
which lets you create and edit materials, maps,
and combinations of the two. You’ll learn how
to use the basic interface, how to assign materi-
als, and how to get materials from several
sources, including material libraries.

Basic Materials:
Colors and Shading
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Assigning Materials to
the Scene 2

The first thing you might want to do is assign
one of the existing sample materials to an object
in the scene.

The objects in the current scene have no mate-
rials assigned them. They display object wire-
frame colors. These colors are assigned from the
color swatch beside the object name field in the
command panels. Remember, object wireframe
colors are not materials. They’re primarily for
display in the viewports.

In the following steps, you’ll assign one of the
sample materials to the cone.

Assign a material to the cone:

1. Use File>Open to load tut10_1.max.

2.  Click Material Editor in the toolbar.

The Material Editor dialog appears.

3. In the camera viewport, click to select the
cone.

The active sample slot determines which
material is assigned to the scene. Perhaps you
want to assign the second sample material to
the cone.

4. Click the middle sample slot in the top row.

5.  Click Assign Material to Selection.

The cone turns green, and four white trian-
gles appear in the corners of the sample slot.

Assign a different material to the torus and the
box:

1. Select both the torus and the box.

2. Click the third sample slot on the top row.

3.  Click Assign Material to Selection.

The torus and box turn blue, and white trian-
gles appear in the third sample slot.

3DS MAX automatically assigns names to the
materials—in this case, Material #2 and Material
#3. It’s a good idea to get into the habit of nam-
ing your materials with meaningful labels.
You’ll find it a big help when you later begin
using material hierarchies.

Rename your materials:

1. Click in the name field above the Basic
Parameters rollout.

2. Change the name to Two Objects.

The new name appears in the title bar of the
Material Editor.

3. Click the second sample slot to activate it.

4. Change the name to Cone Material.

toolbar

name
field

sample
slots toolbar
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Hot (and Cool) Materials 2

The white triangles around the sample slots
show that the materials in those slots are hot. A
hot material is one that is instanced in both the
sample slot and the scene. As a result, any
changes you make to a hot material are changed
in the scene at the same time.

The second sample slot is currently active, and
it’s a hot material. See what happens when you
change its settings.

Edit a hot material:

1. Make sure the second sample slot is active.

2. Change the H(ue) spinner values (below Basic
Parameters, on the right).

Each time you release the mouse, the colors of
both the sample sphere and the cone change.

The color of the cone changes, even though it’s
not the selected object in the scene.

Suppose you select only the torus, and then
adjust its material.

Select the torus and adjust the material:

1. Deselect all the objects, and then select only
the torus.

2. Click the third sample slot, containing the
Two Objects material.

3. Adjust the H(ue) spinner.

The color of both the torus and the box
change because they share the same material.

4. Deselect the torus, and adjust the H spinner.

The color of both objects changes.

When you change hot materials, you alter every
place in the scene where that material is
assigned. In the Material Editor, the only time
you need to select an object is when you’re
assigning a material to an object. When you’re
adjusting a material, object selection doesn’t
matter.

“Cooling” a Material
It’s handy to be able to edit a material in the
Material Editor and have it immediately
updated in the scene. Sometimes you want to
work on a material without affecting the scene.
You want to tweak a material until you’re sure
that’s what you want, and then reassign it. In
other words, you want to cool a hot material.

You cool a material by copying it, and you can
copy a material in two ways.

Use the Copy Material button:

1. Make sure the Two Objects material slot is
active.

2.  Click Make Material Copy in the horizon-
tal toolbar.

The white triangles disappear in the active
sample slot.
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The material is no longer hot. You can now
adjust it, and then reassign it when ready.

3. Adjust the RGB or HSV spinners to change the
color of the material.

4.  Click Put Material to Scene.

The material is reassigned to the two objects,
and the sample slot again becomes hot.

If you want to cool a material and have a dupli-
cate for comparison, you use the following tech-
nique:

Drag to copy a material:

1. Click to select the second sample slot, con-
taining Cone Material.

2. Drag the second sample slot over the first
sample slot.

When you release the mouse, the Cone mate-
rial is copied into the first sample slot. The
white triangles remain in the second slot, but
not in the first.

When you drag to copy a sample, you end up
with two materials with the same name—but
one is cool while the other is hot. In the Material
Editor, you can have up to 42 materials with the
same name, but every material in your scene must
have a unique name.

You can now adjust the cool material, compar-
ing it with the hot material. If you like the
changes you’ve made, you can update the scene.

Edit the cool material, and then reassign it:

1. Adjust the RGB or HSV spinners to change the
copied material in the first sample slot.

2.  Click Put Material to Scene.

The cone takes on the edited material. The
first sample slot becomes hot, and the second
sample slot becomes cool.

Note:  The Put Material to Scene button is
only enabled when the active sample slot is
cool, and a material of the same name exists in
the scene.
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Getting Materials From
the Browser 2

So far, you’ve created your materials from the
default samples. As an alternative to creating
materials, you can get materials from other
sources, and then assign them to the scene.

When you get a material, it’s placed in the active
sample slot. In the following procedure, you’ll
get a material from a material library, place it in
the fourth sample slot, and then assign it to the
torus.

Access the Browser:

1. Click the fourth sample slot (lower-left cor-
ner).

2.  Click Get Material.

The Material/Map Browser appears.

The Material/Map Browser lets you browse
and select materials or maps from a number

of sources. You want to select a material from
a material library.

3. Choose Mtl Library under Browse From.

The window at right displays a long list of
items.

4. Deselect Maps under Show.

The window list now shows only Material
items (with blue spheres beside them).

5. Double-click to select the Red Plastic material.

The name of the selected material appears
above the window and the Red Plastic mate-
rial appears in the fourth sample slot.

6. Select only the torus in the viewport.

7.  Click Assign Material to Selection.

The torus turns red.

Changing Material Libraries

Each time you reset or rerun 3DS MAX, a default
material library, called 3dsmax.mat, is loaded
into memory. However, you can create your
own material libraries and load them at any
time. In addition, if you want your custom
library to load when 3DS MAX starts, simply
rename it 3dsmax.mat, and put it in your \maps
directory.

To load (or save) a library, first make sure that
Mtl Library is chosen under Browse From, as it is
now.

Load the tutorial library:

1. Click Open.

A file dialog appears.

2. Select and load tutorial.mat.

3. Double-click the Yellow Plastic sphere near
the bottom of the window.
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Notice that the Yellow Plastic replaced the Red
Plastic that was a hot material (assigned to the
torus). For the first time, you have a situation
where there’s a material in the scene (Red Plas-
tic) that’s not in the sample slots.

What would you do if you wanted to edit the
Red Plastic material in the scene, while main-
taining the Yellow Plastic material in the Mate-
rial Editor?

Get the Red Plastic material:

1. Select the sixth sample slot (lower-right cor-
ner).

The sixth slot contains a material you’re not
planning to use.

2. Choose Scene under Browse From.

The three materials from the scene, including
Red Plastic, appear in the window.

3. Double-click the Red Plastic sphere to both
select it and exit the Browser.

The sixth sample slot displays Red Plastic, and
it’s hot.
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Setting the Basic
Parameters 2

In this next section, you’ll look at many of the
controls in the Basic Parameters rollout in the
lower portion of the Material Editor.

The Basic Parameters rollout contains controls
that you can use to create and alter materials.
They affect the material in the active sample
slot. If the sample material is hot, they affect the
material in the scene as well.

Ambient, Diffuse, and Specular Colors
Three basic reflective properties of a material
affect the way you perceive its color. They are
ambient, diffuse, and specular.

As seen in real objects, these three properties
can be described, from dark to light, as follows:

Ambient—The color reflected by the material in
shadows. On the sample sphere, the ambient
is the dark crescent curving around the lower
right of the sphere.

Diffuse—The color reflected in direct light. On
the sample sphere, this is the dominant color
seen primarily in the center and upper left of
the sphere.

Specular—The color reflected directly to your
eyes from the highlights of the object. On the
sample sphere, this is the white spot upper-
left of center.

You adjust the three colors by selecting one of
the Ambient, Diffuse, or Specular labels, and
then adjusting the RGB or HSV spinners. How-

ever, for more color control, you can use the
Color Selector, which you access by clicking on
any of the color swatches.

Before changing the color of the Red Plastic
material, make a copy so you can compare the
old with the new.

Copy the Red Plastic material:

1. Drag the Red Plastic material from slot 6 to
slot 5.

The copied material is cool.

You want to see the result in both the sample
slot and the scene, so you’ll work on the hot
material. The cool material can be kept as a
backup, in case you want to restore the origi-
nal.

2. Select sample slot 6.

Although you can use different colors for the
ambient and diffuse properties, a material sur-
face typically has the same colors for these
components. The lighting in the scene pro-
vides the contrast. The buttons to the left of
the color swatches let you lock either pair so
that adjusting one color is the same as adjust-
ing the other.

Access the Color Selector for Diffuse:

1. Click the color swatch to the right of Diffuse.

The Color Selector appears.

2. Drag the mouse anywhere inside of the large
color box.

When you release the mouse, the color
changes in the sample slot and in the scene.

diffuse

specular

ambient
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Using the Color Selector
You’ve used the Color Selector in previous tuto-
rials. Take a closer look at its controls.

The large box containing a spectrum of colors
represents all the colors available to your dis-
play. Inside the box is a cross cursor that indi-
cates the current color. You can change the loca-
tion of this cursor directly by dragging it, or you
can change its position using the various sliders
in the dialog. The currently selected color also
appears in a color swatch above and to the right
of the Reset button. The color you had when
you first started using the dialog appears in a
color swatch to its left.

Change the color by dragging the cursor:

1. Drag the cross cursor around in the color box.

As you drag the cursor, the current color
swatch changes, the Diffuse and Ambient
color swatches change, and the various spin-
ners and sliders change as well. When you
release the mouse, the diffuse and ambient
colors update in the sample slot, and in the
scene.

2. Click Reset.

The original red color is restored.

The remaining controls in the Color Selector let
you choose or adjust the current color by means
of changing various components of the color.

Depending on how you view color, some con-
trols will appeal to you more than others.

Notice that the colors in the color box are
arranged in a spectrum of hues from left to
right, and from a pure color at the top, to dark
colors at the bottom. The arrows at the top and
the side of the color box give you complete con-
trol over the horizontal (hue) direction and the
vertical (blackness) direction.

Use Hue, Blackness, and Whiteness:

1. Drag the cursor to the top of the color box (if
it’s not there already).

2. Make sure the Whiteness arrow is all the way
at the top.

3. Drag the Hue arrow back and forth.

As you drag the Hue arrow, you change noth-
ing but the hue. It’s exactly the same as
adjusting the Hue spinner located on the
right side of the dialog.

4. Drag the Blackness arrow about half way
down the side of the color box.

The color grows darker.

5. Drag the Hue arrow back and forth.

You’re now moving through hues of a uni-
form dark value.

The Whiteness slider takes precedence, add-
ing whiteness to the current hue.

6. Drag the Whiteness slider about half way
down.

The color grows pale.

Here’s something to watch out for. The White-
ness slider takes precedence, and if you try to
adjust a white color, you might have to turn up
the Whiteness. Here is an example.
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Adjust the Whiteness:

1. Drag the Whiteness slider all the way down.

The current color is white.

2. Drag the cross cursor anywhere in the color
box.

No matter what color you choose, the current
color is white because the Whiteness slider is
at the bottom.

3. Drag the Whiteness slider all the way up.

The color appears.

Here’s how to work with grays.

Access the gray ramp:

1. Drag the Blackness slider all the way down.

The Whiteness slider now displays a grayscale
ramp.

2. Drag the Whiteness slider to select a gray
shade.

The controls on the right side of the dialog pro-
vide both sliders and spinners. You can either
drag the slider bars or use the spinners to set
them.

The Red, Green, and Blue spinners set the levels
of red, green, and blue in the color. In addition,
their slider bars update dynamically to display
the colors available by adjusting the sliders.

The Value spinner increases the blackness, while
lowering the whiteness, or vice-versa.

The Saturation spinner increases or decreases
both the blackness and the whiteness of a color.
High saturation values result in less realistic,
toy-like surfaces.

Find a suitable color:

1. Use the various color controls to find a color
you like for the Diffuse and Ambient
swatches.

2. Leave the Blackness slider at least half way up
the side of the color box. (Don’t make the
color too dark.)

Now that you’ve found a color for the surface of
your material, you can try a specular color.

White specular highlights tend to appear on
artificial surfaces, such as plastics or shiny
enamels. Short of using the metal shading mode
(described later), you can sometimes take the
“plastic” off of a material by using a specular
color that’s related to the diffuse.

Change the Specular color:

1. Drag the Diffuse color swatch over the Specu-
lar color swatch.

A prompt appears asking if you want to copy
or swap the colors.

2. Click Copy.

Now both swatches contain the same color,
and the specular highlight appears dimmer.

You might find this new effect more suitable, or
you might prefer the original, white specular
highlight. Keep in mind that the color of the
lights in your scene also affect the material.

Saving Your New Material
Perhaps you like this new material you’ve cre-
ated, and you want to save it to a library so you
can use it in another scene. First, consider where
the material currently exists—as it appears, not
as it’s named:



3t2tut10.fm    10  Thu Oct  2 14:40:41 1997

Tutorial 10

10
 –

 1
0

B
as

ic
 M

at
er

ia
ls

: C
o

lo
rs

an
d

 S
h

ad
in

g

• It’s assigned to the torus. Assuming you save
your scene, you can always retrieve this mate-
rial by choosing Scene in the Browser.

• It’s in the sample slot of the Material Editor. If
you save your scene now, and don’t change
the sample slot, the material will be there
when you next load the scene.

You can use this material, as long as you’re in
this scene. But if you want to assign it to a dif-
ferent scene, you’ll have to first store the mate-
rial in a library.

Store the new material in the tutorial library:

1.  Click Put to Library.

A naming dialog appears.

Because a different material called Red Plastic
already exists in the current library, you need
to either overwrite the Red Plastic material, or
rename the new one. The new material
doesn’t look like Red Plastic, so renaming it is
a good idea.

2. Type My First Material in the name field, and
then click OK.

The new material is added to the Tutorial
library, and the tutorial.mat file is updated.

Rendering the Scene
When adjusting materials, you soon reach a
point where you need to render the scene to see
the effect of the material on the object. The
Gouraud-shaded viewports can show you the
general highlights and shadows, but they can’t
accurately display the specular highlights,
which you’ll be adjusting next.

The following steps set up the renderer for a
small, 320x240 display window that you can
repeatedly re-render to view your progress.

Render the scene:

1. Make sure the camera viewport is active.

2.  Click Render Scene in the toolbar.

The Render Scene dialog appears.

3. Make sure that Single is chosen.

4. Click 320x240.

5. Make sure the Save File is unchecked.

6. Click Render.

The Rendering in Progress dialog appears,
along with a small rendering window. When
the rendering is complete, only the rendering
window remains.

7. Drag the rendering window so it’s over the
Color Selector and not hiding the Material
Editor.

Setting Shininess
The illusion of shininess (or dullness) is a factor
of the size and intensity of the specular high-
light. In the Material Editor, the Shininess spin-
ner affects the size of the specular area, and the
Shin. Strength spinner affects the intensity of
the shininess.

Adjust the shininess size and strength:

1. Click the Specular color swatch to bring the
Color Selector to the front.

2. Drag the Whiteness slider almost all the way
to the bottom.

The specular highlight is again white.

3.  Turn on Backlight to the right of the sam-
ple slots (if it is not already turned on).

A backlight appears along the lower-right
edge of the sample sphere.
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4. While watching the Highlight curve to the
right of the spinner, drag the Shin. Strength
spinner down to about 20.

The Highlight curve shrinks in height. At the
same time, the intensity of the specular high-
lights diminish.

5. Drag the Shininess spinner down to
around 10.

The specular highlights widen.

6.  Click Render Last.

The specular highlights on the torus are
broader, making the surface appear duller.

When Shininess Strength is too high, and Shin-
iness is too low, you can get harsh backlights on
your surfaces. Use the Soften option to mitigate
this.

Try out Soften:

1. Make sure Soften is set to 0.0.

2. Set Shin. Strength to 80.

The backlight appears as a hard, white cres-
cent.

3. Drag the Soften spinner up to the maximum
of 1.0.

The backlight is softened.

Adjust the shininess to suit you:

1. Play with the Shininess and Shin. Strength
spinners until you have highlights you like.

2.  Click Render Last in the main toolbar to
view the scene.

3.  Click Put to Library, click OK, and answer
Yes to update the material in your library, and
on disk.

Shading Modes
There are four shading modes that affect the
overall surface of the material: Constant, Phong,
Blinn, and Metal. This section lets you examine
the differences of three of these by making cop-
ies of your new material.

Copy the material and change shading modes:

1. Drag the sixth slot to the fifth slot.

2. Drag the fifth slot to the fourth slot.

The bottom row of slots contain identical
materials.

3. Select the fifth slot, and then choose Con-
stant from the Shading list.

The sphere appears flat-shaded.

4. Select the sixth slot, and then choose Metal
from the Shading list.

The sphere appears darker.

Phong Shading

Phong is the “workhorse” of shading modes. It
provides a sharp delineation of ambient, diffuse,
and specular values, and you’ll find yourself
using it most of the time.
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Constant Shading
This shading mode provides a constant shading
across each “facet,” or co-planar surface of the
object. The result has the appearance of so-
called “flat” shading, except that it provides
specular highlights.

Use this mode to provide a faceted look to your
geometry without having to use the Edit Mesh
modifier to change the smoothing groups in the
object.

Metal Shading
Metal provides realistic looking metallic sur-
faces, as well as a variety of organic-looking
materials.

Metal mode is different than the other shading
modes in several respects. For one thing, glanc-
ing highlights are much brighter on metal sur-
faces, given a similar highlight curve. In addi-
tion, metal materials use the same color for both
the diffuse and specular properties. In 3DS
MAX, you can access and edit the specular color
swatch, but the Specular option button is dis-
abled to signify that the color is not used in the
material.

Because there’s no separate specular highlight,
the two shininess spinners react differently. The
Shin. Strength spinner still controls intensity,
but the Shininess spinner affects both the inten-
sity and size of the specular area.

Compare the Phong and metal highlight
curves:

1. Examine the Highlight curve while the metal
sample slot is active.

The curve is low and rounded.

2. Select the fourth sample slot, containing the
Phong material.

Although the Shininess and Shin. Strength
values are the same, the Phong curve is higher
and narrower.

3. Select the sixth slot, containing the metal
material.

4. Adjust the Shin. Strength spinner while
observing the Highlight curve.

The basic width of the curve remains the
same, while only its height varies.

5. Set Shin. Strength to 40.

6. Adjust the Shininess spinner up and down,
before finally setting it at 70.

Both the height and the width of the curve
vary.

Because the sixth slot is hot, the torus now
has a metal material.

7.  Click Render Last.

The torus has a metallic look.

8. Select the fourth slot containing the Phong
material.

9.  Click Put Material to Scene.

10.  Click Render Last.

The torus has a more plastic-looking surface.

Special Attributes
The Self-Illumination spinner creates the illu-
sion of incandescence by replacing any shadows



3t2tut10.fm    13  Thu Oct  2 14:40:41 1997

Tutorial 10

B
as

ic
 M

at
er

ia
ls

: C
o

lo
rs

an
d

 S
h

ad
in

g
10

 –
 1

3

on the surface with the diffuse color. At 100 per-
cent, the shadows are completely replaced by
the diffuse color, creating the illusion of self-
illumination.

Unless you use environmental effects, lights
only illuminate your scene; they don’t appear in
the rendering. You can use self-illuminated
materials on objects that represent lights to pro-
vide things like car headlights, and so on.

Turn up Self-Illumination:

1. Make sure the fourth sample slot is still
selected and set Self-Illumination to 50.

2.  Click Render Last.

The torus appears to glow slightly.

3. Set Self-Illumination to 100.

4.  Click Render Last.

The torus appear incandescent.

5. Set Self-Illumination to 0.

The Wire option lets you view the surface as a
wireframe.

Turn on Wireframe:

1. Check Wire.

The sample sphere and the torus appear in
wireframe display.

2. Check 2-Sided.

You can now see the wires on both sides of the
torus.

3.  Click Render Last.

The torus appears in wireframe mode, using
the colors and shading of the material.

The 2-Sided option makes the material appear
on both sides of the faces to which it’s assigned.

You use 2-Sided materials primarily in the fol-
lowing cases:

• To see both sides of wire materials.

• To see both sides of transparent materials.

• When the inside of an object is visible, such
as when one or more of its faces have been
removed.

• When you’re working with imported geome-
try in which the face normals are not uni-
formly aligned.

Tip: When face normals aren’t uniformly
aligned, it’s often better to use the Normal
object modifier to flip face normals. The 2-Sided
option takes slightly more rendering time
because you’re rendering twice as many faces as
you would otherwise. Then again, if you’re hav-
ing problems with a large, complex scene, you
might save time by simply applying a 2-Sided
material rather than attempting to flip the cor-
rect faces.
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Setting Extended
Parameters 2

The controls in the Extended Parameters rollout
augment the Wireframe and the Opacity effects.
You’ll continue adjusting the Wireframe effect,
and then move on to material opacity.

Wireframe Size in Pixels or Units
Use the extended parameters for the wireframe
effect to set the size of the wire and specify the
measurement in pixels or units.

When you use pixels, the thickness of the wire
is based on the screen pixels. As a result, it’s
absolute, and remains the same, regardless of its
distance from the camera. If you use units, the
thickness is based on world units, and varies,
depending on the distance from the camera.

Change the wireframe size:

1. Open the Extended Parameters rollout.

Additional controls for opacity and wireframe
appear.

2. Under Wire, make sure Pixels is chosen.

3. Set the Size spinner to 3.0.

The wire is thicker in the sample slot.

It’s easier to compare the effect of pixels and
units if you first adjust the camera view to give
a greater sense of distance. You can most easily
do this with the viewport-navigation Perspec-
tive tool, which dollies the camera in one direc-
tion, while changing the field of view in the
other.

Change the camera perspective:

1. Choose Edit>Hold.

2.  Click Perspective in the viewport naviga-
tion area.

3. Drag upward in the camera viewport, until
the view is warped, and the front of the torus
is near the bottom of the viewport.

4. Right-click to exit Perspective adjustment
mode.

Now you can render the scene and compare the
two wireframe displays. Begin with the Pixels
option.

Compare the wire effects:

1.  Click Render Last.

The wires appear to be thinner toward the
front of the torus, and thicker toward the
back. This is an optical illusion. Actually, the
wires are the same thickness throughout.

2. Choose Units.

3.  Click Render Last.

The torus now looks more natural. The wires
are thicker in front and thinner in back.

4. Choose Edit>Fetch, and answer Yes to restore
the original camera view.

5. Uncheck 2-Sided and Wire.
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Changing Opacity
The opacity (or transparency) of a material is set
using the Opacity spinner. Usually, when you
adjust opacity, you turn on the checkered back-
ground in the sample slots so you can better
view the effect.

Reduce the opacity in the material:

1.  Click Render Last to review the look of
the torus with an opaque material.

2.  Turn on Background to display the check-
ered background in the sample slot.

3. Set the Opacity spinner to 50.

The sample sphere turns transparent, and you
can see the background through it.

In addition, the viewport shows the torus in a
special “screen door” transparency display.
While not nearly as accurate as the scanline
renderer, this helps you to see which of your
objects will be transparent in your rendered
scene.

4.  Click Render Last.

5. The torus is now transparent.

Transparent materials benefit from the 2-Sided
option, because you often want to see the inside
of the object.

Add 2-Sided:

1. Check 2-Sided.

2.  Click Render last.

Specular highlights appear on the inside sur-
faces of the torus.

Opacity Falloff

Real transparent surfaces vary their opacity,
depending on the angle of the material to your

point of view. For example, a bottle appears
more transparent at its center than at its edge
because you’re looking through more glass at its
edge.

In the Extended Parameters rollout, you can
specify transparency falloff, based on the angle
of the face normals to the view.

Add and adjust Falloff:

1. Set the Opacity spinner to 100.

2. In the Extended Parameters rollout, set Falloff
to Out.

3. Set the Amt. spinner to 100.

The outer edge of the sample sphere is trans-
parent, while the inner portion is opaque.

4. Set the Opacity spinner to 70.

The inner portion of the sphere is partially
transparent.

5.  Click Render Last.

The outer edges of the torus are more trans-
parent than the inner.

6. Set Falloff to In.

7.  Click Render Last.

The inner portions of the torus are more
transparent than the outer.

The terms In and Out refer to the angles of the
face normals in the geometry with regard to the
point of view. For example, when Out is chosen,
as the angles of the face normals rotate away
from your point of view (outward), they grow
increasingly transparent.

Opacity Color Effects
3DS MAX has three basic methods of achieving
transparency:
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• Subtractive transparency darkens colors behind
the material by subtracting the material’s col-
ors from the background colors.

• Additive transparency brightens the colors
behind the material by adding the material’s
colors to the background colors.

• Filter transparency tints the colors behind the
material using a specified transmission color.

If you simply want to reduce the apparent opac-
ity of a material, while maintaining the color
values of its diffuse (or mapped) properties, use
subtractive transparency.

Try subtractive transparency:

1. Set the Falloff Amt. spinner to 0.

2. Set the Opacity spinner to 50.

3. Drag a copy of the fourth sample sphere to
the fifth and sixth slots.

The bottom row of slots contain identical
materials.

4. Select the fifth slot.

5. Choose Subtractive in the Extended Parame-
ters rollout.

The sample sphere is muddier than the one in
the sixth slot.

6.  Click Put Material to Scene.

7.  Click Render Last.

The torus is transparent, but murky.

Additive transparency is good for special effects,
such as light beams, or smoke.

Look at additive transparency:

1. Select the fourth sample slot.

2. Choose Additive.

The colors behind the sphere become bright.

3.  Click Put Material to Scene.

4. Set the Opacity spinner to 100.

5. Set Falloff to Out, and the Amt. spinner
to 100.

6.  Click Render Last.

The torus appears as a ghostly image.

Filter transparency is the default system,
because it provides a more realistic transparency
effect. When the Filter option is set in the
Extended Parameters rollout, the color used by
the Filter color swatch tints the transparency of
the material.

In life, a transparent material, such as colored
glass, affects the colors behind it, not by the dif-
fuse or ambient colors (which are reflected col-
ors), but by the transmission color.

The transmission color is that property of a sub-
stance that filters certain colors, and allows oth-
ers to pass. For example, a sheet of red cello-
phane is a filter that blocks all light except in the
red wavelength of the spectrum. By using filter
transparency, you can specify a transmission
color, and achieve strong, saturated colors, no
matter how transparent the material.

In the following steps, you’ll create a clear, green
material that might be suitable for a green glass
bottle. You leave the specular color white,
because you want clear, white specular high-
lights. The ambient and diffuse colors will be
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black, because you want only the transmission
color to reveal the material, and not the surface
colors.

Use Filter to create a clear, green material:

1. Select the sixth sample slot.

2.  Click Put Material to Scene.

3. Make sure Filter is chosen in the Extended
Parameters rollout.

4.  Make sure the Lock button is on between
Ambient and Diffuse.

5. Click either the Ambient or Diffuse color
swatch, and then use the Color Selector to
change both swatches to black.

6. Click the Specular color swatch, and make it
white.

7. Click the Filter color swatch, and choose a
green color (such as RGB: 0, 175, 15).

8. Set the Opacity spinner to 50.

9.  Click Render Last.

The torus is a deep, saturated transparent
green.
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The materials you apply to 3D geometry are not
limited to solid colors. You can assign various
types of images to your materials to achieve a
whole range of effects such as wood grain, text
labels, reflective effects, engraved surfaces, and
so on.

The images you assign to materials are called
maps. There are several different types of maps
you can use in 3DS MAX. They include stan-
dard bitmaps (such as .tif, .jpg, or .tga files), pro-
cedural maps, such as Checkers or Marble, and
image-processing systems such as compositors
and masking systems.

Materials that contain one or more images are
called mapped materials. By assigning the maps
to different attributes of the materials, you can
affect the color, the opacity, the smoothness of
the surface, and much more.

For many map types, the Renderer needs
instructions telling it where the map should
appear on the geometry. These instructions are
the mapping coordinates, and the subject of this
tutorial.

Mapping Coordinates
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Mapping Coordinates 2

Mapping coordinates specify the placement, ori-
entation, and scale of a map on the geometry.
They’re a little like the instructions you might
give to someone hired to cover your room with
patterned wallpaper.

If you apply a mapped material to an object
without mapping coordinates, the Renderer has
no way of knowing where to place the map, and
displays the material without it.

In 3D Studio MAX, there are three ways to apply
mapping coordinates:

• Set the Generate Mapping Coords. option in
the creation parameters rollout of any stan-
dard primitive. This option provides mapping
coordinates specifically designed for the
primitive. Because mapping coordinates
require additional memory, you only turn
them on when you need them.

• Apply a UVW Map modifier. You choose from
several types of mapping coordinate systems
and customize the placement of the mapping
coordinates on the object. In addition, you
can animate the transformations of the map-
ping coordinates.

• Use special mapping coordinate controls for
special objects. For example, Loft objects pro-
vide built-in mapping options that let you
apply mapping coordinates along their
length and around their perimeter.

Assuming you’ve applied a mapped material to
an object, there are three cases where you don’t
need mapping coordinates:

• Reflection and Refraction maps don’t need
mapping coordinates. They use an environ-
mental mapping system, in which the place-
ment of the map is based on the rendered
view, and fixed to the world coordinates in
the scene.

• 3D procedural maps (such as Noise or Marble)
don’t need mapping coordinates because
they’re procedurally generated, based on the
local axis of the object.

• Face-mapped materials don’t need coordi-
nates because the maps are placed based on
the facets in the geometry.
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Adjusting Mapping
Coordinates 2

In the following exercise, you’ll assign a mapped
material to three primitives—a box, a cylinder,
and a sphere. You’ll turn on each of their built-
in mapping coordinates, apply a mapped mate-
rial, and then turn on the display of the map in
the viewports. After that, you’ll adjust the map’s
placement on the geometry, using the controls
in the Material Editor.

Once you’ve seen how to adjust the map using
the built-in coordinates, you’ll apply a UVW
Map modifier and examine the added flexibility
it provides.

Load a sample scene and assign a material:

1. Choose File>Open, and load tut11_1.max.

A box, a cylinder, and a sphere appear.

2.  Click Material Editor.

3. Select the three objects.

4. Make sure the first sample slot of the Material
Editor is selected. It contains the Skyscraper
material.

5.  Click Assign Material to Selection.

The objects change to the diffuse color of the
material, but the maps don’t appear.

Generate the built-in mapping coordinates:

1. Deselect the three objects, and then select
only the sphere.

2. Open the Modify panel.

3. Check Generate Mapping Coords., at the bot-
tom of the Parameters rollout.

4. Select the cylinder, and check Generate Map-
ping Coords in the Parameters rollout.

5. Select the box, and check Generate Mapping
Coords.

Displaying Maps in the Viewport
The previous steps are all you need to render the
mapped material assigned to the three objects.
However, one additional step lets you see the
map on the geometry in the shaded viewports.
And this step helps you to adjust the placement
of your maps.

As you’ll see in later tutorials, a single material
can contain any number of maps. The scanline
renderer can use all of these maps for their vari-
ous purposes, but the viewport renderer can dis-
play only one map per material at any time.

Because viewing mapped materials slows the
viewport display, it’s up to you to decide which
map (if any) you want to display. To display a
specific map, you go to that map’s level in the
Material Editor, and then turn on its display. (If
you later go to a different map in the same mate-
rial, and turn its display on, the other map is
automatically turned off.)

In this next exercise, you’ll go into the Diffuse
mapping level of the Skyscraper material, and
turn on the map display.

Turn on the Diffuse map display:

1. Open the Maps rollout in the Material Editor.
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A list of all mapping types appears.

2. Click the Map button in the Diffuse row.

The panels change to display controls specific
to the Diffuse mapping level. Although the
title bar of the Material Editor still displays
Skyscraper as the name of the current material,
the name field below the sample slots now
reads Skyscraper Map Level, and is labeled Dif-
fuse to indicate the level you’re on.

3.  Click Show Map in Viewport to turn on
the map’s display. (The button is under the
sample slots.)The skyscraper appears on the
three objects.

It might also be nice to see what the tutskysc.jpg
bitmap looks like.

View the tutskysc.jpg image:

1. Choose File>View File.

2. In the resulting file dialog, find tutskysc.jpg in
the \maps directory, and load it.

New York’s Empire State building appears in a
large window.

Built-in Mapping Coordinates
The built-in mapping coordinates are designed
for each object type. The box mapping coordi-
nates place a duplicate map on each of its six
sides. For the cylinder, the image is wrapped
once around its sides, and duplicates of the
image are distorted at the end caps. A sphere has
the image wrapped once around the sphere, and
then gathered at the top and bottom.

Offsetting and Rotating the Map
Although the built-in mapping coordinates are
often the best available for a specific object, you
can’t adjust their position relative to the geom-
etry. You can, however, adjust the map relative
to the mapping coordinates by using the con-
trols in the material itself.

Change the Offset:

1.  Exit the View File window.

2. In the Coordinates rollout of the Material Edi-
tor, set the U Offset spinner to 0.25.

The map images on all of the objects shift to
the right.
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3. Set the V Offset spinner to 0.25.

The map shifts up on all the objects.

The values you set in the Offset spinners specify
the distance of offset based on the percentage of
the map image. In the preceding steps, you
moved the image 25 percent of its width to the
right, and 25 percent of its height upward.

Change the Angle:

• Set the W Angle spinner to 45.

The map rotates 45 degrees on all the objects.

About UVW Coordinates
Since the letters U, V, and W appear in a few
places in the Coordinates rollout, this might be
a good place to talk about them.

Most material maps are a 2D plane assigned to a
3D surface. As a result, the coordinate system
used to describe the placement and transforma-
tion of maps is different than the X, Y, and Z
axis coordinates used in 3D space. Specifically,
mapping coordinates use the letters U, V, and
W—the three letters preceding X, Y, and Z in the
alphabet.

The U, V, and W coordinates parallel the relative
directions of X, Y, and Z coordinates. If you look

at a 2D map image, U is the equivalent of X, and
represents the horizontal direction of the map;
V is the equivalent of Y, and represents the ver-
tical direction of the map; W is the equivalent of
Z and represents a direction perpendicular to
the UV plane of the map

You might ask why you need a “depth” coordi-
nate like W for a 2D plane. One reason is
because it’s sometimes handy to be able to flip
the orientation of a map, relative to its geome-
try. To do this, you need the third coordinate.

Using a UVW Map Modifier
When you adjust the map placement by using
the controls in the Material Editor, you affect
the map for every object assigned that material.
(As you can see, the maps on all three objects
have been altered by your adjustment of the
Offset and Angle spinners.) This is often the best
approach when you’re designing a material con-
sisting of several maps. If you want to adjust the
same material differently on various objects,
you need to use a different approach.

For greater flexibility, you can assign an object
modifier, called UVW Map, that lets you apply a
variety of mapping coordinate types for each
object.

You use a UVW Map modifier for two main rea-
sons:

• You want greater control over how the map-
ping coordinates relate to the geometry.

• The object you’re mapping does not have
built-in mapping coordinates. For example, it
might be an imported mesh.

When you apply a UVW Map modifier to an
object with built-in mapping coordinates, the
applied mapping coordinates take precedence.
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Note: To save memory and disk storage, you
should always clear the Generate Mapping
Coords. option for any object to which you
apply a UVW Map modifier.

Restore the original material mapping settings:

1. Set the W Angle spinner to 0.

2. Set the U and V Offset spinners to 0.

Planar Mapping

You’ll first examine planar mapping applied to
the box.

Apply a UVW Map modifier to the box:

1. Select the box.

2.  Click Zoom Extents All Selected (flyout).

3. On the Modify command panel, click the
UVW Map button.

The skyscraper appears on the top of the box,
and the sides of the box are orange.

As a default, planar mapping coordinates are
used by the UVW Map modifier. The modifier
gizmo represents the type of mapping. At
present, the gizmo is in the center of the box.

Move it up over the top of the box so you can
see what it looks like.

Move the Planar gizmo:

1. Click Sub-Object.

2.  Click to turn on Lock Selection Set in the
status bar.

3.  Using Select and Move in the Front view-
port, move the yellow gizmo above the cube.

Planar mapping projects the image in a straight
line in both directions, perpendicular from the
surface of the gizmo. The gizmo represents the
image. The green line is the right side of the
image, and the small yellow line on one side
indicates the top of the image.

The edges of the box are orange because the
orange border of the bitmap image is being pro-
jected through the object. You can see this effect
even better by moving the gizmo.

Change the position of the planar gizmo:

• Move the gizmo around in the Perspective
viewport, leaving it slightly off center over
the box.

As you move the gizmo, streaks of the image
pass through the box.
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Avoiding Streaks
The advantage of planar mapping is that it
projects a 2D map with the least amount of dis-
tortion. Its disadvantage is that it causes streaks.

You can often avoid the streaks by changing the
angle of the gizmo.

Change the bitmap, and rotate the gizmo:

1.  Click Select and Rotate, and select the XY
axis constraint button.

2. Drag downward in the Perspective viewport
to rotate the gizmo on both axes.

With the image projected at an oblique angle,
the streaks are removed.

As you’ve seen, you can use any of the transform
tools to adjust the placement, orientation, or
size of the gizmo.

Scale is the one transform you haven’t tried.

Scale the gizmo:

•  Click Select and Uniform Scale, and then
scale the gizmo down about 50 percent.

The repeated images are reduced in size.

Tiling and Mirroring
The Tile option in the Material Editor is on by
default, repeating the image along the U and V
directions.

Turn off tiling:

1. Uncheck the Tile U option.

The image repeats only along the V direction.

2. Uncheck the Tile V option.

The image floats by itself.

The rest of the object displays the material’s dif-
fuse and ambient surface colors, which were set
at the top level of the material. In a more com-
plex material, you might see another map
behind the image, or whatever is higher in the
hierarchy.
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The Mirror option is a variation on the Tile
option. Tile repeats the image over and over,
while Mirror flips the image repeatedly.

Turn on mirroring:

1. Check the Mirror U option.

The two mirrored copies of the skyscraper fill
the area taken by the original image, and the
mirrored copies are repeated along the U
direction.

2. Check Mirror V.

Four diagonally mirrored copies fill the area
taken by the original image, and the copies
extend in all directions.

Mirroring and tiling are handy for creating pat-
terns based on a simple image. Use them when
you need wallpaper and other repetitive designs.

Tip: You can use the Tiling values to scale the
map image. Negative Tiling values increase the
size of the image.

Bitmap Fit and Normal Align
When you first applied the UVW Map modifier,
the planar gizmo took its size from the dimen-
sions of the box—resulting in a fairly thick sky-
scraper. When you need an accurate aspect
ratio, use the Bitmap Fit tool.

Fix the aspect ratio using Bitmap Fit.

1. Uncheck Mirror U and Mirror V.

The mapping again displays a single image.

2. Click Bitmap Fit in the Alignment area of the
Modify panel.

A file dialog appears.

3. Select tutskysc.jpg from the \maps directory,
and then click OK.

The aspect ratio of the planar gizmo is
adjusted to match that of the selected bitmap
file.

The Normal Align tool lets you align the gizmo
with the face normals of the object.

Align the image:

1. Click Normal Align in the Alignment area.

2. In the Perspective viewport, drag the mouse
across the three sides of the box.

As you drag across each side, the gizmo is
reoriented so it’s parallel with the specified
face.

3. Center the image on the front face, and then
release the mouse.

The picture of the skyscraper now floats in the
diffuse color on the side of the cube.

Cylindrical Mapping
Cylindrical Mapping, as its name suggests, is
designed for cylindrically shaped objects, such
as vases, bottles, table legs, and so on.
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Apply a UVW Map modifier to the cylinder:

1. Check U and V Tile.

2.  Turn off Lock Selection Set.

3. Turn off the Sub-Object button.

4. Select the cylinder.

5.  Click Zoom Extents All Selected.

6. Apply UVW Map.

The default planar mapping projects the bit-
map image through the cylinder so that the
image is correct on the top (and bottom), but
streaked along the sides.

7. On the Parameters rollout on the Modify
panel, choose Cylindrical.

The image is now wrapped around the sides
of the cylinder. The top (and bottom) of the
cylinder are orange. The front of the image is
at the front of the cylinder, and a seam is
along the back side.

No matter how you map an object, when you
try to wrap a 2D plane around a 3D object, there
are bound to be places where the image isn’t
perfect. (When you gift-wrap a package, there

are always places where the wrapping paper
overlaps and must be taped down.)

You saw the streaks in the planar map. When
you use a cylindrical map, the problems are at
the top and bottom of the cylinder, as well as at
the seam.

Where the image slips over the top (or bottom),
it’s gathered into a point at the center. Cur-
rently, the top of the cylinder is orange, because
the border of the bitmap image is mapped across
the top. Look what happens when you move the
gizmo up.

Change the position of the cylindrical gizmo:

1. Turn on Sub-Object.

2.  Turn on Lock Selection.

3. Click Select and Move, and turn on the Y axis
constraint.

4. In the Front viewport, slowly move the map-
ping gizmo about half way up the cylinder,
while watching the effect on the top of the
cylinder in the Perspective viewport.

The bitmap pixels are mapped around the sides
of the cylinder, but when they slip over the edge
of the cylinder, they’re distorted as they’re
forced toward the center of the top.

There’s a quick fix for this when you’re working
with cylinders.

Use the Cap option:

1. Click Reset in the Alignment area of the UVW
Map modifier.

The gizmo returns to the center of the cylin-
der.

2. Check Cap beside the Cylindrical option.
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The skyscraper appears at the top of the cylin-
der.

The Cap option applies the image using planar
mapping through the top of the cylinder and
cylindrical mapping around the sides.

The Cap option is handy when you’re mapping
organic, abstract images without a distinct
design. However, it projects planar mapping
based on the angle of the face normals in an
object, and there’s a problem when you use it for
objects that aren’t perfectly cylindrical.

If you’re mapping, say, a turned table leg, the
bulges and indents in the leg will catch the pla-
nar mapping when Cap is on. To see this effect,
apply a curved Taper to the cylinder.

Taper the cylinder before the UVW Map:

1. Open the Stack list, and select Cylinder to
move to the creation parameters in the Stack.

2. Apply a Taper modifier.

3. Set the Amount to –0.5.

4. Drag the Curve spinner up to about 1.5 and
watch the mapping on the cylinder.

At a certain point, the image mapped to the
top of the cylinder begins moving down
along the curved sides.

If you modify the sides of your cylinder after the
UVW Map modifier in the Stack, you can avoid
the remapping.

Taper the cylinder after the UVW Map:

1.  Click Remove Modifier from the Stack.

2. Open the stack, and choose UVW Mapping.

3. Apply a Taper modifier.

4. Set the Amount to –0.5, and the Curve to 1.5.

The mapping remains distinct across the top
and along the sides because the distortion is
occurring after the mapping in the Stack.

5.  Click Remove Modifier from the Stack to
restore the original shape of the cylinder.

Spherical Mapping
There are two types of spherical mapping. The
Spherical option in the UVW Map modifier is
the same type of mapping that’s built into the
created sphere. However, as usual, the UVW
Map modifier gives you added flexibility.

Apply UVW Map to the sphere:

1.  Turn off Lock Selection Set.

2. Select the sphere.

3.  Click Zoom Extents All Selected.

4. Apply a UVW Map modifier.

5. Choose Spherical.

The spherical map wraps the bitmap around the
sphere into a cylinder—just like cylindrical
mapping—and then pinches together the open
ends.
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If you have a map whose right and left edges tile
properly, a spherical map results in only two
peculiarities, at the top and bottom. Because of
the orange border around the skyscraper image,
the spherical map also reveals an orange seam at
the back of the ball.

The spherical map projects outward from its
center, so scaling the gizmo has no effect. How-
ever, you can get an interesting effect by moving
it away from the center of the object.

Move the spherical gizmo:

1. Turn on Sub-Object.

2.  Turn on Lock Selection Set.

3.  Using Select and Move with XY con-
straints, move the gizmo in the Perspective
viewport so it’s not centered in the sphere.

The image is magnified on the surface of the
sphere that’s furthest from the gizmo, and
reduced on the surface that’s closest to the
gizmo.

Shrink Wrap and Box Mapping
Spherical mapping results in peculiarities at the
top and bottom of the sphere. To avoid these
peculiarities, you can use a variation on spheri-
cal mapping, called Shrink Wrap.

Shrink Wrap wraps the image completely
around the object, leaving only one peculiarity.
Imagine using a circular cookie cutter on the
image to trim its corners, and then wrapping the
image around the object and gathering the
ends, like the string on a balloon.

Try Shrink Wrap:

1. Click Center in the Alignment area.

The gizmo returns to the center of the sphere.

2. Check Shrink Wrap in the Parameters rollout.

3.  Use Arc Rotate Selected to view different
sides of the sphere.

The map is wrapped completely around the
sphere, coming together at the bottom where
an orange dot is all that’s left of the borders.

Box is a special type of mapping based on the
angles of the faces. A box gizmo is placed
around the object. The faces of the object whose
angles are closest to matching one of the six
sides of the box, receive planar mapping from
that side.

Use Box mapping on the sphere:

1. Check Box in the Parameters rollout.

2.  Use Arc Rotate Selected to view different
sides of the sphere.

The skyscraper appears on several sides of the
sphere.

Box mapping is particularly useful when you
have a complex piece of geometry and an
abstract pattern. It avoids the streaks and distor-
tions that can appear in certain areas when you
use the other mapping methods.
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Sub-Object Mapping 2

A single mapping projection method is often
insufficient for complex geometry. The solution
is to apply different mapping methods at the
sub-object level. This gives you complete con-
trol over every portion of your object.

You apply sub-object mapping in the same way
that you apply any other type of modification to
a sub-object selection. Use Edit Mesh to define
the selection, and then apply and adjust a UVW
Map modifier.

For a simple example, you’ll use planar mapping
for a portion of the side of the cylinder.

Apply Edit Mesh to the cylinder:

1. Turn off Sub-Object.

2.  Turn off Lock Selection Set.

3. Select the Cylinder.

4.  Click Zoom Extents All Selected.

5. Right-click the Front viewport label, and
choose Wireframe.

6. Apply an Edit Mesh modifier.

7. Choose Face in the Selection Level list.

8. In the Front viewport, hold CTRL, and click to
select each of 12 faces in a 4 x 3 region of faces
in the center of the cylinder.

9. Apply a UVW Map Modifier.

10.Switch the Front viewport to Smooth + High-
light display.

The selected faces are mapped strangely because
of the orientation and size of the planar gizmo.

Reorient and resize the planar gizmo:

1. Click Normal Align, and drag the mouse
across the center of the selected faces and cen-
ter the box.

The gizmo is now aligned with the front, but
it’s still too small.

2. Click Fit to resize the gizmo to fit the faces
selected in the Edit Mesh modifier.

The skyscraper appears centered on the side
of the cylinder.

If you alter the mapping using the controls in
the Material Editor, the image will be changed
on all surfaces. But if you use the controls in the
UVW Map panel, you’ll only affect the image on
the selected faces.

Adjust the UVW Map controls:

1. Turn on Sub-Object.

2.  Turn on Lock Selection Set.

3.  Click Select and Uniform Scale.

4. Scale up the image about 300 percent.

5.  Using Select and Move in the Front view-
port, drag the gizmo down until the top of the
skyscraper is centered in the selection.
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Using Blur and Blur
Offset 2

The Blur and Blur Offset controls in the Param-
eters rollout of the map level of the Material Edi-
tor have not yet been addressed. Their effect is
most easily seen using a different object and
scene.

Load a new scene, and access a new material:

1. Load tut11_2.max.

In the Camera viewport, a checkered box goes
off into the distance.

You can use a shortcut to access the Diffuse
map level on the material.

2. In the Material Editor, make sure that the first
sample slot is active. (It’s called Mighty Thin
Checkers.)

3.  Click the map button to the right of the
Diffuse color swatch.

The lower portion of the Material Editor dis-
plays the Checker Map Level.

The Blur and Blur Offset controls determine
how the map is blurred, or softened in the ren-
dering. You can’t see their effect in the viewport
renderer, only in the scanline renderer.

Using Blur
The Blur setting blurs the map based on its dis-
tance from the view. The farther away the map
is, the greater the blurring. You should always
use some blurring on your maps to avoid the
type of scintillation, or aliasing, that can occur
when pixel details are reduced off in the dis-
tance.

The Blur default is 1.0, which is a good setting
for most purposes. In the following procedure,
you can examine the effect of Blur by first ren-
dering the checker surface with practically no
Blur, then rendering it again with the default
setting, and then again with a higher setting.

Render the scene at a higher resolution so you
can see the details.

Render the camera view in 640 x 480:

1. Set the Blur spinner to 0.1.

2.  Click Render Scene.

The Render Scene dialog appears.

3. Make sure that Single is chosen.

4. Make sure the resolution is set for 640x480.

5. Click Render.

The checkered box appears in the rendered
scene.

Look very closely at the borders between the
white and black checkers. Here and there, you’ll
see a white pixel in the black area, or vice versa.
The problems are more pronounced toward the
back of the box where the map is scaled down in
size.

Render the same scene using the default Blur:

1. Set the Blur spinner to 1.0.
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2.  Click Render Last.

As the rendering progresses, you can see the
isolated pixels disappear.

The checkers in the back are blurred just slightly
more than those in the foreground.

The Blur effect is more pronounced when you
use higher settings.

Use Blur with a higher setting:

1. Set the Blur spinner to 3.0.

2.  Click Render Last.

The checkers in the back blur into a gray haze.

Using Blur Offset
Blur Offset blurs the map without regard to
depth. That is, all the pixels in the map are
blurred equally, regardless of how close or how
far they are from the camera.

Whereas the Blur value is primarily used to
avoid aliasing, Blur Offset is useful when you
want to soften, or defocus the details in a map.
It’s the equivalent of blurring the bitmap in an
image-processing program before applying it as
a material map.

Increase the Blur Offset:

1. Set the Blur spinner back to 1.0.

2.  Click Render Last to look again at the
default settings.

The checkers appear fairly clean throughout.

3. Set Blur Offset to 0.2.

4.  Click Render Last.

All of the checkers are blurred equally, from
front to back.
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Face-Mapped Materials 2

There’s another method of applying mapped
materials that requires no mapping coordinates
whatsoever. In the Material Editor, you can cre-
ate a face-map material. When a face-map mate-
rial is assigned to an object, the map is automat-
ically applied to each facet of the object.

To complete this tutorial, you’ll design a mate-
rial using the Face Map option, and assign it to
a torus.

Reset, and create a torus:

1. Close the rendering window.

2. Reset 3DS MAX.

3. Create a fat torus in the Perspective viewport.

4. If not already, switch the Perspective viewport
to Smooth + Highlight.

5.  Use Arc Rotate to tilt the view down
slightly.

Now, create a material.

Design the material:

1. Open the Material Editor and select any sam-
ple slot.

2.  Click Assign Material to Selection.

3. Click the map button beside the Diffuse color
swatch.

4. Make sure New is chosen in the Browser.

5. Choose Bitmap, and click OK.

6. Click the wide button labeled Bitmap, and
choose PAT0006.tga.

7.  Click Go to Parent.

8. Check Face Map.

The sample sphere is tiled with tiny repeti-
tions of the map image.

The map images are small because the sample
sphere has a lot of small faces.

You’ve created a face-mapped material. Add a
metallic appearance.

Make the torus metal, and render:

1. Choose Metal in the Shading list.

2. Set Shininess to 80, and Shin. Strength to 20.

3.  Click Render Scene, choose 640x480, and
click Render.
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Tutorial

In the previous tutorial, you learned how to
place your maps anywhere on the surface of the
geometry. In this tutorial, you’ll explore some
of the various types of map you can use on a
material.

You can assign maps to most of the components
that make up a material. For example, you can
replace the ambient, diffuse, or specular color
components with a map. You can use a map to
affect the self-illumination quality of a material,
and you can use a map to affect the very opacity
of a material.

Maps offer the level of realism you look for in
materials. The different types of maps you can
use range from the common bitmap, to the flex-
ible procedural map.

The exercises in this chapter not only demon-
strate the various map types, but also begin to
show you methods of navigating a complex
material. By the end of this tutorial, you’ll have
created a material consisting of six different
maps

Mapping Types
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Begin with a Basic
Material 2

You’ll apply various mapping types to the stan-
dard teapot available in the Create command
panel. The scene has been set up for you, so all
you need to do is load the tutorial file.

Load the tutorial file, and assign a basic
material:

1. Choose File>Open, and load tut12_1.max.

A scene consists of a teapot on a stand.

2.  Click Material Editor.

3. Make sure the first sample slot is active in the
Material Editor.

4. Edit the name field to read Teapot Material.

5. Select the Teapot.

6.  Click Assign Material to Selection.

7. Deselect the Teapot.

8. Make sure the Camera viewport is active.

9.  Click Quick Render.

The rendered teapot is lit by a spotlight and
an omni light.

10.Drag the rendering window over the Front
viewport.

This is what the teapot looks like with a basic
material. Only the Ambient, Diffuse, and Specu-
lar colors, plus the various shininess settings
affect its surface.
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Diffuse (and Ambient)
Maps 2

The first type of map you’ll look at is the most
common. It’s called a diffuse map because it
maps an image to the diffuse component of the
material. As a default, it identically maps the
ambient component as well, because you sel-
dom use a different map for diffuse and ambient
components.

Note: In previous releases, a diffuse map was
called a texture map. A texture map in those
releases always mapped both the diffuse and
ambient components of a material.

Applying a diffuse map is like painting an image
on the surface of the object. For example, if you
want the teapot to be made out of marble, you
can apply a marble bitmap image as a diffuse
map.

Open the Maps rollout and choose a map type:

1. On the Material Editor, open the Maps roll-
out.

The Maps rollout lists all of the map types on
the left. The Amount spinners specify how
much of the map will affect the specific com-
ponent of the material. Clicking the wide but-
tons on the right displays the Material/Map
Browser where you choose the type of map.

2. Click the Map button (labeled None) in the
Diffuse row.

The Material/Map Browser appears, display-
ing only maps.

3. Make sure that New is chosen in the Browse
From area.

4. Click Bitmap, and then click OK.

The lower portion of the Material Editor
changes.

Choose a bitmap and render the teapot.

Select a bitmap, and render:

1. In the Bitmap Parameters rollout, click the
wide button labeled Bitmap.

A file dialog appears.

2. In the \maps directory, find and load
marbtea2.gif.

The sample sphere becomes marble.

3.  Click Show Map in Viewport.

The marble map appears on the teapot in the
viewport. (A spherical UVW Map modifier has
been previously applied to the teapot.)

4.  Click Render Last.
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Getting Your Bearings 2

Although you can descend many levels in any
material or map, in this tutorial you’ll only drop
down one level to a single map type.

When you selected the map type from the
Browser, the lower portion of the Material Editor
changed to display controls specific for the
selected type of bitmap. You’re now one level
down in the material you named Teapot Mate-
rial. The name of the material is still in the title
bar of the Material Editor, but the name of the
level is in the editable name field below the sam-
ple slots. (Currently, the editable field contains
a default name.)

Beside the editable field is the label Diffuse,
which tells you which component of the mate-
rial you’re mapping. To the right, is the Type
button, labeled Bitmap because that’s the type of
map you chose from the Browser.

Using the Material/Map Navigator
There are many ways to move up and down
between the map and the top level. One
involves using the Material/Map Navigator,
which is a dialog to help you view and move
through the levels of a material.

Use the Material/Map Navigator:

1.  Click Material/Map Navigator.

The Material/Map Navigator dialog appears.

Notice that the line containing the
marbtea2.gif map is highlighted. That shows
where you are in the material. You can move
to any material, or to any level of a material
by clicking either the blue-sphere material
icons, or the green map icons.

2. Click the blue sphere icon beside Teapot
Material.

The panels in the Material Editor change to
display the top-level controls, including all
the map buttons.

3. Click the green map icon.

You’re back at the map level of the first mate-
rial.

Navigating with Go to Parent
Another way to move between levels is to navi-
gate using controls in the Material Editor. For
example, when you’re down one or more levels,
the Go to Parent button  is enabled in the
toolbar below the sample slots. Clicking this
button moves you up one level.

Use the Go to Parent button:

1.  Click Go to Parent.

You’re at the top level, and the Go to Parent
button is disabled. In the Material/Map Navi-
gator, Teapot Material is highlighted.

Besides watching the Material/Map Naviga-
tor, you can tell you’re at the top level of a
material when the Go to Parent button is dis-
abled, and the name in the edit field matches
the name in the title bar.

When you’re at the top level, you get back
down to the map level by clicking its button
in the Maps rollout.
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2. Click the Diffuse Map button.

You’re back at the map level.

Navigating with the Name Field
Here’s another way to change levels. The edit-
able name field is a pop-up list that displays the
parental hierarchy when you’re below the top
level.

Move up using the name field:

• Open the name pop-up list, and choose Tea-
pot Material.

You’re back at the top level.
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Maps from the Material
Library 2

If you want to change the marble map to some-
thing else, you don’t have to get a map from
disk. Use the Material/Map Browser to select
your maps from any material in any location.

For example, a map called tutash.jpg is used in a
material in the Tutorial material library. Here’s
how to get it.

Get tutash.jpg from tutorial.mat:

1. Exit the Material/Map Navigator.

2. Click the Diffuse Map button in the Maps
rollout to return to the map level of the mate-
rial.

If you click the wide button labeled Bitmap in
the Bitmap Parameters rollout, the file dialog
will appear, and you’ll again be choosing a
map from the disk. To access the Browser, you
click the Type button instead. Usually, you’d
use this button to change the type of map. In
this case, you’re going to select the same type,
but use the Browser to look in a different loca-
tion.

3. Click the Type button (labeled Bitmap).

The Browser appears.

4. Choose Mtl Library in thre Browse From area.

5. Click Open in the File area.

6. Choose tutorial.mat from the file dialog.

The maps used in the Tutorial material library
appear.

7. Select and load the tutash.jpg bitmap (part of
the Wood Bitmap).

The wood-grain bitmap replaces the marble
bitmap.

8.  Click Show Map in Viewport.

9.  Click Render Last.

You now have a wooden teapot.

It’s a good idea to name your material levels.

• In the name field, enter Wood Grain Bitmap.

Changing the Amount of the Map
As a default, the diffuse map is applied at 100
percent, completely replacing the diffuse and
ambient colors. You can change the percentage
of any mapping type in the Maps rollout.

Change the mapping amount:

1.  Click Go to Parent to return to the top
level of the material.

2. In the Maps rollout, reduce the Amount spin-
ner in the Diffuse row to about 50 percent.

The sample sphere takes on the reddish tint of
the diffuse color.

3. Increase the Diffuse Amount spinner to 100
percent. The full map again replaces the dif-
fuse (and ambient) colors.
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Opacity Maps 2

Opacity maps use the intensity levels of the
image to alter the opacity of a surface. White is
opaque, black is clear, and values in between are
semitransparent.

Apply Checkers as an opacity map:

1. Click the Opacity Map button.

The Browser appears.

2. Choose New.

You can determine the different category of
maps by setting the filter options down in the
Show area.

3. Choose 2D Maps.

Other than Bitmap, the rest of the items in
the list are procedural plug-ins.

4. Choose Checker, and click OK.

Portions of the sample sphere are now trans-
parent, and the lower half of the Material Edi-
tor now displays controls for the procedural
Checker plug-in.

5.  Turn on Background to better view the
transparency.

6. In the name field for this level, enter Checkers
Opacity.

Notice that the label for the name field at this
level is Opacity, and the Type button is called
Checker instead of Bitmap. Also, now that you
have two maps active at the same level of this
material, a new button is enabled beside the Go
to Parent button. It’s the Go to Sibling button.

Use the Go to Sibling button:

1.  Click Go to Sibling.

You’re moved laterally to Wood Grain Bit-
map.

2.  Click Go to Sibling again.

You’re back at Checker Opacity.

Tip: If you open the Material/Map Navigator
and examine the hierarchy of this material as
you build it, you’ll see exactly where you are.

The controls for the Checker plug-in are some-
what different than those for a bitmap. The
Coordinates rollout is the same, but the Checker
Parameters rollout is completely different.

A bitmap is an image produced by a fixed matrix
of colored pixels—like a mosaic. Procedural
maps, such as Checker, however, generate an
image using a mathematical algorithm. As a
result, the types of controls you might find for a
procedural map will vary depending on the
capabilities of the procedure.

Adjust the Checker settings:

1. Set the U and the V Tiling spinners to 5.

2. Set the Angle spinner to 45.

The size and angle of the transparent and
opaque areas changes.

You can adjust the colors of the checkers, but
because this is an opacity map, only the
intensity (or value) in the color matters.

3. Click the black color swatch, labeled
Color #1.

The Color Selector appears.

4. Adjust the Value spinner (or slider) to about
128.

The transparent areas in the sample sphere
grow more opaque.

5. Reset the Value spinner to 0.

6. Click the white color swatch, labeled
Color #2.

7. Lower the Value spinner.
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The opaque areas in the sphere become
increasingly transparent.

8. Reset the Value spinner to 255.

When you use an opacity map (or most types of
transparent materials) you often want a two-
sided material so you can see the surface
through the transparent portions. The 2-Sided
quality is an attribute of the material and not
the map. To set it, you go back to the top level
of the material.

Set 2-Sided, and render the teapot:

1.  Click Go to Parent.

2. Scroll the panel down to display the Basic
Parameters rollout.

3. Check 2-Sided.

4.  Click Render Last.

The teapot appears with diamond-shaped
holes.
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Shininess Maps 2

An opacity map alters only the opacity of the
ambient and diffuse components of the mate-
rial. The shininess of the material (as seen by the
specular highlights) is not affected by an opacity
map. This can be demonstrated by making the
specular highlights on the teapot a little more
obvious.

Broaden the specular highlights:

1. Set the Shininess spinner to 20.

2. Set the Shin. Strength spinner to 70.

3.  Click Render Last.

The broad specular highlights wash across
both the opaque and the transparent areas of
the surface.

This effect gives the illusion of a glass teapot
with painted, wood-grain triangles on its sur-
face.

In this exercise, however, you want the transpar-
ent areas to look like holes. To do this, you’ll
remove the shininess using the same map as
you’re using for the opacity.

You can map both Shininess and Shininess
Strength. The distinction between the two is
subtle, but beware that you’ll almost never use
Shininess mapping. In most cases, when you
want to alter the intensity of the specular high-
lights, apply the map to the Shininess Strength
component of the material. (Specular mapping,
as you’ll see later, affects only the color of the
specular highlights.)

Rather than reassign the Checker plug-in to the
Shininess Strength component, you can simply
drag a copy of the map from one button to the
other.

Instance the Checker:

1. In the Maps rollout, drag the Opacity Map
button over the Shin. Strength button.

A dialog appears that offers a choice between
copying, instancing, or swapping the map. By
instancing the map, any changes you make to
it at either map level affects it identically at
the other map level. Because you want the
shininess to always be mapped the same as
the opacity, the choice is clear.

2. Check Instance, and click OK.

3.  Click Render Last.

The specular highlights appear only on the
opaque portions of the teapot.
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Bump Maps 2

Like opacity maps and shininess maps, bump
maps use the intensity of the image to affect the
surface. The intensity affects the apparent
smoothness of the surface—white areas pro-
trude, and black areas recede.

Use bump maps when you want to take the
smoothness off a surface, or create an embossed
look. Keep in mind, however, that the depth
effect of a bump map is limited. If you want
extreme depth in a surface, you should use mod-
eling techniques instead.

In the following steps, you’ll assign yet another
type of procedural map—a Noise plug-in.

Assign a Noise plug-in:

1. Click the Bump Map button in the Maps roll-
out.

The Browser appears, displaying only 2D
maps.

2. Set 3D Maps in the Show area.

Only the 3D Map types are listed.

3. Double-click Noise to select and exit.

The Bump map level appears displaying the
various Noise parameters.

4. Name this level Bumpy Noise.

Show End Result
Because you’re working on a bump map, it’s dif-
ficult to see exactly what you’re doing with all of
these other maps in the way. Also, a bump map
only perturbs the surface, so you can’t see the
intensity values of the Noise plug-in.

The Material Editor has a button that lets you
look at the material at the level you’re on
instead of looking at the end result of all the
other maps and settings. It works similarly to
the Show End Result button that’s used in the

Modifier Stack. Since it has the same function, it
has the same name.

Turn off Show End Result:

•  Turn off the Show End Result but-
ton beside the Go to Parent button.

The sample sphere becomes a random mix-
ture of blacks, whites, and grays.

Notice that when you turn off Show End Result,
not only are the various maps removed, but the
shading values as well. The “sphere” is now
completely flat.

Next, you’ll adjust a couple of settings, and then
render the result.

Set the Noise parameters:

1. Set the Size spinner to 0.10 in the Noise
Parameters rollout.

2. Choose Turbulence.

3.  Turn on Show End Result.

You can see a slight change in the surface.

Unlike all other map types, the bump map
defaults to a much lower Amount setting
because too much bump mapping can cause
aliasing on the rendered surface. In addition,
the Bump Amount setting is not a percentage,
but a range of bumpiness from 0 to 999.

Increase the amount of the bump mapping:

1.  Click Go to Parent.

2. Increase the Bump Amount spinner to 20.
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The Show End Result button removes all the
other levels of the material. If you simply want
to see the bump effect without the holes, you
can temporarily turn off the opacity and shini-
ness strength mapping.

Toggle opacity and shininess strength:

1. Uncheck the boxes beside Shin. Strength and
Opacity.

2.  Click Render Last.

A bumpy wooden teapot appears.

3. Check Opacity and Shininess Strength again.

4.  Click Render Last.

The teapot appears with its checkered holes
and bumpy surface.

Note: You might notice that it’s taking longer to
render the teapot. Opacity mapping takes
longer to render, with bump mapping coming
in a close second. If you want to compare ren-
dering times, you can render the teapot several
times, turning off a single mapping component
each time and comparing the rendering times
that appear in the prompt line.
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Specular Maps 2

Specular mapping is used primarily for special
effects, because it doesn’t occur naturally. The
important thing to remember is that, unlike
Shininess or Shininess Strength mapping that
alter the intensity of the specular highlights,
specular mapping alters the color of the specular
highlights.

Specular mapping is easier to see without the
opacity and bump maps, so turn them off.

Turn off some of the maps:

1. In the Maps rollout, uncheck the Shininess
Strength, Opacity, and Bump boxes.

The sample sphere retains only the wood
grain.

2. Scroll the panel so the Basic Parameters roll-
out is visible.

Shortcut Map Buttons

In addition to the Maps rollout, you can use
shortcut buttons in the Basic Parameters rollout
to assign and access map levels. Notice the but-
ton to the right of the Diffuse color swatch and
the six buttons below it. Each of these perform
exactly the same function as the wide buttons in
the Maps rollout.

Use the shortcut map buttons:

1. Click the button to the right of the Diffuse
color swatch.

You’re now at the Wood Grain Map level.

2.  Click Go to Parent.

3. Click the button to the right of the Opacity
spinner.

You’re at the opacity map level.

4.  Click Go to Parent.

Notice also that the Diffuse button displays an
uppercase M, while the Shin. Strength and
Opacity buttons each display the lowercase m.
That’s to show you that the Diffuse map is
active. The other buttons have maps assigned,
but are turned off. The blank buttons mean that
no map is assigned.

Some map types have no corresponding mate-
rial component. For example, the bump map
can only be accessed through the Maps rollout.

Now that you know about the shortcuts, you
can use one to assign a specular map.

Access and assign a specular map:

1. Click the button beside the Specular color
swatch.

The Browser appears.

2. Choose All in the Show area.

The window displays all map types.

3. Click Bitmap, and then click OK.

The Material Editor displays the specular map
level.

4. Click the wide button labeled Bitmap.

5. In the file dialog, select and load PAT0003.tga.

The specular area in the sample sphere is col-
ored by the bitmap.

6. Name this level of the material: Specular Pat-
tern.

You can turn off Show End Result to better
view the bitmap.

7.  Turn off Show End Result.

Only the bitmap is displayed.
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8. Set the U and V Tiling spinners to 3.0.

9.  Turn on Show End Result.

10.  Click Render Last.

The teapot appears with the pattern revealed
only in the specular areas.

Showing the Map in the Viewport
In the previous tutorial, you learned that a sin-
gle material can show only one map in the view-
port at any time. You now have a material that
consists of several different maps. Here’s how
you’d navigate through the various maps if you
had to adjust them in the viewport.

Use the Show Map button:

1.  Click Show Map in Viewport.

The specular map now covers the teapot.

At this point, you might adjust coordinates to
place the map where you want it. To restore
the wood grain, you’d do the following:

2.  Click Go to Parent.

3. Click the map button beside the Diffuse color
swatch.

You’re now at the Diffuse map level.

4.  Click View Map in Viewport.

The wood grain again covers the teapot.

The sample sphere did not change its appear-
ance because you’re only selecting the map to be
displayed for this material in the viewport.
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Self-Illumination Maps 2

A self-illumination map lets you use a map to
affect the intensity of the self-illumination
effect. Like many other map types, only the
intensity of the map values affect self-illumina-
tion. White provides the most, while black has
no effect.

In the following steps, you’ll add a pair of self-
illuminated eyes to the teapot.

Assign and adjust a Self-Illumination map:

1.  Click Go to Parent to return to the top
level of the material.

2. In the Basic Parameters rollout, increase the
Self-Illumination spinner to 100.

The ambient shading is replaced by the dif-
fuse value, which is the wood grain bitmap.

3. Click the map button to the right of the Self-
Illumination spinner.

4. Choose Bitmap from the Browser, and click
OK.

You’re now at the level of the self-illumina-
tion map.

5. Click the wide button labeled Bitmap.

6. Load tuteyes.tga from the file dialog.

7. Name this level of the material Bright Eyes.

The tuteyes.tga image contains an alpha channel
for transparency, and consists of two cartoon
eyes floating against a clear background. You
can view both the image and its alpha channel
in the View File window.

View the tuteyes.tga image:

1. Choose File>View File.

2. Select and load tuteyes.tga in the \maps direc-
tory.

A window appears displaying two white eyes
with black pupils, against a black background.

3.  Turn on the Display Alpha Channel but-
ton in the toolbar of the View File window.

The pupils turn white. The white areas and
the pupils in the image are opaque portions of
the alpha channel, while the black back-
ground is clear.

4.  Exit the View File window.

Next, you’ll turn off the U and V Tile options,
leaving a single image of the map against the
object. You’ll then use the Offset spinners to
position the eyes at the front of the teapot.

Adjust the position of the map:

1.  Click Show Map in Viewport.

White eyes appear against a black teapot.

2. Uncheck the U and V Tile boxes.

The diffuse color shows through the clear
alpha portions of the map. This area will be
wood grain in the rendered scene.

3. Set the U Offset to –0.25.

4. Set the U and V Tiling to 2.0.

The eyes are now on the side of the teapot,
facing the camera.

5.  Click Render Last.



3t2tut12.fm    15  Thu Oct  2 14:49:05 1997

Tutorial 12

M
ap

p
in

g
 T

yp
es

12
 –

 1
5

The eyes appear to glow because they’re the
same value in shadow as in light.

Tip: Self-illumination maps are handy for
things like tiny lights seen at a distance. It’s
often a good idea to design a self-illumination
map to match your diffuse map. For example,
the diffuse map might have small, yellow rect-
angles to represent windows, while the self-illu-
mination map consists of matching white rect-
angles against black to illuminate the yellow
windows.
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Saving Your New
Material 2

You’ve created a complex material. It’s a good
idea to store it in the Tutorial library.

Save the material:

1.  Click Put to Library.

Because you’re not at the top level of the
material, an alert asks if you want to put the
entire material into the library. You could
save just the map level you’re on, but you
want to save the whole material.

2. Answer Yes.

Another alert appears displaying the current
material name.

3. Press OK to store Teapot Material in the
library, and to update the library on disk.

Your material now exists in three places:

• The scene

• The material editor

• The material library

Using the Browser, you can get any level of this
material from any of these three places.

View your new material as it appears in the
Browser.

Open the Material/Map Browser:

1.  Click Get Material.

2.  Click View List, if it’s not already selected.

3. Choose Mtl Editor in the Browse From area to
view the materials in the sample slots.

The Teapot Material is listed beside the blue
icon. Indented, and listed below, are the six
maps you’ve added to the Teapot Material.
For each map, you can see the name you pro-
vided, plus the type of map in parenthesis. If
it’s a bitmap, the file name follows.

4.  Click View Large Icons.

The icon for the Teapot Material contains the
shading, plus all active maps. It looks just like
the sample sphere in the Material Editor.
Maps contained in the Teapot Material are
shown with no shading because only materi-
als carry diffuse, ambient, and specular prop-
erties.

5.  Exit the Browser.



3t2tut12.fm    17  Thu Oct  2 14:49:05 1997

Tutorial 12

M
ap

p
in

g
 T

yp
es

12
 –

 1
7

Basic Reflection Maps 2

There are three types of reflection maps you can
create:

• Basic reflection maps

• Automatic reflection maps

• Flat-mirror reflection maps

The basic reflection map is covered in this sec-
tion.

A basic reflection map creates the illusion of
chrome, glass, or metal by applying a map to the
geometry so that the image looks like a reflec-
tion in the surface. Reflection maps don’t need
mapping coordinates because they’re locked to
the world, not to the geometry. The illusion of a
reflection is created because the map doesn’t
move with the object, but with changes in the
view—as do real reflections.

To try out a basic reflection map, you’ll make a
new material.

Create a new material:

1. Select the second sample slot in the Material
Editor.

2. Select the teapot.

3.  Click Assign Material to Selection.

4. Deselect the teapot.

5. In the Maps rollout, click the Reflection Map
button. (Don’t select the Refraction button by
mistake.)

6. Choose New in the Browser, and select Bit-
map. Then click OK.

The panels in the Material Editor display the
Reflection Map controls.

7. Click the wide button labeled Bitmap, and
select and load tutvally.tga.

The sample sphere looks like a colorful,
chrome ball.

8.  Click Render Last.

The teapot has a shiny, mirror-like surface.

Changing the Shininess and Color
The reflection surface is affected by the shini-
ness settings and the ambient and diffuse colors.

Adjust the shininess:

1.  Click Go to Parent.

2. Set the Shininess spinner to 50.

3. Set the Shininess Strength spinner to 90.

The specular highlights are sharper and
brighter.

Adjust the Ambient and Diffuse color:

1.  Click the lock button between the Ambi-
ent and Diffuse labels, and answer Yes at the
prompt.

2. Click either the Ambient or the Diffuse color
swatch.

The Color Selector appears.



3t2tut12.fm    18  Thu Oct  2 14:49:05 1997

Tutorial 12

12
 –

 1
8

M
ap

p
in

g
 T

yp
es

3. Drag the cursor around in the color box to
select various colors. Observe the changes in
the sample sphere.

The colors tint the reflective surface.

4. Observe the sample sphere while creating a
light color with a lot of white, then create a
dark color with a lot of black.

Lighter colors tend to obscure the reflection
map, while darker colors reveal the reflection
map.

5. Choose a blue color with a value of about 120.

6. In the editable name field of the Material Edi-
tor, enter Blue Chrome.

7.  Click Put to Library, and click OK.

8.  Click Render Last.

The teapot is now shiny blue.

Blurring the Reflection
Reflective surfaces are not always crystal clear
and mirror-like. Look around, and you’ll see
that many reflective surfaces are somewhat dull.
By blurring the reflection map, you can create
the same effect, and disguise the fact that the
image in the reflection might not be the same as
the environment that surrounds it.

Blur the map:

1. Drag the Chrome sample slot to the third
sample slot.

2. In the Maps rollout, click the Reflection Map
button to enter the reflection map level.

The Blur Offset setting is extremely sensitive;
a small value produces plenty of blurring.

3. Set Blur Offset to 0.3.

4.  Click Put Material to Scene.

5.  Click Render Last.

The teapot now has a “brushed” metal
appearance.

6.  Click Put to Library, and answer Yes.

7. Name the material Dull Blue Chrome, and
click OK.

Mixing Reflection and Diffuse Maps
The most common use of reflection maps in a
realistic scene is to add just a touch of reflection
to an otherwise non-reflective surface. In previ-
ous exercises, you created shiny wood and mar-
ble surfaces, but neither had any reflections to
add those subtle irregularities that provide the
illusion of reality.

In the following steps, you’ll create a material
that mixes a diffuse map with a reflection map.
Typically, you might begin with a diffuse-
mapped material and add a touch of reflection,
but you can just as easily add a diffuse map to
your existing material, and then adjust the
reflective qualities.

Create a shiny wood material:

1.  Click Go to Parent.

2. Click the Diffuse map button.
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3. Choose either Mtl Editor or Mtl Library, and
then choose tutash.jpg. Then click OK.

A dialog appears that offers a choice between
instancing or copying.

4. Check Instance, and click OK.

5.  Click Go to Sibling.

6. Set the Blur Offset to 0.1 to make the reflec-
tion a bit sharper.

7.  Click Go to Parent.

8. In the Maps rollout, set the Amount spinner
for the Reflection map to 30.

9. Name the material Polished Wood.

10.  Click Put to Library, and then click OK.

11.  Click Render Last.

The surface of the teapot appears to be made
of a highly polished wood. You can’t really
make out the details of the reflection, but the
map provides the effect you want.

You learned that you can heighten the illusion
of reflection by assigning the same map to your
background as is used in your reflection. You
can also assign an automatic reflection map that
reflects the environment it’s in. The environ-

ment can consist of all geometry, or geometry
and environment mapping.

12.  Exit the Material Editor.
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Environment Maps 2

An environment map is not assigned in the Mate-
rial Editor, because it’s not applied to the geom-
etry of an object, but rather to the scene itself.
Environment maps appear in the background,
as seen from the camera or perspective view.

As an alternative to mapping the environment,
you can simply change the color of your back-
ground. Whether you’re changing the back-
ground color, or assigning a map to the environ-
ment, all of it is done through the Environment
dialog, which is accessed through the Rendering
menu.

The easiest thing to change is the color of your
environment, so try that first.

Change the color of the environment:

1. Choose Rendering>Environment.

The Environment dialog appears.

This modeless dialog provides a number of
ways to affect the environments in your
scene, including plug-ins that let you set up
fog, volumetric lighting, and other effects.

2. Click the color swatch in the Background area
at the top of the dialog.

The Color Selector appears.

3. Choose a color you like.

4.  Click Render last.

The teapot appears before a colorful back-
ground.

Next, you’ll assign the tutvally.tga file as a back-
ground.

Assign an environment map:

1.  Exit the Color Selector.

2. Click the Environment Map button (labeled
None) in the Environment dialog.

The Browser appears.

3. Choose tutvally.tga from the Mtl Editor. Then
click OK.

A dialog appears that offers a choice between
instancing or copying.

4. Check Instance, and click OK.

5.  Exit the Environment dialog.

When you assign a map to the environment, it’s
the same as if you’d assigned a mapped material
to an object in your scene. To edit or adjust the
assigned map, you need to place it in one of the
sample slots in the Material Editor.

Put the environment map to the Material
Editor:

1. Open the Material Editor.
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2. Select the fourth sample slot.

3.  Click Get Material.

The Material/Map Browser appears.

4. Select Scene under Browse From.

5. Double-click tutvally.tga to assign the map to
the Material Editor.

6. On the Coordinates rollout, select Environ
Mapping and choose Screen from the list.

The entire map appears, but it’s blurred
because it retains the Blur Offset that you set
while it was a reflection map.

7. Set Blur Offset to 0.

The map is now in focus.

8.  Click Render Last.

The valley scene appears in the background.

Now, see what a mirrored chrome teapot looks
like.

Assign Blue Chrome, and re-render:

1. Select the teapot.

2. Select the second sample slot containing the
Blue Chrome material.

3.  Click Assign Material to Selection.

4.  Click Render Last.

The teapot now looks as if it belongs in the
scene.

Choosing a Mapping Coordinate System
When you work with any type of map, it’s
important that you use the right mapping coor-
dinate system. There are two basic types:

• Texture

• Environment

The texture coordinate system locks the map to
the geometry based on mapping coordinates. As
you move the object, the map moves along with
it. Texture coordinate systems are used with all
except reflection, refraction, and environment
maps.
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Environment coordinates are locked instead to
the world. If you move the object, the map
remains in place. If you move the view (or cam-
era) the map changes. This type of mapping sys-
tem is used with reflection, refraction, and envi-
ronment maps.

There are four types of environment coordi-
nates:

• Cylindrical

• Spherical

• Shrink-wrap

• Screen

The first three types are the same as those used
by the UVW Map modifier described in the pre-
vious tutorial. Imagine a sphere, infinite in size,
surrounding your scene and mapped with
spherical mapping coordinates. This is essen-
tially the effect you get with spherical environ-
ment mapping. Shrink-wrap wraps the map
around a giant sphere, leaving only one singu-
larity. Cylindrical is like a giant cylinder.

The Screen system, that you used in the previ-
ous exercise, maps the image directly to the
view, with no distortion. It’s similar to planar, in
that it’s like a giant backdrop hung in the scene.
Unlike the other environment mapping meth-
ods, Screen is locked to the view. When you
move the camera, the map moves with it. As a
result, you can use it only for still renderings, or
animations in which the camera doesn’t move.

To use a bitmap with any environmental map-
ping system other than Screen, you need a high-
resolution map because of the size of the virtual
sphere, or cylinder. For example, tutvally.tga is
only 512 x 480 pixels, which is not large
enough. See what happens when you use it with
a Shrink-wrap mapping coordinate system.

Render the scene with Shrink-wrap mapping:

1. Select the fourth sample slot.

2. In the Mapping pop-up list, choose Shrink-
wrap Environment.

3.  Click Render Last.

You see only a small portion of the image
(stretched around the world), and the back-
ground appears fuzzy.

As an alternative to a high-resolution bitmap,
you can use either procedural maps, or bitmaps
designed for tiling. The following steps create an
interesting effect using Cylindrical mapping.

Add shingles to the environment:

1. Click the wide button labeled Bitmap.

2. In the file dialog, open the \maps directory,
and select and load tutshngl.jpg.

3. Open the Mapping list, and choose Cylindri-
cal Environment.

4. Set U and V Tiling to 10.

5.  Click Render Last.

A curved, shingled wall appears in the back-
ground.

Of course, now that you’ve got shingles in the
background, the teapot reflection is no longer
correct. Luckily, you can take care of that by
using an automatic reflection map, the subject
of the next exercise.
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Automatic Reflections
and Refractions 2

An automatic reflection map uses no mapping
at all, but looks outward from the center of the
object, and maps what it sees onto the surface.
On the one hand, it’s automatic, so you don’t
have to bother with matching a map with the
environment. On the other hand, it takes extra
calculation time during rendering.

Automatic refraction maps work in exactly the
same way, but use a different algorithm to map
the view onto the surface. The image looks like
something you’re seeing through the surface
instead of reflected off the surface.

Making an Automatic Reflection Map
Creating an automatic reflection map is easy.
You’ll start with a new material, and assign it to
the teapot.

Create and assign an automatic reflection map:

1. Select the fifth sample slot.

2. Select the teapot.

3.  Click Assign Material to Selection.

4. Open the Maps rollout, and click the Reflec-
tion Map button.

5. Choose New in the Browser, choose
Reflect/Refract, and click OK.

The Reflect/Refract parameters appear.

6.  Click Render last.

After some rendering calculation, the teapot
appears, reflecting the shingle environment.

Notice that the teapot is tinted by the ambient
and diffuse colors. As with standard reflection
maps, you can use the ambient and diffuse col-
ors to alter the hue.

Automatic reflection maps reflect any geometry

in the scene. You wouldn’t need to bother with
an environment map if the teapot was sur-
rounded by geometry representing, say, a
kitchen. There are some hidden spheres in this
scene that will prove the point.

Unhide the spheres and re-render:

1. Click Unhide All in the Display command
panel.

Nine spheres surround the teapot.

2.  Click Render last.

3. You can see the spheres reflected in the side of
the teapot.

You’ll be changing the scene. If you want to
return to this scene to experiment, save it now;
your materials will be saved along with it.

Save the current scene:

• Use File>Save As to save the scene as
mytut12.max.

Making an Automatic Refraction Map
As you know, refraction maps create the illusion
of transparency by mapping the environment to
the surface in such a way that it appears as if
you’re seeing through the object. In reality,
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when you have a refraction map assigned to a
surface, the Opacity slider has no effect on the
material (though you can use an opacity map).

You’ll use a new scene to look at refraction map-
ping.

Load and render the scene:

1. Use File>Open to load tut12_2.max.

2.  Make sure the camera viewport is active,
and click Quick Render.

The scene is a blue ball in front of a striped
pole, against a sunset background.

Assigning an automatic refraction map is as easy
as assigning an automatic reflection map.

Create a refraction-mapped material:

1. Select the sphere.

2. Select the first sample slot.

3.  Click Assign Material to Selection.

4. Open the Maps rollout, and click the button
in the Refraction row.

5. Choose New, choose Reflect/Refract, and click
OK.

The sample sphere disappears, displaying
only its specular highlights.

6.  Turn on Background.

You can now see the refraction effect on the
checkered background.

At the top material level, you can set the index
of refraction to specify the density of the sub-
stance through which the light waves pass.
Because this is not real refraction, experiment
with different settings to achieve the effect you
want.

Change the index of refraction:

1.  Click Go to Parent.

2. Open the Extended Parameters rollout.

3. Set the Refract Map/Raytrace IOR to 0.83.

The checkers are warped into a different pat-
tern. As in a previous exercises, you can add
realism by adding a touch of reflection.
Rather than create an automatic reflection
map from scratch, you can simply copy the
refraction map to the reflection map slot.

Add some reflection:

1. In the Maps rollout, drag the Refraction Map
button over the Reflection Map button.

2. Choose Copy, and click OK.

Small reflections of the checkered back-
ground appear over the refraction effect.

3. Set the spinner in the Reflection row to 30.

4.  Click Render Last.
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The sphere appears transparent. You can see
the bent pole behind it, and a hint of the
reflection.
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The Material Editor could really be called the
Material and Map Editor, because you can use it
to design both materials and maps—and any
combination of the two. In addition, you can
create material or map hierarchies.

A material hierarchy is a material that consists
of other materials (or maps). Similarly, a map
hierarchy is a map consisting of other maps.
Materials that consist of other materials are
called compound materials. Maps consisting of
maps are compound maps.

In this tutorial, you’ll learn how to create com-
pound materials and compound maps. You’ll
use Multi materials to apply different materials
at the sub-object level of geometry. You’ll sam-
ple the various procedural maps that let you
create mapped materials from scratch. You’ll
also see how to apply automatic flat reflections
for mirror-like surfaces.

During the process, you’ll navigate the multiple
levels of the Material Editor and get an idea of
just how deep you can go.

Compound Materials
and Maps
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Compound Materials 2

In the previous tutorial, you created a single
material consisting of six different map types. As
complex as that material was, it was still a sin-
gle, standard material.

As you’ve already learned, a standard material
consists of ambient, diffuse, and specular com-
ponents, along with shininess, opacity, self-illu-
mination settings, and other special attributes,
such as Wire, and 2-Sided. These are the familiar
settings you’ve already worked with in the Basic
Parameters rollout of the Material Editor.

You also can assign maps to the various compo-
nents of a standard material. The maps are
images whose source can be bitmaps or proce-
dural plug-ins, such as Checker or Noise.

The standard material is the default material in
the six sample slots of the Material Editor. How-
ever, you can change the type of material you’re
working on by clicking the button labeled Type
below the sample slots. This displays the
Browser, and lets you select from a list of alter-
native, plug-in material types. Most of them are
compound materials, because they let you create
a material consisting of two or more sub-materi-
als.

Double-Sided Materials
The first type of compound material you’ll look
at is the double-sided material. It lets you assign
a different material to each side of an object’s
surface. That is, the front side of a face receives
one material, and the back side of the face
receives the other.

Load a scene, and alter the text object:

1. Choose File>Open, and load tut13_1.max.

The camera viewport displays the word DOU-
BLE in 3D text.

2. Select the text.

3. In the Modify command panel, uncheck Cap
End.

With the capping faces removed from the front
of the text, you can see inside the letters. As a
default, backfaces (the back sides of faces) are
invisible in the shaded views.

Assign a material, and then change its type:

1.  Click Material Editor.

The Material Editor appears.

2. Select the fourth sample slot, containing the
default cyan material.

3.  Click Assign Material to Selection.

The displayed faces change color. Because this
is a standard material, it appears only on the
front side of the faces.

To change the standard material to a different
type, you click the button labeled Type.

4. Click the Type button, currently showing
“Standard.”
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The Material/Map Browser appears, display-
ing only materials.

5. Make sure New is chosen.

6. Choose Double Sided, and then click OK.

7. In the next dialog, choose Keep old material
as sub-material, and click OK.

Both sides of the faces appear.

You’ll be doing a lot of Material Editor naviga-
tion in this tutorial, so take the time, whenever
necessary, to stop and get your bearings.

You’re now at the top level of a nonstandard
material which is a double-sided type. The Basic
Parameters rollout for this material doesn’t
show all the usual color swatches of a standard
material. Instead, it displays two buttons and a
spinner.

The top button (labeled Facing Material) dis-
plays the words Material #4 (Standard). When
you selected Double Sided from the Browser,
you were given a choice of keeping the previous
material as part of the Double-Sided material, or
discarding it. You chose to keep it, and the Mate-
rial Editor inserted it as a child of the double-
sided material.

Take a look at the Material/Map Navigator to see
where you are.

Name your material, and view the Navigator:

1. Edit the name field to read Double-Cyan/Yel-
low.

2.  Click Material/Map Navigator.

The Navigator window appears showing the
material hierarchy.

You can see by the highlight that you’re at the
top level of the Double -Cyan/Yellow material. It
contains a Translucency parameter (see the
Material Editor) and a single material called Fac-
ing Material. A second material (Back Material)
has not yet been assigned.

Rename the first (facing) material:

1. In the Material Editor, click the button
labeled Facing Material.

You’re now at one sub-material level of your
double material—the facing material. This is a
standard material, so the Basic Parameters
rollout displays the familiar controls.

2. Edit the name field to read My Cyan.

The title bar of the Material Editor displays
the parent material name, while the edit field
displays the name of the current level.
Because you’re not at the top level, the Go to
Parent button is now active.

3.  Click Go to Parent.

You’re back at the top level. The Facing mate-
rial button displays the new name of your
sub-material.

Here’s how to access the second material for the
backside of the faces.
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Access the second sub-material:

• Click the Back Material button.

The basic parameters for a standard material
appear.

Look again at the Navigator and see which icon
is highlighted. You’re now at the level of the sec-
ond “child” of the parent material, the Back
Material. The Ambient, Diffuse, and Specular
color swatches are shades of gray. This material
is the default standard, and no color has been
assigned.

The sample sphere is still cyan because its sur-
face is the outside of the faces. If you want to see
the effect of any changes you make to the back
side, turn off the Show End Result button. The
sample slot will show only the current settings
in the hierarchy.

Change the color and name of the back
material:

1.  Turn off Show End Result.

The sample sphere turns gray.

2.  Turn on the Lock button between Ambi-
ent and Diffuse. Click Yes at the prompt.

3. Click the Diffuse color slot, and then choose
a bright yellow color in the Color Selector.

4.  Exit the Color Selector.

5. Edit the name field to read My Yellow.

The text in the viewport still appears all one
color because the interactive viewport renderer
can’t display double-sided materials. Use the
Renderer to see the effect.

Render the scene:

1.  Click Quick Render.

The rendered text appears with a cyan surface
on the outside, and a yellow surface on the
inside.

2. Drag the render window over the Front view-
port to get it out of the way.

So far, you’ve changed the color on the two
sides of the surface. The real power in using
compound materials, however, is that each
sub-material can be as complex as any stan-
dard material. For example, you might want a
different shininess on the outside, and per-
haps some self-illumination on the inside.

Alter the properties of the sub-materials:

1. Increase the Self-Illumination spinner to 50.

The yellow sample sphere grows brighter in
the shadows.

2.  Click Go to Sibling.

You’re moved to the Facing material (watch
the Navigator to see where you are).

3. Set Shininess to 50, and Shininess Strength
to 80.

4.  Click Render Last.
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The inside of the text is incandescent yellow,
and the outside is shiny cyan.

At the parent level of the material are controls
that affect both materials. In this case, a single
spinner, labeled Translucency, lets you mix the
two materials.

Go to the parent level, and increase the
Translucency:

1.  Click Go to Parent.

2. Set Translucency to 30.

3.  Click Render Last.

Thirty percent of the facing material bleeds
through the back to create a translucent
effect.

Creating a Blend Material
Another type of compound material is the Blend
material. It lets you mix two materials on a sin-
gle side of the surface. Now that you’ve seen one
compound material, the set up for Blend will
look familiar.

Create a Blend material:

1. Select the third sample slot.

2. Click the Type button, choose Blend, and
click OK.

3. Choose Keep old material as sub-material and
click OK.

The Blend controls appear.

4. Edit the name field to read Blend-O-Matic.

Among the controls, two similar buttons let you
assign sub-materials. The first sub-material but-
ton contains the standard material that was pre-
viously in this sample slot.

In the following steps, you’ll assign a second
sub-material, change its properties, and then
move to the first sub-material and change its
properties.

Set up the sub-materials:

1. Click the Material 2 button.

As a default, the Blend material displays only
the first sub-material in the sample slot.
Because Show End Result is still off, the cur-
rent level is displayed, and the sample sphere
is gray.

2.  Lock the Diffuse and Ambient color
swatches, and then change their color to a
pale pink. (For example, you might use an
RGB value of 255, 190, 175.)

3. Open the Shading list, and choose Constant.
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The sample sphere is pink and faceted.

4. Edit the name field to read Pink Facets.

5.  Click Go to Sibling.

The blue sub-material appears. You’ll make
this one transparent.

6.  Turn on Background.

7. Set the Opacity spinner to 70.

8. Edit the name field to read Blue Bubble.

9.  Turn on Show End Result.

10.  Click Go to Parent.

You’re all set. Adjust the blend between the two
sub-materials, and animate a change between
materials.

Animate the blend:

1. Play with the Mix Amount spinner to see the
effect of different blends.

At 0, only the blue transparent material
shows. As you move toward 100, the material
grows pink, faceted, and opaque.

2. Set the Mix Amount to 0.

3. Go to frame 50.

4. Turn on Animate.

5. Set the Mix Amount to 100.

6. Turn off Animate.

7.  Click Make Preview.

8. Choose Custom Range, and set the second
spinner to 50.

9. Click OK.

A material preview is created, and then the
dialogs reappear, along with the Media Player.

10.Play the preview.

The sample sphere changes from a smooth
transparent material to a pink faceted mate-
rial.

Blending with a Mask

The Mask button lets you use the intensity val-
ues in a map instead of the Amount slider to
determine how much of the two materials will
appear. The black portions of the map display
the first material, the white portions display the
second material, and values in between display
a blend of the two materials.

View the map you’ll use:

1. Stop the preview, and exit the Media Player.

2. Choose File>View File, enter the \maps direc-
tory, and load tutdots.gif.
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The image is of blurry white dots against a
black background. The blurred borders of the
dots provide intermediate intensities that will
blend the two materials.

3.  Exit the View File window.

Assign the mask:

1. Click the button labeled Mask, choose Bitmap
from the Browser, then click OK.

2. Click the wide button labeled Bitmap, and
load tutdots.gif.

3.  Click Go to Parent.

You can see the pink, faceted, opaque material
displayed in the areas where the white dots are
mapped, and the blue transparent material tak-
ing over where the black background is.

When you use a mask, you can use the Mixing
Curve controls to affect the blend between the
white and the black areas of the map.

Change the mix:

1. Check Use Curve.

2. Lower the value in the Upper spinner.

As you lower the value in the Upper spinner,
the effect of the black in the mask image is

reduced, allowing the white and gray por-
tions to increase. When Lower is zero, and
Upper is around 0.05, the edges of the pink
areas are crisp because most of the intermedi-
ate gray is ignored. At the extreme of 0 for
both spinners, the pink takes over com-
pletely.

3. Set the Upper spinner to 1.0, and then raise
the Lower spinner.

The opposite is true. As you raise the Lower
spinner value, the effect of white in the mask
is reduced, and the black takes over, causing
the blue transparent material to cover more of
the sphere.

4. Set the Upper spinner to 1.0, and the Lower
spinner to 0.0.

Adding Maps

You know from previous Material Editor tutori-
als that you can assign maps to any component
in a material. The same is true of sub-materials.
In the following steps, you’ll assign different dif-
fuse maps to each of the sub-materials in your
Blend material.

Assign diffuse maps:

1. Click the button labeled Material 1.

You’re at the Blue Bubble sub-material level.

2. Set the Opacity spinner to 100.

3. Click the map button beside the Diffuse color
swatch.

The Browser appears.

4. Choose Bitmap from the Browser and click
OK.

You’re now at the Diffuse map level.
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5. Click the wide button labeled Bitmap, and
select and load tutash.jpg.

The sample sphere is now wood-grain with
pink, faceted dots.

Next, move to the other sub-material, and
assign a different map.

6.  Click Go to Parent.

7.  Click Go to Sibling.

You’re at the Pink Faceted sub-material level.

8. Click the map button beside the Diffuse color
swatch, choose Bitmap, click the wide Bitmap
Button, and then select and load marbtea2.gif.

The material is now a wood grain with fuzzy
dots of green marble.

You can see the potential in using a mask to
blend sub-materials, and the many levels you
can combine.
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Sub-Object Materials 2

One type of compound material you’ll use fre-
quently is the Multi/Sub-Object material that
lets you assign different materials at the sub-
object level of your geometry.

In the following exercise, you’ll load a scene
consisting of some simple objects, and then
you’ll create a Multi/Sub-Object material. Fol-
lowing that, you’ll use your new material to
apply different materials to selected faces.

Load a new sample file:

1.  Exit the Material/Map Navigator.

2. Choose File>Open to load tut13_2.max.

A collection of geometric objects appears.

3. Make sure the first sample slot in the Material
Editor is selected.

4. Click the Type button, choose Multi/Sub-
Object, and click OK.

5. Choose Keep old material as sub-material,
and click OK.

The Basic Parameters rollout displays ten sub-
material buttons.

Building a Multi/Sub-Object Material
The Multi object panel displays more buttons
than the previous compound materials you’ve
used, but the process is the same. You click but-
tons to assign your sub-materials.

You use the Set Number button to specify the
total number of buttons (or sub-materials) in
the parent material.

One difference in the Multi/Sub-Object mate-
rial, is that the sub-material buttons are already
assigned default standard materials. In addition,
you can use the color swatches to their right to
assign diffuse colors at the parent level.

Begin by naming your Multi material, and then
change some colors.

Name the Multi material, and assign some
Diffuse colors:

1. Edit the name field to read Lotsa Materials.

2. Click the Set Number button and set the
Number of Materials to 5. Then click OK.

3. Click the color swatch for the second mate-
rial.

The Color Selector appears.

4. Choose a yellow material.

Because of the light gray default color origi-
nally in the swatch, you’ve got to decrease the
whiteness to get a saturated yellow.

5. Raise the arrow in the Whiteness slider to get
a bright yellow.

6. Click the color swatch for the third material
and make it deep blue.

7. Click the color swatch for fourth material and
make it bright red.
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8. Move up and click the color swatch for the
first material and make it bright green.

That’s enough to get started. When you’re
working with Multi materials, you can always
add materials as you go.

9. Close the Color Selector.

Automatic Sub-Material Assignment
The polyhedron primitive takes special advan-
tage of multi-materials, as you’ll see when you
assign the Multi material to the polyhedron.

Assign the material to the polyhedron:

1. Activate the camera viewport.

2. Press P to switch to Perspective viewport.

3. Select the polyhedron.

4.  Click Zoom Extents All Selected.

5.  Click Assign Material to Selection.

The colors are assigned to the tube in a ran-
dom order.

6. In the Modify command panel, increase the P
and Q spinners in the Family Parameters area.

7. In the Family area, select Star1, and then
Star2.

8. Play around with the various polyhedron
spinners and settings.

Right away, you can see the value of the Multi
material. When assigned to a polyhedron, the
first three materials are automatically assigned
to the three families that make up the geometry.
To change any of the materials, all you have to
do is alter their parameters in the material edi-
tor.

Sub-Object Material Assignment
With the exception of the polyhedron, through-
out the tutorials you’ve assigned one material to
one object. In an earlier tutorial, you applied dif-
ferent mapping coordinates to selected faces, but
you still used the same material.

In this section, you’ll see how to assign different
materials to different faces. The faces of every
object are assigned material ID numbers (typi-
cally, ID #1). Some objects, such as polyhedron
and box, are assigned more than one material
ID.

Using the Edit Mesh modifier, you can select
faces, and assign different ID numbers. The ID
numbers specify which of the sub-materials in a
Multi/Sub-object material are used on the faces
in the object.
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Start with a tube, and turn it into a complex-
looking object.

Switch Objects:

1. Select the tube.

2. Open the Display command panel.

3. Click Hide Unselected.

All objects but the tube are hidden.

4.  Click Zoom Extents All.

5.  Click Assign Material to Selection.

6. Choose File>Save As, and save the scene as
mytut13.max.

In the next steps, you’ll apply an Edit Mesh
modifier, select faces, and assign material ID
numbers.

Use Edit Mesh to select faces:

1. Apply Edit Mesh in the Modify command
panel.

2. Change the selection level to Face.

3.  In the Selection area, make sure Polygon
is selected.

4.  To the right of the prompt line at
the bottom of the MAX window, click the
Crossing Selection icon to switch it to Win-
dow Selection.

While in region-select mode, only the faces
inside the drag region will be selected.

5. Close any dialogs covering the Front view-
port.

6. In the Front viewport, drag a region that
encompasses the bottom two cross sections of
the tube.

The faces in the two bottom cross sections
turn red.

Now that your faces are selected, it’s a simple
matter to assign one of the sub-materials.

Assign the second sub-material to the selected
faces:

1. Close the Edit Face rollout.

With the Edit Face rollout closed, the Edit Sur-
face rollout appears below.

2. Change the ID spinner to 2.

The lower portion of the tube turns yellow.
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Assign the rest of the sub-materials:

1. In the Front viewport, region-select the third
cross-section band from the top of the tube.

2. Set the ID spinner to 3.

The band turns blue.

3. Region-select the top cross-section of faces,
including the top cap of faces.

4. Set the ID spinner to 4.

The selected faces turn red.

You can design your sub-materials while you’re
in the process of selection. For example, you
might decide you want a fifth material for the
inner core of the tube.

Select the inner core of the tube, and then
assign a fifth sub-material:

1. Switch the Front viewport to the Top view,
and click Zoom Extents.

2.  Click Circular Selection Region from the
Selection Region flyout.

3. In the Top viewport, start from the center and
drag a circular region that surrounds the
inner core of faces in the tube.

4. Click the color swatch beside the fifth mate-
rial.

5. Choose a deep purple in the Color Selector.

6. Set the ID spinner in the Modify command
panel to 5.

7.  Exit the Color Selector.

8. Switch the Top viewport to Front, and click
Zoom Extents.
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9. Activate the Perspective viewport.

10.  Click Quick Render.

Playing with Multi Materials
Now that you have several sub-materials
assigned, you can really have some fun. Begin
by modifying the tube for a more interesting
shape.

Taper the tube:

1. Turn off the Sub-Object button (so subse-
quent modifications are applied to the whole
geometry).

2. Apply a Taper.

3. Set Amount to 0.4, and Curve to –1.

4.  Click Render Last.

Changing Material 3
Perhaps you want a metallic band where the
blue material is? It’s simply a matter of going
into the third sub-material and changing a few
of its properties.

Change Material 3:

1. Click the third material button.

The basic parameters for the third sub-mate-
rial appear. You can tell you’re at least one
level down because the Go to Parent button

 is active.

2.  Turn off Show End Result.

You now view only the current sub-material.

3. Choose Metal in the Shading list.

4. Set the Shininess to 80, and the Shin.
Strength to 25.

5.  Turn on the lock button between Ambient
and Diffuse, and answer Yes at the prompt.

6. Click the Diffuse color swatch, and choose an
unsaturated, brown color. (For example, RGB:
135, 100, 40.)
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7. Edit the name field to read Metallic band.

8.  Click Render Last.

The blue band is now a metallic band.

Remember, you can continue clicking Render
Last to view your progress while you’re adjust-
ing the individual sub-materials.

Changing Material 1
Now, you decide you’d like to have some trans-
parency in the two bands currently assigned to
the first sub-material. It’ll be interesting to see
what will show through.

If you had the Navigator displayed, you could
quickly get to Material 1 by clicking its icon in
the list. But you can easily get there by going up
to the parent and then back down to the sub-
material.

Move to Material 1:

1.  Click Go to Parent.

You’re back up at the top level.

2. Click the first material button.

You’re now at the level of the first sub-mate-
rial.

3.  Lock the Ambient and Diffuse color
swatches, and then change them to a light
cyan color.

4. Set Shininess to 60, and Shininess Strength
to 85.

5.  Turn on Background.

6. Select 2-Sided.

7. Open the Extended Parameters rollout. In the
Opacity area, choose In, and set the Falloff
Amt. spinner to 80.

8. Edit the name field to read Pale Transparency.

9.  Click Render Last.

You can now see through the two bands.

Changing Material 5
Looking through the outside of the tube, you
can see the purple material assigned to the inner
core. This material is not two-sided, and the
backfaces of the surface are invisible.

To fix this, you could turn on the 2-Sided option
for the fifth sub-material. A more interesting
method is to change material 5 into a Double
Sided material. This displays a surface on both
sides of the faces, and lets you assign different
materials on both sides.

Change Material 5 to Double Sided:

1.  Click Go to Parent to return to the top
level of the Multi material.

2. Click the fifth material button.

You’re now at the level of the fifth material.

3. Click the button labeled Type, and choose
Double-Sided from the Browser.

4. Choose Keep old material as sub-material.
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You’re now at the top level of the fifth sub-
material. The original purple material is in the
Facing material button.

5. Edit the Name field to read Core Double.

6. Click the Back Material button.

You’re now at the Back sub-material level of
the fifth sub-material level of the original,
parent Multimaterial.

7. Set the Ambient and Diffuse colors to a deep
forest green.

8. Choose File>Save to update the scene to disk.

9.  Click Render Last.

The core of the cylinder as seen through the
transparent rings is green, while the inner
core is purple.
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Getting Your Bearings 2

Feeling lost? You’re actually only three levels
deep in the current material.

To see where you are, examine the clues in the
Material Editor dialog:

• The title bar tells you that the name of your
parent material is Lotsa Materials.

• The label to the left of the name field tells you
that this specific level is a Back material.

• The Type button tells you that the material at
this level is a Standard material.

• The name field holds only the default mate-
rial name for this level. (This is why it’s a good
idea to name your levels.) However, if you
open the pop-up list, you’ll see that the cur-
rent material is a child of Core Double, which
is, in turn, a child of Lotsa Materials.

No matter how deep you go, you can always get
back to any parent level by using the name field.

Now, take a look at the Navigator to get another
view of the hierarchy.

Open the Material/Map Navigator:

1.  Click Material/Map Navigator.

You can see that Lotsa Materials has five chil-
dren. The fifth child is named Core Double, and
it’s a Double Sided material. The children of
Core Double are Facing Material and Back Mate-
rial, and Back Material is highlighted to indicate
where you are.

Use the Navigator to jump around:

1. Click Lotsa Materials.

You’re placed at the parent level, where you
can see all five sub-material buttons.

2. Click Metallic Band.

You’re now at the sub-material containing the
metal shading.

3. Click Pale Transparency.

The transparent blue sphere appears.

4. Click Back Material.

You’ve returned to the green sub-material
level of the Core Double material.

5.  Exit the Material/Map Navigator.

Wires and Maps
Now that you’re moving through material trees
with confidence, you can alter more of the sub-
materials. Change the yellow band at the base of
the cylinder to a wire material.

Change Material 2:

1. Open the name field pop-up list, and choose
Lotsa Materials to get back to the top level.

2. Click the second material button.

3. Check 2-Sided and Wire.

4. Choose Metal from the Shading list.

5. Set Shininess to 70, and Shin. Strength to 55.

6. Edit the name field to read Yellow Wire.

7.  Click Render Last.
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And what about maps? How would you assign a
diffuse map to the purple inner core of the cyl-
inder? The mapping coordinates have already
been assigned to the geometry in this sample
scene, so it’s a matter of finding the sub-mate-
rial, and adding a map.

Find the purple core, and assign a diffuse map:

1.  Click Go to Parent to get to the top level.

2. Click the fifth material button, labeled Core
Double.

You’re at the parent level of the Double Sided
material.

3. Click the Facing Material button.

You’re at the level of the purple material, and
you can assign a diffuse map.

4. Click the map button beside the Diffuse color
swatch.

5. Choose Bitmap in the Browser, and click OK.

6. Click the wide Bitmap button, and then select
and load tutshngl.jpg.

7. Edit the name field to read Shingles Map

8.  Click Render Last.

You’re not quite finished. It might be nice to
change that boring red rim to checkers.

What’s the fastest way back to the top level of
the material?

Assign the Checker Procedural to the rim:

1. Open the name list, and choose Lotsa Materi-
als.

You’re back at the top level.

2. Click the fourth material button.

3. Click the map button beside the Diffuse color
swatch.

4. Choose Checker from the Browser.

5.  Turn on Show Map in Viewport.

The rim of the tube turns black and white.

6. Set the U and V Tiling spinners to 5.0.
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7. Click the Color #1 swatch, and choose a color
you like, then click the Color #2 swatch and
choose a color that goes with it.

8. Edit the name field to read Rim Checks.

9. Choose File>Save to update the scene.

10.  Click Render Last.

Next, you’ll look at compound maps, and some of
the various plug-in procedural maps.
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Compound Maps 2

Just as you can combine “boxes within boxes”
of materials, you can combine maps within
maps.

Take, for example, the checkered rim of the
tube. To change the color of each of the check-
ers, you could use maps, and each map could
contain its own maps.

You’re currently at the level of the Checker dif-
fuse map, called Rim Checks. Turn it into a com-
pound map.

Assign Marble to one of the checks:

1. Click the Maps button beside the Color #1
swatch.

2. Choose Marble from the Browser, and click
OK.

You’re now at the Marble sub-map level of the
Checker map.

3.  Click Render Last.

Half of the checkers display the marble veins.

Rather than using colors for the marble, you can
use more maps.

Assign maps to the Marble veins:

1. Click the Maps button beside the Color #1
swatch of the Marble map.

2. In the Browser, choose Checker.

You’re now in a different Checker level that’s
a sub-sub-level of the original Checker.

3. Set the U and V Tiling spinners to 30.

4.  Click Go to Parent to return to the Marble
level.

One of the marble veins contains the small
checkers.

5. Click the Maps button beside the Color #2
swatch.

6. Choose Bitmap from the Browser.

You’re now in a Bitmap parameters panel
affecting the second vein color of the Marble
map.

7. Click the wide Bitmap button, and select and
load sunset90.jpg.

8.  Click Go to Parent.

The Marble map displays tiny checkers in one
vein color, and the sunset bitmap in the
other.

The remaining Marble settings affect the pattern
of veins, which, in turn, affect the masking of
the tiny checkers and the sunset bitmap.

Adjust the veins:

1. Set the Vein Width spinner to 0.05.

The veins are narrower and closer together.

2. Set the Y angle spinner to 45.

The veins are now at an angle.

3.  Click Go to Parent.

You’re now back at the Checker level, and you
can see that one set of checkers contains the
marble veins, which contain the tiny checkers
and the sunset bitmap.

Assign Noise to the other check:

1. Click the Maps button beside the Color #2
swatch.

2. Choose Noise from the Browser.

You’re now at the Noise level for the second
set of checkers.
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In the next steps, you’ll assign the tutash.jpg bit-
map to one color of the Noise, and the
marbtea2.gif bitmap to the other.

Assign bitmaps to the Noise components:

1. Click the Maps button beside the Color #1
swatch.

2. Choose Bitmap from the Browser.

3. Assign tutash.jpg to the bitmap level.

4.  Click Go to Parent.

5. Repeat the previous three steps, but this time
assign marbtea2.gif to the second color, and
return to the Noise level.

The Noise is now a subtle blend of the two bit-
maps.

6.  Click Go to Parent to return to the
Checker level.

7.  Click Render Last.

The checkered rim is no longer quite as sim-
ple as it was.

With a slight adjustment, you can make the rim
even subtler.

Soften the rim:

1. Set the Soften spinner to 0.3.

The checker boundaries are blurred.

2. Choose File>Save to update the file.

3.  Click Render Last.

Notice that the so-called “tiny” checkers are
larger on the geometry. You could easily change
their size by going back to that level.

If you feel lost, before moving on to the next
section, open the Material/Map Navigator and
examine the hierarchy of the Rim Checks map.
Move to each level by clicking the green icons in
the Navigator. If you want, adjust the various
parameters and re-render the scene.

Using the Gradient Map
Up until now, everything you’ve created and
edited in the Material Editor has been a mate-
rial, and the maps have been sub-components
of the materials. However, you can create and
edit only maps, if you like. These maps can then
be assigned to components of other materials,
when you need them, or assigned as environ-
mental maps to your scene.

You’ll create a new map using the Gradient pro-
cedural map type. Gradient provides tools that
let you mix a ramp of three colors, or (of course)
maps.
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To create a map instead of a material, you click
Get Material, and then choose a map instead of
a material.

Create a map:

1. Select the third sample slot.

2.  Click Get Material.

Note that the Get Material function always
replaces whatever was in the active sample slot
with what you choose from the Browser.

3. Choose Gradient in the Browser.

A circular ramp of gray appears in the sample
slot.

Notice that this is not a material. You know that
you’re at the top level of the map, because you
can see that the Go to Parent button  is dis-
abled. In addition, the name in the edit field is
the same as the name in the title bar.

The familiar top-level material controls, such as
the Ambient, Diffuse, and Specular color
swatches, are not in the lower panels. Instead,
you find the controls for the Gradient map.

Another clue that this is a map is the lack of
shading in the sample slot. The highlights and
shadows that make the other samples look like
balls are entirely lacking in a map.

The Gradient map contains three color compo-
nents you use to set a three-color ramp. As a
default, they’re set to white, gray, and black.
Change the gradient to yellow-to-red.

Change the gradient colors:

1. Click the Color #1 swatch.

The Color Selector appears.

2. Select a bright yellow color.

The top portion of the sample gradient
becomes yellow.

3. Click the Color #2 swatch.

4. Select a deep red color.

The color swatch is now a ramp from yellow,
to red, to black.

Rather than changing the third color, you can
adjust the placement of the middle color
using the Color 2 Position spinner.

5. Set the Color 2 Position spinner to 0.8, then
to 1.0, then to 0, and then finally to 0.3.

At the extreme positions of 1 or 0, only two
colors are used for the gradient. At 0.3, you
get more yellow at the top, and less black at
the bottom.

There are a number of other controls that let
you creatively edit your gradient. For example,
you might want a radial instead of a linear gra-
dient.

Adjust the gradient parameters:

1. Choose Radial beside Gradient Type.

The effect might be better seen with a differ-
ent sample shape.

2.  Click Cube in the Samples Type flyout to
the right of the sample slots.

The box shape appears in the sample slot, and
you can see the radial pattern on each of its
sides.

Here’s how to change the order of the colors.

3. Drag the Color #1 swatch over the Color #3
swatch.

4. Click Swap.

The colors now radiate from the brightest in
the center.
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The Noise settings provide methods of dither-
ing your gradient colors.

5. Set the Noise Amount spinner to 0.5.

The colors are jumbled.

6. Set the Size spinner to 0.2.

The colors appear dithered.

Large sizes are also interesting.

7. Set the Size spinner to 2.0.

Of course, you can use maps instead of colors.
For example, you might use a Gradient map as
one sub-component.

Change the black to a gradient:

1. Click the Map button beside the Color #1
color swatch (now containing black).

2. Choose Gradient from the Browser.

3. Click the Color #1 swatch, and choose a com-
pletely different color, such as a blue or
magenta.

4. Click the Color #2 swatch, and choose yet
another unrelated color, such as green.

5. Click the Color #3 swatch, and choose a third
unrelated color.

6. Set the Noise Amount to 1.0, and the Size to
0.2.

Name your map so you’ll recognize it. You
might want to apply it somewhere on your tube
object.

Name the map:

1.  Click Go to Parent to return to the top
level of the map.

2. Edit the Name field to read My Magic Gradi-
ent.

3.  Click Put to Library, and click OK.

Here’s how to apply your custom map.

Apply the new map to the tube:

1. Click the first sample slot, containing the
Lotsa Materials material assigned to the tube.

2.  Click Material/Map Navigator to display
the Navigator.

3. Select the Shingles Map, under Core Double,
to jump to that level of the material.

4.  Exit the Navigator.

5. Click the Type button, currently labeled Bit-
map.

6. Select Mtl Editor in the Browse From area.

7. Choose My Magic Gradient from the list, and
then click OK.

8. Choose Instance, and click OK.

The custom gradient map replaces the shin-
gles bitmap.

9. Choose File>Save to update the scene.

10.  Click Render Last.

The inside of the tube is now covered with
your new gradient pattern.
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Compositing Maps
One of the procedural map types is a compositor
that lets you overlay two or more maps on top
of each other. To see how this works, you’ll use
a different object.

Switch objects:

1. Click Unhide All in the Display command
panel.

2. Select the Cylinder object. (Zoom back, if nec-
essary.)

3. Click Hide Unselected to hide all but the cyl-
inder.

4.  Click Zoom Extents All.

Create a material with a composite map:

1. Select the fourth sample slot.

2.  Click Assign Material to Selection.

3. Click the Map button beside the Diffuse color
swatch.

4. In the Browse From area, choose New, and
then choose Composite and click OK.

Like the Multi/Sub-Object map, the Composite
map lets you set up as many sub-maps as you
want, except that all of these maps are layered
one on top of the other. The first map is the
background, the second map is layered over
that, and so on.

In the following steps, you composite a bitmap
containing text over the familiar tutshngl.jpg bit-
map.

Set two bitmaps for compositing:

1. Click the Map 1 button.

2. Choose Bitmap from the Browser.

3. Click the wide Bitmap button, and select and
load tutshngl.jpg.

4.  Click Go to Parent.

5. Click the Map 2 button.

6. Choose Bitmap from the Browser.

7. Load tutamax.tga.

The tutamax.tga image contains an alpha chan-
nel which provides transparency through which
the tutshngl.jpg bitmap can be seen.

Adjust the placement of the text:

1.  Turn on Show Map in Viewport.

2. Uncheck both U and V Tile.

3. Set U and V Tiling to 2.5; set V offset to 0.1.

4.  Click Render Last.

The cylinder appears, wrapped in shingles,
with the word “Max” appearing over the
shingles.
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By reducing the output of the map, you can
make a bitmap transparent. In this case, it’ll
make the text look like faded paint on the shin-
gles.

Reduce the output of the second bitmap

1. Open the Output rollout at the bottom of the
Material Editor dialog.

2. Set the Output Amount spinner to 0.5.

3.  Click Render Last.

You can use the Noise procedural map to add a
layer of dirt.

Add dirt:

1.  Click Go to Parent, to return to the Com-
posite level.

2. Click Set Number, set the number of maps
to 3, and click OK.

3. Click the Map 3 button.

4. Choose Noise from the Browser.

By adjusting the Noise settings you can get a
streaked dirt effect.

5. Set the Y Tiling to 5 to create streaks.

6. In the Noise Parameters rollout, set the Size to
15.

7. Choose Turbulence.

Because there’s no alpha channel in the Noise
map, you turn down its output to make it
semi-transparent.

8. In the Output rollout, set the Output Amount
to 0.5.

And turn down the RGB Level to darken the
map.

9. Set the RGB Level to 0.5.

10.  Click Render Last.
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Masking and Compositing
You can use the Composite map combined with
a Mask procedural map to create a masking pat-
tern. This is different than the Blend material
you used earlier, in which you used a mask to
combine two materials. Here, you’ll use a mask
to combine two maps.

Switch the objects:

1. Click Unhide All in the Display command
panel.

2. Select the Sphere.

3. Click Hide Unselected to hide all but the
sphere.

4.  Click Zoom Extents All.

5. Select the fifth sample slot.

6.  Click Assign Material to Selection.

In the following steps, you’re going to assign the
sunset90.jpg bitmap as the background, and
then composite tutash.jpg over it.

Set up the maps:

1. Click the Map button beside the Diffuse color
swatch.

2. Choose Composite from the Browser.

3. Click the Map 1 button, choose Bitmap, and
assign sunset90.jpg as the bitmap for Map 1.

4.  Click Go to Parent to return to the Com-
posite level.

5. Click the Map 2 button, and choose Mask.

The Mask map options let you assign a map, and
a mask. The intensity levels of the mask reveal
or hide the assigned map. If you were to use a
Mask map by itself as, say, a diffuse map, the
mask would reveal the diffuse color. In this case,
however, it’ll reveal the previous map in the
compositing list.

Set up the map and the mask:

1. Click the Map button, choose Bitmap, and
assign tutash.jpg as the bitmap.

2.  Click Go to Parent to return to the Mask
level.

3. Click the Mask button, and choose Checker.

4. Set the U and V Tiling to 5.

5. Choose File>Save to update the scene.

6.  Click Render Last.

The sphere is covered by checkers consisting
of wood grain and sunset.
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Setting Up Flat Mirror
Reflections 2

With automatic flat-mirror reflections, you can
create effects like mirrors, or polished floors. You
learned in the last tutorial how to create auto-
matic reflections for nonflat surfaces (such as
teapots). The flat-mirror reflection is a similar
effect, but there’s a basic rule you have to follow
in order to make it work:

The material containing the flat-mirror reflection
must be assigned only to a collection of coplanar
faces.

The term “coplanar” means that all of the face
normals have the same angle—they’re all paral-
lel to each other. A typical example is a floor, or
a wall. If you create a flat-mirror material and
assign it to an entire object like a sphere, or even
a box, the effect won’t work, because not all of
the faces are coplanar.

With the exception of the rare 2D object, the
only way you can assign a material to only
coplanar faces is to assign it at the sub-object
level, which means that the way to successfully
assign a flat-mirror material is to use a Multi-
Sub-Object material.

In the following procedure, you’ll switch objects
to a nine-sided cylinder, create and assign a
Multi/Sub-Object material. Then you’ll select
only the coplanar faces of the upper surface of
the cylinder, and assign a sub-material that you
can use as an automatic flat-mirror.

Switch objects again:

1. Click Unhide All in the Display command
panel.

2. Select the large Platform object.

3. Click Hide Unselected to hide all but the plat-
form.

4.  Click Zoom Extents All.

Create the Multi material:

1. Select the sixth sample slot.

2.  Click Assign Material to Selection.

3. Click the Type button, and choose Multi/Sub-
Object from the Browser.

4. Choose Keep old material as sub-material,
and click OK.

5. Edit the name field to read Marble Plain &
Mirror.

The original material has been moved to the
first Material button. All you need do, to begin,
is create a flat-mirror for the second material.

Create the flat-mirror material:

1. Click the second material button.

2. Open the Maps rollout, and click the Reflec-
tion Map button.

3. Choose Flat Mirror from the Browser.

4.  Click Go to Parent.

5. Set the Diffuse color to black.

As with all reflections, the diffuse color tints
the reflection. Black gives you a perfect mir-
ror.

6. Edit the name field to read Flat Reflection.

7.  Click Go to Parent.

Next, apply an Edit Mesh modifier, and select
the upper faces.

Assign the flat mirror material to coplanar faces:

1. Apply Edit Mesh in the Modify command
panel.

2. Choose Face selection level, and make sure
Polygon face selection is active.

3. Click the top of the platform to select its face.
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Seen in the Front viewport, the selected face
is a horizontal red line.

4. Close the Edit Face rollout to see the Edit Sur-
face rollout.

5. Set the ID spinner to 2 (if it is not already so).

The upper surface of the platform turns black.

The platform now has two sub-materials
assigned to it. The first material was assigned to
the entire object when you clicked Assign Mate-
rial to Selection. The second material was
assigned to the coplanar selected faces of the top
surface when you switched to ID 2.

In order to see a reflection, you need something
to reflect, so unhide the other objects.

Unhide the remaining objects:

1. Click Unhide All in the Display command
panel

2. Activate the Perspective viewport, and press C
to switch it to a camera view.

3.  Click Render Last.

The various objects are reflected in a mirrored
surface. The edges of the platform are plain
green. (Notice the effect of the edited Lotsa
Materials material on the polyhedron.)

That’s the basic approach to using flat mirrors.
The basic steps are as follows:

• Create a Multi/Sub-Object material in which
one of the sub-materials is assigned a flat-mir-
ror map. (Avoid using the first material, since
that’s often assigned to the entire object, as a
default.)

• Assign the flat-mirror map. At the sub-mate-
rial level, click the Reflection map button,
and choose Flat Mirror from the Browser.

• Apply the Multi/Sub-Object material to an
object.

• Use Edit Mesh to select a set of coplanar faces
in the object.

• Use the Edit Mesh ID spinner to assign the
flat-mirror sub-material to the selected faces.

Adding a Diffuse Map to the Reflection
You can combine a diffuse map with the flat-
mirror for a better effect. By using the same dif-
fuse map for both materials, the two surfaces
will look like the same material.
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Add marble to both sub-materials:

1. Click the first material button.

2. Edit the name field to read Plain Marble.

3. Click the map button beside the Diffuse color
swatch.

4. Select Mtl Editor in the Browse From area.

5. Find and select marbtea2.gif from the list, and
then click OK.

6. You are asked if you want an instance or a
copy. Choose Copy.

7.  Click Go to Parent to return to the Mate-
rial 1 level.

8.  Click Go to Sibling to go to the Material 2
level.

9. Edit the name field to read Mirror Marble.
Previously it was Flat Reflection.

10.Click the map button beside the Diffuse color
swatch.

11.Select marbtea2.gif from the list, and then
click OK.

12.  Click Render Last.

The platform is now a green marble with a
reflective top.

As with most reflections, reducing the amount
of reflection lends reality to the scene.

Reduce the reflection:

1.  Click Go to Parent.

2. On the Maps rollout, set the Amount spinner
for the Reflection map to 60.

3.  Click Render Last.
f
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Tutorial

Lights combine with materials to provide the
color and chiaroscuro in your scene. The lights
in 3D Studio MAX are special objects that don’t
themselves appear in the rendered scene, but
they affect the surfaces of the geometry so that
they appear illuminated.

There are several types of lights that come with
3D Studio MAX. This tutorial covers the most
commonly used lights: omni lights, and target
spotlights.

Using Lights
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Omni Lights 2

You’ll start out by illuminating a dinosaur with
two omni lights. The general rule in lighting is:
the fewer the better. Try to light your scenes with
one or two lights, and then add more as circum-
stances warrant.

Omni lights provide a point source of illumina-
tion that shoots out in all directions. They’re
easy to set up, but they don’t cast shadows, and
you can’t restrict the focus of their beam. You
can, however, restrict which objects are illumi-
nated by an omni light.

Begin by loading the scene:

1. Choose File>Open, and load tut14_1.max.

A triceratops appears.

2.  Make sure that Degradation Over-
ride is on (to the right of the prompt line).

When Degradation Override is off, the adaptive
degradation system is active. You don’t want
your shaded viewport to degrade to wireframe
when you’re attempting to adjust lights.

In the next steps, you’ll create two omni lights
in the scene. There are two things to note here:

• When no lights exist in your scene, two invis-
ible omni lights are turned on as a default. As
soon as you create your own light in the
scene, however, the two default lights are
turned off.

• You can create an omni light by simply click-
ing, or you can drag the mouse, in which case
the omni light is created and then positioned
in the same mouse move.

Create a couple of omni lights:

1.  Click Lights in the Create command
panel.

2. Click the Omni button.

3. Toward the bottom of the Top viewport, click
and drag to both create an omni light, and
move it.

As soon as you create the omni light, the
default lights are turned off. As you drag the
light, you can see its effect on the surface of
the triceratops.

4. Release the mouse, and then create a second
omni light by clicking toward the top of the
Top viewport.

As with all objects, the lights are created on the
home grid, which means they’re both level with
the dinosaur’s feet. Typically, one of the first
things you do after creating lights, is adjust their
elevation in the scene.

Adjust the height of the lights:

1.  Using Select and Move, click the first
omni light (Omni01) in the Front viewport,
and move it above the triceratops.
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2. Spend some time moving the two omni lights
around in the various viewports to get a feel
for adjusting the position of your lights.

Notice that if you position a light under the
platform it still illuminates the belly of the dino-
saur. Omni lights shine right through objects
because they don’t cast shadows. A shadow is
caused by one object blocking another. If a light
can’t cast shadows, it shines through everything
in its way.

Placing Highlights
3DS MAX includes an align function, called
Place Highlight, that helps you position your
lights based on where you want the specular
highlights to fall on the surface of the object.

Place Highlight positions a selected object (usu-
ally a light) based on the face normal you point
to with the mouse.

Use Place Highlight:

1. Select Omni01.

2.  Click Place Highlight in the Align flyout
in the toolbar (to the left of the Named Selec-
tion field).

3. In the Camera viewport, drag the mouse
slowly over the triceratops.

A blue arrow displays the face normal under
the mouse cursor, and the light is moved so
that the specular highlights appear under the
mouse point.

When you release the mouse button, you’re
no longer in Place Highlight mode, and must
select it again if you want to perform further
adjustment.

4. Use Place Highlight to position the first omni
light so the specular highlights shine on top
of the triceratops’ snout.

Use Place Highlight with the second light:

1. Select Omni02.

2.  Click Place Highlight.

3. Drag the mouse to illuminate the underside
of the triceratops’ belly.

Adjusting Color
You can adjust the color of your lights at any
time. In this case, you can use color to give this
scene some melodramatic lighting.
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Adjust the omni-light colors:

1. While the Omni02 light is selected, open the
Modify panel.

2. Click the color swatch to the right of the On
check box in the General Parameters rollout.

The Color Selector appears.

3. Adjust the colors while watching the camera
viewport.

As you change colors in the dialog, the colors
change in the viewport, as well.

4. Choose a red color, and then click OK.

The Color Selector goes away, and the under-
side of the dinosaur is illuminated by a flow-
ing lava stream, bubbling nearby.

5. Select Omni01.

6. Click its color swatch.

You can increase the intensity, or apparent
brightness of a light by increasing its Value
setting.

7. Increase the value to 255.

The front of the dinosaur is brighter.

Perhaps instead of bright white, you want to
emulate the light from a blue sky.

8. Find a pale-blue color, and then click OK.

The gray triceratops is colored with light.

Ambient Light
Ambient light is the general light that illumi-
nates the entire scene. As a default, there’s a
small amount of ambient light in every scene. If
you examine the darkest shadows on the tricer-
atops, you can still make out the surface because
of the ambient light.

Take a look at how ambient light affects your
scene.

Adjust ambient light:

1. Choose Rendering>Environment.

The Environment dialog appears.

2. Click the color swatch beneath the Ambient
Light label.

The Color Selector appears. The initial value
of the ambient light is low. As you increase
the brightness of your ambient light, you
reduce the contrast in the scene.

3. Slowly increase the Value spinner.

The higher the value, the lighter the shadows,
and the more washed out the scene appears.

4. Choose various colors in the color selector.

When you use colored ambient light, you tint
the entire scene.

5. Set the ambient color to black, and click
Close.

6. Exit the Environment dialog.
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Spotlights 2

The most versatile light in 3DS MAX is the target
spotlight. You can aim it and specify the size of
its light beam, cast shadows with it, and even
project images through it.

The remainder of this tutorial demonstrates the
various settings available with spotlights. You’ll
use a scene in which two spotlights have already
been set up.

Load and render the scene:

1. Choose File>Open, and load tut14_2.max.

2.  Make sure the camera viewport is active,
and click Quick Render.

The word LIGHT floats in an open-sided
room, lighted by two spotlights.

You can see the icons representing the two spot-
lights in the orthographic viewports. The yellow
cone is the light itself, attached to a cyan line. At
the other end of the line is a blue square repre-
senting the target of the spotlight.

You can adjust spotlights by dragging the spot
or its target in the viewport, but the best way to
adjust a spotlight is to create a spotlight view-
port.

Assign spotlight viewports:

1. Activate the Top viewport.

2. Press $ (the shortcut for Spotlight viewport).

A dialog appears listing three spotlights. (One
is hidden and turned off. You’ll use it later in
the tutorial.)

3. Choose Spot01, and click OK.

The top viewport is replaced with a spotlight
viewport showing the scene as if you were
looking from the spotlight to its target.

4. Activate the Left viewport, and press $.

5. Choose Spot02, and click OK.

The Left viewport is replaced by a view
through the second spotlight.

6. Choose Edit>Hold, so you can return to this
configuration.

Adjusting the Hotspot and Falloff
You’ve seen how a flashlight or a theater “follow
spot” casts a circle of light. Depending on the
quality of the flashlight or the adjustment of the
follow spot, the edge of the pool of light is either
blurred or sharp. In a blurred pool of light, the
bright circle in the center is the hotspot, and of
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even intensity. The outer extremity of the light,
where it meets the darkness, is the falloff. The
difference in circumference between the
hotspot and the falloff determines the relative
sharpness of the pool of light.

You can see by the sharp edges of the light pools
in the rendered scene that the hotspot and the
falloff of the two spotlights are almost the same.
You can also see this by looking at the two con-
centric circles in the spotlight viewports. The
dark blue circle is the outer boundary of the fal-
loff, and the cyan circle is the outer boundary of
the hotspot.

There are two places to adjust the hotspot and
falloff. You’ll use the Modify command panel
for Spot 02, and the spotlight viewport for
Spot01.

Adjust the Spot02 hotspot:

1.  Use Select Object to select Spot02 in the
Front viewport. (It’s the one toward the right
of the viewport.)

2. Open the Modify command panel and scroll
to the Spotlight Parameters rollout.

3. Set the Hotspot spinner to 15 degrees.

As you reduce the size of the hotspot, the
cyan circle in the Spot02 viewport shrinks in
size.

Use the viewport navigation controls to adjust
Spot01:

1. Activate the Spot01 viewport.

2.  Click Spotlight Falloff in the viewport
navigation controls.

3. Drag the mouse downward in the Spot01
viewport.

As the falloff gets larger, the view zooms out.
This is because a spotlight viewport displays
the area covered by the angle of the falloff.

4. Continue adjusting the Falloff until its angle
is approximately 50 degrees (as displayed in
the prompt line).

5.  Click Render Last.

The edges around the pools of both lights are
softer.

Although both lights now have soft edges, the
size of one of the lights has changed while the
other remains the same. Because you decreased
the hotspot of Spot02 without changing its fal-
loff, it covers the same area as it did previously.
However, Spot01 now covers a larger area
because you increased its falloff to produce the
soft edge. The falloff of a spotlight always
defines the area of its light.

Projector Lights
By adding a map to your spotlight, you turn it
into a projector. You can assign a single image,
or you can assign an animation to create the
effect of either a slide projector or a movie pro-
jector. You can also use projector maps to cus-



3t2tut14.fm    7  Thu Oct  2 14:53:15 1997

Tutorial 14

U
si

n
g

 L
ig

h
ts

14
 –

 7

tomize the shape of your light, in the same way
gobos are used in the lighting industry.

Set up Spot02 as a projector spot:

1. Choose Edit>Fetch, and answer Yes to restore
the original setup.

2. Select Spot02 in the Front viewport.

3. Click the Map (None) button, in the Spotlight
Parameters rollout.

The Material/Map Browser appears.

You can now select any map that’s available
through the Material Editor. You can even
load a new Material Library to select a map.

4. Choose Material Library in the Browser.

5. Click Open, and then load tutorial.mat.

6. Choose The Valley, containing tutvally.tga,
and then click OK.

The Projector check box is automatically
turned on, The Valley is assigned to the spot-
light.

Before rendering, brighten the “projector
lamp,” and turn on shadows.

7. Scroll the Modify panel to find the RGB and
HSV spinners, and then set the V(alue) spin-
ner to 255.

8. Scroll down to the Shadow Parameters roll-
out, and check Cast Shadows.

Adjust the other spotlight so it doesn’t wash out
the projection, and also casts shadows.

Adjust Spot01:

1. Select Spot01.

2. Set its V spinner at about 70.

3. Check Cast Shadows.

4.  Click Render Last.

Rectangular, Ratio, and Roll
You’re not limited to circular spotlights. Because
you’re projecting a rectangular image, you
might want to try a rectangular spotlight.

Change the spotlight shape to rectangular:

1. Select Spot02.

2. Check Rectangle in the Spotlight Parameters
rollout.

The circles in the Spot02 viewport become
rectangles, as does the Spot02 cone display in
the other viewports.

Adjust the aspect ratio:

• Set the Asp spinner in the Spotlight Parame-
ters rollout to 1.8.

As you adjust the spinner, the aspect ratios of
the hotspot and falloff rectangles change, but
their angles remain the same.
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When you use projection spotlights or rectangu-
lar spotlights, it’s often helpful to adjust their
roll angle. You can do this with the navigation
controls.

Adjust the roll angle:

1. Select the Spot02 viewport.

2.  Click Roll Light, and drag in the viewport
until the text object is somewhat aligned with
the rectangular falloff area.

Tighten the spot, and soften the edges a bit.

3.  Click Truck Light, and drag in the view-
port to center the text object in the falloff
area.

4.  Click Spotlight Falloff, and zoom in until
the falloff area barely surrounds the text
object.

5.  Click Hotspot, and reduce the hotspot
area to be slightly smaller than the text
object.

6.  Click Render Last.

The Valley image is confined to a rectangular
shape not much larger than the text object.

Excluding Objects from Light
The first spotlight is washing over the text
object, diminishing the effect of the projector
spot. Perhaps you want the projector spot to
project its image on the text object without hit-
ting the walls and column.

You can use the Exclude/Include function to
specify exactly which objects in the scene are
affected by each light.

Exclude the text object from Spot01:

1.  Select Spot01.

2. Click Exclude in the General Parameters roll-
out.

The Exclude/Include dialog appears.

You can copy any item in the left window to
the right window, and then specify whether
the items in the right window are to be
excluded or included in the Spot01 lighting
effect.

3. Choose text object from the list in the left
window, and then click the > button to move
it to the right window.

4. Make sure that Exclude and Both are chosen

5. Click OK.

Now, you can use the Include function to con-
fine the second spotlight to the text object.

Include only the text object with Spot02:

1. Select Spot02.

2. Click Exclude.

3. Choose text object, and click the > button to
place it in the right window.

4. Choose Include.

5. Click OK.

What was previously the Exclude button in
the General Parameters rollout is now labeled
Include.

6.  Click Render Last.

The projection on the text is vivid, because
it’s not also lit by the first spotlight. In addi-
tion, the projection lights only the text
object, because all other objects in the scene
are excluded from Spot02.



3t2tut14.fm    9  Thu Oct  2 14:53:15 1997

Tutorial 14

U
si

n
g

 L
ig

h
ts

14
 –

 9

Notice that Spot01 no longer casts a shadow of
the text object. Although you don’t want the
light from the spot to hit the text object, it
might be better if the spot continued to cast a
shadow. You can take care of this in the
Exclude/Include dialog.

Restore the shadow:

1. Select Spot01.

2. Click the Exclude button.

3. Choose Illumination below the Exclude and
Include options, and click OK.

By excluding only the illumination effect, the
shadow-casting effect remains.

4.  Click Render Last.

The scene appears as before, except that the
shadow of the text object is cast on the walls
and floor.

You can also turn off the shadow-casting ability
of an object, no matter what the lights have
been set for.

Turn off shadow casting properties:

1. Select the text object.

2. Right-click the text object, and choose Prop-
erties.

The Object Properties dialog appears.

3. Uncheck Cast Shadows, and click OK.

4.  Click Render Last.

The shadow disappears.

Using light exclusion, you can literally paint
your scene with light. For example, you might
want to bring out those two columns.

Create omni lights for the columns:

1. Activate the Front viewport, and press T to
switch to the Top viewport.

2. Click the Omni button in the Create/Lights
command panel.

3. Just outside the lower-right corner of the
“room,” click to create an omni light.

4. Click again to create a second omni light
beside the first.

5. Open the Modify command panel.

6. Click Exclude.

7. Move column02 into the right window,
choose Include, and click OK.

8. Set the RGB spinners to 255, 0,0 (bright red).

9. Select the first (omni01) light.

10.Repeat steps 6–8, including only column01,
and make this light bright green (0,255,0)

11.  Click Render Last.

The scene appears with two brightly lit red
and green columns.
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Shadows
Each spotlight has the option of casting shad-
ows. As you’ve seen, this is simply a matter of
setting Cast Shadows in the Shadows Parameters
rollout of the spotlight. There are two basic
types of shadows that you can choose from for
each spotlight: shadow-map and ray-trace.

A shadow-map shadow is actually a bitmap
that’s projected from the direction of the spot-
light. This method provides a softer edge and
requires less calculation time than ray-traced
shadows, but it’s less accurate. Ray-traced shad-
ows require more calculation and rendering
time, but provide perfectly accurate shadows
with hard edges. In addition, only ray-traced
shadows cast accurate shadows with transparent
objects.

You’ll try out the two types of shadows using
different objects in the same “room.”

Switch objects:

1. Choose Edit>Fetch, and answer Yes.

2.  Click Select by Name in the toolbar.

3. Hold CTRL and click column01, column02,
and text object in the list window.

4. Click Select.

5. Click Hide Selected in the Display command
panel.

The three objects disappear.

6. Click Unhide by Name.

7. Hold CTRL, choose Cage and Vase, and click
Unhide.

A vase and a wireframe “cage” appear.

Now, you’ll render the scene, using shadow-map
shadows for the first spotlight, and ray-trace
shadows for the second.

Turn on shadows, and render the scene:

1. Select Spot01.

2. Check Cast Shadows in the Modify command
panel. (Make sure that Use Shadow Maps is
chosen, as well.)

3. Select Spot02, and check Cast Shadows.

4. Choose Use Ray-Traced Shadows.

5.  Click Render Last.

The vase and the cage are lit by the two spot-
lights. The ray-traced shadows on the left wall
are crisp and black, while the shadow-map
shadows on the other wall are soft.

Adjusting Shadow Maps

You can adjust the shadow map settings to
achieve a sharper shadow. It’s a matter of chang-
ing the resolution and the pixel sampling of the
shadow’s bitmap.

Change the shadow-map settings:

1. Select Spot01.



3t2tut14.fm    11  Thu Oct  2 14:53:15 1997

Tutorial 14

U
si

n
g

 L
ig

h
ts

14
 –

 1
1

2. Set the Size spinner to 600 in the Shadow
Parameters rollout.

The Size spinner specifies the resolution of
the shadow bitmap. You’ve just increased it to
600 pixels based on the diameter of the falloff
area. (This also means more memory is
required to render the shadows.)

3. Set the Smp Range spinner to 2.

The Sample Range determines how many pix-
els are sampled around the edge of the
shadow. The fewer the pixels, the sharper the
edge.

4.  Click Render Last, and watch the shadows
on the right wall.

As the scene re-renders, you can see that the
shadow-map shadow is sharper.

Because shadow-map shadows are only bitmaps,
you need to keep in mind their resolution in
relation to your distance from the shadow, and
the detail required by the shadow. If the resolu-
tion is too low, and the camera too close, the
shadow might look more like sooty smudges.

Overshoot
The Overshoot option causes a spotlight to
flood beyond its falloff area, and cast light in all
directions. To best see its effect, light the scene
with a single spotlight.

Turn off a spotlight, and turn on Overshoot:

1. Select Spot01.

2. Uncheck On on the General Parameters roll-
out to turn off the spotlight.

3. Select Spot02.

4. Check Overshoot in the Spotlight Parameters
rollout.

5.  Click Render Last.

The entire room is flooded with light, and the
pool defined by the falloff is gone.

Overshoot essentially turns the spotlight into
an omni light with shadow-casting abilities. All
of the spotlight features are available, except
that the light is no longer confined to the area
of the falloff. However, other spotlight features
are confined to the falloff area. For example,
only the geometry within the falloff casts shad-
ows.

Notice that the base of the cage is not casting a
shadow because it’s outside of the falloff. (You
can see this clearly in the Spot02 viewport.)

Adjust Spot02 to cover the cage:

1. Activate the Spot02 viewport.

2. Alternately use the Truck Spotlight  and
Spotlight Falloff  controls to adjust the fal-
loff area so it completely surrounds the cage.

3.  Click Render Last.

The shadows now appear at the base of the
cage.
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Transparent Shadows
Ray-traced shadows let you cast accurate shad-
ows from transparent objects. You can see this
by changing the material assigned to the vase.

Change the vase material, and re-render:

1. Uncheck Overshoot.

2.  Click Material Editor to display the Mate-
rial Editor.

3. Make sure the first sample slot (containing
the Transparent material is active.

4. In the name field, type Vase.

Note: Type Vase exactly as shown, or the Put
Material to Scene button won’t become
enabled.

5.  Click Put Material to Scene.

The previous, face-mapped vase material is
replaced with the transparent material.

6.  Click Render Last.

A glass vase appears under the cage, casting a
blue transparent shadow.

As long as you combine ray-traced shadows with
Filter transparency in your material, you can

cast colored shadows. Shadow Maps don’t cast
transparent shadows, and Subtractive or Addi-
tive transparency doesn’t provide colored shad-
ows.

You can use a map in the Filter component of a
material to achieve special effects.

Add a map to the Filter component:

1. Click the Map button beside the Filter Color
swatch in the Material Editor.

2. Make sure Material Library is chosen in the
Browser, and select and load the Hex Sign bit-
map. Then click OK.

3. On the Basic Parameters rollout, set the U and
V Tiling spinners to 4.

4.  Click Go to Parent.

5. Set the Ambient and Diffuse color swatches to
black.

Dark surface colors provide more intense
opacity colors.

6.  Click Render Last.

The vase appears with a colorful design, and
casts a colorful shadow.
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Your rendered scene includes the forms of the
geometry, the color, shading, and textures pro-
vided by the materials, and the color and shad-
ing provided by the lights. Another important
visual component in your scene is the environ-
ment that affects the very atmosphere of your
scene.

In this tutorial, you’ll explore these atmo-
spheric effects in the Environment dialog:

• Standard Fog

• Layered Fog

• Volume Lights

Setting Up Environments
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Standard Fog 2

Standard fog tints your scene in depth, based on
the camera’s view. You can adjust the amount of
tinting at the near and far extremes, the color,
and even apply maps that affect the color or the
opacity of the fog.

You’ll use a simple scene demonstrating depth
to see the effect of standard fog.

Load and render the sample scene:

1. Choose File>Open, and load tut15_1.max.

The scene consists of a column of numbers, 1
through 4, aligned on a board. The subject
matter is insignificant except that, from the
camera view, the numbers recede into the dis-
tance. Distance is the component that most
influences standard fog.

2.  Make sure the Camera viewport is active,
and click Quick Render.

The rendered view is similar to the shaded
viewport.

3. Drag the render window over the Front view-
port.

Setting Camera Environment Ranges
The first step in using standard fog is to set the
range within which the effect will take place.
This is done by adjusting environment range
parameters that are carried with a camera’s cre-
ation parameters.

Display the environment ranges:

1. Select the camera.

2. Open the Modify command panel.

3. On the Parameters rollout, check Show in the
Environment Ranges area.

Two rectangles appear—one yellow, the other
brown. The yellow rectangle is the near range
of the environment effect, and the brown
rectangle is the far range.

The fog will grow thicker based on the environ-
ment range settings. The fog effect begins at the
near range, and ends at the far range.

Set the ranges to encompass the four numbers:

1. Adjust the Far Range spinner so that the rect-
angle, as seen in both the Top and Left view-
ports, is just beyond the numeral 4. (Approx-
imately 2400.0.)

2. Adjust the Near Range spinner so that its rect-
angle is just before the numeral 1 object.
(Approximately 700.0.)
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Environment Dialog
Now that you’ve defined the depth of the fog,
you can use the Environment dialog to assign
the Fog plug-in.

Open the Environment dialog:

1. Choose Rendering>Environment.

The Environment dialog appears.

2. On the Atmosphere rollout, click the Add but-
ton.

A list of atmospheric effects appears.

3. Choose Fog, and click OK.

The Fog plug-in provides two types of fog: stan-
dard and layered. The area of the controls labeled
Fog provides functions common to both types.
The remaining functions in the dialog become
enabled or disabled depending on the state of
the Standard and Layered buttons.

Switch between Standard and Layered:

1. On the Fog Parameters rollout under Fog,
choose Layered.

The Near % and Far % spinners are disabled,
and the controls in the Layered area are
enabled.

2. Choose Standard.

The spinners in the Standard area again
become active.

far range near range
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Fogging the Scene
Having assigned the Fog plug-in, you’ve essen-
tially assigned fog to the scene. You’ve already
set up your camera ranges, so you can render to
see the effect of the default fog values.

Render the scene:

•  Click Render Last.

As you can see, the front of the board is fairly
clear, and the numbers grow increasingly white
as they recede into the distance.

Changing the Color of the Fog
You don’t have to use a white fog. For example,
you might want a real “pea soup” fog.

Change the fog color:

1. Click the color swatch in the Fog Parameters
rollout.

The Color Selector appears.

2. Choose a pea-green color. (Suggestion: RGB
130, 140, 70.)

3.  Click Render Last.

The numbers appear in a green mist.

Distance Cueing
Examine another environment technique. It’s
called distance cueing.

Distance cueing attenuates all light in the scene,
based on the camera ranges. That is, as things
recede into the distance, they grow darker. You
can use subtle distance cueing to provide a
greater sense of depth to your scenes, or more
obvious distance cueing to impose a dark,
oppressive atmosphere.

To achieve distance cueing, you simply apply
black fog.

Apply black fog for distance cueing:

1. Set the color in the Color Selector to black.

2.  Click Render Last.

The numbers fade off into darkness.

Changing the Ranges
By changing the camera environment ranges,
you can change the depth of the fog. To see this,
restore the white fog, and alter the camera
ranges.

Change the environment ranges:

1. Set the color in the Color Selector to white.
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2.  Exit the Color Selector.

3.  Click Render Last to see the current fog
before adjusting the ranges.

The fog begins before numeral 1, and ends
after numeral 4.

4.  Iconize the Environment dialog so you
can see the Top and Left viewports.

5. Increase the Near Range spinner value in the
Modify command panel so the rectangle in
the viewports is between numeral 1 and
numeral 2. (Approximately 1000.0.)

6. Decrease the Far Range spinner value so the
rectangle in the viewports is between numer-
als 3 and 4. (Approximately 2000.0)

7.  Click Render Last.

The fog begins just before numeral 2, and is
fully opaque just after numeral 3. Numeral 4
is completely hidden in fog.

In addition to changing the camera ranges, you
can alter the amount of fog at the near and far
limits. The default settings specify no fog at the
near range, and 100 percent fog at the far range.
By reducing the percentage of fog at the far
range, you can reveal the numeral 4 without
adjusting the camera ranges.

Adjust the fog percentage:

1.  Open the iconized Environment dialog.

2. In the Standard area, set the Far % spinner to
80.

3.  Click Render Last.

You can now see the numeral 4. Since the fog
is no longer 100 percent, it appears grayer
because you can see the black background
through it.

Fogging the Background
As a default, the fog is applied not only to the
geometry, but also to the background. You can
turn this off, if you like.

Turn off the Fog Background option:

1. Uncheck Fog Background.

2.  Click Render Last.
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As you can see, this is a strange effect, but it
might come in handy if you’re compositing
several items in Video Post.

By adding an identifiable background, you
might have a better idea of your fog’s effect.
There’s a background stored in the Material Edi-
tor you can use.

Assign an environment background:

1. On the Environment dialog, on the Common
Parameters rollout, click the Environment
Map (None) button.

2. Under Browse From, chose Mtl Editor.

3. Choose The Valley, and click OK. Then select
Instance.

4.  Click Render Last.

With Fog Background turned off, the valley
bitmap appears bright and clear behind the
fogged geometry.

5. Check Fog Background.

6.  Click Render Last.

With both the geometry and the background
fogged, the scene looks more believable.

Mapping the Fog
You can apply maps to color the fog and to
change its opacity. Mapped fog is not com-
pletely realistic when used in a scene with an
animated camera, but you can produce some
interesting special effects with the technique.

The Material Editor contains two pre-made
environment maps that you can use to see the
effect of mapped fog. For an opacity map, a stan-
dard Noise procedural map will place holes in
the fog.

Apply an opacity map to the fog:

1.  Click Material Editor to view the maps.

The Noise map is in the second sample slot.

2. Click the Environment dialog to bring it to
the front.

3. In the Fog Parameters rollout, click the Envi-
ronment Opacity Map (None) button.

4. Choose Noise Map, and click OK. Then select
Instance.

5.  Click Render Last.
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The fog is now wispy.

Now, see what happens with a color map.

Map the fog with color:

1. Click the Environment Color Map (None)
button.

2. Choose Gradient Flash, and click OK. Then
select Instance.

3. Uncheck the Use Map button beside Environ-
ment Opacity Map.

4.  Click Render Last.

The geometry merges with brightly colored
patterns.
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Layered Fog 2

The second type of fog in the Fog plug-in is lay-
ered fog. This is a “slab” of fog that’s infinitely
deep and wide, with a specified height. Unlike
standard fog, layered fog is fixed to the world.
You can place the top and bottom of the layered
fog at any unit height in the scene, but the
“slab” is always parallel with the ground plane
in world space.

You’ll use a different scene to examine layered
fog.

Load a new scene:

1.  Exit the Material Editor.

2. Choose File>Open, and load tut15_2.max.

3. Make sure the camera viewport is active.

4.  Click Quick Render to view the scene
before you apply the fog.

The scene is a floor with a few columns and
some additional objects scattered about. Lay-
ered fog doesn’t use camera ranges because it’s
fixed to the scene. You can begin by assigning a
Fog plug-in to the scene, and then take a look at
some of its parameters.

Assign a Fog plug-in:

1. Choose Rendering>Environment to display
the environment dialog.

2. Click Add.

3. Choose Fog, and click OK.

4. Choose Layered in the Fog Parameters rollout.

The parameters in the Layered area are
enabled.

Decide where the top and bottom of your fog
are going to be. You set both values in world-
space Z coordinates, perpendicular to the
ground plane. The ground plane is 0, and the
columns in the scene are 100 units high, sitting
on a floor that’s 5 units high. A good bet would
be a layered fog that begins at 0 (the ground
plane) and rises to 30 units.

Set the altitude of the fog:

1. Set the Top spinner to 30, and leave the Bot-
tom spinner at 0.

2.  Click Render Last.

The layered fog appears, unrealistically, with
a sharp, white line at the horizon.
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Softening the Horizon
The horizon displays a hard line because the
layer of fog is projected into infinity, and you’re
looking at the edge of the fog. If your scene were
enclosed in geometry that blocked the horizon,
this wouldn’t be a problem. For example, a back
wall would block the horizon and maintain the
proper illusion.

Add a wall and re-render:

1. Click Unhide All in the Display command
panel.

A wall appears behind the existing objects.

2.  Click Render last.

The edge of the layered fog is soft along the
wall, but hard where you can see the horizon
on either side.

3. Select and delete the Wall object.

You can soften the sharp fog line, but since
some of the layered fog settings depend on the
horizon line, it might be helpful to turn on the
camera horizon display.

Turn on camera horizon line:

1. Select the camera in the Front viewport.

2. Check Show Horizon in the Modify com-
mand panel.

A black horizontal line appears in the Camera
viewport.

If you compare the line in the viewport with the
white line in the render window, you can see
that they’re both at the horizon of the scene.

In the Environment dialog, the Horizon Noise
option applies noise to the upper edge of the fog
at the horizon line, erasing a portion of it, and
producing a soft edge.

Apply horizon noise:

1. Check Horizon Noise in the Environment dia-
log.

2.  Click Render Last.

The edge of the horizon is feathered.

You can also soften the fog by adding falloff to
the top or bottom. This has no effect on the
edge of the horizon line, but thins the border of
the fog where you can see it against the objects.
In the following steps, watch the top of the fog
where it crosses the cylinders.
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Add falloff to the fog:

1. Choose Top beside the Falloff option buttons.

2.  Click Render Last.

The fog is thinner at the top, and the effect
increases more gradually toward the floor.

Since the layered fog goes off to the horizon, the
upper edge of the fog is at the horizon and can’t
be above it. When you apply horizon noise,
you’re actually erasing the fog effect below the
horizon. Keep this in mind when you plan your
shots. You could end up with a camera angle
that’s not realistic if you’re looking at objects in
the distance that are above the fog, when they
should be below it.

You can increase the softness of the horizon line
by increasing the Angle value. This is the angle
below the horizon line, as seen from the camera,
in which the noise will affect the fog. The
greater the angle, the softer the edge of the fog—
but the more exposed ground below the hori-
zon.

In the current scene, you can use a relatively
high angle, because the checkered floor ends far
before the horizon, and there are no objects in
the distance.

Increase the horizon noise angle:

1. Set the Angle spinner to 10.

2.  Click Render Last.

The fogged area at the horizon line is thinner,
and you can begin to see tendrils of fog in the
affected region.

The Size value sets the size of the noise pattern,
and affects the “tendrils.” It’s similar to the Size
value in the procedural Noise map in the Mate-
rial Editor. By adjusting the size of the noise, you
change the pattern of irregularity near the hori-
zon. You can see the effect—unrealistically—by
using a low value.

Change the noise size:

1. Set the Size spinner to 5.

2.  Click Render Last.

The fog is “pebbly” near the horizon.

3. Reset the Size spinner to 20.
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Using More Than One Layer
You can have several layered fogs in your scene.
For example, if you wanted to place a floating
cloud bank in the sky, here’s how you’d go
about it.

Add a second layer of fog:

1. Click the Add button in the Environment dia-
log.

2. Choose Fog, and click OK.

A second Fog plug-in is added to the list. Its
new parameters appear in the panel below.

3. Choose Layered.

4. Set the Top spinner to 200, and the Bottom
spinner to 150.

5. Choose Horizon Noise, and set the Size to 50.

6. Set the Angle spinner to 10.

A different color might be interesting, as well.

7. Click the color swatch in Fog Parameters.

8. Choose a pale lavender color. (Suggested: RGB
150, 95, 170.)

9.  Click Render Last.

The scene appears with a strange lavender fog
floating in the sky.

Animating the Noise
The Phase spinner is provided so you can ani-
mate the horizon noise. Changing the Phase
value rearranges the apparently random pattern
of the noise, producing a “boiling” effect when
animated. There’s not much point in adjusting
the Phase spinner unless you’re animating your
noise, because one random pattern looks very
much like another.

To quickly see the effect of the Phase value, ani-
mate a Noise map in the Material Editor.

Create and animate a Noise map:

1.  Click Material Editor.

2. Select the fourth sample slot.

3.  Click Get Material.

4. Choose New, and double-click Noise.

The parameters for a Noise map appear.

5. Go to frame 100.

6. Turn on the Animate button.

7. In the Material Editor, set the Phase spinner
in the Noise Parameters rollout to 10.
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8.  Click Make Preview, and click OK.

After the material preview has been created,
the Media Player appears.

9. Click the Play button on the Media Player.

The noise pattern moves in a random motion.

10.Stop the animation.

11.  Exit the Media Player.

Here’s how to animate the layered fog in your
scene.

Animate the layered fog:

1.  Exit the Material Editor.

2. Make sure the Animate button is still on, and
that you’re still on frame 100.

3. Set the Phase spinner in the Environment dia-
log to 10.

4. Click the Fog color swatch, and change the
color to anything you like. (The fog will
change color during the animation.)

5. Choose the first Fog in the Effects list window.

6. Set the Phase spinner to 5 (to make the noise
in the ground fog move more slowly).

7. Turn off the Animate button.

8. Choose File>Save As, and save your file as
mytut15a.max.

You can render the animation now, or you can
skip the following procedure, finish the tutorial,
and then reload your saved scene and render it
later.

Render the scene:

1. Make sure the Camera viewport is active.

2.  Click Render Scene.

3. Choose Active Time Segment.

4. Select the resolution and aspect ratio you
want.

5. Click the Files button, and specify a file name.

6. Click Render to begin the rendering process.
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Volume Lights 2

Volume lights combine light functions with fog
to produce the effect of light shining through
dust or fog. Using the Volume Light plug-in, you
can use any light to project atmosphere into
your scene. If you’ve seen a car’s headlights in
fog, you’ve seen the effect of volume lights.

You’ll begin with a scene of a spotlight shining
down over an object. You’ll assign volume light-
ing to the spotlight, and then examine the vari-
ous settings that change the volume effect.

Load the sample file:

1. Choose File>Open, and load tut15_3.max.

2. Make sure the Camera viewport is active.

3.  Click Quick Render.

This scene consists of a single spotlight directly
over a star-shaped object that is floating over a
box floor. The spotlight is casting shadows, and
its hotspot and falloff are almost the same size,
producing a sharp pool of light. The background
is a dark, teal green rather than usual black.

You assign volume to a light in much the same
way as you assign fog to your scene. In a way,
you’re really assigning fog to the light.

Assign Volume Light:

1. Choose Rendering>Environment.

2. Click the Add button, choose Volume Light,
and click OK.

The Volume Light parameters appear.

Having added Volume Light to your scene, you
now must choose which lights you want to cast
a volume of fog. There’s only one light, so the
choice is easy.

Assign volume to the light:

1. Click Pick Light.

The light you pick from the viewports is
assigned a volume effect.

2. Point the mouse at the spotlight in the Cam-
era viewport.
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When the mouse is over the light, its cursor
changes to a cross.

3. Click the spotlight.

The name of the light (Spot01) appears in the
pop-up list in the Environment dialog.

Using this technique, you can assign the same
Volume Light effect to several lights in your
scene, each of which appear in the pop-up list.
You can also have several Volume Light effects
in your Effects list, each with different settings,
and each affecting different lights. Keep in
mind, though, that each light casting a volume
requires additional rendering time.

You can use the current Volume Light settings to
see the effect. The default values are not very
subtle, but they’re a good starting point.

View the rendered effect:

•  Click Render Last.

The spotlight’s beam is visible as a white cone,
casting shadows through the star.

Softening the Light
Examine the white cone of fog. Notice the shad-
ows cast by the star through the fog. Notice also

that the sides of the cone are sharp, and the
cone is far too opaque for a realistic scene.

Of the many parameters that affect volume
light, two provide much of what you need:

• The distance between the hotspot and the fal-
loff changes the softness of the edge of the
cone.

• The Density spinner changes the opacity of
the cone.

You can soften the edge of the cone by enlarging
the distance between the hotspot and the fal-
loff.

Adjust the hotspot:

1. Select the spotlight.

2. Open the Modify command panel.

3. On the Spotlight Parameters rollout, reduce
the Hotspot spinner to 10.

4.  Click Render Last.

The edges of the white cone are softer and
more transparent.

You can reduce the opacity of the cone by low-
ering the Density value in the Environment dia-
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log. For subtler lighting, use lower density set-
tings.

Reduce the density:

1. Set the Density spinner to 2.5.

2.  Click Render Last.

The cone is both soft and transparent.

As with most effects in 3D graphics, you’re deal-
ing with illusions. In reality, the image you see
would be produced by dust particles in the air
passing through a beam of light. Here, the lights
are actually casting a cone of “dust.” The correct
thickness, or density of the “dust” depends on
the type of scene you’re lighting, the back-
grounds, the ambient light, the style of scene
you’re designing, and so on.

Changing the Glow
The Max and Min Light settings affect the
“glow” of the light. This might be easier to see if
you return to the higher density setting.

Decrease the Max Light % value:

1. Set Density back to 5.

2. Set Max Light % to 20.

3.  Click Render Last.

The central area of the cone is dimmer.

4. Set Max Light % to 5.

5.  Click Render Last.

6. The entire cones grows dimmer.

The minimum light includes the area outside
the cone. As a result, when you increase the
minimum light, it applies fog to the surround-
ing scene. If there are no objects behind the fog,
the fog goes into infinity, and becomes com-
pletely opaque.

Restore Max Light %; increase Min Light %:

1. Set Max Light % to 90.

2. Set Min Light % to 10.

3.  Click Render Last.

The background turns completely white; the
star and the floor are whitened partially.

You raise the Min Light % setting above 0 if you
have a scene enclosed in geometry, and want fog
to affect the area beyond the beam of light.
Remember, though, if you use a Min Light %
value greater than 0, make sure your scene is
completely enclosed in geometry or the back-
ground will turn solid fog color.

4. Set Min Light % back to 0.

Attenuating the Fog
The light attenuation values affect the throw of
the fog cone. By activating attenuation, you can
use it to limit the length of the cone.

Attenuation ranges have already been set for
this scene, so all you have to do is turn it on and
render.
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Activate attenuation:

1. Check Use Near and Use Far in the Attenua-
tion area of the Modify command panel.

2.  Click Render Last.

The white cone begins to vanish before it
reaches the floor.

In the Attenuation area of the Environment dia-
log, the Start % and End % values provide a way
of adjusting the attenuation of the fog effect
based on the current light attenuation settings.

The Start % and End % values default to 100 per-
cent, meaning that the fog will start at the cur-
rent Start Range setting for the light, and end at
the current End Range setting. As you adjust the
Start % and End %, you offset the start and end
of the fog effect. Thus, a Start % of 50 would
place the beginning of the fog’s attenuation
halfway between the source of the light and the
current Start Range. To lengthen the end of the
fog beyond the current End Range, you increase
the End % value.

Increase the End %:

1. Set the End % spinner in the Environment
dialog to 150.

2.  Click Render Last.

The fog reaches to the floor.

Restore the previous settings:

1. Set the End % spinner to 100.

2. Uncheck Use Near and Use Far in the Attenu-
ation area of the Modify command panel.

Volume Light Noise
With the remainder of the settings, you’ll apply
noise to the light fog, and animate the noise.
The noise itself is similar to the noise used by

the layered fog. When you use noise in a volume
light, you can create anything from dust motes
to odd, swirling puffs of smoke or fog in the
cone of light.

The easiest way to see the effect of the noise set-
tings is to use values that make the noise pattern
more obvious than you might ever use.

Turn on the noise:

1. In the Environment dialog under Noise,
check Noise On.

This check box must be on before any of the
noise parameters can take effect.

2. Set the Amount spinner to 1.

This is as high as this spinner goes.

3.  Click Render Last.

The fog breaks up into faint puffs.

As a general rule, when you increase the amount
of noise, you need to increase the density as well
because noise breaks up the fog.

Adjust the noise parameters:

1. Under Volume, set the Density to 40.

2.  Click Render Last.
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The light puffs become dense white.

3. Set Size to 10.

4.  Click Render Last.

The puffs are smaller.

The Uniformity setting affects the smoothness
of the noise. As you increase Uniformity, the
clear areas between the puffs begin to fill in with
white; as you decrease Uniformity, the clear
areas become predominant, and the puffs break
up more.

The range of the Uniformity spinner is only
from –1 to 1, so it doesn’t take much to affect
the noise.

Change the Uniformity:

1. Set the Uniformity spinner to 0.2.

2.  Click Render Last.

The puffs and the areas between the puffs
grow whiter.

3. Set Uniformity to –0.2.

4.  Click Render Last.

The puffs become smaller and fainter, and the
clear areas grow larger.

Working with various combinations of settings,
you can get an effect like dust motes.

Create dust motes:

1. Set Amount to .99

Reducing the noise by only this amount will
restore a degree of whiteness to the cone.

2. Set Density to 60.0.

You need to increase the density greatly
because you’ll reduce the size greatly.

3. Set Size to 3.35.

This gives you very tiny puffs.

4. Set Uniformity to –0.5.

The negative setting breaks up and isolates
the puffs.

You’ll barely see these smaller puffs in a
320 x 200 rendering, so increase the resolu-
tion.

5.  Click Render Scene.

6. Click the 640x480 button.

7. Click Render.

Tiny particles float in a thinly misted light
beam.

The remainder of the noise parameters are
designed to let you animate the noise pattern.
They work in the same way as Volume Fog.

To animate the noise, the Phase value must be
keyframed. These are the steps you take to ani-
mate volume light noise:

• Make sure noise is applied (Noise must be set,
and the Amount spinner must be greater than
0).

• Animate the Phase value over time. (Turn on
the Animate button, go to a non-zero frame,
and change the Phase spinner value.)

• Optionally, turn up the Wind Strength value,
and specify a direction for the noise.

The Wind Strength value has no effect if Phase
is not animated. When you animate the noise,
the animated pattern is confined to the cone of
light.
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Volume Projector Lights
You can dramatically alter the volume effect by
using a projector light.

Reset some parameters:

1. Uncheck Noise On.

2. Set Density to 3.0.

3.  Click Render Scene.

4. Click 320x240, and click the Render button.

A relatively normal white cone of light
appears.

Now, assign a projector image to the spotlight,
and render again. There’s a bitmap image stored
in the Material Editor.

Assign a projector image, and render:

1. Select the spotlight (if it’s not still selected).

2. Click the Map (None) button on the Spotlight
Parameters rollout on the Modify command
panel.

3. Under Browser From, select Mtl Editor.

4. Choose Hex Sign from the list, and click OK.
Then select Instance.

5.  Click Render Last.

A faux Pennsylvania Dutch hex sign is pro-
jected through the light, casting streaks of
color in the fog.

Using projector images with volume fog, you
can recreate the effect of stained-glass windows
or, with an animated projector image, a projec-
tor beam in a smoky theatre.

Volume Omni and Directional Lights
Volume light can be assigned to all the different
light types. For example, you can create glowing
balls of light using omni lights. You can see this
using an inactive omni light that’s hidden in the
scene.

Unhide and activate the omni light:

1. Click Unhide All in the Display command
panel.

An omni light appears.

2. Select the omni light.

3. On the Modify command panel, on the Gen-
eral Prameters rollout under Color, check On.

4.  Click Render Last.

The two objects are more brightly lighted by
the addition of an omni light.

Unlike spotlights, when you use volume light-
ing with an omni light, the attenuation settings
of the omni light are always used by the fog,
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regardless of whether they’re activated in the
Modify command panel. Without attenuation,
the fog would emanate infinitely in all direc-
tions from the omni light and flood the scene.

Even with attenuation, the fog might flood the
scene if the attenuation settings are too large.
So, the first thing to check when applying vol-
ume light to an omni light is its attenuation set-
tings.

Set the attenuation:

1. Check Show Far in the Attenuation area of
the Modify command panel.

The attenuation hoops appear. The brown
hoops representing the end range encompass
the entire scene, which is more fog than
you’ll want.

2. Set the Start Range spinner to 20.

3. Set the End Range spinner to 30.

If you assign the omni light to the current Vol-
ume Light settings, it will use the same fog set-
tings. To apply different fog settings to the omni
light, you add another Volume Light to the
effects list, and assign the new effect to the omni
light.

Add a Volume Light effect:

1. Click Add in the Environment dialog.

2. Choose Volume Light, and click OK.

There are now two Volume Light items in the
effects list. The second item is highlighted,
and its parameters appear below.

3. Click Pick Light.

4. Click the omni light in the camera viewport.

5.  Click Render Last.

The omni light appears in the seen as a soft,
blurry ball.

The rest of the volume light settings provide the
same effects as when used with spotlights.
Unlike spotlights, omni lights have no hotspot
and falloff controls. However, changing the dis-
tance between the attenuation ranges provides
some measure of control over the softness of the
omni fog.

Change the attenuation range:

1. Increase the End Range spinner to 100.

2. Set Use in the Attenuation area, so the light
doesn’t illuminate the objects in the scene.

3.  Click Render Last.

The omni light produces a large circle of fog
with a soft edge.

Directional lights cast a cylinder of parallel light
beams. When used as a volume light, they pro-
vide a column of light that you can use for
effects such as alien saucers illuminating pick-
up trucks parked on lonely, country roads.

Set up a directional light:

1.  Click Lights in the Create command
panel.

2. Move the Environment dialog away from the
Top viewport.

3. Click Target Direct in the Create command
panel, and then click and drag in the Top
viewport, to create a directional light at the
right edge of the star.
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4. In the Front viewport, move the directional
light straight up to the top of the viewport.

Because the beam from the directional light is
parallel, it will illuminate everything, as long
as it’s higher than the star object. However,
the volume effect will stop at the directional
light icon. You want to make sure the icon is
out of camera range (unless you want the top
of the beam showing in your scene).

5. Open the Modify command panel.

6. Set Hotspot to 40, and Falloff to 50.

7. Click Cast Shadows.

8.  Click Render Last.

The scene is rendered with an additional cir-
cle of light cast by the directional light.

You can use the same volume light settings for
both the omni and the directional light.

Assign the volume light, and render:

1. Click Pick Light in the Environment dialog.

2. Select the direction light in any viewport.

The light appears in the pop-up list.

3.  Click Render Last.

A straight beam of white light shoots down
from the sky.

click here to place
directional light
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Tutorial

This tutorial introduces you to the basic anima-
tion concepts in 3D Studio MAX by showing
you how to bounce a ball.

During the exercises, you’ll use the Track View,
where you edit animations. You’ll also learn
how to edit keys and manipulate function
curves.

At the end of the tutorial, you’ll animate the
bouncing ball along a path, and add sound to
your animation.

In this tutorial, you’ll also learn about morphing,
an animation technique that changes the shape
of an object to a different shape.

Basic Animation
and Morphing
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Setting Things Up 2

In order to bounce a ball, you need to create a
ball.

Make a sphere:

1. Click the Sphere button in the Create com-
mand panel.

2. In the center of the ground plane in the Per-
spective viewport, create a sphere with a
radius of about 30 units.

3. In the Name and Color field, type Ball, and
press ENTER.

4.  Pan the Perspective and Left viewports so
the ball is near the bottom of the viewports.

5. Make sure the Perspective viewport is set for
Smooth + Highlight.

6. Repeat step 5 with the Left viewport.

7.  Click Select and Move, and the Restrict to
Y axis button.

8. In the Left viewport, move the ball up about
100 units (to the next bold grid line).

As you know from previous tutorials, you create
animation by turning on the Animate button,
and then performing an action at a frame other
than frame 0. This process creates keys at the
frames where you perform the action. When
you play an animation, 3DS MAX interpolates
the values between the keyed frames (or key-
frames) to produce the animated effect.

In the Track View, you can actually watch the
keys appear as you create them.

Introducing the Track View
There are two ways you can display the Track
View—either as an alternate viewport, or as a
floating dialog. In this exercise, you’ll open it as
a dialog.

Open the Track View:

•  Click Track View in the toolbar.

The Track View dialog appears over the upper
two viewports.

The window on the left side of the Track View is
the hierarchy list. It contains a list of all objects
and materials in the scene, plus all tracks that
can be animated. A track is a discrete channel of
animation. For example, each object carries a
track for Position, for Rotation, and for Scale
keys. A parametric object can also carry anima-
tion tracks for its radius, the number of seg-
ments, and so on. Anything you can animate
has a track.

hierarchy list toolbar edit window

navigation buttons
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To the right of the hierarchy list is the edit win-
dow, where you move, copy, or delete key dots,
and edit function curves.

The toolbar near the top of the Track View con-
tains various controls and buttons that change,
depending on the display in the edit window.
There are five buttons in the toolbar that change
the display in the edit window.

In the lower-right corner of the Track View are
navigation buttons that let you zoom and pan
the edit window.

Traversing the Hierarchy
The hierarchy list displays all of the objects in
your scene, plus their characteristics that can be
animated. You travel through the hierarchy list
by selecting objects and expanding and collaps-
ing their branches.

This is a simple scene, consisting of a single
object. You’ll animate the position of the ball, so
begin by finding the ball’s Position track.

Find the Position track:

1. Click the plus (+) icon beside the Objects item
in the hierarchy list.

The Ball item appears below.

2. Click the plus (+) icon beside the Ball item.

Two new items, Transform and Object (Sphere),
appear below Ball. The first holds the trans-
forms with which every object is created. The
second holds the creation parameters for the

object. Both of these the parameters can be
animated.

3. Click the plus (+) icon beside Transform.

Position, Rotation, and Scale tracks appear
below the Transform item.

Note: To see the creation parameters, click the
plus icon beside Object (Sphere). You’ll see all of
the creation parameters that can be animated
for the Sphere object. Click the minus (-) icon to
collapse the creation parameters.

Edit Keys

Edit Time

Edit Ranges

Position Ranges

Function Curves
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Animating Position 2

Now that the Track View is displayed, create a
Position key, and see what happens.

Animate the first motion:

1. In the MAX window, drag the Time Slider to
frame 10.

As you drag the time slider, a thin vertical
line, representing the current frame, appears
in the edit window of the Track View.

2. Turn on the Animate button.

3. In the Left viewport, move the ball down
until it rests on the ground plane.

In the Track View, gray key dots appear in the
Position track at frames 0 and 10. In the
Transform and Ball tracks, black range bars
appear.

4. Drag the time slider to see the result.

The ball moves down over frames 0–10, and
then stops moving.

5. Turn off the Animate button.

As soon as you moved the ball, Position keys
were created at two frames, representing the
original position of the ball at frame 0, and the
new position of the ball at frame 10. The gray
key dots in the Position track represent the two
keys.

Altering the Animation
In addition to animating in the viewports, you
can create animation by manipulating the key
dots in the Track View. For a bouncing motion,
you want the ball to return to its original posi-
tion by frame 20. The key dot at frame 0 repre-
sents the original position of the ball, and by
copying that key dot to frame 20, you’ll get the
movement you want.

You copy key dots in the Track View in the same
way that you copy objects in the viewports—by
holding SHIFT while moving the key dot.

Copy the Position key:

1.  Click Move Keys in the Track View toolbar
(if it’s not already selected).

2. Hold SHIFT, and drag the key dot at frame 0 to
the right to frame 20.

A vertical yellow line helps you align the dot’s
position with the ruler. The value field at the
bottom of the Track View displays the current
frame of the selected key dot.

A new key at frame 20 contains the position
value from frame 0. The black range bars grow
to encompass the time span of all three keys.

3. Drag the time slider to examine the anima-
tion.

The ball moves down, and then back up.

The range bars are controls that let you move or
scale key dots. The range bar in the Ball track
represents all keys that belong to the ball. Cur-
rently, keys are only in the Position track, but
this range bar could represent keys for the cre-
ation parameters as well as for the transforms.
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The range bar in the Transform track represents
only the three transform tracks. Currently, it’s
the same as the Ball range bar.

Checking Out the Range Bars
It’s not necessary for this exercise, but why not
take a moment to try out the range bars.

Move the range bars:

1. Point the mouse in the middle of either range
bar.

The mouse cursor changes to two-way arrows.

2. Drag the bar in the approximate area of
frames 30–50.

The key dots move along with it.

3. Drag the time slider.

The ball doesn’t start moving down until
frame 30, and then returns at frame 50.

Scale the range bars:

1. Point the mouse at either end of the range
bars.

The cursor changes to a one-way arrow.

2. Drag to lengthen the range bars.

The key dots are scaled to match the overall
length of the range bar.

3. Drag the time slider.

The ball takes longer to bounce down and up.

Return things the way they were:

• Drag the bars back to their original positions,
spanning frames 0–20. (Or click Undo until
they’re back where they were.)

Tip: You can drag the Track View ruler down to
any track for precise measurement.

Looking at Function Curves
The Function Curve display provides another
way to look at animation in the Track View.

View the Position track as a function curve:

1. Click the Transform track label.

2.  Click the Function Curves button in the
Track View toolbar.

The track rows in the edit window are
replaced by an empty grid.

3. Click the Position track label to display its
function curves.

A blue line appears in the edit window.

The light gray background in the edit window
represents the active time segment, which is
the same range of frames available to the time
slider. The dark gray background is the area of
time outside of the active time segment.

4. Click the blue function curve to display the
key dots.

The key dots appear as small, black squares at
frames 0, 10, and 20.

There are actually three function curves in the
Position track. They’re colored red, green, and
blue, and represent position along the X, Y, and
Z axes. The blue spline is the Z axis, but the red
and green X and Y splines are overlaid at the 0
value line because they contain the same value
throughout the animation.

The vertical direction of the edit window repre-
sents key values, while the horizontal axis repre-
sents time. In the blue function curve, you can
see that the ball begins above 100 units along Z
at frame zero, swoops down to 30 units at frame
10, and then returns at frame 20.
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Note: The position of the ball is measured from
its pivot point, at the center of the sphere, to the
ground. Because the ball has a radius of 30 units,
when it rests on the ground at frame 10, the Z
position is 30 units.

Using Out-of-Range Types
Currently, the ball bounces down and back up,
and then stays up for the rest of the animation.
Here’s how to cycle the up-and-down move-
ment.

Change the Out-of-Range Type:

1. Make sure the Position track is selected (the
“Position” text label is highlighted).

2.  Click the Parameter Curve Out-of-Range
Types button.

The Param Curve Out-of-Range Types dialog
appears.

You use this dialog to project the pattern of the
key dots in the selected track. These patterns are
applied to the animation outside the range of all
keys in the track. This is why they’re called out-
of-range types.

As a default, tracks use a constant out-of-range
type. This simply means that the track values
before and after the range of keys remain con-
stant. For example, the X, Y, and Z values after
frame 20 remain the same for the rest of the ani-

mation, so the ball stays at the same position
from frame 20 to frame 100.

The Cycle out-of-range type will make the key
pattern repeat cyclically.

The arrow buttons beneath each type let you
assign one type to the time leading up to the
pattern, and another type to the time beyond
the key pattern. In this animation, everything
starts at frame 0, so all you need do is assign the
Cycle type after the last key.

Cycle the Position keys:

1. Click the right-arrow button beneath the
Cycle pattern, and then click OK.

The pattern of the blue function curve repeats
beyond frame 20. Notice that the blue line is
solid through the active range of keys, and a
dashed line outside of the range.

2. Play, and then stop the animation.

The ball moves up and down over all 100
frames.

Adjusting Curve Tangents
The ball’s movement isn’t right for a proper
bounce. Looking at the function curve, you can
probably see why. The spline breaks abruptly at
the top, and arcs at the bottom. Essentially, the
profile of the curve is upside down. You want
the ball to bounce abruptly at the bottom, and
ease gently over the apex of the curve.

The angle and direction of the spline through
each key dot is called the tangent, which you can
adjust in various ways. For this exercise, you’ll
use preset tangent types to alter the way the
spline curves through the key dots.

The tangent of the spline through each key dot
is part of the key information—or key info. There
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are two ways to access the Key Info dialog for
any key.

Display Key Info:

• Do one of the following to access the Key Info
display: Right-click middle key dot at frame
10 in the blue line. Click to select the middle
key dot in the blue line, and then click the
Properties button .

The Key Info dialog appears displaying infor-
mation for the Ball\Position track.

The controls in this dialog let you alter the val-
ues of the selected key (or keys) for a specific
track. The arrows at the upper-left step through
the keys in time. The Time spinner lets you
change when the key occurs, and the three spin-
ners below let you change the values of the key
on the three axes.

The two icons at the bottom of the dialog are
flyouts that let you assign preset tangent values
to the key. Each side of a key can have a different
tangent. On the left side of the key is the incom-
ing tangent, and on the right is the outgoing tan-
gent.

Smooth tangent curves are the default, as you
can see by the smooth curvature of the key at
frame 10.

Change the tangents:

1.  Click the Play button to start the anima-
tion, and let it play while you adjust the tan-
gents.

2.  Click the Fast tangent in the In fly-
out.

The line entering the key dot on the left curves
down. At the same time, the new tangent has
distorted the line on the other side of the key
dot. The ball now moves erratically up and
down.

Now, copy the fast value from the incoming
side of the key to the outgoing side.

3. Click the arrow button on the right side of the
In flyout.

The lines on both sides of the selected key
mirror each other. The ball moves regularly
up and down, but “hits” the ends of its move-
ment abruptly.
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4. Click the left key-step arrow at the top of the
Key Info dialog.

The first key, at frame 0, is selected.

5.  Click the Slow tangent in the Out fly-
out.

The line curves gracefully out from the first
key.

6. Use the Key step arrows to move to the third
key at frame 20.

7.  Change the In tangent to Slow.

The upper portions of the line curve,
while the key at frame 10 is shaped like a V.
The ball now bounces as it should, hitting the
ground abruptly, and then arcing gently
through apex.

8. Stop the animation.

9.  Click the exit button to dismiss the Key
Info dialog.

Slow-In applied here
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Animating Scale 2

You’ve decided the ball is rubber and, having
studied several books on proper animation tech-
niques, feel that you should add some squash-
and-stretch to liven up the effect.

3D Studio MAX has a form of Scale, called
Squash, that you can use to make the ball flatten
out when it hits the ground.

In the following steps, you’ll squash the ball at
frame 10, bracket the Scale keys so the squash
occurs only when the ball hits the ground, and
then use the Track View to analyze animation
anomalies.

Changing the Pivot Point
Scale occurs around the pivot point of an object,
and the default placement for a sphere’s pivot
point is its center. Before performing the squash,
you need to move the pivot point to the bottom
of the ball.

Adjust the pivot point:

1. Go to frame 10, where the ball meets the
ground.

2. Select the ball.

3. Open the Hierarchy command panel, and
click the Pivot button.

4. Click Affect Pivot Only.

The ball’s pivot point icon appears.

5. In the Left viewport, move the pivot down to
the base of the ball, where it meets the
ground.

Squashing the Ball
Now that the pivot is properly set, you can
squash the ball.

Squash the ball:

1. Click the Affect Pivot Only button again to
turn it off.

2. Turn on the Animate button.

3.  Turn on Percent Snap in the prompt line.

4.  Click Select and Squash in the Scale fly-
out.

5. Make sure the XY constraint button is active.

6. In the Perspective viewport, drag upward
across the ball to squash it 70 percent along
the Z axis (140 percent along X and Y).

7. Drag the time slider to see the result.

The ball squashes down over frames 0–10,
and then remains squashed for the rest of the
animation.

8. Turn off the Animate button.
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You’ll use the same technique you used in copy-
ing the Position keys to make the ball return to
its original size. In this case, however, you want
the squash to happen only a couple of frames
before and after frame 10. This technique is
called bracketing keys.

Bracket the Squash keys:

1.  Click Edit Keys in the Track View to dis-
play the key dots in the edit window.

Keys appear at frames 0 and 10 in the Scale
track, because Squash is a Scale transform.

2. Hold SHIFT and drag a copy of the Scale key
dot at frame 0 to frame 8.

3. Repeat the process, copying the key dot at
frame 8 to frame 12.

Because you’ll use Out-of-Range to cycle the
pattern of Scale keys (as you did the Position
keys), you want the key patterns for both
tracks to cover the same range of frames, and
be synchronized. Make one more copy.

4. Hold SHIFT, and drag a copy of the key dot at
frame 12 to frame 20.

5. Drag the time slider to view the result.

The ball doesn’t squash quite the way you
expected.

It looks like the squash is being anticipated. It’s
not limited to frames 8–12, and it squeezes in
before squashing down. Anticipation is usually
good for animation, but you might want some-
thing a little more precise.

Animation Analysis
Whenever you have unexpected results in an
animation, use the function curve editor to ana-
lyze the problem.

Display the Scale function curve:

1.  Click Function Curves to display the
function curve editor.

2. Click the Scale track label to display its curve.

3. Hold CTRL and click the Position label to add
the Position curve to the function curve dis-
play.

4. Click the green arrow icon beside Scale to dis-
play the key dots in the Scale function curve.

As a default, 3DS MAX assigns smooth tangents
to key values. In most cases, this results in real-
istic animation and avoids the mechanical look
that linear tangents would provide. However,
when you place keys closely together in time,
the smooth curves can “bunch up,” causing
unexpected results.

In this case, you want linear Scale curves
between the keys at frames 0 and 8, and
between the keys at frames 12 and 20.

default curve tangents
cause this
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Fix the Scale tangents:

1. Right-click any of the Scale key dots to display
the Key Info dialog for the Ball\Scale track.

2. Click the key step arrows to move to key 1 at
frame 0.

3.  Click the Linear tangent in the Out
flyout.

4. Click the right arrow beside the Out
flyout to copy the linear tangent to the
incoming side of the keys at frame 8.

Because the outgoing tangent of the first key,
and the incoming tangent of the second key
now both contain linear tangents, the result
is a straight line between keys 1 and 2.

5. Click the key step arrows to move to key 5 at
frame 20. (Clicking the left arrow will “wrap”
to key 5.)

6. Change the In tangent to linear, and
then click the left arrow button to
copy the linear tangent to the outgo-
ing vector of the keys at frame 12.

7. Drag the time slider.

The squash now occurs only between frames
8 and 12.

You’ve probably noticed that the squash begins
before the ball hits the ground, and ends after
the ball hits the grounds. You’ll take care of that
after you cycle the pattern of Scale keys.

Add Out-of-Range to the squash:

1.  Click the Exit button to dismiss the Key
Info dialog.

2. Click the Scale track label to deselect the Posi-
tion track.

3.  Click Parameter Curve Out-of-Range
Types.

4. Click the right arrow button under Cycle, and
then click OK.

The Scale function curve pattern cycles
throughout the animation, matching the
Position pattern.

5. Play, and then stop the animation.

It doesn’t look bad, even if the squash is hap-
pening before the ball hits the ground. You can
fix this by altering the Position keys.

Fix the Position problem:

1.  Click Edit Keys to display the edit keys
window.

2. Drag the Position key dot at frame 10 to
frame 8.

3. Hold SHIFT and copy the Position key dot at
frame 8 to frame 12.

linear tangents
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4. Play, and then stop the animation.

The ball bounces properly.

Because both the bouncing position and the
squash use out-of-range types to cycle their ani-
mation, you can increase the number of frames
in your animation, and the ball will continue to
bounce. In the exercise that follows, you’ll want
some extra frames, so add them now.

Lengthen the animation:

1.  In the Controls area to the right of the
Animate button, click the Edit Time button.

The Time Configuration dialog appears.

2. Set the Length spinner to 200.

3. Click OK.

4. Play, and then stop the animation.

The ball bounces in exactly the same way, but
does it over 200 frames.

Save the scene:

• Choose File>Save to save the current scene as
mytut16.max.
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Bouncing Along a Path 2

Now that you’ve created a bouncing ball, you
decide you’d like it to bounce somewhere,
besides up and down. You’ll make it follow a
meandering path. To get this effect, you’ll per-
form the following general steps:

• Create a spline shape for the path.

• Create a dummy object.

• Assign the dummy to a Path controller, and
then point it to the shape.

• Link the ball to the dummy.

Before continuing, you should understand two
concepts. First is the concept of animation con-
trollers, and the second is the reason for the
dummy object.

Animation Controllers
All animation in 3DS MAX is performed
through animation controllers, which are core
component plug-ins. Each animation track has
its own controller, and each controller can be
different.

In the hierarchy list, the controller tracks are
symbolized by the green-arrow icons. You can
see which specific controllers are assigned to
each track by turning on the controllers display
in the Track View.

Turn on the controller display:

•  Right-click Filters in the Track View tool-
bar, and choose Controller Types from the
drop-down menu.

The controller names appear beside the tracks
to which they’re assigned.

You can assign different controllers to the
tracks, affecting the way they respond. The Bez-
ier Controller, currently assigned to all the Posi-
tion tracks, lets you move objects using the

Select and Move transform tool, and converts
those movements into Bezier splines that you
see in the Function Curve edit window.

Dummy Objects
A dummy object is a cube that’s invisible to the
Renderer. You use dummy objects primarily to
influence the animation of other objects by
linking those objects to the dummy.

You’ll use a dummy object in this exercise to
compound the effect of two Position tracks. You
want the ball to bounce up and down, and to
follow a spline path specified by a path control-
ler. However, the ball can have only one Posi-
tion track.

If you were to replace the ball’s current Position
controller with a Path controller, the ball would
follow the path, but would no longer move up
and down.

Instead, you make a dummy follow the path,
and then link the ball to the dummy. The
dummy carries the ball around the path, while
the ball moves up and down.

Creating the Path
The first step is to create your path. You’ll use a
circular spline shape.

Create a shape path:

1.  Close the Track View.

2. Move to frame 0.

3. Activate the Top viewport.

4.  Zoom out slightly.

5.  Click Shapes in the Create command
panel.

6. Click the Circle button.
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7. In the Top viewport, drag outward from the
center of the ball to create a circle with an
approximate radius of 200 units.

8.  Click Zoom Extents All.

Putting a Dummy on the Path
The next step is to create the dummy, and then
assign its Position track to a Path controller.

Create a dummy:

1.  Click Helpers in the Create command
panel.

2. Click the Dummy button.

3. In the Top viewport, drag anywhere to create
a dummy object that’s slightly larger than the
ball.

Assign the dummy to a Path controller:

1. Make sure the dummy is selected.

2. In the Motion command panel, open the
Assign Controller rollout.

A small window appears displaying a hierar-
chy that’s similar to the one found in the
Track View, except that only the transform
controllers for the selected object are dis-
played.

3. Select the Position controller by clicking its
text label.

4.  Click the Assign Controller button.

The Assign Position Controller dialog displays
all controllers that can be assigned to the
Position track.

5. Choose Path, and then click OK.

A Path controller now governs the dummy’s
position in the world. You can no longer
move the dummy using the Select and Move
tool.

After choosing a path controller, you can pick
any shape object as a path. Of course, you have
to remember to pick a path, or the object can go
nowhere.

Pick a path for the dummy:

1. On the Path Parameters rollout, click the Pick
Path button.

2. Click the circle shape.

The dummy jumps over to the first vertex in
the shape.

3. Drag the time slider.

The dummy moves around the circular path.
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Link the ball to the dummy:

1. Go to frame 0.

2.  Using the Select and Move tool with XY
constraints, move the ball in the Top view-
port until it’s centered over the dummy.

3.  Click Select and Link in the toolbar.

4. In the Front viewport, drag a link from the
ball to the dummy.

When you release the mouse, the dummy
flashes briefly to show it’s linked.

5. Activate the Perspective viewport, and play
the animation.

The dummy carries the bouncing ball around
the path.

6. In the Display command panel, check Help-
ers in the Hide by Category rollout.

The dummy vanishes, leaving only the ball
bouncing along the spline.

7. Uncheck Helpers to show the dummy again.

8. Stop the animation and save your scene.
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Adding Sound 2

Your animation is complete, and now you want
to add sound. You can approach sound in two
ways in 3DS MAX:

• Using a Metronome

• Using a .wav file

Using a Metronome
3D Studio MAX has a built-in metronome that
you can use when you know the beat to which
you want to animate, and plan on adding sound
later that matches that beat.

In the following steps, you’ll see how to turn on
and adjust the metronome. You’ll also arrange
the Track View so you can see both your keys
and the Sound track.

Arrange the Track View:

1.  Click Track View to display the Track
View.

2. Click the (+) button beside Sound to open the
Sound track.

A Metronome track appears, displaying black
dots.

3. Split the Track View window by doing the fol-
lowing:

• Point the mouse just above the top of the
right-most scroll bar, until the cursor changes
to double arrows.

• Drag downward to split the Track View.

The two windows are independently scrolla-
ble views into the same Track View.

4. Scroll the lower portion to find the Dummy
object in the hierarchy list.

Note: If you don’t see the Dummy object, you
forgot to uncheck Helpers in the Hide by Cate-
gory rollout on the Display command panel.

Because the Ball is now linked as a child of the
Dummy, you need to expand the Dummy’s
branch to find the Ball.

5. Click the square plus icon beside Dummy to
reveal its children.

The Ball appears.

6. Scroll the view so you can see the Sound track
in the upper portion of the Track View, and
the Position and Scale key dots in the lower
portion.

Tip: You can most easily scroll the hierarchy
list by dragging over a blank area of the win-
dow. The mouse cursor changes to a hand in
areas where you can scroll.

Now, try out the metronome.

Adjust the metronome:

1. Right-click in the Metronome track.

The Sound Options dialog appears.
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2. Increase the Beats per Minute spinner.

As you adjust the spinner, the spacing
between the black dots changes.

3. Set Beats per Minute to 180, and Beats per
Measure to 2.

4. Check Active, and then click OK.

5. Play, and then stop the animation.

During playback, your internal computer
speaker clicks to the metronome beat.

Typically, you’d set your metronome beat, based
on the rate you need for the final animation
(taken from an existing or planned sound track).
You’d then either create or adjust your anima-
tion to match the beat.

Instead of using the metronome, however,
you’ll adjust your animation to match the beat
of a .wav file.

Using a .wav File
You can display and play any standard .wav file
in 3D Studio MAX. When you make a preview,
the .wav file is saved with the .avi file, and
played back with it.

In the following steps, you’ll assign a .wav file to
your animation, and then synchronize the ani-
mation with the file.

Add a .wav file:

1. Right-click in the Sound track to display the
Sound Options dialog.

2. Uncheck Active in the Metronome area.

3. Click Choose Sound.

A file selector appears.

4. Click to select (but don’t load) tutdrum.wav.

After a moment, a playback device appears in
the file selector.

5. Click the Play button in the file selector to
play the sound. Click the button again to halt
the playback.

As you can see, you can use the file selector to
preview sounds before loading them.

6. Click Open to close the file selector.

Active is automatically checked in the Sound
Options dialog.

7. Click OK to exit the Sound Options dialog.

Blue and red wave forms appear in the Sound
track. You may have to enlarge the Track View
window to see both wave forms.

8. Play, and then stop the animation.

The sound plays along with the animation,
but the ball doesn’t bounce to the beat.

The blue wave form is the right channel of ste-
reo sound, and Red is the left. The light portions
of the wave forms represent the actual length of
the sound file (about 430 frames for tut-
drum.wav). The dark segments show where the
sound repeats.

Synchronizing the Animation Tracks
Two of your animation tracks use a Cycle out-of-
range type, which means that they’ll regularly
repeat the animation pattern over the course of
the animation. In order to sync a sound beat to
a exact cyclic pattern, the sound must be per-
fectly “on the beat.”

In the following exercise, the drum beat is fairly
regular, but, in most cases, you should avoid
cyclic animation patterns when you’re trying to
sync animation to pre-existing sound. The pref-
erable method is to make copies of the key pat-
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terns to create the regular pattern. You can then
adjust every key necessary to perfectly sync the
sound.

Here’s another concept to think about. Through
everything you’ve done, Snap Frames  has
been active in the Track View. This means that,
when you drag or scale key dots, they always
snap to the frame.

In 3DS MAX, you can work in time increments
as small as 1/4800th of a frame. When you scale
a set of key dots with Snap Frames active, the
key dots snap to whole frames, which means
that, in the scaled result, the key dots usually
will not maintain their original relative posi-
tions.

In the following steps, you’ll turn off Snap
Frames for two reasons. First, you want to accu-
rately position the wave form to start at frame 0.
You don’t want it snapping to whole frames.
Second, you need to scale the pattern of the
Position and Scale key dots to match the visual
profile of the wave forms, which don’t fall on
whole frames.

Synchronize the animation to the sound:

1.  In the Track View toolbar, turn off Snap
Frames.

2.  Use Zoom Region to zoom in on the pat-
tern of key dots in the Position and Scale
tracks.

3. Right-click to exit Zoom Region mode, and
return to Move Keys mode.

4. Drag the Sound track range bar slightly to the
left, so that the first beat in the wave form is
aligned with frame 0.

5. Drag the right end of the Ball’s Transform
range bar leftward, until it aligns with the
beginning of the second beat, just past
frame 15.

The key dot pattern for the position and scale
of the ball is scaled down to cover the range
of the sound’s beat.

6. Play the animation.

With some luck, the ball bounces in time to
the beat.

Here’s where you run into the situation dis-
cussed earlier. Because of the cyclic regularity of
the animation, it takes a certain amount of trial
and error to get a cyclic animation in sync with
a sound file. You might have to repeat steps 5

alignment at frame 0
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and 6 several times before you get what you
want.

Tip: You can display the wave forms in the
Function Curve display by selecting the Wave-
form track text label. This lets you superimpose
the cyclic animation curves over the wave
forms. Although you can’t scale the range bars
in the Function Curve display, you can open a
second Track View and adjust the range bars in
the second Track View while observing their
effect in the Function Curve display of the first
Track View.

Editing the Path
The nice thing about Path controllers is that you
can easily change your motion path by simply
editing the shape spline.

Edit the shape path:

1. Stop the playback, and close the Track View.

2.  Click Select and Move in the toolbar.

3. Select the shape path.

4. In the Modify command panel, apply an Edit
Spline modifier.

5. Make sure the Sub-Object button is on, and
that Vertex appears in the list to its right.

6. Using the Select and Move tool, select and
move vertices in the shape. Increase the over-
all length of the shape, and change the eleva-
tion of some of the vertices.

7. Play the animation.

The ball bounces along the altered path, still
in sync with the drum beat.
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Morphing 2

Morphing is a term derived from metamorphosis,
which means to change physical shape or form.

The purpose of the morph object is to create an
animated object that changes shape by morphing
between two or more objects. Although it
appears that a single object is changing form, in
reality the morphing process translates the posi-
tion of the vertices from their arrangement in
one object to the arrangement in another—rela-
tive to their local coordinate system.

All objects chosen to make up a morph object
must have the same number of vertices. Typi-
cally, you achieve this by cloning an object, and
then altering the geometry of the clones with-
out changing their vertex count. You can also
create loft objects that have the same number of
vertices, but very different forms.

You can check the number of vertices in an
object by right-clicking the selected object, and
choosing Properties from the menu. The Object
Properties dialog displays the number of vertices
and faces in the object.

Animating a Sneeze
You’ll create your first morph object by mor-
phing between five faces that have been mod-
eled to form the facial expressions in a sneeze.

Load the sample file:

1. Choose File>Open, and load tut16_1.max.

The viewport shows five similar faces, each
with a slightly different expression.

2. Select each of the faces, from front to back,
and observe their names in the object name
field of the command panel.

From front to back, the names are:

• face

• twitch1

• twitch2

• ahhh

• chooo

To create a morph object, you first decide which
of the objects will be your morph object, and
which will be added to create the morph.
Because the animation usually begins with the
form of the morph object and changes to the
form of the added objects, you typically select
the object that displays the form you want at
the beginning of your animation.

Note: Keep in mind that the object you select as
your morph object will be permanently altered.
If you plan on using the original object for
something else in the future, make a copy of it
first.
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Begin the creation of a morph object:

1. Select the face object closest to the front
(named face).

2.  Make sure Geometry is selected in the
Create command panel.

3. Choose Compound Objects from the list.

The Morph button appears. If at least one
other object in the scene does not have the
same vertex count as the selected object, the
Morph button is not active.

4. Click the Morph button.

Controls appear in the panel below.

Note: The moment you click the Morph button,
you convert the selected object into a morph
object, regardless of what you do next. The only
way to restore the original object at this point, is
to click Undo.

You use morphing controls to select the target
object that you want your selected object to
morph to. Keep in mind that you’re not chang-
ing the current object into the target object,
you’re merely moving its vertices so they’re in
the same position as the target object—relative
to each object’s local axis.

To create a morph you move to the frame at
which you want the completed form of the tar-
get object to appear, and then select a target
object. (There’s no need to turn on the Animate
button, because you’re creating the animation
by setting morph objects rather than applying
transforms or parametric value changes.)

You have a choice as to what happens to the tar-
gets you select. You can move them into the
morph object, in which case, they’re no longer
available in the scene, or you can copy or
instance them. In this case, it might be handy to
leave the originals in the scene so you can see
their expressions.

Morph the face using copies of the targets:

1. Choose Copy in the Pick Targets rollout.

2. Go to frame 20.

3. Click Pick Target

4. Click the second face object in the line (the
gold face).

The front face changes, taking on the form of
the second face.

5. Go to frame 40, and click the third face.

The front face takes on the form of the third
face.

6. Go to frame 60, and click the fourth face.

7. Go to frame 80, and click the fifth face.

In some cases, your original geometry might no
longer exist in the animation. For example, if
you’d used the Move option, the other four
faces would now be gone.

Each object that you add to a morph object is
listed in the Morph Targets window with M_ (for
Morph) prefacing the original object name.
Once you’ve added a target object to the morph
object, you can create morph keys by selecting a
target in the list, and then clicking the Create
Morph Key button.

You’ll use this technique to return the face to its
original state at the end of the animation.
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Use the Morph Targets window:

1. Go to frame 100.

2. In the Morph Targets window, select M_face.

3. Click Create Morph Key.

The front face returns to its original form.

4. Choose Rendering>Make Preview to create a
preview of the animation.

The face in the front of the line twitches, and
then sneezes.

Looking at the Morph Keys
Each target object that you assign creates a
morph key, which you can access in the Track
View.

Open the Track View:

1.  Click Track View to display the Track
View dialog.

2. Expand Objects, and then expand the face
object in the Hierarchy list.

The face object has a sub-category called
Object (Morph).

3. Expand Object (Morph).

A Morph track appears containing keys for
each of the morph targets.

By changing the position of the keys, you can
change the timing of the sneeze. For example,
you can prolong the period of the “ahhh” por-
tion of the sneeze by simply moving a key dot.

Alter the sneeze:

1. Drag the time slider to find the position at
which the mouth is wide open, and then

locate the corresponding key dot in the
Morph track.

On frame 60, the mouth is opened widest.

2. Select the fourth and fifth key dots, and move
them forward about 10 frames.

3.  Exit the Track View dialog.

4. Choose Rendering>Make Preview to create a
preview of the animation.

The mouth opens wide a bit longer, and the
end sneeze is more abrupt at the end.

Morphing with Affect Region
At times, morphing provides animation capabil-
ity otherwise lacking in a function.

The Affect Region function in the Edit Mesh
modifier lets you push and pull vertices like
taffy. That is, you can pull a vertex, and a region
of vertices follows, letting you create bulges and
dimples in your geometry.

Although you can animate vertices by using the
Xform modifier, the Affect Region influence
remains in the Stack with the Edit Mesh modi-
fier, and cannot be directly animated. This is
where morphing comes in.

You can create duplicate objects with identical
vertices, use Affect Region to change their geom-
etry, and then create a morph object to animate
the Affect Region effect.

The scene in the following exercise contains
three identical spheres that were cloned with
the copy option.

Load the spheres, and then edit their vertices:

1. Choose File>Open, and load tut16_2.max.

Three spheres appear.
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2. Select the middle sphere (Sphere02).

3. Open the Modify command panel, and apply
an Edit Mesh modifier.

The vertices of the sphere turn white.

4.  Click Select and Move.

5. Set the transform coordinate system to Local.

6. Click the Z axis constraint button.

You’re now set to move the vertices along their
local Z axis. This will move them to or from
their surface normals.

Set up, and use Affect Region:

1. On the Edit Vertex rollout, check Affect
Region in the Modify command panel.

2. Click Edit Curve.

The Edit Affect Region Curve dialog appears.

3. Set the Bubble spinner to 1 to create a smooth
curve.

4. Click OK.

5. In the Perspective viewport, click to select a
vertex, and then drag it outward from the sur-
face of the sphere.

The vertex and the surrounding vertices move
outward, creating a bulge.

6. Repeat step 5 with several other vertices on
various surfaces of the sphere—creating both
dimples and bulges, until you have an inter-
esting form.

Now that you’ve created a monster, you can
repeat the process on another sphere.

Use Affect Region on the third sphere:

1. Turn off the Sub-Object button so you can
select a different object.

2. Select the third sphere (Sphere03).

3. Apply Edit Mesh.

4. Drag some vertices to create bulges and dim-
ples in different areas of the sphere.

5. Turn off the Sub-Object button.
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You’re ready to morph. You have three objects
with the same number of vertices, but different
forms. This time, you’ll move the target objects
into the morph object so that you end up with
a single object in the scene.

Create a morph object:

1.  Maximize the Perspective viewport.

2. Select the sphere on the left (Sphere01).

3. On the Create panel, select Compound
Objects from the list, then click the Morph
button.

4. Select Move.

5. Click Pick Target.

6. Go to Frame 30.

7. Click Sphere02.

The first sphere now looks like the second,
and the second sphere is gone.

8. Move to frame 60, and select Sphere 03.

A single object remains, and the Morph Tar-
gets window lists three targets.

9.  Click Zoom Extents.

Now, you can alter the morphing animation on
the fly by simply moving to different frames,
and assigning morph keys to different targets.

Create additional morph keys:

1. Go to frame 100.

2. Choose M_Sphere01 in the Morph Targets
window.

3. Click Create Morph Key.

The original sphere shape returns.

4. Move to frame 40, and click Create Morph
Key.

5. Move to frame 80, choose M_Sphere02, and
click Create Morph Key.

6. Move to frame 15, choose M_Sphere03, and
click Create Morph Key.

Now that you’ve created a morphing master-
piece, you can view the results in a preview.

Create a preview:

• Choose Rendering>Make Preview and create a
preview of the animation.

The sphere bulges and pulses and dimples.
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Morphing Loft Objects
You can directly animate several components of
loft objects. They include the vertices of the
deformation curves, the creation parameters of
the shapes that make up the loft object, and the
vertices of the path and cross-sectional shapes
(using an Xform modifier).

You cannot directly animate the Bezier values of
the shapes or deformation curves, or the trans-
formations of the cross-sectional shapes relative
to the path. To do this, you create a morph
object from two or more loft objects.

To insure that loft objects have the same num-
ber of vertices, check the following for each
morph target:

• Each path shape must have the same number
of vertices.

• All cross-sectional shapes in all loft objects
must have the same number of vertices.

• Capping must be set to Morph (instead of
Grid).

• Optimize Shapes must be off.

• Adaptive Path Steps must be off.

• The Shape Steps value must be the same for
each loft object.

• The Path Steps value must be the same.

It’s possible to break some of these rules and still
produce loft objects with the same number of
vertices. If you’re uncertain, choose File>Sum-
mary Info to see the number of vertices for each
object in your scene.

In the following procedure, you’ll create a loft
object, make morph targets, and then create a
morph animation.

Create the shapes:

1. Reset 3DS MAX.

2. Turn on Smooth + Highlight in the Perspec-
tive viewport.

3.  Turn on 2D Snap Toggle.

4.  Click Shapes in the Create command
panel, and click Line.

5. Click in the center of the Front viewport,
move the mouse straight up about 100 units,
and click again to set a second vertex. Right
click to create a line.

6. Click N-Gon.

7. In the Top viewport, create an n-gon that’s 30
units in radius.

8. Create a second n-gon that’s 20 units in
radius.

9. Check Circular.

10.  Turn off 2D Snap Toggle.

You now have a line, and two n-gons. The
smaller is circular, the larger is linear.
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The n-gons will be the cross-section shapes.
Note that both have the same number of verti-
ces.

Create the loft object:

1. In the Geometry branch of the Create com-
mand panel, open the list, and choose Loft
Object.

2. Select the line.

3. Click Loft, and then click Get Shape.

4. Click the circular n-gon.

A cylindrical loft object appears.

5. Check On in the Path Parameters rollout.

6. Set the Path spinner to 10.

7. Click the linear n-gon.

The sides of the object go from circular to fac-
eted.

8. Set the Path spinner to 100.

9. Click the circular n-gon.

The end of the object returns to circular.

Before cloning the loft object, adjust the skin
parameters.

Adjust the skin parameters:

1. Open the Modify command panel.

2. Open the Skin Parameters rollout.

3. Under Display, check Skin so you can see the
geometry.

Toward the front of the path, the geometry is
more complex.

4. Uncheck Adaptive Path Steps.

The geometry is now uniform along the path.
In the shaded viewport, the surface over the

larger n-gon is not as well defined because it’s
not supported by as many faces.

5. Under Options, increase the Path Steps to 15.

The increased number of cross sections
improve the definition of the surface.

Optimize Shapes is unchecked, and Capping is
already set to Morph, so you don’t have to
change those settings.

To create a morph target, you’ll clone the loft
object. This ensures that the number of path
and shape steps remains the same between each
object.

Create a second loft object:

1.  Using Select and Move, hold SHIFT and
drag the loft object to the right in the Front
viewport.

2. Choose Copy, and then click OK.

3.  Click Zoom Extents All, when necessary,
to view all of the objects.

You’ll adjust the loft parameters of each object
as you create it.
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Change the second loft object:

1. Uncheck Skin in the Skin Parameters rollout.

The Skin options is for display purposes only.
Since it doesn’t affect the geometry, it won’t
affect the number of vertices in the loft
objects.

2. Turn on Sub-Object to access the Shape selec-
tion level.

3. Select the linear n-gon shape at level 10 of the
path.

4. Set the Path Level spinner to 50 to move the
shape halfway along the path.

5.  Using Select and Rotate with the Z axis
constraint, rotate the shape about 60 degrees.

Create a third loft object, and alter it:

1. Turn off the Sub-Object button.

2.  Using Select and Move, hold SHIFT and
drag the second loft object to the right.

3. Choose Copy, and click OK.

4. Turn on Sub-Object, and click the linear n-
gon shape.

5. Set the Path Level spinner to 80.

6.  Use Select and Rotate to rotate the shape
another 60 degrees.

You can also use morphing to animate changes
in Bezier values.

Make yet another loft object, and change the
path curvature.

Create a fourth loft object, and edit it:

1. Turn off the Sub-Object button.

2.  Using Select and Move, hold SHIFT and
drag the third loft object to the right.

3. Choose Copy, and click OK.

4. Turn on Sub-Object, and choose the Path
selection level.

5. Choose Line in the Stack list.

6. Apply an Edit Spline modifier.

7.  Use Region Zoom in the Front viewport to
zoom in on the fourth loft object.

8. Right-click the top vertex in the path, and
choose Bezier.

9.  Using Select and Move with XY axis con-
straints, adjust the vertex handles to curve
the path.

10.Choose File>Save, and save the file as
mytut16a.max.

In this last procedure, had you added vertices to
the path, the last object would no longer be a
valid morph target.
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Now that you have four loft objects with the
same number of vertices, you can create your
morph animation.

Create the morph object:

1. Turn off Sub-Object, and select the first loft
object.

2. In the Geometry branch of the Create com-
mand panel, open the list, and choose Com-
pound Objects.

3. Click Morph, make sure Instance is chosen,
and click Pick Target.

4. Move to frame 20, and click the second loft
object.

The first loft object changes shape.

5. Move to frame 40, and click the third loft
object.

6. Move to frame 60, and click the fourth loft
object.

7. Use the Morph Targets list and the Create
Morph Key button to create any morph com-
bination you want at any frame.

8. Zoom in on the morph object in the Perspec-
tive view, and then use Rendering>Make Pre-
view to create a preview animation.

Tip: To make your morphing loft object more
interesting, assign a mapped material. You can
turn on the mapping coordinates for the loft
object by accessing the original loft creation
parameters in the Modifier Stack list, and then
checking Apply Mapping in the Surface Parame-
ters rollout.
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Tutorial

This tutorial presents two major concepts in
3DS MAX animation:

• Function Curves

• Animation Controllers

Function curves appear in the Track View, and
provide the best method of viewing and editing
animation tracks. With the function curve dis-
play, you can actually see the animation values
as they change over time.

Animation controllers are the plug-ins that
make everything move in 3DS MAX. They’re
automatically assigned to everything you ani-
mate. You’ll go behind the scenes in this tuto-
rial, and see what makes them tick.

Animation Using
Curves and Controllers
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Function Curves 2

Function curves are editable splines that repre-
sent animation values in a line-graph format.
They provide a valuable way of both visualizing
and editing your animation tracks. You used
function curves in Tutorial 9, “Bouncing a Ball.”
Here, you’ll go into greater detail.

You can display function curves for most of the
parameters that can be animated in 3DS MAX.
To keep things simple, this tutorial concentrates
on a single object and its Position track.

Making a Pyramid
In the following steps, you’ll construct a Cone
primitive so it looks like a four-sided, flat pyra-
mid. While you’re at it, you can try out the key-
board entry system in 3DS MAX.

Set things up for a four-sided cone:

1.  In the Create command panel, under
Geometry, click the Cone button.

2. On the Parameters rollout, set Height seg-
ments to 1 and Sides to 4.

3. Uncheck Smooth.

Use Keyboard Entry to create the cone:

1. Open the Keyboard Entry rollout.

The first three fields place the cone in world
X, Y, Z coordinates. You can leave them at
zero to create the cone at the origin of world
space.

2. Set Radius 1 to 30.

3. Set Radius 2 to 10.

4. Set Height to 50.

5. Click the Create button.

A four-sided, flat-top pyramid appears in the
center of the ground plane.

Viewing the Trajectory
Whenever an object moves through world
space, you can view its trajectory. A trajectory is
the visible path the object makes because of its
movement. A real-world example of this might
be the colorful smoke trail left by a stunt plane.

You can toggle the trajectory display of any
object in the Display branch.

Turn on the Trajectory display for the cone:

1.  In the Display command panel, on the
Display Properties rollout, select Trajectory.

2. Turn on the Animate button, and go to
frame 30.
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3.  Using Select and Move in the Perspective
viewport, drag the pyramid to the right-front
corner of the ground plane.

A line appears, displaying the trajectory of the
motion. Small white boxes, indicating the
Position keys, are at the start of the line, and
the current position of the pyramid.

4. Go to frame 60, and drag the pyramid to the
left side of the viewport.

The trajectory line curves through the white
key square representing frame 30.

5. Go to frame 80, and drag the pyramid toward
the back and left, so it’s in the upper-left cor-
erof the Top viewport.

6. Go to frame 100, and drag the pyramid to the
right side of the ground plane.

7. Turn off the Animate button.

8. Play, and then stop the animation.

The pyramid moves in a smooth sweep along
its trajectory.

The trajectory display is not necessary for func-
tion curve editing, but it helps you to see what’s
happening with the position of the object.

frame 30

frame 60

frame 80 frame 100
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Viewing the Position Function Curve
Now, go into the Track View and examine the
function curves for the Position track.

Use Swap Layouts to display the Track View:

1. Right-click the Perspective viewport label,
and choose Swap Layouts.

The Track View appears in a wide viewport
over two smaller Top and Perspective view-
ports.

2. Turn on Smooth + Highlights in the Perspec-
tive viewport.

3. In the hierarchy list, expand Objects, Cone-
01, and Transform to view the Position track.

In Edit Keys display, you can see the five key
dots representing each of the Position keys.

4.  Click Function Curves in the Track View
toolbar.

A blank function curve Edit window appears.

The Edit window for function curves is different
than the other Track View displays, which show
horizontal rows corresponding to each track
label in the hierarchy list. When you display
function curves, the entire Edit window is used.
You must select a track’s text label in order to
display the function curves for that track.

Display the Position function curve:

1. Click to highlight the Position text label in
the hierarchy list.

Colored lines appear in the function curve
window.

You display function curves by selecting their
track. Try the following:

2. Click the Rotation text label.

The curves disappear, because no animation
yet exists for rotation.

3. Click the Position label again.

The Position curves reappear.

You can display key dots in function curves, as
well as in the key editing displays. In function
curves, the key dots appear as small, black
squares. The two ways to turn on their display
are to click the green icon beside the track label,
or to click the function curve itself.

Display key dots in the function curves:

1. Click the green arrow beside Position.

Key dots appear on the curves.
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2. Click anywhere in the Edit window outside of
the curves to make the key dots disappear,
and then click any one of the curves to make
the key dots reappear.

Editing the Curves
Function curves are like line charts that repre-
sent the animation values by their vertical posi-
tion in the Edit window. Time, as usual, is repre-
sented horizontally.

In this example, the red, green, and blue lines
represent the position of the pyramid in world
coordinates along the X, Y, and Z axes, respec-
tively. In other words, red is X, green is Y, and
blue is Z. Since there’s been no movement of the
pyramid along the Z axis (above or below the
ground plane), the blue line is flat along the zero
value in the Edit window.

There are two basic ways to edit function curves.
You can either change the position of the key
dots, thereby altering the curve, or you can edit
the tangents and the values of the keys them-
selves. You’ll look at both of these, but first,
store your current scene on disk.

Save the scene:

1. Choose File>Save As and save this scene as
mytut17.max. You return to this scene in a
future exercise.

2. Choose Edit>Hold, so you can quickly return
to this point should you need to.

While editing the function curves in the follow-
ing steps, feel free to drag the time slider, or play
the animation to see the effect of your editing.
If you drag the time slider so your current frame
corresponds with the key dot you’re editing,
you’ll see the effect on the object itself at that
point in time.

Drag a key dot:

1. Click the black key dot on the red line at
frame 30 of the function curve.

The key dot turns white to indicate that it’s
selected. At the same time, the corresponding
square in the trajectory turns gray. The key’s
current frame and its value appear in the two
fields at the bottom of the Track View.
Remember, the red line represents the X axis,
so the value is the position, in units, along the
X axis at this frame.

2. Look at the trajectory in the viewports, and
then drag the dot up to around 100.

When you release the mouse, the correspond-
ing square in the trajectory moves to the right
along the X axis. (If the time slider is near
frame 30, the pyramid moves as well.)

3. Drag the same dot downward.

The gray square in the trajectory moves to the
left.

4. Select the key dot in the green (Y axis) line at
frame 30.

5. Drag the dot up and down, releasing the
mouse with each drag.

The red trajectory square moves in and out
along the Y axis.

6. Drag the dot horizontally in the Edit window.

click this key dot
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All three X, Y, and Z dots move at the same
time. The curvature of the trajectory changes
on either side of the white square, but the
square itself does not move.

Because each of these function curves represents
one-third of the Position track (the X, Y, and Z
axes), you can alter an individual key’s value by
dragging it vertically, but if you alter its place in
time, then the remaining two keys must coin-
cide.

The two numeric fields at the bottom of the
Track View display key dot values. Use them to
precisely enter your own values.

Use the statistics fields:

1. Type 30 in the current frame field (the left
field) in the Track View, and then press ENTER.

The three dots move to frame 30.

2. Type –100 in the value field to the right of the
current frame field, and press ENTER.

The Y key value is now exactly –100 units, so
the trajectory position of the pyramid at
frame 30 is exactly 100 units forward of its
original position.

You can display the statistics for any key right
beside the key dot itself.

Display the Key Statistics:

1.  Turn on Show Selected Key Stats, to the
right of the two numeric fields.

The current frame and value appear beside
the selected Y key dot.

2. Select the Z key dot at frame 60 (the third dot
from the left, in the blue line).

3. Drag the dot upward.

As you drag the dot, the current frame and
current value numbers change both in the

fields and in the display beside the key dot.
When you release the dot, the trajectory
curves above the ground plane.

4. Type 60 in the current frame field, and 0 in
the value field, and then press ENTER.

The Z key dot returns to its original position.

Moving Trajectory Keys
You can directly adjust the trajectory using tools
in the Motion command panel.

Adjust the trajectory:

1.  In the Motion panel, click Trajectories.

2. Click Sub-Object.

Keys becomes active in the Sub-Object list.

3.  Using Select and Move in the Top view-
port, drag one of the white squares.

The trajectory moves. In the function curve,
all three key dots at the specific key frame
become selected, and their values change.
(The Z value doesn’t change because you’re
not changing the Z position from the Top
viewport.)
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Accessing Key
Information 2

Additional controls are available for each key
frame. You can get to these controls in several
ways. First, you’ll look at the Key Info display in
the Track View.

You access the Key Info dialog either by select-
ing a key dot in a function curve and clicking
the Properties button  in the Track View
toolbar, or by simply right-clicking a key itself.
The fastest and simplest approach is often the
best.

Access the Key Info dialog:

• Right-click any of the key dots at frame 30 of
the function curves.

The Key Info dialog appears, displaying the
name of the object and track in its title bar:
Cone01\Position.

Although you clicked a single key dot, the Key
Info dialog represents all three key values at the
current frame for the current track. (Your values
will be different than those in the illustration.)
Each track can have a separate Key Info dialog.

From here, you can easily move to the other
keys in time.

Adjust the Key Info controls:

1. Click the left and right arrows in the upper-
left corner of the Key Info dialog.

The arrows let you step through the key posi-
tions, from key 1 at frame 0, to key 5 at frame

100. The selection of key dots and trajectory
squares changes, and the values in the X, Y,
and Z spinner fields change as well.

2. Use the arrows to move to key 2 at time 30.

3. Adjust the Time spinner in the Key Info dia-
log, leaving it at frame 30 when you’re fin-
ished.

Adjusting the spinner changes the position of
the keys in time.

4. Adjust the three X, Y, and Z spinners, right-
clicking to cancel, each time.

Adjusting the spinners is the equivalent of
dragging the key dots vertically. They let you
input precise axis values.

Note: Since the Z axis begins at a value of 0,
you might want to hold CTRL while you drag
the spinner. (CTRL magnifies the effect of the
mouse on a spinner, while ALT reduces the
effect of the mouse.)

Key Info in the Motion Command Panel
If you’re dealing with transform keys, you can
access the same key info controls in the com-
mand panel.

Access the motion parameters:

1. Click Parameters in the Motion command
panel.

In the Key Info (Basic) rollout, you can see the
same controls as in the Key Info dialog, but if
the time slider is not on a key frame, most of
them are disabled.

2. Drag the time slider to frame 30.

3. The controls in the command panel become
enabled when you reach the key frame.
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The Motion command panel is dedicated solely
to transforms (move, rotate, and scale). If you
need fast access to a transform key, you can get
it here without opening the Track View.

3DS MAX has a few tricks to help you find key
frames.

View and locate keyed frames:

1. While watching the Top viewport, drag the
time slider slowly through the key frames 30,
60, and 80.

In wireframe viewport displays, white brack-
ets appear around selected objects on frames
in which those objects contain transform
keys.

You can jump directly to transforms key
frames.

2.  Click Time Configuration in the time
controls section.

The Time Configuration dialog appears.

In the Key Steps area at the bottom of the dia-
log, you can choose to have Key Mode work

only when an object is selected, and only
when one of the three transform buttons is
active in the toolbar. Set it so it works for all
transform keys for the selected object.

3. Uncheck Use Current Transform.

Check boxes for the three transform types are
enabled. By leaving each of them checked,
Key Mode will step through each of the trans-
form key frames for the currently selected
object.

4. Click OK.

5.  Turn on Key Mode Toggle.

6.  Click Next Key several times.

The pyramid jumps to each of the key frames.

There’s yet another way to move to key frames,
and it’s available in the Motion command
panel.

Use the Motion Command panel:

1. Drag the time slider to any frame that’s not a
key frame.

Most of the controls in the Key Info (Basic)
rollout are disabled.

2. In the Key Info (Basic) rollout of the Motion
command panel, click either the left or right
key number arrow.

The Time slider jumps to the specified key
frame (as does the pyramid), and the rest of
the controls are enabled.

Although the controls appear to be the same in
both the Key Info rollout of the Motion com-
mand panel and the Key Info dialog of the Track
View, keep in mind these differences:

• In the Motion Control panel, the Key Info
rollout affects the current key frame you’re on
and the currently selected object.
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• In the Track View Key Info dialog, the con-
trols affect the currently selected keys for a
specific track.

Tangent Types
A tangent is the meeting of a curve at a point in
the curve. This is the case with each key-dot
point along the function curves. As a default,
3DS MAX assigns smooth tangents to the keys
in a Position function curve. This is the reason
that the pyramid moves in smooth curves
through the key frames.

The two large flyout buttons at the bottom of
the Key Info panel provide five different types of
predefined tangent types, plus a sixth type that
lets you create your own custom tangents.

If you look at a single key dot and the line run-
ning through it, the line on the left side of the
key dot is the incoming tangent, and the line on
the right is the outgoing tangent. Using the tan-
gent flyout buttons, you can assign a different
tangent type to the incoming and the outgoing
lines for each key dot. The button on the left
assigns the incoming tangent at the left side of
the selected key dot, and the button on the right
assigns the outgoing tangent on the right side of
the selected key dot.

Restore the scene:

1. Choose Edit>Fetch, and answer Yes.

2. Expand the Hierarchy to view the Position
track for Cone01.

3.  Click Function Curves to display the
function curve window.

4. Click the Position label to display the curve.

Assign a Fast-In tangent:

1. Click one of the function curves to display its
key dots.

2. Right-click any of the key dots at frame 30 to
display the Key Info dialog.

The tangent types are applied to the X, Y, and
Z curves at a frame, regardless of which of the
three dots are selected.

3.  Open the In tangent flyout button,
and select Fast.

The curves change in the red and green lines
to the left of the key dots.

The tilt of the new tangent on the left of the key
dots only slightly affects the outgoing tangents
on the right. Notice also that the outgoing lines
leading from the frame 0 keys are not affected
because they have a different tangent. The blue
Z line shows no change because it’s at zero.

If you wanted to apply this same tangent type to
the outgoing side of the key dot, you could select
it from the Out flyout button. But there’s a
shortcut you can use when you copy a tangent.

The arrow buttons on the side of the flyout but-
tons copy the tangent type to the right or the
left. For example, the button at the left of the In
tangent flyout, would copy that tangent to the
outgoing side of the previous key dot.

In: Out:

incoming
tangent

outgoing
tangent
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Copy the In tangent to the Out tangent:

1.  Click the arrow button on the right side of
the In flyout button.

The Out flyout now has the same tangent
type as the In flyout.

Now that Fast is duplicated on both sides of
the key dots, the tangents come to a point,
which you can see in both the function
curves, and in the trajectory.

2. Drag the time slider to see the effect on the
pyramid’s motion.

The pyramid moves smoothly until it reaches
frame 30, at which point it jerks around a cor-
ner.

Using Custom Tangents
Here, you’ll look at the Custom tangent type
that lets you adjust your function curves using
handles.

First, restore the default smooth tangents. You
can use the same technique you used in the pre-
vious steps.

Restore the smooth tangents:

1. Make sure the key dots at frame 30 are still
selected.

2. Open the In tangent flyout, and click
the Smooth tangent.

3.  Click the arrow button on the right side of
the In tangent button.

The function curves are restored to their
smooth curvature.

Assign a custom tangent:

•  Open the In tangent flyout, and click
the Custom tangent.

Tangent handles appear at the selected key
dot. (If more than one key dot at that frame is
selected, handles appear there as well.)

Although you assigned a Custom tangent type
to only the In button, the Out button was
changed as well. This is because, when you use
custom tangents, you usually want handles on
both sides of the key dot. The rule is, if both tan-
gent sides are Smooth, they both change to Cus-
tom. If either side is something other than
Smooth, you can apply Custom to either side.

Now that you have handles, you can adjust your
curves.

Adjust the custom handles:

1. Make sure the key dot in the red function
curve at frame 30 is selected.

2. Drag either of the Bezier tangent handles (the
tiny black squares) to rotate the tangent.

Rotating the tangent alters the curvature of
the function curve on either side of the key
dot. In addition, it alters the trajectory in the
viewports.
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Because the function curves represent 3D spa-
cial values, the rotation of the handles is limited
to less than 90 degrees.

Rotate the X tangent to the extreme:

1. Rotate the X tangent as far as you can toward
the vertical.

2.  Click Zoom Extents, while the Perspec-
tive viewport is active.

3.  Click Zoom Value Extents in the Track
View, and rotate the X tangent even more
toward the vertical.

4.  Apply Zoom Extents again to the Perspec-
tive viewport.

The trajectory is flying way off in both direc-
tions along the X axis.

A perfectly vertical tangent handle would
make the trajectory infinitely wide. This is
why their adjustment is limited.

5. Return the X tangent to a nearly horizontal
position while alternately using the Zoom
Value Extents  and Zoom Extents  but-
tons to restore the previous view of the scene
and function curves.

Breaking the Tangents
Right now, the Bezier handles are locked, so that
adjusting one handle affects the other. You can
break the handles to apply separate custom
curves to either incoming or outgoing sides of
the tangent.

Break the tangents:

1. Hold SHIFT, drag the incoming handle, and
then release the mouse.

The incoming handle rotates, leaving the out-
going handle behind. The tangent is now
“broken.”

2. Alternately drag one, and then the other han-
dle.

The incoming and outgoing handles are com-
pletely independent, and can create sharp
corners in the curve.

You can lock the two tangent handles at any
angle. There are two places to apply the lock.
One is a global lock tool in the Track View tool-
bar. The other is the local tangent lock in the
Key Info dialog.

Apply the global tangent lock:

1.  Turn on Lock Tangents in the Track View
toolbar.

2. Drag either handle.

Although the tangents are broken, their cur-
rent angle relative to each other is locked. In
addition, if more than one key dot is selected,
all tangents are locked and equally affected.

3.  Turn off Lock Tangents.

The other method of locking the tangents is the
local tangent lock.

Apply the local tangent lock:

1. Click the Advanced button in the Key Info
dialog.

The dialog expands to display additional con-
trols.
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The In and Out spinners provide another way
to adjust the rotation of the tangent handles.

2. Drag the X/In spinner up and down, and then
adjust the X/Out spinner.

As you adjust the spinners the corresponding
tangent handles rotate.

3.  Click the Lock button between the X In
and Out spinners, and then adjust either X
spinner.

4. Drag the tangent handles in the Edit window.

The angle of the tangent handles is locked.

When you lock the tangents using the Key Info
controls, they remain locked until you either
unlock them in the same way, or assign different
tangent types.

Note: The In/Out spinners in the Advanced sec-
tion of the Key Info dialog are only enabled
when the selected key dot contains custom tan-
gent types.
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Using Animation
Controllers 2

Animation controllers are core component
plug-ins that determine how an animation
parameter is interpolated over time.

3D Studio MAX assigns default transform con-
trollers as soon as you create an object. It assigns
additional controllers for animated parameters,
and so on when you first animate those param-
eters.

In this exercise, you’ll learn how to assign differ-
ent controllers.

Restore the pyramid animation:

1. Use Files>Open to reload mytut17.max, the
pyramid scene you created in the last exercise.
(If you’re coming directly from the previous
exercise, you can choose Edit>Fetch, instead.)

The pyramid appears, along with the Track
View in the horizontal viewport. The position
trajectory is visible in the Perspective and the
Top viewports.

2. Expand the hierarchy to view the Position
track.

3.  Click Function Curves to display the
function curve window.

4.  Click the Position label to display its curve.

5. Play, and then stop the animation.

The pyramid follows its curved trajectory.

Perhaps you don’t want the smooth trajectory
assigned by the default Position controller.
You’ve got something more mechanical in
mind, and you want straight lines between each
of the key frames.

You could edit the tangent curves for each of the
keys, using linear tangent types, but then every
time you added a new Position key, a smooth
tangent would be assigned by the default con-

troller. You want all of your Position keys to be
linear, so you assign a Linear Position controller.

First, look at the controllers that are already
assigned, and then see how to change one of
them.

Display the controllers:

1.  Right-click Filters in the Track View tool-
bar, and choose Controller Types.

The names of the assigned controllers appear
to the right of each track label.

2. Point the mouse at the vertical line dividing
the Hierarchy from the Edit window (so the
double-arrow cursor appears), and then drag
to the right to widen the hierarchy list so you
can see the controller labels.

Each of the green arrow icons in the hierarchy
list represents a track with a controller. Cur-
rently, you can see that the Transform track con-
tains its own controller (consisting of Position,
Rotation, and Scale). In addition, each of the
transform tracks is assigned a controller.

The Position track has a Bezier Position control-
ler. This is the default controller that provides
smooth, rounded trajectories.

To change a controller, you simply select a track
containing a controller, and then click the
Assign Controller button.

Assign a Linear Position controller:

1. Make sure the Position text label is high-
lighted.

2.  Click Assign Controller.
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The Assign Position Controller dialog
appears.

The dialog lists all controllers that are avail-
able to be assigned to a Position track.
Because all controllers are plug-ins, there
might be more than are shown in the preced-
ing illustration.

3. Choose Linear Position from the list, and
then click OK.

All segments of the function curves become
linear, as do the segments of the trajectory.

4. Play, and then stop the animation.

The pyramid moves in a mechanical fashion,
from key frame to key frame.

5. Click one of the curves in the Track View to
display the key dots.

6. Turn on the Animate button, go to frame 70,
and move the pyramid anywhere along the
ground plane.

A new key is created, which is as linear as all
the others.

7. Turn off the Animate button.

What Happened to Key Info?
The animation controller provides the controls
you use to adjust the key values. In the case of
the default Bezier Position controller, this
includes the tangent types, the custom tangent
handles, and all of the other Key Info controls.

The Linear Position controller is much simpler.
It provides no extra controls at all.

1. Right-click any key dot in the function
curves.

Nothing happens. No Key Info dialog
appears.

2. Open the Motion command panel, and click
Parameters (if it’s not already selected).

3. Go to any key frame, and examine the
Motion command panel.

There are no controls beneath the Position,
Rotation, and Scale buttons.

When you assign a Linear Position controller,
you can only move the object and adjust the key
dots in the function curves.

Using a TCB Controller
Take a look at another type of controller. It’s
called a TCB Position controller because it pro-
vides Tension, Continuity, and Bias controls of
the splines.

Assign a TCB controller:

1. Make sure the Position text label is high-
lighted.

2.  Click Assign Controller.

3. Select TCB Position, and click OK.

The function curves are smooth and rounded
again.

4. Click a curve to display the key dots.
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5. Right-click any key dot at frame 30.

A different Key Info dialog appears.

This controller doesn’t have tangent types.
Instead, it lets you edit the splines by adjusting
Tension, Continuity and Bias spinners.

Try out the TCB controls:

1. Set the Tension, Continuity, and Bias spinners
to various values.

The spline window in the Key Info dialog
shows you the effect of your changes. At the
same time, the function curves, and the tra-
jectory path change accordingly.

2. Adjust the Ease To and Ease From spinners.

The spacing of the tick marks in the spline
window changes, and the spacing of the yel-
low step marks along the trajectory changes
as well.

3.  Close the Key Info dialog.

Restoring the Bezier Position Controller
Use caution when you replace one controller
with another. Depending on the type of control-
ler you choose, you could lose all of your keys,
because some controllers don’t even use keys.
The Linear, TCB, and Bezier controllers use keys,
and when you switch between them, the keys
remain but are assigned the default values of the
controller. If you return to a Bezier Position con-

troller, all of your keys are assigned smooth tan-
gent values.

In the following steps, you’ll reassign the Bezier
Position controller. Because it’s a transform con-
troller, you can do it in the Motion command
panel as well as in the Track View.

Reassign the Bezier Position controller:

1. Make sure the pyramid is selected.

2. Open the Assign Controller rollout in the
Motion command panel.

A hierarchical list of transform controllers
appears. It’s the same as the list in the hierar-
chy list, except it displays only the transform
controllers for the currently selected object.

3. Click the Position label in the list.

The Assign Controller button becomes active.

4.  Click the Assign Controller button to dis-
play the controller list.

5. Choose Bezier Position from the list, and then
click OK.

6. Reselect the Position label in the Track View.

The smooth trajectory and function curves
reappear.

Making Noise
You’ve been working on nothing but the Posi-
tion track all this time. Perhaps you’d like to
affect a different part of the animation. In the
following steps, you’ll assign a Noise controller
to one of the pyramid’s creation parameters.

Assign a Noise controller:

1. In the hierarchy list, expand the Object
(Cone) branch by clicking its plus icon.

2. Click to highlight the Radius 2 track.



3t2tut17.fm    16  Thu Oct  2 15:30:48 1997

Tutorial 17

17
 –

 1
6

A
n

im
at

io
n

 U
si

n
g

 C
ur

ve
s

an
d

 C
o

n
tr

o
lle

rs

Radius 2 is the radius at the top of the cone.

3.  Click Assign Controller.

4. Choose Noise Float, and click OK.

A jagged line floats across the Edit Window.

5. Play, and then stop the animation.

The top of the pyramid is closed, but every so
often it enlarges briefly.

6. Click either the jagged line, or the green
arrow beside Radius 2.

No key dots appear.

The Noise Float controller generates random
values, which you can see by the function curve.
Although you can view its values in the function
curve, you can only adjust those values in its
Properties dialog.

Properties Dialog
You get to the properties dialog in the same way
you got to the Key Info dialog. Because there are
no key dots you can right-click, you use the
Properties button instead.

Access the Noise properties dialog:

1.  Click Properties.

The Noise Controller properties dialog
appears.

Raising the Strength value will increase the
maximum radius of the top of the pyramid.

2. Increase the Strength spinner to 100.

3. Drag the time slider.

At frames where the noise curve is highest,
the top of the pyramid opens widest.

4. Uncheck Fractal Noise.

The noise curve is smoother.

5. Single-click the up arrow of the Seed spinner
several times.

The profile of the curve changes. The Seed
spinner changes the kernel of the randomly
generated noise.

6.  Close the Noise properties dialog.

Combining with List Controllers
The next steps provide an example of what not
to do when assigning controllers. It’s an easy
mistake to make, and probably better to make it
during a tutorial, than under a deadline. Subse-
quent steps will demonstrate the correct proce-
dure.

Say that you so enjoy the effect of a Noise con-
troller you want to assign it to the Position track
of the pyramid. Perhaps you have visions of a
bumpy road. Here’s how you might go about it
if you’d never read these tutorials:

Save your scene, and then assign Noise:

1. Choose File>Save to update mytut17.max

2. Select and highlight the Position track in the
hierarchy list.

3.  Click Assign Controller.

4. Choose Noise Position, and click OK.

5. Play, and then stop the animation.
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The pyramid jumps around in the center of
the scene.

Changing certain types of controllers can cause
you to lose all of your original keys. That’s what
happened here.

You’ve replaced your original Position keys with
a noise generator that has no keys. As a result,
your pyramid randomly changes position along
the X, Y, and Z axes but no longer follows its
original trajectory. (In fact, the new trajectory
looks like a tangled string.)

This is not what you want. You’d like the pyra-
mid to follow its original trajectory, and in addi-
tion, jump up and down. In other words, you
want to combine the two controller types.

To combine two or more controllers, you use yet
a third type of controller, called a List controller.
A List Controller is not really an animation con-
troller, as such. It’s a special controller that
holds one or more combined controllers.

Restore the original animation, and see how it
works.

Assign a List controller:

1.  Either click Undo, or reload mytut17.max.

2. Select the Position track.

3.  Click Assign Controller.

4. Choose Position List, and click OK.

5. Click the plus icon that appears beside the
Position track.

Two new tracks appear, labeled Bezier Posi-
tion, and Available.

When you add the Position List controller, it
adds two controllers as children of the Position
track, moves the original Position controller

into the first track, and places an Available track
beneath it, which is merely a placeholder.

The important thing here is to select the correct
track before assigning the new controller.
Because the assigned controller replaces the
selected track, you want to select the Available
track.

Add a Bezier Noise controller:

1. Click to highlight the Available track.

2.  Click Assign Controller, choose Noise
Position, and click OK.

The Noise Position track is added where the
Available track was, and a new Available track
is created beneath it.

Before viewing the animation, display both
curves at once:

3. Hold CTRL and select the Bezier Position
track.

The function curves for both tracks appear.

4. Play, and then stop the animation.

The pyramid follows its bumpy path.
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You might want the pyramid to bounce only
vertically, and you want it to happen only over
a few frames of the animation—as if you’ve
come across a patch of bumpy road.

Create the bumpy road:

1.  Click Time Configuration in the time
controls area, uncheck Real Time, and click
OK.

Turning off Real Time forces 3DS MAX to dis-
play all frames of animation during viewport
playback. The animation will be slower, but
you’ll be better able to judge the bumpiness.

2. Select only the Noise Position track.

3.  Click Properties to display the Noise Con-
troller dialog.

4. Set X strength and Y strength to 0.

The noise now only affects the Z axis.

Limit the bumpy road:

1. Close the Noise Controller dialog.

2.  Click Edit Keys in the Track View toolbar.

There are no keys for the Noise controller, but
you can limit its effect, and move it anywhere
in time.

3. In the Noise Position track, drag the left end
of the range bar to frame 40, and the right end
to frame 60 (all approximate).

The trajectory path shows the limited area of
bumpiness.

4. Play, and then stop the animation.

The pyramid travels around a smooth path,
its top opening and closing, it bumps over
frames 40–60, and then continues on a
smooth ride.
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Using the Path
Controller 2

The trajectory you display for the pyramid
shows its positional path, based on the Position
keys you created by using the Select and Move
tool while the Animate button was on. There’s
another way of moving an object along a path
that doesn’t require the Select and Move tool, or
the Animate button.

Making the Path
In the following steps, you’ll create a spline
shape and a box, and then assign a Path control-
ler so the box moves along the spline. This is
similar to the process you used in “Bouncing the
Ball,” but here, you’ll use some additional con-
trols that let you really take advantage of the
Path controller.

Create an N-Gon spline shape:

1. Choose File>New, answer No, select New All,
then click OK.

2.  Click Shapes in the Create command
panel, and then click the N-Gon button.

3. Drag from the center of the ground plane out-
ward to create an N-Gon that’s about 200
units in radius.

4. Leave the number of sides at 6, and check Cir-
cular.

5.  Click Zoom Extents All.

You now have a circular shape with six verti-
ces. Next, you’ll move those vertices to create
an interesting path.

6. While the N-Gon shape is selected, open the
Modify command panel, and apply an Edit
Spline modifier.

The vertices appear on the shape as tick marks
because you automatically change to Sub-
Object Vertex mode when you apply an Edit
Spline modifier.

7.  Click Select and Move, and click the Z
axis constraint button.

Note: In the following steps, don’t move the
first vertex of the shape. The first vertex is the
one on the right, surrounded by the small
white box.

8. In the Perspective viewport, drag some of the
vertices up, and some of them down to create
an irregular path.

9. Click the XY axis constraint button.

10.In the Top viewport, drag some of the verti-
ces toward or away from the center of the N-
Gon to further distort the shape. (You can
adjust the Bezier handles as well, if you like.)

When you’re finished, the N-Gon might look
somewhat like the following illustration.

That takes care of your path. Now, create an
object to be controlled by the path. For this
exercise, a box will do.

Create a box:

1.  Click Geometry in the Create command
panel, and then click the Box button.
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2. Create a box anywhere on the ground plane.
Make it 20 units in length, 60 units in width,
and 10 units in height.

Assigning a Path Controller
As with all controllers that affect transforms,
you can assign a Path controller in either the
Track View or the Motion command panel.
However, once assigned, only the Motion com-
mand panel lets you specify which spline will be
used as the path. As a result, you typically use
the Motion command panel to both assign the
Path controller and specify the path.

Assign the Path controller:

1. Make sure the box is selected.

2. Open the Motion command panel, and then
open the Assign Controller rollout.

A hierarchical list of the box’s transform con-
trollers appears.

3. Click the Position title in the list.

Above the list window, the Assign Controller
button becomes active.

4.  Click Assign Controller.

The Assign Position Controller dialog
appears.

5. Choose Path, and then click OK.

6. Close the Assign Controller rollout.

Notice that the Key Info rollout has been
replaced by a Path Parameters rollout. Also
notice that a Path controller now controls the
position of the box, and you can no longer use
the Select and Move tool on the object.

Attempt to move the box:

• Using the Select and Move tool, try to move
the box.

The box is frozen in place.

The only thing that will move the box at this
point is a spline path. You can use as a path any
shape containing a single, open or closed spline.

Pick a path:

1. Click the Pick Path button in the Path Param-
eters rollout.

2. Click the N-Gon shape.

The box moves to the shape.

3.  Click Time Configuration in the time
controls area, check Real Time, and click OK.

4. Play the animation.

The box moves around the spline shape.

Following and Banking
You’ve learned about the basic steps in making
an object follow a path. Now, look at the extras.

In the Path Options area of the Path Parameters
rollout are controls that add to the effect of the
animation. Currently, the box moves around
the path, but maintains its orientation to the
world. That’s easy to change.

Turn on Follow:

1. While the animation is playing, check Follow
in the Path Options area.

The box now uses the path to determine its
orientation. You can turn this on and off.

2. Uncheck Follow, and then check it again.

While Follow is off, the box reverts to its pre-
vious orientation; when Follow is on, the box
again follows the contour of the spline.
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Banking is another control you can use to affect
the orientation of the box.

Turn on banking:

1. Select Bank.

The box now banks (rolls) as it negotiates the
curves of the spline.

2. Increase the Bank Amount to about 0.8.

The banking becomes extreme.

3. Stop the animation, and drag the time slider
until the box is at a point on the path where
you can easily see the banking.

4. Adjust the Bank Amount spinner in both pos-
itive and negative directions.

You can more easily adjust a precise bank
amount while the object is still, and you can
bank in either direction.

5. Leave the Bank Amount at 0.8.

Adjusting the Path Parameters
When you assign a Path controller, an addi-
tional Percent track is added, as child to the Posi-
tion track. It is this track that lets you control
your object along its path.

View Key Info for the Percent track:

1. In the hierarchy list of the Track View, expand
Objects, Box01, Transform, and Position.

2.  Click Edit Keys (if it’s not already
selected).

3. In the Percent track, right-click the key dot at
frame 0 to display the Key Info dialog.

You can see two key dots—one at frame 0, and
the other at frame 100. These are assigned by the
Path controller as a default. If you switch
between the first and second key, you’ll see that

the Value number in the Key Info dialog
changes from 0 to 100. This is the percentage of
the position of the box along the path, begin-
ning at the first vertex in the spline.

By repositioning the range bar in the Position
track, you can change when in time the box
moves the full length of the path.

Change when the box moves:

1. Drag the left end of the Position range bar to
about frame 30.

2. Drag the right end of the Position range bar to
about frame 70.

3. Play the animation.

The box remains still over frames 0–30, covers
the full distance of the spline over frames 30–
70, then becomes still again for the rest of the
animation.

4. Point the mouse at the middle of the Position
range bar, and drag the entire bar to a differ-
ent range of frames.

The box covers the full distance, but over a
different range of frames.

By changing the percentage value, you can
affect how far along the spline the box moves.

Change the distance the box moves:

1. Stop the animation.

2. Restore the range bar to cover frames 0–100.
(This is most easily done by entering the val-
ues directly into the Time field of the Key Info
dialog, while at key 1 and key 2.)

3. In the Key Info dialog, move to key 1, and set
the Value (percent) spinner to 30.

4. Move to key 2, and set the Value spinner to
70.
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5. Play, and then stop the animation.

Over frames 0–100 the box moves, but it
begins 30 percent of the way along the path,
and ends 70 percent of the way along the
path.

You can also edit the function curve for the Per-
cent track.

Edit the Percent function curve:

1. Using the Key Info dialog, restore the full per-
centage of 0 percent at frame 0 and 100 per-
cent at frame 100.

2.  Close the Key Info dialog.

3. Select the Percent text label (if it’s not already
selected).

4.  Click Function Curve.

5. Click the function curve to display its key
dots.

As a default, the Percent function curve is a lin-
ear change from 0 to 100 percent. You can get
some interesting effects just by adding and edit-
ing a single key.

Add a key, and then edit its Bezier tangent:

1.  Click Add Keys, and then click in the
middle of the function curve, near frame 50.

2.  Click Move Keys.

3. Right-click the new key dot that you just
added.

4. In the resultant Key Info dialog, select Cus-
tom from either of the tangent flyouts.

5.  Close the Key Info dialog.

6. Rotate the tangent handle clockwise until the
function curve is a smooth, sideways S.

7. Play, and then stop the animation.

The box moves along the path, and then
backs up, and then moves forward again,
before finally completing the circuit.

Save your animation before proceeding:

• Choose File>Save, and save the current scene
as mytut17b.max file.
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The Look At Controller 2

The Look At controller takes over the entire
Transform controller of an object, and then
forces that object to constantly look at another
object. See how it works by adding a cylinder to
the current scene.

Make a cylinder look at the box:

1. In the Perspective viewport, in the approxi-
mate center of the N-Gon path, create a cylin-
der with a radius of about 15, and a height of
80.

2. In the Motion command panel, open the
Assign Controller rollout.

3. Click the Transform label in the small win-
dow.

4.  Click Assign Controller.

5. Click Look At in the Assign Transform Con-
troller dialog, and then click OK.

The cylinder rotates to a horizontal position.

Examine the controllers in the small hierarchy
list. Transform is now handled by a Look At con-
troller. The Position and Scale transforms are
still handled by the Bezier controllers, but the
Rotation track is now a Roll Angle, because you
can now only adjust the rotation of the object
about its local Z axis. The X and Y axes are
reserved by the controller to make the object
look at its target.

In addition, the cylinder has flopped over on its
side because, until you assign a target object for
it to look at, it points the negative end of its
local Z axis at the origin of the world.

Pick a target:

1. Click the Pick Target button.

2. Click the box. (This is probably best done in
the Top viewport. If you miss and hit the
spline by mistake, simply repeat the step.)

The cylinder now points at the box.

3. Activate the Perspective viewport.

4. Play, and then stop the animation.

As the box follows the path, the cylinder
points at the box.

5.  Use the Select and Move tool to move the
cylinder around in the scene.

Even as you move it in the viewport, the cyl-
inder continues to look at its target.

Conehead and the Dummy
It’s easy to assign Look At controllers, but you
should be aware of some issues.

Say you want a person’s head to look at the box
while it’s moving around. The head is made up
of a hierarchy of objects (eyes linked to the
head, and so on). You probably want to assign
the Look At controller to the parent of the hier-
archy—perhaps the head itself.

Because of the orientation of the head’s pivot
point, as soon as you complete the assignment,
the head is looking in the wrong direction. (The
Look At controller points the negative Z axis of
the object toward the target.)

What do you do?

Using the Pivot commands of the Motion
branch, you could reorient the head object
while leaving its pivot point behind. This would
let you rotate the head to any angle because the
Look At controller is locked to the object’s pivot
point, and not its head. Seems like a perfect
solution.

Unfortunately, hierarchical linkage is also based
on each object’s pivot point. Therefore, if you
rotate the head and leave the pivot point
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behind, you’ll also leave behind all of the chil-
dren of the head (the nose and eyeballs).

To avoid the problem, create a dummy object,
assign it a Look At controller, adjust the head to
the orientation you want, and then link the head
to the dummy object.

In the following steps, you’ll do just that, after
first merging a hierarchy of objects representing
a head.

Restore the scene and merge Mr. Conehead:

1. Reload mytut17b.max.

2. Choose File>Merge, and find and select
tut17_1.max.

3. In the Merge dialog, click the All button that’s
below the list window, and click OK.

A conical “head” appears in the center of the
path. The large cone is the parent, and the
nose and eyes are linked as children.

Orient Mr. Conehead:

1. Make sure you’re at frame 0.

2. Click Select and Rotate, and choose the Local
coordinate system.

3. Select the large cone “head” and rotate it
about its Z axis until its “nose” points at the
box.

Create a dummy, and assign a Look At
controller:

1.  Click Helpers in the Create command
panel, and then click the Dummy button.

2. Create a dummy object anywhere in the
scene that’s slightly larger than Mr. Cone-
head.

3.  Click Align in the main toolbar, and then
click the large cone.

The Align Selection dialog appears.

4. Check X Position, Y Position, and Z Position,
and then choose Center under both Current
Object and Target object.

5. Click OK.

The dummy object is centered around Mr.
Conehead.

6. While the dummy is still selected, open the
Motion command panel, and open the Assign
Controller rollout.

7. Select Transform in the list window.

8.  Click Assign Controller.

9. Click Look At, and then click OK.

10.Click Pick Target, and click the box.

The dummy rotates to look at the box.

Link Mr. Conehead to the dummy:

1. Again, make sure you’re at frame 0.

2.  Click Select and Link.

3. Select the large cone.

Because of the proximity of the cone to the
dummy, it’ll be easier to link them using
Select by Name.

4.  Click Select by Name.

5. Choose Dummy01 from the list, and click
Link.

6. Play, and then stop the animation.

Mr. Conehead watches the box move around
the path.

Add some extra motion:

1. Select the dummy.
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2. Switch the Top viewport to the Front view-
port, and zoom out.

3.  Using Select and Move with Y axis con-
straint, move the dummy (and Mr. Cone-
head) up until it floats over the path and the
box.

As you move the dummy, the whole assembly
rotates to continue watching the box.

4. Go to frame 100, turn on the Animate button,
and move the dummy object down until Mr.
Conehead is below the path.

5. Turn off the Animate button.

6. Activate the Perspective viewport.

7. Play, and then stop the animation.

As he floats down, Mr. Conehead watches in
fascination while a block flies around him.

Copying and Pasting Objects
In the Track View, you can copy and paste
between objects, and you can copy and paste
between like animation controllers. This is a
powerful feature that lets you copy any anima-
tion tracks from one object to another, or
replace simple objects with more complex
objects.

For example, you want Mr. Conehead to watch
something more complex than a box. Perhaps
an animated polyhedron would be more inter-
esting. Here’s how to go about it.

Make a polyhedron:

1.  Click Geometry in the Create command
panel, select Extended Primitives from the
list, and then click the Hedra button.

2. Drag the mouse in the Perspective view to cre-
ate a polyhedron with a radius of about 30
units. (You might have to scroll the command
panel to see the Radius spinner.)

3. Click Star1 to change the type of polyhedron.

4. Turn on the Animate button, and go to frame
100.

5. Under Family Parameters, set the P spinner
to 1.

6. Turn off the Animate button.

7. Drag the time slider back and forth.

The polyhedron changes shape over time.
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Rather than assigning the polyhedron to the
path, simply replace the box object on the path
with the polyhedron.

Copy and Paste the polyhedra:

1. In the Track View, expand Hedra so you can
see its Object (Hedra) track.

2. Click the Object (Hedra) label.

The Copy Object  button becomes active
in the Track View toolbar.

3.  Click Copy Object.

4. Expand Box01 in the hierarchy list, so you
can see the Object (Box) track.

5. Click to highlight Object (Box).

The Paste Object button  becomes active
in the Track View toolbar.

6.  Click Paste Object.

The Paste dialog appears.

7. Make sure that Copy is selected, and click OK.

The box takes on the shape of the polyhedron
while maintaining its original surface color.

Note that you haven’t actually replaced the box.
You’ve assigned the geometry and creation
parameters of the polyhedron to the box. It’s
still called Box01, but its parameters are that of
a polyhedron.

Clean up the scene, and create a preview:

1. Select and delete theoriginal polyhedron.

2. Right-click the Perspective viewport label,
and turn off Show Grid.

3. In the Display command panel, check Shapes
and Helpers under Hide by Category.

The dummy and the spline path disappear.

4. Choose Rendering>Make Preview, and then
click Create.

5. When the Media Player appears, click the Play
button to play the animation.

Mr. Conehead floats in space, contemplating
a jewel-like polyhedron.
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Tutorial

With 3D Studio MAX, you can animate isolated
objects flying through space or bouncing along
the ground. You can animate the very geometry
of each object as it twists and bends over time,
but when you want to animate a collection of
objects, each influencing the other, you link
those objects together in a hierarchy.

Hierarchical linkage lets you drive a car down a
road so that its four rotating wheels aren’t left
behind in the dust. It holds the wings on the
bird, the head on the shoulders, and connects
the shin bone to the ankle bone.

This tutorial shows you how to link objects
together, and then animate the linkage. It takes
you deeper into the Track View, where you
explore the interconnectivity of the hierarchy
list. Later in this tutorial, there are a couple of
fun projects for you to try.

Hierarchy and Forward
Kinematics
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Different Types of
Hierarchy 2

A hierarchy is like an outline in which some
items are at a higher level, while others are
nested and indented at a lower level. Hierarchies
can also be viewed as trees of many branching
levels.

3D Studio MAX contains hierarchies in several
places, and all of them can be displayed in a
structured list in the hierarchy list of the Track
View.

The Modifier Stack has its own hierarchy; its
lower levels accessed by way of the Sub-Object
button.

The Material Editor has two parallel hierarchies.
Compound materials let you create materials
consisting of materials, while compound maps
let you create maps consisting of maps.

Finally, in the scene itself, you can link objects
to create a third form of hierarchy, called hierar-
chical linkage.

It is this third form—the object hierarchy—on
which this chapter concentrates.

Object Hierarchy
Object hierarchies are created by linking objects
together to form some kind of assembly for ani-
mation. As a result, the term used to describe an
object hierarchy is hierarchical linkage.

Hierarchical linkage takes the form of a family
tree. Given two linked objects, one is a parent,
and the other a child. A single parent can have
many children linked to it, but each child object
can have only one parent. In 3DS MAX, the
effect of such linkage varies depending on
whether you use forward kinematics or inverse
kinematics. Forward kinematics, the default
method, is described in this chapter.

In forward kinematics, when a parent object
moves, its children must follow. If the child

wants to go off on its own, the parent remains
behind. For example, in a hierarchical linkage of
a human figure, when the torso (the parent)
bends over, the head (the child) moves along
with it, but you can turn the head without
affecting the torso.

Similarly, the torso is the parent to the upper
arms. Both upper arms are children to the torso
parent, and siblings to each other, because they
share the same parent. The upper arms are also
parents to the forearms, which are, in turn, par-
ents to the hands, and so on. If you move the
torso, the arms and hands move; if you move
the upper arm, the forearm and hand move, but
you can rotate the hand without affecting the
arms or torso.
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The Robot Arm 2

To demonstrate hierarchical linkage, you’ll use a
mechanical robot arm.

Load the robot arm:

1. Choose File>Open.

2. Select and load tut18_1.max.

The robot arm is made up of six objects named
as follows, from the bottom up:

Base—The base of the robot arm.

Vertical Shaft—The vertical shaft in the Base.

Hinge—The U-shaped support at the end of the
Vertical Shaft.

Arm—The horizontal arm resting in the Hinge.

Horizontal Shaft—The horizontal shaft inside
the Arm.

Hand—The U-shaped claw at the end of the
Horizontal Shaft.

Right now, none of the objects in the robot arm
are related except for their arrangement in
space. You could create an animation in which
the Base flies off in one direction while the Hand
rotates and flies off in another. But if the robot
arm were real, all its pieces would be linked in
various ways. Thus, when you moved the Base,
the entire assembly would move. The V-Shaft
would slide up and down but could not be
moved sideways.

Hinge

Vertical Shaft Base

Arm Horizontal Shaft

Hand
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Track View in a Viewport2

Before linking the robot arm together, set up the
Track View.

The hierarchy list in the Track View displays all
objects in your scene in a hierarchical fashion.
Although you don’t need to use the Track View
to link objects, it’s an excellent way to make sure
you’ve performed the linkage correctly.

One way to display the Track View as a floating
dialog box is to click the Track View  button
in the toolbar. That’s fine when you’re simply
jumping into the Track View to make a few
adjustments, but when you’re working con-
stantly between the Track View and your scene,
it’s preferable to set up the Track View as a view-
port. After all, the Track View is just another way
to view your scene.

You can change any existing viewport into a
Track View. However, the Track View works best
in a wide, horizontal viewport.

In this exercise, you establish two separate view-
port layouts, and then switch between them. Set
up one of the two layouts for the Track View.

Establish a Track View layout:

1. Choose Views>Viewport Configuration.

The Viewport Configuration dialog appears.

2. Click the Layout tab to switch to the Layout
panel.

The Current Layout area is set to Layout A,
which displays the four quartered viewports.

3. Choose Layout B.

Layout B is a tri-divided view in which the
Track View is in the wide horizontal viewport,
and the Top and Perspective views are
assigned to the remaining smaller viewports.

4. Click in the proxy Top viewport, and change
it to Front.

5. Click in the proxy Perspective viewport, and
change it to Camera1.

6. Click OK.
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7.  Click Zoom Extents All.

Once you have your two layouts set up, you can
easily switch between them.

Switch viewport layouts:

1. Right-click on the label of either the Front or
Camera1 viewports, and choose Swap Lay-
outs.

The four-viewport layout appears.

2. Right-click on any viewport’s label, and
choose Swap Layouts again.

The triple viewport layout returns.

The viewport navigation buttons at the lower-
right of the screen work only for the normal
viewports. The Track View has its own naviga-
tion buttons in the lower-right corner of its
viewport. You’ll notice this primarily when you
maximize either the viewport or the Track View.

Maximize the viewports:

1.  Click the Min/Max Toggle in the lower-
right corner of the Track View.

2. The Track View fills the screen.

3.  Click the Track View Min/Max Toggle
again.

The three viewports are restored.

4. Activate the Camera1 viewport

5.  Click Min/Max Toggle among the view-
port navigation buttons.

The camera viewport fills the screen.

6.  Click Min/Max Toggle to restore the three
viewports.

7. Change the Camera viewport to Smooth +
Highlight.

Navigating the Hierarchy
Before you link the robot arm, examine the hier-
archy list of the Track View. This is where you
navigate all of the hierarchies in 3D Studio
MAX, so it’s a good idea to familiarize yourself
with its structure.

Currently, the hierarchy list contains eight
items:

The seven items below World are indented to
indicate that they’re children of the World.

Notice the little plus and minus icons beside
each item. The plus (+) means that the item
holds more items (children), and the minus (-)
means that the item is already opened. The
Scene Materials item contains neither a plus nor
a minus because no materials exist in this scene,
so Scene Materials contains no children.

You open and close items in the list by clicking
the plus or minus icons. For example, if you
want to examine the hierarchy of the Medit
Materials (the materials in the Material Editor),
you click on its plus icon.

Open the Medit Materials item:

1. Click the plus icon beside Medit Materials.

A list of all standard materials appears.

2. Click the plus icon beside Material #1.

Two new indented items appear: Parameters
and Maps. These are children of Material #1.

3. Click the plus icon beside Parameters.
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A list of all parameters available to Material #1
appears.

You can scroll the window using the scroll bar
at the far right of the Track View, or you can
use the following shortcut.

4. Point the mouse over a blank area of the hier-
archy list.

The mouse cursor turns into a hand.

5. Drag the window to scroll it.

You can collapse the tracks by clicking again on
the minus icons, or you can use one of several
shortcuts available by right-clicking over a track.

Collapse all of the Medit Materials tracks:

1. Scroll the hierarchy list so you can see the
Medit Materials item.

2. Right-click over the Medit Materials text
label.

A menu appears.

3. Choose Collapse Tracks.

All of the expanded tracks are collapsed.

The right-click menu is specific to the listed item
over which you click. For example, if you’d
right-clicked over Material #1, only its branch of
tracks would collapse.

The Two Hierarchies
Objects have a double hierarchy. There’s the
hierarchy of the linked objects, and the hierar-
chy of object parameters.

Notice the square and the circle beside the
Object item. The square represents objects, and
the circle represents parameters.

Expand the Objects item:

• Click the square plus icon beside Objects.

A list of all objects in the scene appears.

The yellow cube icon symbolizes an object. You
can see that each object has a square and a circle
icon beside it because each can be linked to
another object, and each has its own set of
parameters. Currently, the squares are all blank
because none of the objects are linked together.
The circles all contain pluses because each
object has a number of parameters as a default.

Take a look at some of the object parameters.

Expand an object:

1. Click the plus icon beside Vertical Shaft.

Two items appear: Transform and Object
(Cylinder). When you create an object, you
always have transforms and creation parame-
ters.

2. Click the plus icon beside Transform.

Tracks for Position, Rotation, and Scale
appear.

3. Close the Transform tracks by clicking on its
minus icon.

4. Click the plus icon beside Object (Cylinder).

Tracks for all of the creation parameters of a
cylinder appear.

5. Right-click Vertical Shaft, and choose Col-
lapse Tracks.

All tracks belonging to Vertical Shaft are col-
lapsed.

Unlike the Vertical Shaft, which is an unmodi-
fied cylinder, the Base object contains a Taper
modifier. Look at all of its tracks, after first max-
imizing the Track View.
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Expand the Base:

1.  Click Track View Min/Max Toggle to
expand the Track View to full screen.

2. Right-click the Base item, and choose Expand
Tracks.

All tracks belonging to the Base object are
expanded.

Notice that the immediate two children of Base
are Transform and Modified Object. Contained
within Modified Object are the Taper modifier,
and the creation parameters (Object (Cylinder)).
Since all of the tracks are opened, you can also
see the various parameters for the Taper and the
cylinder. All of the green arrows represent ani-
mation controllers, so everywhere you see a
green arrow, you know that the track can be ani-
mated.

Collapse the list and restore the Track View:

1. Right-click Base, and choose Collapse Tracks.

The expanded tracks collapse, and the list of
scene objects remains.

2.  Click the Track View Min/Max Toggle to
reduce the size of the Track View.

Now that you have an idea of how to navigate
the parametric hierarchy; you can link the robot
arm together while watching the effect in the
Track View.
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Linking Objects
Hierarchically 2

Creating a linked hierarchy is simply a matter of
selecting an object you want as a child, clicking
Select and Link  in the toolbar, and then
dragging a linkage to the object you want as its
parent. But first, you should think through the
logic of the hierarchy.

The robot arm is pretty straightforward. When
the Base moves, all else moves. When the Verti-
cal Shaft moves up and down, the Base remains
still, but all of the objects attached to the Verti-
cal Shaft move. The Base, then, should be the
parent to the Vertical Shaft, the Vertical Shaft
the parent to the Hinge, and so on, down the
tree to the Hand.

Begin by linking the Vertical Shaft to the Base.

Link the Vertical Shaft to the Base:

1.  Click Select and Link in the toolbar.

Select and Link is also a selection tool.

2. In the Front viewport, click to select the Ver-
tical Shaft, and then drag the cursor from the
Vertical Shaft over the Base before releasing
the mouse button.

As you drag the mouse, the cursor changes,
depending on the type of object the mouse is
over. While the mouse is still over the Vertical
Shaft, the cursor indicates that it’s an invalid
link (you can’t link an object to itself). When
the mouse is over the Base, the cursor changes
to indicate the link is valid. When you release
the mouse button, the Base flashes white
briefly to show that it’s been linked.

Testing the Linkage
The Vertical Shaft is now a child of the Base. In
the Track View, the Vertical Shaft is no longer
visible, but the square icon beside Base now con-
tains a plus. This is because the square icons rep-

resent object hierarchy, and the Base object now
has a child object.

Open the Base:

• Click the square plus icon beside the Base.

The Vertical Shaft appears, indented, as a
child of the Base.

If you were linking objects without the Track
View displayed, you could test your linkage in
another way. Remember, in forward kinematics,
when you move the parent, the child moves
with it, but when you move the child, the par-
ent isn’t affected.

Test the links:

1.  Click Select and Move.

2. Move the Base object, and then click Undo to
cancel.

As you move the Base, the Vertical Shaft
moves with it.

3. Move the Vertical Shaft, and then click Undo
to cancel.

The Vertical Shaft moves freely, and the Base
remains behind.

Actually, all transforms are inherited in forward
kinematics, as you’ll see later.
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Link the rest of the objects:

1.  Click Select and Link.

2. Choose Edit>Hold (in case you need to repeat
the linkages).

3. Select the Hinge (at the top of the Vertical
Shaft), and drag to link it to the Vertical Shaft.

4. Link the Arm (running across the Hinge) to
the Hinge.

5. Link the Horizontal Shaft (within the Arm) to
the Arm.

6. Link the Hand to the Horizontal Shaft.

7. In the Track View, right-click Base, and choose
Expand Objects.

The linked tree appears as indented items in
the hierarchy list.

Note:  If your links are incorrect, select the
child objects that are not properly linked,
click Select and Unlink  to unlink them,
and then link them again to the correct
objects.

8. Choose File>Save As, and save a new version
of your scene as mytut18.max.
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Hierarchical Selection 2

When you have a hierarchical linkage of objects,
special selection methods are available. In addi-
tion, whether your objects are linked or not, you
can always use the Track View to select objects
in your scene.

Select objects using the Track View:

1. Click the yellow cube icon beside Hinge in
the hierarchy list.

The cube is highlighted, and the Hinge is
selected in the viewport.

2. Click the yellow cube beside Arm.

The Arm is selected.

When one object in a hierarchy is selected, you
can move up and down the hierarchy, selecting
objects with the UP ARROW or DOWN ARROW

keys.

Select with UP ARROW and DOWN ARROW:

1. While the Arm is selected, press UP ARROW.

The Hinge becomes selected.

2. Press UP ARROW again.

The Vertical Shaft is selected.

3. Press DOWN ARROW twice.

The Arm is again selected.

DOWN ARROW moves down the hierarchy, from
the parent to the child, while UP ARROW moves
in the opposite direction.

You can select all of the children of a specific
object in two ways—by right-clicking, or by
double-clicking.

Select the children of the Arm:

1. While the Arm is selected, right-click over it
in the viewport and choose Select Children.

All objects from the Arm to the Hand are
selected.

2.  Click Undo to revert to the single,
selected Arm.

3. Double-click the Arm.

Again, all the Arm’s children are selected.

To deselect all children, you use the right-click
menu.

Deselect children:

1. Make sure the Arm and all its children are
selected.

2. Right-click any of the selected objects, and
choose Deselect Children.

Only the Arm remains selected.

When you use Deselect Children, it deselects all
except the first parent in the selected hierarchy.
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Locking Axes 2

In certain situations, linked objects should logi-
cally move or rotate about certain axes only. The
Vertical Shaft, for example, should move up and
down, but it should not move sideways through
the Base. Of course, you can use the axis con-
straints in the toolbar to prevent unwanted
movement, but what if you want to set up your
assembly so there’s no chance of a wrong adjust-
ment?

In the Hierarchy command panel, you can lock
the axes of all three transforms for any object.
This is not absolutely necessary for successful
animation of a hierarchy, but it can make things
easier when you’re adjusting the parts for an
animation.

Locking the Vertical Shaft
You’ll first lock the motion of the Vertical Shaft
to a single axis. It can move up and down, but
not sideways. Because you’ll lock the local axes
of the objects, you begin by switching to the
Local axis coordinate system so the axis tripod
accurately displays the correct axis labels.

Lock the Vertical Shaft:

1.  Click Select and Move.

2. Choose Local from the Coordinate System
list.

3. Choose Views>Show Axis Icon to display the
axis tripod.

4. Select the Vertical Shaft.

5. Open the Hierarchy command panel, and
click Link Info.

The Link Info panels appear.

You can see from the axis tripod that you
want the Vertical Shaft to move along its Z
axis.

6. Check X and Y under Move in the Locks
panel to lock those axes during movement.

Because you don’t want to accidentally rotate
the shaft, you can do the following as well:

7. Check X, Y, and Z under Rotate.

8. Leave the Scale axes unlocked.

Now, test the results. This is easier in View coor-
dinate mode.

Test the locks:

1. Switch to the View coordinate system.

2. While XY axis constraint is active, move the
Vertical Shaft in the Front viewport, and then
click Undo to cancel.

You can move the shaft vertically, but not
horizontally.

3. Try moving the Vertical Shaft in the Camera
viewport.

The shaft moves vertically, but the movement
feels strange because the mouse is mapped to
the XY axis-constraint plane, rather than the
Z axis.

Tip: When you’re transforming an object with
axis locks in a nonorthographic viewport, set
the axis constraints in the toolbar to match that
of the unlocked axis.

Locking the Arm
Before locking the Arm’s rotation, you need to
move its pivot point so it rotates correctly in the
Hinge object.

Move the pivot point:

1. Select the Arm.

2. Click the Pivot button in the Hierarchy com-
mand panel.
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3. Click Affect Pivot Only.

The pivot of the Arm object appears.

4.  Using Select and Move, position the pivot
in the Front viewports so it’s centered over
the Hinge.

Now, lock the Arm’s axes.

Switch to Local and lock the Arm:

1. Choose the Local coordinate system.

You can see by the local axis tripod, that you
want to lock out all but the Y axis for rotation.

2. Click the Link Info button.

3. In the Locks rollout, check X, Y, and Z under
Move, and X and Z under Rotate. Don’t
change the Scale checkboxes.

4.  Use Select and Rotate to rotate the Arm,
and then click Undo to cancel.

The Arm rotates only about its local Y axis,
ignoring the current axis-constraint button in
the toolbar.

Locking the Rest
Now that you know the technique, lock the
remainder of the objects in the robot arm. The
following describes the free transforms. For each
object, lock the appropriate Move and Rotation
axes.

Note: Don’t lock the Scale axes; you use them
later.

Hinge—Rotates about its Z axis.

Horizontal Shaft—Moves along its X axis.

Hand—Rotates about its X axis.

Base—Moves along X and Y.

After locking the objects, save your scene:

• Choose Files>Save to update the scene file.
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Animating the Robot
Arm 2

Now that your robot arm is properly linked and
locked, you can animate the assembly. This is
simply a matter of turning on the Animate but-
ton, and then moving or rotating the objects at
various frames. You’ll start by creating a couple
of patterned animations.

Rotating the Hand
Assume that the Hand has a faulty servomotor
forcing it to rotate 90 degrees back and forth
throughout the animation. You can set the ini-
tial rotation, and then use Parameter Curve Out-
of-Range Types in the Track View to repeat the
rotation pattern for the remainder of the anima-
tion.

First, create some extra time by increasing the
number of frames in the active time segment.

Lengthen the active time segment:

1.  Click Time Configuration among the
time controls.

The Time Configuration dialog appears.

2. Set the Length spinner to 200, and click OK.

There are now 200 total frames in the active
time segment.

Rotate the Hand:

1. Turn on the Animate button, and move to
frame 30.

2.  Click Select and Rotate.

3.  Turn on Angle Snap in the prompt line.

4. Rotate the Hand 90 degrees.

5. Turn off Angle Snap.

You now have an animation of the Hand rotat-
ing over frames 0–30.

Apply Ping Pong to the rotation pattern:

1. In the Track View, click the plus icon beside
Hand, the plus button beside Transform, and
then the plus button beside Rotation.

The three rotation tracks are displayed. You
can see the key dots for X, Y, and Z rotation at
frames 0 and 30.

You’ll apply the Parameter Curve Out-of-
Range type to all three rotation axes.

2. Click to highlight the X Rotation label, and
then hold SHIFT and click the Z Rotation
label.

All three rotation tracks are selected. (You can
also use the CTRL key to add to your Track
View selection, just as you do when selecting
objects in the viewports.)

3.  Click Parameter Curve Out-of-Range
Types in the Track View toolbar.

The Param Curve Out-of-Range Types dialog
appears.

4. Click the In and Out arrow buttons beneath
Ping Pong, and then click OK.

5. Play, and then stop the animation.

The hand rotates back and forth over the
entire animation.

Moving the Vertical Shaft
The servomotor for the Vertical Shaft is in even
worse shape than the one driving the Hand. It
pumps the shaft erratically up and down. To cre-
ate this effect, you’ll set a pattern of Position
keys, and then repeat it throughout the anima-
tion.
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Move the Vertical Shaft:

1.  Click Select and Move, choose the View
coordinate system, and the XY axis con-
straint.

2. Go to frame 20.

3. Move the Vertical Shaft up a little in the Front
viewport.

4. Go to frame 30, and move the shaft down
until the Hinge is just above the Base.

5. At frame 50, move the shaft all the way up,
leaving only a little of it still in the Base.

Set the Parameter Curve Out-of-Range Type:

1. In the Track View, right-click on Hand, and
choose Collapse Tracks.

2. Open the Vertical Shaft and find the Position
track.

There are four key dots in the Position track.

3. Select the Position track label.

4.  Click Parameter Curve Out-of-Range
Types, click the In and Out arrow buttons
beneath Cycle, and then click OK.

5. Play, and then stop the animation.

The Vertical Shaft pumps erratically up and
down, while the Hand repeatedly rotates.

Unlike Ping Pong, which mirrors the animation
pattern, Cycle repeats the same pattern, again
and again, causing the shaft to jerk back down
at the end of each repeated pattern.

Make It Move
You’ll use the animated robot arm in the next
section, but you shouldn’t need specific tutorial
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steps to complete the animation. Be creative.
Move to different frames, and rotate and move
the remaining objects—the Hinge, the Arm, and
the Horizontal Shaft.

Note: Be sure to follow these procedures while
animating the robot arm:

• Don’t create keys past frame 170.

• Don’t animate the Base object.

• If you need to adjust the camera view (say, to
zoom out), remember to first turn off the Ani-
mate button. Otherwise, you’ll animate the
adjustment.

Once you’ve animated the rest of the robot arm,
continue with the tutorial. You’ll see how to add
some additional motion.
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Releasing Linked Axes 2

In forward kinematics, all transformations
applied to a parent are inherited by the linked
child object. As a result, if you rotate, scale, or
move the parent, the child is likewise rotated,
scaled, or moved. However, there are times
when you don’t want this to happen.

Take, for example, a Ferris wheel where the main
wheel is the parent, and the cars are the chil-
dren. You want to be able to rotate the wheel
without rotating the cars—at least along one
axis. (You might want the Ferris wheel to fall
over, and the cars along with it.)

In the Link Info panel of the Hierarchy com-
mand panel is a rollout called Inherit that lets
you release the inherited linkage between a
child and its parent. Here’s how you might use
it with your robot arm.

The Base of the robot arm is flexible and pumps
up and down while the rest of the assembly goes
about its business. See what happens if you
attempt this while the linkages are left in their
current states.

Scale the Base:

1. Turn off the Animate button.

2.  Click Non-Uniform Scale in the Scale fly-
out.

3. Choose the Local coordinate system, and
click the Z axis constraint.

4. In the Camera view, scale the Base up and
down, and then click Undo to cancel.

As you scale the Base, all of its linked children
scale as well.

Releasing the Child from Its Parent
You need to release the inheritance of the scale
transform between the Base and its child. To do

this, you select the child, because it looks to the
parent for it transformations.

Release the scale inheritance:

1. Select the Vertical Shaft.

2. In the Inherit rollout of Link Info, uncheck Z
under Scale.

3. Reselect the Base.

4. Scale the Base up and down, and then click
Undo to cancel.

Only the Base scales.

Animate and oscillate the scale:

1. Turn on the Animate button, and go to frame
20.

2. Scale the Base down about 75 percent.

3. Go to frame 40 and scale the Base up about
150 percent.

4. In the Track View, expand the Base and select
its Scale track.

5.  Click Parameter Curve Out-of-Range
Types, click the In and Out buttons beneath
Ping Pong, and then click OK.

6. Play, and then stop the animation.

The Base pumps up and down while the robot
arm moves about.
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Robo Tango 2

Synchronize the assemblies:

1. Turn off the Animate button.

2. Switch the Front viewport to the Top view.

3.  Click Zoom Extents.

4.  Use Zoom to zoom out in the Top view-
port to provide extra room around the robot
arm.

5.  Click Select and Move.

6. Region-select all objects in the robot.

7. Hold SHIFT and drag a copy of the assembly
upward in the Top viewport. (See the follow-
ing illustration.)

The Clone Options dialog appears.

8. Choose Instance under Object, and make sure
Copy is selected under Controller.

9. Click OK.

10.Activate the camera viewport.

11.Play, and then stop the animation.

The two assemblies move identically.

You can use the Track View to shift in time the
animation of entire assemblies. In the following

steps, you’ll shift the animation of one of the
robot arms. First, use one of the Track View fil-
ters to clear away some of the clutter from the
hierarchy list.

Desynchronize the robots:

1.  Right-click Filters in the Track View tool-
bar, and choose Animated Tracks Only.

Only the animated objects are displayed in
the hierarchy list.

2. In the hierarchy list, right-click Objects, and
choose Collapse Tracks.

3. Right-click Base01 (the second Base object),
and choose Expand Objects.

You can now see the pair of hierarchies for the
two robot arm assemblies.

The current display in the Edit window (Edit
Keys) lets you edit and move the individual key
dots, and parental range bars. Another display
mode lets you adjust range bars that can affect
entire subtrees of child objects.

Switch to Edit Ranges:

1.  Click Edit Ranges to switch the Edit win-
dow to edit range display.

2.  Click Modify Subtree in the Track View
toolbar.

Range bars appear that affect all their chil-
dren.

3. In the Track View navigation controls, click
Zoom Horizontal Extents.

4. Point the mouse anywhere in the middle of
the Base range bar, and then drag it to the
right until its left end is near frame 50.
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All range bars belonging to children of the
Base move along with it.

5. Play, and then stop the animation.

The duplicate motions look completely differ-
ent simply because they’re offset.

6. Use File>Save to update your scene.

Using Dummy Objects
What if you wanted your two robot arms to
rotate around each other? You could position
the pivot point of both Base objects between the
robot arms and rotate them about each other,
but that wouldn’t work. The pivot point is
already at the bottom of the Base, and you can’t
move it now without altering the effect of the
pumping movement. (There’s only one pivot
point per object.)

If only you had an extra, invisible object to
which you could link both robot arms. Then,
you’d simply rotate the invisible object to rotate
both robot arms. That’s exactly what the dummy
object does.

A dummy object is simply a cube that does not
show up in the rendering, but which you can
use to influence the animation. You’ll place one
in the center of the two robot arms, link the
bases to the dummy, and rotate the dummy
object.

Create a dummy object:

1.  Click Zoom Extents All.

2.  Click Helpers in the Create command
panel.

3. Click the Dummy button.

4. In the Top viewport, click between the base of
the two robot arm assemblies, and drag out-
ward to create a small cube. (Its size doesn’t

matter, and it doesn’t have to touch either of
the robot bases.)

The dummy acts like any other object. It can be
moved, rotated, and scaled. The only difference
is that it doesn’t show up when you render your
scene.

Link the bases to the dummy:

1.  Click Select and Link.

You can link any number of child objects to a
parent. Rather than linking one object at a
time, you can select your objects first, and
then link the selection.

2. Click anywhere to deselect the Dummy
object.

3. Select one of the Base objects, and then hold
CTRL and click the other Base object so that
both Bases are selected.

4. Drag a link line from either of the selected
Base objects to the dummy object.

While you drag the mouse, a dotted link line
appears from the pivot points of the Base
objects. The dummy flashes briefly when you
release the mouse button.
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The hierarchy list looks empty. The dummy is
the only displayed object because it’s become
the parent of all the other objects.

Expand the dummy:

• Click the square plus icon beside the dummy.

The rest of the objects appear in the list.

Now that the dummy is the parent of both
assemblies, any transform that you apply to the
dummy is inherited by both robot arms.

Using a Dummy with Link Inheritance
You’re going to rotate the dummy about its local
Z axis. To make things more interesting, you’ll
release the inheritance of both Base objects
about the Z axis. This way, when you rotate the
dummy, the robot arms will move around in a
circle, but they’ll continue to face in the same
direction.

Release the Z inheritance:

1. Click Select and Rotate, choose the Local
coordinate system, and click the Z axis con-
straint.

2. Select one of the two Base objects.

3. In the Hierarchy command panel, click Link
Info (if it’s not already selected).

4. In the Inherit rollout panel, uncheck Z under
Rotate. (Don’t do it in the Locks rollout panel
by mistake.)

5. Select the other Base object, and uncheck Z
for its rotation axis.

Animate the dummy rotation:

1. Move to frame 200.

2. Turn on the Animate button.

3.  Turn on Angle Snap.

4. Rotate the dummy –360 degrees about its Z
axis.

5. Turn off the Animate button.

6. Play the animation.

The robot arms perform a little dance around
each other while pumping up and down and
moving their arms.

7. Stop the animation, and save your scene.
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Solving the Pong Puzzle 2

This last section presents a puzzle. You’ll load a
file, watch its animation, and then try to figure
out how it’s done.

This is the kind of thing you do when you
download sample files from information ser-
vices, or look at animations that others have
done. The better you get at deducing how an
effect was accomplished, the more ideas you can
borrow.

Load the file, play the animation, and then put
this guide away while you try to solve the puz-
zle.

Load and play the pong puzzle:

1. Choose File>Open, and load tut18_2.max.

2. Play the animation.

A paddle sweeps back and forth, just in time
to hit a ball, which bounces off three walls.

It looks like collision detection. Is the ball really
bouncing off the objects, or is something much
simpler happening here? See if you can figure it
out before you proceed to the next section.

Solution (Don’t Peek!)
The following steps show how you might work
through the solution to the puzzle. The secret,
as is often the case, is in using Track View to fig-
ure out the relationship between the objects in
the scene.

Set the viewports up:

1. Stop the animation.

2. Right-click the Camera viewport label, and
choose Swap Layouts.

3.  Click Zoom Extents All.

First, get an idea of which item in the hierarchy
list corresponds to which object in the scene.

Select each object:

1. Click the square plus icon beside Object to list
all objects in the scene.

2. Click on each of the yellow cube icons to see
which object in the scene matches the items
in the Hierarchy viewport.

The three Box objects are the three blue walls,
the Ball is the red ball, and it has a child. This
is your first real clue.

3. Click the square plus icon beside Ball.

A Paddle object appears.

4. Click the yellow cube beside Paddle.

The purple paddle is selected in the scene.

So the paddle is a child of the ball. Before pursu-
ing that, take a look at the trajectory of the ball.

View the trajectory:

1. In the Motion command panel, click Trajec-
tories.

2. Select the red ball.

The ball simply bounces in straight lines from
one wall to the other, and down toward the pad-
dle.
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The paddle is a child of the ball. That means that
it should follow the ball wherever it goes. But it’s
only following it in one direction.

What does that suggest?

It appears that the paddle is not inheriting all of
the ball’s transforms.

Examine the Hierarchy:

1. In the Hierarchy command panel, click Link
Info.

2. Select the paddle.

The Y and Z axes have been turned off in the
Move section of the Inherit rollout.

There’s your answer! The animation is really
very simple. It consists of nothing but the ball
moving from wall to wall to paddle. The paddle
itself is driven by the ball because it’s the ball’s
child. However, because it only inherits position
along its X axis, that’s the only direction it will
move.

Simple, once you know the secret.
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Tutorial

3D Studio MAX provides a complete, three-
dimensional inverse kinematics system with
which you can animate complex hierarchies of
objects by moving a single object in the chain.

The exercises in this tutorial introduce you to
the concepts of inverse kinematics (IK). You’ll
compare IK to forward kinematics, and then
learn how to set joint parameters for complete
control of your hierarchy.

You’ll learn about the two methods of animat-
ing inverse kinematics, and examine some of
the special IK functions, such as Damping and
Eases. You’ll see how to set up a walk cycle, and
how to use splines as part of your IK linkage.

Inverse Kinematics
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About Inverse
Kinematics 2

In the previous “Hierarchy and Forward Kine-
matics” tutorial, you saw that, in forward kine-
matics, children inherit the transformations of
their parent. That is, when you move a parent
object, the child object follows, but when you
move a child, the parent is left behind.

Inverse kinematics is a system in which the par-
ents follow the children. You can see the effect
using a simple hierarchy.

The Golden Mace
Because linked objects in inverse kinematics sys-
tems are often referred to as chains, why not
experiment with a chain?

Load a sample file:

• Using File>Open, load tut19_1.max.

This medieval mace is already linked in a hierar-
chy. In inverse kinematics, as in forward kine-
matics, you begin by linking objects, just as you
did in the previous tutorial. In this case, the
handle is the parent, the top link of the chain
(Link1) is the child of the handle, the next link
is the child of the link above it, and so on, down
to the spiked ball, which is the leaf of the chain.

You can verify the linkage in the Track View, but
you can also quickly view hierarchies in the
Select by Name dialog.

Open the Select by Name dialog:

1.  Click Select by Name.

The Select Objects dialog appears.

2. Select Display Subtree.

Child objects are indented beneath their par-
ents in the list.

3. Click Cancel.

Activating Inverse Kinematics
Using this linked hierarchy, you can see the
basic difference between forward kinematics
and inverse kinematics.

As a default, 3D Studio MAX is in forward kine-
matics mode.

Test for forward kinematics:

1.  Click the Min/Max toggle to maximize
the Camera view.

2.  Click Select and Move in the toolbar, and
make sure the XY axis constraint is selected.

3. Drag the handle of the mace to move it
around, and then click Undo to cancel.

As you move the parent handle, the child
links and the spiked ball move with it.

4. Drag one of the middle links, and then click
Undo to cancel.

All objects below the link move along with it,
while all objects above the link remain in
place.

Tip: This exercise is faster in wireframe display.
Change your viewport display if you find things
are going slowly.
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You’ve just demonstrated the basic concept of
forward kinematics, that children inherit the
transformation of their parents.

Now, look at Inverse Kinematics. It’s as easy as
flipping a switch.

Turn on inverse kinematics:

1.  Turn on the Inverse Kinematics On/Off
Toggle in the toolbar.

The icon turns blue to indicate that 3DS MAX
is in a special mode.

2. Drag the spiked ball around, and then click
Undo to cancel.

All the linked objects above the ball follow it
in a realistic manner.

Inverse kinematics causes the parents to follow
the children, but it’s a one-way linkage.

Move the middle of the chain:

1. Press F to switch the camera view to the Front
view.

2. Move one of the middle links, observe the
effect above and below the link, and then
click Undo to cancel.

As you drag a middle link, the objects above it
move in IK fashion, but the objects below use
forward kinematics. Inverse kinematics is solved
from the affected object, up through the hierar-
chy toward the root. All objects below the
affected object in the chain use forward kine-
matics.

The “affected object” is called the end effector.
The end effector is simply the last child in the
chain that’s causing the IK effect. Often, it’s the
leaf object (the lowest level on the branch), but
it doesn’t have to be. In the previous example,
it’s the middle link in the chain.
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Setting Joint Parameters 2

You may have observed that, as you move the
spiked ball (the end effector), you have no real
control over the remaining objects in the chain.
The handle wobbles, and each link has a mind
of its own.

Using joint parameter settings, you can specify
which axes of each object can rotate, and the
limits of their rotation. You can also specify how
each object will slide along its axes, in relation to
its parent.

In general, inverse kinematics is easier to ani-
mate than forward kinematics, but requires
more planning. To properly construct a success-
ful IK assembly, you must consider the type of
movement each object in the hierarchy should
make. Typically, you build your assembly of
objects, link them together, and set all of their
joint parameters. Only then do you begin to ani-
mate.

Setting Up the Robot Arm
To demonstrate how to set up IK joint parame-
ters, you’ll use the robot arm that you linked in
a previous tutorial.

Load the file:

• Load tut19_2.max (a linked version of the
robot arm, minus the animation).

The robot is linked, but no joint parameters
have been set. See how it works under IK.

Test the IK action of the robot arm:

1.  Make sure Inverse Kinematics is active.

2.  Click Select and Move, and XY con-
straints.

3. In the Camera viewport, drag the red hand of
the robot arm around, and then click Undo to
cancel.

Although the various objects follow the hand,
they rotate and move chaotically.

Unlike the mace, in which every link was the
same size and neatly arranged in a row, the
objects that make up the robot arm are various
sizes, and each has different motion require-
ments.
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In the following steps, you’ll set the joint
parameters, beginning with the Hand, and work
your way up the IK chain to the Base.

You use the Joint Parameters settings in the
Hierarchy command panel to specify each
object’s rotational limits, and positional—or
sliding—limits.

Joint Parameters for the Hand
Make sure Hand is still selected, and then do the
following:

Access the joint parameters settings:

1. In the Hierarchy command panel, click the IK
button.

The panel fills with controls.

2. Examine the controls by scrolling the panel
up and down.

There are a lot of controls here, but you’ll exam-
ine them a section at a time. Ignore the first
three rollouts. Everything you need to set joint
parameters is in either the Sliding Joints or Rota-
tional Joints rollouts, which contain duplicate
controls.

The Rotational Joints panel lets you specify
about which axes an object can rotate, and how
far it can rotate. For example, you can set one
object to rotate only about its parent’s X axis
from -45 to 180 degrees.

The Sliding Joints panel performs the same
functions with the position of objects. It lets you
specify how far an object can slide from its par-
ent, along any axis.

Note: An object can move, even if it can’t slide,
because the slide is measured as a positional off-
set from the object’s joint. The joint is the link
between the object and its parent.

All IK limits reference the local axes of the parent
of the selected object. To view those axes, switch
to the Parent transform coordinate system.

Display the axis tripods as local coordinates:

• Choose Parent from the coordinate system
list in the toolbar.

The axis tripod for the Hand is oriented to the
local axes of its parent, the Horizontal Shaft.

Note: The local axes of all of the objects in the
robot arm have the same orientation, but the
preceding step is good practice when you’re
working with objects that aren’t so neatly
arranged.

You want the Hand to be able to rotate a full 360
degrees about the X axis. You don’t want it to
slide. As a default, sliding joints are disabled,
and all rotational joints are enabled. Therefore,
all you have to do is turn off the rotational
joints for the Y and Z axes.

Access the rotational joints settings:

1. Close the Sliding Joints rollout (if it’s not
already closed.)
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2. Open the Rotational Joints rollout (if it’s not
already open).

There are three areas with duplicate controls,
one for each axis. The Active check box deter-
mines if an axis is enabled. As you can see, the
Active check box is selected in all three Axis
areas of the panel.

The Limited check box enables the From and To
spinners, when checked, and lets you set limits
to each active axis. For the Hand object, you
don’t want limits because it’s going to freely
spin 360 degrees. However, it’s always a good
idea to use the From or To spinners to check that
you’re activating the correct axis.

Check your axes directions:

1. Check Limited in the X Axis, Y Axis, and Z
Axis areas to enable the From and To spin-
ners.

2. Drag the From spinner in the X Axis area.

The Hand rotates about the X axis.

3. Drag the From or To spinners in the Y Axis
and Z Axis areas.

As you drag the spinners, the hand rotates
about its Y or Z axes.

4. Uncheck Limited in the X, Y, and Z Axis areas.

Note: When you use the From and To spinners
only to check your axis, but don’t plan on set-
ting limits, be sure and uncheck Limited. If you
leave From and To at 0, and Limited checked,
the axis can’t rotate.

Limit the Hand rotation to the X axis:

• Uncheck the Active check boxes in the Y Axis
and Z Axis areas.

That’s all there is to it. As far as IK is concerned,
the Hand can only rotate about its parent’s X
axis.

Limiting the Horizontal Shaft
The next object up the chain is the Horizontal
Shaft. It uses a sliding motion in relationship to
its parent, the Arm. However, it does not rotate.

Set sliding joint limits for the Horizontal Shaft:

1. Press PAGE UP to select the Horizontal Shaft.

2. In the Rotational Joints rollout, uncheck
Active in all three axis areas.

3. Open the Sliding Joints rollout.

4. Select Active in the X Axis area. (The Y and Z
axes should already be deselected.)

The shaft will now slide along its X axis. In this
case, you do want to set limits. You don’t want
the shaft to pull completely out of the arm, or
move back through the arm.
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To set the slide limits, you check Limited, and
then set the From and To spinners.

Note: Be aware of two things in the following
steps:

• The values you set for the From and To slide
limits are offset values from the pivot point of
the selected object to the pivot point of its
parent. While you’re dragging the From or To
spinner, the object jumps to whatever posi-
tion the spinner value displays. When you
release the spinner, the object jumps back to
its original position.

• In order to scale up the initial values from
zero, you’ll hold CTRL when you first drag the
spinners.

Adjust the From and To spinners:

1. Press F to switch to the Front viewport.

2. Check Limited in the X Axis area.

3. Hold CTRL, and drag the From spinner until
you reach a value of approximately 275 units.
(CTRL amplifies the effect of the mouse on the
spinner.)

As soon as you start to drag, the Horizontal
Shaft jumps to where its pivot point (at the
center of the Shaft) is aligned with the pivot
point of the Arm (near the Hinge). While you
drag the spinner, the shaft moves along X
until the hand is just beyond the front of the
arm. As soon as you release the spinner, the
shaft pops back to its previous position.

4. Drag the To spinner until you reach a value of
approximately 750.

Again, the Shaft pops back, and then slowly
moves to the right. You can continue drag-
ging the spinner, or you can simply type the
correct value into the spinner field, and press

ENTER. At 750 units, the Shaft is extended
almost to the end of the arm.

Although the object jumps back to its original
position, you can view its limits by clicking the
From and To labels.

View the limits:

1. Press and then release the mouse button over
the From label.

The Shaft jumps to its From limit while the
mouse button is pressed.

2. Repeat the same with the To label.

The Shaft jumps to its To position, and then
returns.

Limiting the Arm
The Arm is another rotational joint. Unlike the
Hand, you want to limit the Arm so it doesn’t
tilt beyond the confines of its parent Hinge
object. This is also best done from the Front
viewport.

Limit the Arm rotation:

1. Press PAGE UP to select the Arm.

do not tilt beyond
hinge
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2. Close the Sliding Joints rollout to reveal the
Rotational Joints settings.

3. Uncheck Active in the X Axis and Z Axis
areas.

4. Check Limited in the Y Axis area.

5. In the Y Axis area, adjust the From and To
spinners to tilt the arm within the confines of
the Hinge (about -25 to 25).

Finishing Up
You now have a choice. Do one of the following,
depending on how much you want to learn, or
how little time you have to spare:

• Use the techniques described to set the joint
limits for the rest of the objects in the robot
arm assembly. The Hinge spins a full 360
degrees with no limits, and the Vertical Shaft
moves up and down, limited so it doesn’t
leave the Base (or plunge into it). The Base
object is the root of the assembly. Since you
don’t want it to move, make sure you deacti-
vate all of its rotational axes. After setting all
the joint parameters, save your scene as
mytut19.max.

• Use File>Open to load tut19_2a.max. This is
the robot arm with all of the joint parameters
properly set.

Testing the IK Linkage
You can test your joint parameters by simply
turning on IK, and then dragging the Hand
object in the various viewports.

Test the joint parameters:

1.  Make sure Select and Move is selected,
choose View in the coordinate system list,
and then click the XY axis constraint button.

2. Activate any orthographic viewport.

3. Make sure that the Inverse Kinematics
button is selected.

4. In various viewports, drag the Hand object
while observing the effect. Right-click to can-
cel each time.

The objects that make up the robot arm fol-
low the Hand, but are constrained by their
joint parameters.

Damping a Joint
As you move the Hand up and down in the
Front view, you might notice that the Vertical
Shaft slides “loosely” within the base. As a
default, all of the IK joints are frictionless. You
can increase the apparent friction of a joint by
increasing its Damping setting.

Increase Damping in the Vertical Shaft:

1. Select the Vertical Shaft.

2. Find the Z Axis controls in the Sliding Joints
rollout.

These are the controls you set to limit the
From and To position of the Vertical Shaft.

3. Set the Damping spinner to 0.800.

4. Move the Hand up and down in the Front
viewport.

The movement of the Vertical Shaft lags
behind.

Damping is just one of several controls that let
you subtly adjust your IK linkages in 3DS MAX.
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Animating with Inverse
Kinematics 2

There are two methods you can use to animate
an inverse kinematics assembly:

• Interactive IK

• Applied IK

Interactive IK consists of simply turning on the
Animate button, and then using the mouse to
move objects in the IK assembly at various
frames. While this is the easiest method, it’s not
the most accurate.

Applied IK requires that you bind the end-effec-
tor object to a follow object. You animate the fol-
low object to describe the motion you want, and
then use the Apply IK button to calculate the
correct IK solution for a specified range of
frames.

You’ll look at both methods, beginning with
interactive IK.

Using Interactive IK
You’ll use the Hand as the end effector to ani-
mate the robot arm. But first, hold the current
settings of the scene; you’ll fetch them later in
this exercise.

Hold these settings:

• Choose Edit>Hold.

Now, proceed with the animation.

Animate the robot arm using interactive IK:

1. Turn on the Animate button.

2. Go to frame 20.

3. Drag the Hand object to reposition the robot
arm in any way you want.

4. Go to frame 50.

5. Drag the Hand to position the assembly dif-
ferently.

6. Repeat the process on frames 70 and 100.

7. Turn off the Animation button.

8. Play, and then stop the animation.

The robot moves as you specified.

Using Applied IK
Now, you’ll look at the second method of IK ani-
mation—applied IK.

In the following steps, you’ll create a follow
object, bind the Hand to the following object,
animate the follow object, and then invoke
applied IK, which will calculate the correct
transform keys at every frame.

Create a follow object:

1. Choose Edit>Fetch, and answer Yes at the
prompt.

The robot arm, without the animation, is
restored.

2.  Click Helpers in the Create command
panel.

3. Click the Dummy button.

4. In the Front viewport, create and position a
dummy object that’s slightly larger than the
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Hand object, and floating just in front of it (to
its right, as seen in the Front viewport).

Note: You can use any type of object as follow
objects. A dummy is frequently used because it
doesn’t show in the rendered animation.

In the next procedure, bind the end effector (the
Hand) to the follow object. The end effector will
attempt to be in the same place as the object to
which it’s pinned, within the constraints of the
joint parameters.

Bind the Hand to the dummy:

1. Select the Hand.

2. In the Hierarchy command panel, scroll the
IK panel so you can see the top two rollouts.

3. In the Object Parameters rollout, click the
Bind button.

The button turns green to indicate that it’s
the current mode.

4. Point the mouse at the Hand, drag out to the
dummy until the pushpin cursor  appears,
and then release the mouse.

The dummy flashes briefly, its name appears
above the Bind button, and Bind Position
becomes checked.

And now, animate the follow object, and the
Hand will follow.

Animate the follow object:

1. Turn on the Animate button.

2. Drag the time slider to frame 20, and begin
moving the dummy.

The Hand pops to the center of the dummy.
However, if you move the dummy beyond the
joint limits, the Hand stops at its IK limits and
merely points in the direction of the dummy.

3. At frames 40, 60, 80, and 100, move the
dummy object above, below, and to the sides
of the robot arm.

4.  Use the Select and Rotate tool to rotate
the dummy at various frames, about various
axes.

5. Drag the time slider to view the movement of
the dummy and the Hand.

The Hand does not always follow the dummy
exactly.

The movement of the Hand is not completely
accurate because it’s based on interpolated val-
ues between each keyframe that you set for the
dummy. To get a precise match, you calculate
the IK solution.

Calculate the IK solution:

1. Make sure that any object in the chain
(including the follow object) is selected.

2. Check Clear Keys.
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3. Make sure that the Start spinner is at 0, and
the End spinner at 100.

The Start and End spinners specify the range
of frames to which the IK solution is applied.

4. Click the Apply IK button.

A grow bar appears in the Prompt line, along
with a Cancel button.

5. When the calculation is complete, drag the
time slider to examine the results.

The Hand object follows the dummy as it flies
about, and the rest of the robot arm assembly
follows the hand, obeying the rules of the IK
joint parameters.

If you’ll recall, the Hand is capable of 360
degrees of rotation. However, it’s not rotating
because the IK calculation is not taking the ori-
entation of the dummy into consideration. This
is easily remedied.

Include rotation in the IK calculation:

1. Select the Hand.

2. Check Bind Orientation in the Object Param-
eters rollout.

3. Click Apply IK.

4. When the calculation is complete, drag the
time slider to view the results.

The Hand moves and rotates.

Summary of Steps
Here’s a summary of the steps required to use
applied IK.

• Create a follow object (usually a dummy).

• Bind the end effector to the follow object.
(Bind Position is selected automatically, but

you must choose to turn on Bind Orienta-
tion.)

• Animate the follow object.

• Select any object in the IK chain, or the follow
object.

• Click the Apply IK button.

You can do the second and third steps in either
order, as long as the end effector is pinned to the
follow object before you calculate the IK solu-
tion.

Some other things to be aware of:

• If you select Update Viewports before clicking
Apply IK, you’ll see the calculation of every
frame. Since this slows down the solution, use
Update Viewports only when you’re analyz-
ing your animations.

• Applied IK produces a key at every frame for
every object’s transform track. Compare this
with interactive IK that only produces keys on
the frames you specify. On the other hand,
you can use the Reduce Keys function in
Track View to automatically reduce the num-
ber of keys.
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The Telescope 2

In this brief exercise, you’ll use nested cylinders
to see the effect of the Ease option, and to deter-
mine exactly why applied IK is more accurate
than interactive IK.

1. Load tut19_3.max.

2.  Click the Select and Move button, and set
axis constraint to Z.

3.  Turn on Inverse Kinematics, and move
the top cylinder up and down.

The nested cylinders open and close like a
telescope.

4. Switch the viewport display to Wireframe.

If you examine the joint parameters in the IK
panel, you’ll see that each cylinder (except the
base) has a Slide limit set along its Z axis. All
other axes, including the rotational axes, are
inactive.

Applying Ease
In the previous exercise, you saw how Damping
slowed the reaction of an object over the full
extent of its limits. (The Vertical Shaft was
damped from its bottom position to its top posi-
tion.)

The IK Ease option applies damping only when
an object nears its joint limit. It’s a subtle effect
that softens the often mechanical effect of IK
linkages.

Look again at the effect of the current IK link-
age:

• Drag the innermost cylinder slowly up, and
then slowly down while examining the point
at which each cylinder begins to move.

Each cylinder begins moving abruptly as the
slide limits are reached.

Now, apply Ease to the cylinders and compare
the results.

Apply Ease to each cylinder:

1. Select the innermost cylinder.

2. In the Sliding Joints rollout, select Ease in the
Z Axis area.

3. Press PAGE UP to move to the next cylinder,
and select Ease in the Z Axis area.

4. Repeat step 3 for the third cylinder. (The base
cylinder doesn’t need it.)

5. Slowly drag the innermost cylinder up and
down.

Just before the cylinder reaches its limit, the
next cylinder in the chain begins to move,
and so on, along the hierarchy, producing a
softer effect.

Interactive vs. Applied IK
You learned during the robot arm exercise that
applied IK is more accurate than interactive IK.
Now, you’ll see why.

When you use interactive IK, keys are created for
each affected object in the IK chain only on the
keyframes at which you move the end effector.
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As a result, the effect you see on the objects in
the viewport while moving the end effector is
not necessarily the effect you’ll get when each
object is interpolated between the keyframes.

Interactive Result
Look what happens when you use interactive IK
to animate the telescope:

Animate the telescope:

1. Move the innermost cylinder down until all
the cylinders are collapsed.

2. Turn on the Animate button, and move to
frame 100.

3. Slowly move the innermost cylinder up until
the cylinders are fully extended.

First the innermost cylinder moves up, then
the next one follows, and then the third.

4. Drag the time slider to examine the anima-
tion.

In the animated result, all the nested cylin-
ders begin moving at the same time.

See the difference? When you dragged the cylin-
der with the mouse, the linked cylinders began
moving only when the IK limits were reached.
In other words, they moved sequentially. But
because only two Position keys were actually
created for each cylinder, and those keys repre-
sented the start and end position of the cylin-
ders, during the animation they each traveled
their full distance at the same time.

Applied Result
When you use a follow object and apply IK, an
IK solution is calculated for each frame of the
animation, providing the correct result for every
object in the chain, at all frames. Try the follow-
ing procedures:

Create and animate a follow object:

1. Turn off the Animate button.

2. Open the Helpers branch of the Create com-
mand panel, and create a dummy object on
the ground plane, to the right of the stack of
cylinders.

Note: You don’t have to center the dummy
with the cylinders, because their sliding joint
settings limit them to the Z axis. All you need
provide is a follow object with vertical
motion.

3. Select the innermost cylinder.

4. In the Object Parameters rollout in the Hier-
archy command panel, click Bind, and bind
the cylinder to the dummy.

5. Turn on the Animate button and move to
frame 100.
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6. Move the dummy object up along Z until the
cylinders are completely extended.

The cylinders collapse downward in an
attempt to point to the dummy. They extend
in sequence as you move the dummy upward.

Apply IK:

1. Turn off the Animate button.

2. Make sure the Start and End spinners are set
to 0–100.

3. Check Clear Keys.

4. Click Apply IK.

5. When the calculation is complete, drag the
time slider to examine the animation.

The cylinders move up sequentially, each fol-
lowing the other.
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Solving the Piston Puzzle2

“Solving IK” sounds like a puzzle, and in fact,
most IK assemblies are. When presented with an
assembly of objects that you want to animate in
a certain way, you need to puzzle out the correct
way of linking the objects before IK can come up
with the solution.

Load and examine the following file:

• Load tut19_4.max.

In this scene, all of the objects are correctly
arranged, but none is yet linked.

Here’s the puzzle. You want an animation in
which the Wheel rotates and turns the Pin,
which pulls the Crank, which pulls the Piston
up and down in the Cylinder.

Think about it for a moment. How would you
link the various objects to create the animation
using IK?

The Answer
The first clue to solving this puzzle is that you
don’t link all of the objects in a single IK chain.
The Wheel turns the Pin, and the Crank follows
the Pin. Therefore, the Pin is the follow object in
this IK solution.

The Pin is linked as child to the Wheel, becom-
ing one assembly, and providing nothing more
than animation of the follow object. The second
assembly is the Crank as child to the Piston. This
second assembly is the IK chain that follows the
Pin. The Cylinder doesn’t move, so it doesn’t
need to be linked to anything.

Note: Throughout the steps in this exercise, feel
free to use viewport navigation tools to zoom in
on the objects you need to select, link, and bind.
In particular, the Region Zoom tool is handy for
zooming in on orthographic viewports.

Link the objects:

1.  Click the Select and Link button in the
toolbar.

2. Link the Pin to the Wheel.

3. Now, link the Crank to the Piston.

There’s one other tricky part to the solution.
You’ll see what it is after you’ve set your joint
parameters.

Set the joint parameters:

1. Select the Piston.

2. Click IK in the Hierarchy command panel.

3. Uncheck Active for all axes in the Rotational
Joints rollout.

4. Open the Sliding Joints rollout, and activate
the Z axis.

5. Press PAGE DOWN to select the Crank.

crank

piston cylinder

wheel pin
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6. Close the Sliding Joints rollout.

7. In the Rotational Joints rollout, deactivate the
X and Z axes, and leave the Y axis active.

Double Pivot Points?
And now, you have a problem. If you check the
From or To spinners for the Crank’s Y rotational
axis, you’ll see that the pivot point is in the cen-
ter of the Crank. (Check Limited, drag the spin-
ners, and then uncheck Limited.) For your ani-
mation to work, the crank must pivot about the
tab at the top of the piston—but it must also
pivot about the Pin. How do you set up an
object with two pivot points?

Think about that while you study a related
conundrum.

Adjust the Crank’s pivot and test the linkage:

1. Select the Crank.

2. Click the Pivot button in the Hierarchy com-
mand panel.

3. Click Affect Pivot Only.

The Crank’s pivot axis icon appears.

4.  Use the Select and Move tool to move the
pivot icon down to the bottom of the Crank
where it’s attached to the Piston tab.

5. Click the IK button in the Hierarchy com-
mand panel to exit pivot adjust mode.

6.  Turn on the Inverse Kinematics button.

7. In the Front viewport, use the Select and
Move tool with XY constraint to move the
crank.

The piston and crank move vertically, but the
crank does not rotate.

8. Click Undo to cancel the move.

Why doesn’t the crank rotate? You activated the
rotational axis properly.

In any IK solution, the object used as the end
effector pulls (or pushes) the remaining objects
in the chain. Thus, the position of each object in
the chain affects the position and rotation of its
parent object. In your IK chain of Crank and Pis-
ton, you can move the Crank, but only a child
object can cause the Crank to rotate.

As it turns out, the addition of a child object
provides the following solution to both puzzles:

• A “handle” for the crank.

• A “second pivot point” for the crank.
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By adding a dummy object to the upper end of
the crank, the dummy becomes the new end
effector for the piston chain. Moreover, its pivot
point will be the second pivot point for the
Crank.

A Dummy Ties It All Together
Here’s how to complete the assembly:

1. In the Helpers branch of the Create command
panel, click the Dummy button.

2. Create a small dummy object that’s centered
on top of the Pin.

3.  Use Select and Link to link the dummy to
the Crank.

Test your IK linkage:

1.  Click the Select and Move tool, and then
move the dummy around XY in the Front
viewport.

The Crank rotates, and the Piston moves ver-
tically.

2. Click Undo to cancel.

The final task is to bind the dummy to the Pin
object, rotate the Wheel, and then apply IK.

Complete the animation:

1. In the Hierarchy command panel, click IK,
then click Bind, and bind the dummy to the
Pin object.

2. Move to frame 100, and turn on the Animate
button.

3.  Turn on Angle Snap.

Before rotating the wheel, you should be aware
of some differences between rotation in IK
mode and rotation in forward kinematics mode.

Because of the way IK calculates its solutions,
rotations are limited to repetitions of 180
degrees. If you wanted 360 degrees of rotation
over 100 frames, you’d rotate 180 degrees at
frame 50, and another 180 degrees at frame 100.
Furthermore, when you rotate an object that’s
part of an IK chain, the solution will place the
object at the end orientation you specify, but it
might not use the axis you specified with the
mouse.

None of this is a problem however, if you per-
form your rotation in forward kinematics mode,
while IK is off.

Rotate the wheel, and apply IK:

1.  Turn off IK.

2.  Use Select and Rotate to rotate the wheel
360 degrees about its Z axis.

3.  Turn off Angle Snap.

4. Click Apply IK.

5. Play the animation.

As the wheel rotates, its Pin pulls the dummy,
which pulls the Crank, which rotates and
pulls the Piston.
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Terminators, Precedence,
and Path Links 2

To close this tutorial, you’ll return to the medi-
eval mace, examining some miscellaneous IK
capabilities that you should know about. Termi-
nators let you block the IK solution at any point
along the chain. Precedence lets you set the prior-
ity with which the IK chain is calculated. Path
links are a method of using shape splines as links
in your IK chain.

Tip: The following exercises are faster in wire-
frame display. Change your viewport display if
you find things are going slowly.

Using Terminators
Begin by reminding yourself of how the mace
works using the default IK settings:

Reload the mace and test it:

1. Load tut19_1.max

2. Choose Edit>Hold.

3.  Maximize the Front viewport.

4.  Turn on Inverse Kinematics in the tool-
bar.

5.  Using the Select and Move tool with XY
axis constraints, drag the spiked ball around,
and then click Undo to cancel.

The links and the handle follow in a typical IK
chain.

Using terminators, you can block the IK chain at
any point.

Terminate one of the links:

1. Select the fifth link down from the handle.

2. Check Terminator in the Object Parameters
rollout of the IK panel.

3. Drag the spike ball around, and then click
Undo.

The links from the ball up to the fifth link use
IK, but all remaining objects in the chain are
unmoved.

4. Drag the fifth link around, and then click
Undo.

The objects above the fifth link use IK, but all
objects below it use forward kinematics.

Terminators are handy when you’ve got a com-
plex hierarchical linkage and want IK to be
solved for only portions of the hierarchy. You
can set as many terminators as you want.

Setting Precedence
When you move an end effector, the position
and rotation of all the remaining objects in the
IK chain are calculated in a certain order, using
a default precedence setting. You can set a differ-
ent precedence for every object in your chain.

Remove the terminator, and create another
mace:

1. Select the fifth link from the handle.

2. Uncheck Terminator in the Object parameters
rollout.

3. Choose Edit>Select All.
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All objects in the mace are selected.

4.  Using the Select and Move tool, hold
SHIFT, and drag the selected objects to the
right.

5. In the Clone Options dialog, make sure Copy
is chosen, and Number of Copies is set to 1.

6. Click OK.

A duplicate mace is created.

Both mace assemblies carry the same hierarchi-
cal linkages, and the same default joint-parame-
ter settings.

The default IK precedence solution is from child
to parent. First the child is tested, and then its
parent, and then its parent, and so on, up the
chain to the root. See what happens when you
reverse the precedence of the hierarchy on the
right.

Reverse and compare precedence settings:

1. Select all objects in the mace on the right.

2. In the Object Parameters rollout of the IK
panel, click the Parent -> Child button.

3. Deselect all objects.

4.  Use Select and Move to drag the ball on
the right, and then click Undo.

5. For comparison, drag the ball on the left, and
then click Undo.

The chain on the right seems stiff, compared
to the one on the left.

Notice the difference? In the mace on the right,
the root object—the handle—is solved first, and
the leaf object—the spiked ball— is solved last.
It feels almost like there’s a spring running
through the chain. When you drag the ball in
the mace on the left, lower links are solved first,
so they easily move to position before the upper
links and the handle.

If you select the spiked ball on the right and
press PAGE UP to move up the chain, you’ll see
the precedence number for each box in the Pre-
cedence field. The more positive the number,
the higher the precedence. Since you’ve applied
Parent -> Child to these boxes, negative num-
bers have been assigned the boxes. The root
handle object has a precedence of 0, which is
more positive than the remaining negative
numbers, and therefore the highest precedence.

When all objects are set to 0, the default
Child -> Parent precedence is used. You can use
any numbers to set precedence; it’s not the
value, but the relationship between the num-
bers that counts. Thus: 10, 20, 30 is the same as
10, 200, 3000.

Try some different precedence settings. For
example, select the bottom half of the objects in
the mace on the right, and apply Child -> Par-
ent. See what that does to the chain.
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Creating Path Links
3D Studio MAX lets you use shape splines for IK
path links. To do this, you place a spline as one
object in your chain, and then use a Path con-
troller to link a child to the parent spline.

You can use the mace again to see this tech-
nique.

Set up the objects:

1. Choose Edit>Fetch.

2. In the Display branch, uncheck Shapes in the
Hide by Category rollout.

A blue spline shape appears above the mace.

3. Select the mace handle.

4.  Link the mace handle to the spline shape.

The hierarchy of the mace now has an addi-
tional object at its root—the spline. You’re going
to set things up so that, when you drag the
spiked ball, the motion moves up the chain, and
the handle is dragged around the spline.

You don’t want the spline or the handle to
rotate, so do the following:

Deactivate the objects’ rotational joints:

1. Select the blue spline.

2. Click IK in the Hierarchy command panel,
and deactivate all three axes in the Rotational
Joints panel.

The next thing you’ll do is assign a Path control-
ler to the handle, and then point the handle at
the shape, which becomes its path.

Assign the Path controller:

1. Select the handle.

2. In the Motion command panel, open the
Assign Controller panel.

3. Click to highlight the Position label in the
window.

4.  Click the Choose Controller button.

The Assign Position Controller dialog
appears.

5. Choose Path from the list, and click OK.

A Path controller now determines the posi-
tion of the handle.

6. Click Pick Path in the Path Parameters rollout,
and then click the spline shape.

The handle moves to the front of the spline.

7. Drag the time slider back and forth and then
return to frame 0.

The handle (and mace) moves around the
spline path.

As a default, path Percent keys are created at
frame 0 and 100, resulting in the animation you
see.
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One final thing to do. You need to tell the IK sys-
tem which part of the path the handle can slide
around.

Set the Path joint:

1. Make sure the handle is still selected.

2. Open the Hierarchy command panel.

The Sliding Joints panel has been replaced by
a Path Joint panel.

3. Open the Path Joint panel.

The various controls let you activate the path,
and select the from and to range of the object
as a percentage of the path.

4. Check Active.

That’s all there is to it. You can quickly test the
effect:

1.  Make sure Inverse Kinematics is turned
on.

2.  Use the Select and Move tool to drag the
spiked ball around in the Camera viewport.

The links move in the IK chain, as they did
before, but the handle slides around on the
spline path.
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If you were assembling a completed 3D anima-
tion for broadcast video, one of the last steps
would be a visit to a post-production studio for
postprocessing. There, segments of animation
would be edited together, and sophisticated
equipment used to composite images and add
special effects, such as transitions and titles.

3D Studio MAX offers many of these same capa-
bilities in its Video Post dialog box. Using it,
you can composite multiple layers of bitmap
images and animations along with views of
your scene.

In this tutorial, you’ll learn how to composite
images with your rendered scene, and how to
edit your animations to include cross fades and
titles.

Video Post-production
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Compositing Without
Time 2

In the first half of this tutorial, you’ll use Video
Post to composite images with a static rendering
of a single frame of a scene. You’ll focus prima-
rily on the compositing functions, and ignore
the element of time. In the second half of the
tutorial, you’ll see how time is used in Video
Post to composite animations.

Understanding Alpha
Compositing is the application of two or more
images, one over the other. Naturally, when you
composite one image over another, the image
on top must have some areas of transparency or
nothing of the underlying image is seen. There
are various methods of compositing in Video
Post—all of which are plug-ins—but the primary
method uses an alpha channel.

An alpha channel is an additional 8 bits of data
added to a 24-bit file that describe 256 levels of
transparency. When you composite one image
over another, the alpha data in the second
image describes how to blend the pixels of the
second image with those of the first, resulting in
new color values for each of the pixels.

Depending on the type of bitmap file you out-
put, 3DS MAX can render 32-bit images contain-
ing the alpha channel. (Specifically, the Targa
file format outputs an alpha channel.) When
you render a scene, any area without geometry
is zero alpha, or clear. Solid objects are 255
alpha, or solid, and transparent materials pro-
vide intermediate alpha values.

Antialiasing is perhaps the most important con-
tribution of the alpha channel in compositing.
When an image is antialiased, a gradient of pix-
els is added to its borders.

The alpha channel provides antialiasing by
assigning various levels of transparency to the
border pixels. This feathers the edges, resulting
in clean rather than jaggy borders.

Compositing Images with a Scene
For your first exercise, you’ll use Video Post to
composite two images with a rendered scene.
First, take a look at the scene.

Open and render the sample scene:

1. Choose File>Open, and load tut20_1.max.

2.  Make sure the Camera viewport is active,
and click Quick Render.

You can actually view the alpha channel in the
rendering window.

this stairstep effect is aliasing and
is commonly called “the jaggies”

intermediate colors are added to
make the borders appear smoother
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View the alpha channel:

1.  Click Display Alpha Channel in the tool-
bar of the rendering window.

White indicates the opaque areas, black the
transparent areas, and shades of gray are the
semi-transparent areas.

2.  Click Display Alpha Channel again to
return to the RGB display.

3.  Exit the rendering window.

Included with your tutorial files are two images
you’ll composite with this scene. You’ll use
Video Post to “sandwich” the rendered bowl
between the two bitmap images. The back-
ground will be a digital image of rusted metal. It
contains no alpha, but doesn’t need it because
it’s the background. The second image is a Vic-
torian decorative frame. It contains alpha for
the “hole” in its center.

Adding the Events
To get started, you’ll add the three events that
you want to composite—the background, the
scene with the bowl, and then the image of the
frame. Events are rendered in the order listed in

the queue, so the background image should be
at the top of the queue.

The background is a bitmap image that you input
to the Video Post queue. As a result, it’s an Image
Input event.

Add an image input event:

1. Choose Rendering>Video Post.

The Video Post dialog appears.

2.  Click Add Image Input Event in the tool-
bar.

The Add Image Input Event dialog appears.

3. Click the Files button to display a file dialog.

4. Select tutrust.jpg in the \maps directory, and
click OK.
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There are a number of options you can set at
this point. Instead, you’ll accept the default
settings and add the remaining events. You
can adjust each event later.

5. Click OK to exit the Add Image Input Event
dialog.

The first event appears in the queue with the
Image Input icon and its filename.

The scene is the second event. It’s similar in
effect to an Image Input event, but it’s called a
Scene event.

Add the scene event:

1.  Click Add Scene Event.

The Add Scene Event dialog appears.

In this dialog, you choose the view of your
scene that you want rendered.

2. Choose Camera01 from the View list, and
click OK.

A second event is added to the queue, display-
ing the Scene Event icon and the name of the
view.

You add the third image just as you added the
first.

Add another image:

1.  Click Add Image Input Event.

2. Click Files in the Add Image Input Event dia-
log.

3. Choose tutframe.tga from the list, and click
OK.

4. Click OK to exit the Add Image Input Event
dialog.

You now have three events in the queue.

Adding Image Layer Events
If you were to execute the Video Post sequence
now, each event in the queue would render on
top of the preceding event, blocking its display.
As a result, only the last image would appear. To
composite the events, you use an Image Layer
event.

An Image Layer event provides various methods
of compositing images and scenes. In most
cases, you’ll use the Alpha Compositor, but you
could also use plug-ins such as Pseudo Alpha, to
composite images that don’t contain an alpha
channel. You might also use a Cross Fade Tran-
sition or Simple Wipe when you’re compositing
images over time.

To add an Image Layer event, you must first
select the two events you want to composite.

Add an Image Layer event:

1. Select the tutrust.jpg Image Input event in the
queue.

2. Hold CTRL, and click the Camera01 Scene
event to add it to the selection.

The Add Image Layer Event button is enabled.

3.  Click Add Image Layer Event.

The Add Image Layer Event dialog appears.
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4. Choose Alpha Compositor from the Layer
plug-in list, and click OK.

The queue now has an Alpha Compositor
Layer event as parent to the background and
scene events.

As you build your queue sequence, the events
become a hierarchy in which controlling events,
such as the Image Layer event, become parents
to the events they affect. The background image
and the scene are now children of the Image
Layer event. To composite both of them with
the frame image, you select the first Image Layer
event and the frame Image Input event.

Add another Image Layer event:

1. Click the Alpha Compositor Layer event.

2. Hold CTRL, and click the tutframe.tga Image
Input event.

3.  Click Add Image Layer Event.

4. Make sure that Alpha Compositor is in the
Layer Plug-In list, and click OK.

An Alpha Compositor Layer event is parent to
all the remaining events in the queue.

Executing Video Post
You don’t “render” a Video Post queue, because
you might not have a scene in the queue to ren-
der. Instead, you execute the sequence. You’ll
make more adjustments, but this is a good place
to see what you have.

Execute the sequence:

1.  Click Execute Sequence.

The Execute Video Post dialog appears. It’s
similar to the Render Scene dialog, but its set-
tings are independent of that dialog.

2. Choose Single.

3. Click 320x240.

4. Click Render.

A Video Post progress dialog appears, along
with a rendering window.
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Progress bars appear for each of the events as
they’re executed. Ultimately, the composited
images appear in the rendering window.

Editing the Sequence
You can see the three components in the result-
ing image, and the first thing you notice is that
the bowl is too big. You’ll make other adjust-
ments as well before you execute the sequence
again.

You can edit any of the events by selecting
them, and then clicking the Edit Current Event
button . However, it’s much easier to simply
double-click the event you want to edit.

When you edit an event, you see the same dia-
log that appeared when you first assigned the
event. The steps you’ll take now can also be
taken as you assign each event.

First, you’ll set the tutrust image so that it
doesn’t rescale during the compositing process.

Adjust the tutrust image:

1.  Exit the rendering window.

2. Double-click the tutrust.jpg Image Input
event to display the Edit Input Image Event
dialog.

3. Click the Options button.

The Image Input Options dialog appears.

This dialog lets you position and scale the
image. As a default, each image is resized to
match the Video Post output resolution. The
scaling—or resizing—takes extra time. You
don’t need it for this image, so turn it off.

4. Choose Do Not Resize.

5.  Click the Center button in the Align-
ment area.

6. Click OK to exit the Image Input Options dia-
log, and then click OK again to exit the Edit
Image Input Event dialog.

When you scale an image, it loses a certain
amount of definition. Rather than resize the
frame, you can output the Video Post result at
the resolution of the frame image. Here’s how to
determine the size of the image.

Examine the tutframe image:

1. Double-click the tutframe.tga Image Input
event.

2. Click the Files button to display the file dia-
log.



3t2tut20.fm    7  Thu Oct  2 15:25:20 1997

Tutorial 20

V
id

eo
 P

o
st

-p
ro

d
uc

ti
o

n
20

 –
 7

3. Click the Info button.

A message tells you, among other things, that
the image resolution is 622 x 434, and it’s a
32-bit image (meaning it has an alpha chan-
nel).

4. Click OK to exit the Image Information dia-
log.

5. Click Cancel to exit both dialogs.

You’ll use the resolution information when you
execute the sequence. First, adjust the camera.

Adjusting the Camera

You’ll dolly the camera so that the entire bowl
fits within the frame. The height of the frame
opening is 50 percent of its original size. You can
use the Safe Frames as guidelines to adjust the
camera.

Turn on Safe Frames and dolly the camera:

1.  Iconize the Video Post dialog.

2.  Right-click the Dolly Camera icon to dis-
play the Viewport Configuration dialog.

3. Click the Safe Frames tab.

4. Uncheck Live Area and Action Safe.

5. Set the Title Safe spinner to 50 percent
reduced.

6. Check Show Safe Frames in Active View, and
click OK.

A small, cyan frame appears in the camera
viewport.

7.  Click Dolly Camera, and dolly the camera
out until the top and bottom of the bowl and
lid are centered and inside the safe frame.
(Don’t worry about the sides.)

Now, execute Video Post, using the larger reso-
lution.

Restore Video Post, and execute:

1.  Expand Video Post.

2.  Click Execute Sequence.

3. In the Output Size area, set the Width to 622,
the Height to 434.

4. Click Render.

Rendering the larger size takes longer. Click
the Video Post progress dialog to bring it to
the front so you can watch the progress of
each event in the queue. When all is com-
plete, click the rendering window to bring it
to the front.

The Bowl appears against the rusted metal
background, surrounded by the ornate frame.
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Replacing the Scene Event
You might want to add another image, such as a
credit, to the sequence, but you don’t want to
wait for the scene to render each time you view
the adjusted sequence.

To speed up the Video Post execution you can
eliminate the rendering of the scene. There’s no
animation, so it’s the same as a still image. Now
that you’ve positioned the camera properly, and
established the output resolution, you can cre-
ate a rendered bitmap of the scene, and use the
image instead of the Scene event.

Create a rendering of the bowl:

1.  Close the rendering window and the
Video Post progress dialog.

2.  Iconize the Video Post dialog.

3.  Make sure the Camera viewport is active,
and click Render Scene.

4. In the Output Size area, set the Width to 622
and the Height to 434. Make sure Pixel Aspect
Ratio is set to 1.0.

5. Click Files, enter the name tutbowl.tga,
including the extension, but don’t click OK.

Notice that when you enter the extension
.tga, the Setup button becomes active in the
file dialog. When you provide an extension to
specify the type of file, you can access the
options for the specific file type.

6. Click Setup.

The Targa Image Control dialog appears.

This dialog lets you specify the number of
bits-per-pixels (32 to include an alpha chan-
nel), and other options specific to Targa files.
You can even embed a text description with
your image file.

7. Make sure 32 is chosen, and click OK.

8. Click OK to exit the file dialog.

9. Make sure Single is chosen, and click Render.

The bowl is rendered to a 32-bit image file.

Here’s how to replace the Scene event with a
new Image event.

Add the bowl image event:

1. Close the rendering window.

2.  Expand the Video Post dialog.

3. Make sure that no events are selected.
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4.  Click Add Image Input Event.

5. Click Files, choose tutbowl.tga (in the \Maps
directory), and click OK.

6. Click OK to exit the Add Input Image Event
dialog.

7. Select the tutbowl Image Input event, hold
CTRL, and click the Camera01 Scene event to
add it to the selection.

8. Click Swap Events.

9.  Select the Camera01 event, and click
Delete Current Event (answering Yes at the
prompt).

Now, see how much faster the execution goes.

Execute the sequence:

•  Click Execute Sequence, and then click
Render.

The final composite appears much faster, and
looks exactly the same. The alpha in the ren-
dered image of the bowl provides clean edges
and a semitransparent lid.

Adding a Credit
You’re ready to send the image to a client, but
you want to attach a credit. Video Post is perfect
for adding credits to your rendered scene.

Add a credit:

1. Close the rendering window.

2. Deselect all events in the queue.

3.  Click Add Image Input Event.

4. Click Files, and select and load tutcredt.tga (in
the \maps directory).

The image is a small line of text against clear
alpha. You don’t want this resized, and you
want to place it in the lower-right, inside the
frame.

5. Click Options.

6. Choose Do Not Resize.

7. Choose Coordinates.

8. Set both the X and Y spinners to 306.

9. Click OK, and then click OK again to exit
both dialogs.

Add another Image Layer event:

1. Select the new tutcredt.tga event, and the top
Alpha Compositor Layer event.

2.  Click Add Image Layer event, choose
Alpha Compositor from ther list, and click OK
to add another Alpha Compositor.

Outputting to a File
You’re ready to execute the new sequence, but
this time you want something more permanent
than the display in the rendering window. To
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output to a file, or to any other type of device,
you add an Image Output Event. This lets you out-
put an image at any point in the queue
sequence.

Add an Image Output event:

1. Make sure that none of the events are
selected.

2.  Click Add Image Output Event.

3. Click Files.

4. In the file dialog, choose the type of file you
want to output (such as .jpg or .tga), and name
the file mytut20a.

5. Click OK, and then click OK to exit both dia-
logs.

Your queue now looks like the one in the fig-
ure.

You’re all set to go.

Execute the sequence and save the output:

•  Click Execute Sequence, and then click
Render.

The sequence is rendered, composited, and
saved.

Saving the Video Post Sequence
The Video Post queue is saved with your .max
scene file. However, you can also save the
sequence independently, and then reuse it with
another scene.

Save the sequence:

1. Close the rendering window.

2.  Click Save Sequence in the Video Post
toolbar.

3. Type mytut20a, and click Save.

Experimenting with Video Post
Now that you’ve completed the image, you can
use it to experiment with some of the other
Video Post options. To avoid overwriting the
image you just created, simply disable the Out-
put Image event.

Disable the Output Image event:

1. Double-click the Output Image event in the
queue.

2. Uncheck Enabled, and click OK.

The Output Image event is grayed out.
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You can disable any of the events in the queue
using the same procedure. Disabled events can
be selected and edited like any other event. The
only difference is that they’re not included
when you execute the sequence.

Masking the Image Layer Event
Each of the Image Layer events can be assigned
a bitmap that masks the compositing effect. For
example, here’s how to alter the compositing of
the frame image with a lattice design.

Mask the frame image:

1. Double-click the second Alpha Compositor
Layer event from the top.

2. Click the Files button in the Mask area of the
Edit Layer Event dialog.

3. Choose tutlattc.tga from the \maps directory,
and click the View button.

4.  Click Display Alpha Channel.

The alpha channel is not much different than
the image—crisscrossed bands of white.

5.  Exit the image display, and then click OK
in the file dialog.

6. Open the pop-up list in the Mask area.

The list shows you the various channels of the
image that you can use as a mask.

7. Choose Alpha Channel, and then click OK.

8.  Click Execute Sequence, and then click
Render.

The frame in the image now has lattice-
shaped holes.

The mask affects only the opaque areas of the
frame image. The solid alpha in the mask image
erases the frame image, and the clear areas have
no effect on the frame image. (You can easily
reverse the effect by checking Inverted in the
Edit Layer Event dialog.)

Using a Filter Event
You can assign a Filter event to change the qual-
ity of an image or scene in the queue. You can
also assign Filter events to Image Layer events to
affect the children of the Image Layer event.

One of the Filter events provided with 3DS MAX
is the Negative filter. It inverts the values of the
pixels in the image to which it’s assigned.

Here’s how to use a Negative Filter event to
change the rust background in the current
sequence.

Add a Filter event:

1. Close the rendering window.
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2. Select the tutrust.jpg Image Input event.

3.  Click Add Image Filter Event.

4. Choose Negative from the Filter plug-in list.

5. Click OK.

The tutrust.jpg event is now a child of the
Negative Filter event.

Before executing this sequence, fix the back-
ground image so it scales up to match the out-
put resolution.

Resize the background:

1. Double-click the tutrust.jpg event.

2. Click Options.

3. Choose Resize to Fit.

4. Click OK, and then click OK to exit both dia-
logs.

5.  Click Execute, and then click Render.

The background of the composite is now light
blue instead of red.
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Galactic MAX: The Movie2

Now that you’ve learned how to composite still
images, you can learn how to composite images
over time. You’ll assemble an animation that
might be the basis for a movie sequence.

Vile forces have abducted Catheryn of Shea, muse of
Prince Giliberti, and locked her in the Fifth Tower on
the planet KTX! Joining the Prince in a desperate res-
cue mission are Sir Forrest, Knight of Altos,...and a
bunch of other people. Meanwhile, David the Great
pilots the attacking Flap Jet with a crew of mercenar-
ies as Queen Harriet of Osland awaits news aboard
the mother ship, which even now circles the desolate
planet.

That’s the plot. The movie opens with a title
screen, followed by shots of the prince’s flap jet
heading for the tower. To organize the sequence
in your mind, look first at the visual ingredients,
and then examine the sequence, shot by shot.

Collecting the Ingredients
You’ll use the following files and images in the
composited sequence:

tut20_2.max—A scene of a desert landscape,
complete with a flying flap jet, a tower, and a
sky bitmap (tutsky.jpg) assigned as an environ-
ment map. The scene includes three cameras
that you’ll switch between during the
sequence.

tutplate.jpg—A bitmap image of an embossed
metal plate, used as background for the open-
ing and closing titles.

tuttitle.ifl—An image file list that points to 150
frames (with alpha) of an animated, opening
title sequence.

tutendtl.tga—A closing title with alpha that you
can composite over tutplate.jpg as an ending.

Examining the Sequence
Here’s a shot-by-shot breakdown of the
sequence:

• OPEN on an embossed, iron plate. (30
frames/1 second)

• The animated title, “Galactic MAX” sweeps in
from the top of the screen to center. The let-
ters are cutouts that reveal the 3D scene
behind them. After a brief pause, they zoom
toward the camera, filling it, until the entire
scene is revealed. (150 frames/5 seconds)

• THREE-QUARTER OVERHEAD of the alien
desert. You can see the flap jet flying toward a
distant tower, and rust-colored clouds in the
background. (90 frames/3 seconds)

• CUT to a POV from the flap jet heading
toward the tower. (120 frames/4 seconds)

• XFADE to . . . (30 frames/1 second)

• Tower POV. Shows the flap jet approaching.
As it gets near the tower . . . (120 frames/4 sec-
onds)

• WIPE L-R revealing the embossed iron plate,
and . . . (30 frames/1 second)

• FADE-IN the end title “To be continued . . .”
(30 frames/1 second hold)

• HOLD for 60 additional frames.
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Here’s what the Video Post queue will look like:

Loading the Scene
Begin by loading the scene containing your
cameras.

Load the sample file:

1. Reset 3DS MAX.

2. Choose File>Open, and load tut20_2.max.

The scene has three cameras, which you can see
in three of the viewports. The flap jet will move
along a spline path later in the animation, when
the opening title reveals the scene.

Roughing in the Events
To work out the order of the events in the
queue, think about the layers of each event, and
how one appears in front of the other. For exam-
ple, although the first thing you see in the shot-
by-shot breakdown is the iron plate, the scene
itself is revealed behind the plate. The scene,
therefore, comes before the image of the plate in
the Video Post queue.

Begin by adding the scenes and images to the
queue.

Add the images to the queue:

1. Choose Rendering>Video Post to display the
Video Post dialog.

2.  Click Add Scene Event, select Overview
Camera from the View list, and click OK.

3.  Click Add Image Input Event, click Files,
choose tutplate.jpg from the \maps directory,
and click OK

4. Check Cache in the Add Image Input Event
dialog.

The Cache option, when checked, stores the
image in memory instead of loading each
time a frame is rendered. This greatly speeds
up the Video Post execution when you’re
using a still image over a range of frames. It
doesn’t help with animated images, however.

5. Click OK to exit the dialog.

You’ll work out the special title reveal later.
Move on, instead, to the next camera shot.

6.  Click Add Scene Event, select Jet Camera,
and click OK.

There’s a direct cut from the Jet Camera to the
Tower Camera, so add the Tower Camera
next.

7.  Click Add Scene Event, select Tower Cam-
era, and click OK.

Again, you’ll deal with the wipes and the
fades later. The next image is a repeat of the
iron plate, followed by the fade-in of the end
title.

8.  Click Add Image Input Event, choose tut-
plate.jpg, and click OK.
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9. Check Cache, and click OK.

10.  Click Add Image Input Event, choose
tutendtl.tga, and click OK.

11.Check Cache, and click OK.

Your queue now looks like the one in the figure.

Setting Up the Opening Composite
and Title Cutout
The opening of the sequence shows the iron
plate over the camera shot. An animated title
appears, cutting a hole in the plate, and reveal-
ing the scene. Basically, this effect is exactly the
same as when you composite an image with
alpha over a scene event, except that the iron
plate image doesn’t have an alpha channel.
Instead, you use a special Filter event to provide
the plate with an animated alpha channel.

Begin by compositing the scene event with the
image of the iron plate.

Composite the scene with the first image:

1. Select the Overview Camera and the first tut-
plate.jpg event.

2.  Click Add Image Layer Event.

3. Choose Alpha Compositor, and click OK.

Now, assign a filter to the plate image to give it
an alpha channel.

Set up the Image Alpha filter:

1. Select the first tutplate.jpg event.

2.  Click Add Image Filter Event.

3. Choose Image Alpha from the Filter plug-in
list.

The Image Alpha filter provides alpha to its
assigned image by using a mask bitmap that
you specify.

4. Click Files in the Mask area.

5. Choose tuttitle.ifl from the \maps directory,
and click OK.

You’ll also want to invert the alpha channel
of the mask so the letters are clear rather than
opaque when they move over the iron plate.

6. Check Inverted.

7. Click OK.

There are a number of things going on here, so
stop for a minute and review the sequence up to
this point.

The scene is rendered first. Following this, the
iron plate is composited on top of the scene,
using an Alpha Compositor. The alpha channel
for the plate image is provided by the Image
Alpha filter, using the tuttitle.ifl animation.
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The .ifl file is an image file list, that is simply a
text file listing all of the frame files of an anima-
tion (stored on disk as tutx0001.tga,
tutx0002.tga, and so on). Each frame image is a
Targa file containing an alpha channel and
white text over a clear background.

Image file lists give you complete control over
your animations. You can even use them to loop
and repeat specific frames of an animation.

Adding the Cross Fade
The next special event in the sequence is a cross
fade between the camera attached to the jet and
the camera near the tower. A cross fade is
another type of Layer event. It composites two
images over time by fading from one to the
other.

Add the cross-fade transition:

1. Select the Jet Camera and the Tower Camera
Scene events.

2.  Click Add Image Layer Event.

3. Choose Cross Fade Transition from the list,
and click OK.

As you’ll see later, the important part of setting
up a cross-fade event is to adjust its range bar in
relation to the two images you’re fading

between. You’ll do this when you set the range
bars for all the events.

Fade In the End Title
At the end of the sequence, an end title fades in
over another appearance of the iron plate. You
do this in much the same way as you set up the
opening title. Again, you’ll use an Alpha Com-
positor to combine the plate and the end title
(which contains an alpha channel). You’ll then
use a Fade filter to fade in the title over the
image of the plate.

Add the fade-in to the end title:

1. Select the second tutplate.jpg event and the
tutendtl.tga event.

2.  Click Add Image Layer Event.

3. Choose Alpha Compositor, and click OK.

4. Select only the tutendtl.tga event.

5.  Click Add Image Filter Event.

6. Choose Fade from the list.

7. Click Setup, choose In, and click OK.

8. Click OK to exit the Add Image Filter Event
dialog.

As with the Cross Fade Transition event, you’ll
specify the timing of the fade when you set the
range bars.

Adding a Simple Wipe
The last special event, before setting the range
bars, is a wipe from the tower camera to the end
title sequence.

Look again at your queue.
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You’ll use a Layer event for the wipe, which
composites the end of one image to the begin-
ning of another by sliding the second image
over the first. The question is, where do you
place the event in the queue? To which two
existing events do you apply the wipe event?

Looking at the hierarchy in the queue, you’ll see
that the Tower Camera belongs to a Cross Fade
Transition event, and the end title sequence
belongs to an Alpha Compositor event. Since
you want to wipe from the end of the Tower
Camera event to the beginning of the end title
sequence, you apply the wipe to the two parent
events.

Add the Simple Wipe event:

1. Select the Cross Fade Transition event, and
the last Alpha Compositor event.

2.  Click Add Image Layer Event.

3. Choose Simple Wipe from the list.

4. Click Setup.

The Simple Wipe Control dialog appears.

The two icons on the left specify the direction
of the wipe. The modes specify whether the
image is wiping on (Push) or wiping off (Pop).

5.  Choose the top Direction icon to wipe
from left to right.

6. Choose Push so the iron plate slides on over
the scene during the wipe.

7. Click OK, and then click OK again to exit
both dialogs.

Adding Image Output
Without an Image Output event, all you’ll see is
a series of images in the rendering window. The
following procedure sets up an Image Output
event for an .avi file, but you can choose any
type of animation output format that your sys-
tem supports.
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Add an Image Output event:

1. Make sure that none of the events in the
queue are selected.

2.  Click Add Image Output event.

3. Click Files, specify an output filename, such
as mytut20b.avi, and click OK.

4. Click OK to exit the Add Image Output Event
dialog.

Your sequence should look like the one in the
figure.

Save your sequence and your file:

1.  Click Save Sequence, enter mytut20b.vpx,
and click OK.

2. Choose File>Save As from the main menus,
and save the scene as mytut20b.max.

Setting the Range Bars
The range bars in each of the tracks determine
when each event will take place over the course
of the entire Video Post execution. Video Post
time is completely independent of the time in

the scene. For this sequence, however, the scene
ranges will be locked to Video Post time, so the
range bars for each of the cameras will deter-
mine when, in Video Post time, that portion of
the animation is revealed.

Begin by setting the ranges for the title
sequence, which includes the first Alpha Com-
positor, the Overview Camera, the Image Alpha
Filter, and the tutplate.jpg iron plate image.

Setting the Range for the Opening Title
Looking at the shot-by-shot breakdown, you see
that the iron plate is on screen for 30 frames
before the animated title appears. The title takes
another 150 frames to fill the plate image, so
you’ll need the plate to remain in the sequence
for a total of 180 frames, from frame 0 to frame
179.

Adjust the range bar for tutplate.jpg:

1.  Click Zoom Extents in the Video Post dia-
log.

Use the Video Post navigation tools whenever
necessary during the following procedures.

2. Drag the right end of the range bar in the first
tutplate.jpg track to frame 179.

As you drag the bar, you can see its frame
positions in the status line. The S field is the
start frame, the E field is the end field, and the
F field is the total frame range.

3. Adjust the range bar so the three fields display
S:0, E:179, F:180.

The animated title is carried in the Image Alpha
Filter event. It’s 150 frames long, and its range
will run from frames 30 to 179.

Rather than drag its range bar, here’s an easier
way to set ranges with precision.
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Set the range bar for the Image Alpha Filter:

1. Double-click the Image Alpha Filter event to
display its edit dialog.

2. Type 30 in VP Start Time, 179 in VP End Time,
and click OK.

The status line displays the start and end
times, plus 150 total frames. The range bar for
the Image Alpha Filter event is aligned with
the right end of the tutplate.jpg event.

The Overview Camera event doesn’t have to
start until the title sequence begins to reveal the
scene (frame 30), and it continues for 90 frames
after the end of the title sequence (frame 269).
You could type in both numbers, but here’s a
technique you can use when you want to align
one end of a range with another.

Set up the Overview Camera event range:

1. Select the Overview Camera event range.

2. Hold CTRL, and select the Image Alpha Filter
event range.

The end handles of the second event you
select are solid red instead of white, indicat-
ing that it’s the base selection. When you use
most alignment tools, the base range bar stays
in place while the other selected range bars
move.

3.  Click Align Selected Left.

The Overview Camera range bar moves and
its left end is aligned with the left end of the
Image Alpha Filter.

Use the dialog to set the opposite end.

4. Double-click the Overview Camera event to
display its edit dialog.

5. Type 269 in the VP End Time spinner, and
click OK.

The Overview Camera scene will be displayed
from frames 30 to 269, for a total of 240 frames.

Note: Because the scene events are locked to
Video Post time, the Overview Camera range bar
is like a window into a portion of the overall ani-
mation of the scene. Any animation that occurs
in the scene prior to frame 30 will not be dis-
played. What happens in the scene at, say, frame
250 will occur at frame 250 of the Video Post
sequence.

Remembering the Alpha Compositor
You must also adjust the range of the Alpha
Compositor to cover all the Image Alpha Filter
event. Here’s the easiest way to do that.

Adjust the first Alpha Compositor:

1. Select the first Alpha Compositor event.

2. Hold CTRL, and click the Image Alpha Filter
event.

3.  Click Align Selected Left.

4.  Click Make Selected Same Size.

The two range bars are now the same size.

Adding the Next Scene Event
The next scene event is the camera linked to the
flap jet. There’s a direct cut from the Overview
Camera to the Jet Camera, and then the Jet
Camera proceeds for 120 frames. At the end of
that time, there’s a 60-frame cross fade transi-
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tion, so you’ll need additional time for that as
well. This places the range of the Jet Camera
event from frame 270 to frame 449.

Because the range of one event often follows
another in time, there’s an alignment function
specifically designed for fast cuts.

Adjust the Jet Camera event range:

1. Select the Jet Camera event.

2. Hold CTRL, and select the Overview Camera
event.

3.  Click Abut Selected.

The Jet Camera event moves so its start range
begins one frame after the end range of the
Overview Camera event. (The order of selec-
tion doesn’t matter. Abut Selected always
places the lower events in the queue after the
higher events.)

4. Double-click the Jet Camera event.

5. Type 449 in the VP End Time spinner, and
click OK.

Placing the Cross Fade Transition
The cross fade is 30 frames. Perhaps the easiest
way to place it is to first adjust its range to 30
frames, and then align it to the end of the Jet
Camera event.

Adjust the Cross Fade Transition event:

1. Drag either end bar of the Cross Fade Transi-
tion event, until the status line reads F:30.

2. Hold CTRL, and select the Jet Camera event.

3.  Click Align Selected Right.

The 30-frame Cross Fade Transition range is
aligned with the right end of the Jet Camera
range.

The Tower Camera event totals 120 frames, but
a portion of it is included in the cross fade. You
can use the same technique to adjust and align
this event.

Set up the Tower Camera event range:

1. Drag either end of the Tower Camera range
bar so that it’s 120 frames long.

2. Hold CTRL, and select the Cross Fade Transi-
tion event.

3.  Click Align Selected Left.

The beginning or the Tower Camera range is
aligned with the beginning of the Cross Fade
Transition range.

Notice that the Cross Fade Transition event
overlaps the end and beginning of the two other
events. This is necessary for a cross fade to work
properly.

Adding a Wipe
What’s next in the shot-by-shot? There’s a 30-
frame wipe from the end of the Tower Camera
shot to the iron plate. A wipe is placed in the
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same way as a cross fade. It covers the end of one
range, and the beginning of another.

Again, you’ll set the total frames for the wipe,
align it with the end of the Tower Camera event,
and then adjust the tutplate.jpg event to overlap
and follow it.

Adjust the wipe:

1. Drag either end of the Simple Wipe event
until it’s 30 frames long.

2. Hold CTRL, and select the Tower Camera
event.

3.  Click Align Selected Right.

The Simple Wipe range is aligned with the
end of the Tower Camera range.

4. Adjust the length of the second tutplate.jpg
event so it’s 120 frames long.

This event is 30 frames during the wipe plus
30 frames during the fade-in. The additional
60-frame hold at the end brings the total to
120 frames.

5. Hold CTRL, and select the Simple Wipe event.

6.  Click Align Selected Left.

The tutplate.jpg range begins at the same
time as the wipe, and ends 90 frames beyond
the wipe.

Fading in the Title
The fade-in of the title, and the 60-frame hold
are the last shots. The fade-in begins right after
the wipe is completed, and lasts for 30 frames.
The title must be there at the same start time,
but it remains to the end of the sequence.

Place the fade-in:

1. Drag either end of the Fade filter event so it
totals 30 frames.

2. Hold CTRL, and select the Simple Wipe event.

3.  Click Abut Selected.

The Fade range bar is moved so it starts after
the Wipe.

Adjust the end title event:

1. Adjust the length of the tutendtl.jpg event to
a total of 90 frames.

2. Hold CTRL, and select the Fade event.

3.  Click Align Selected Left.

The tutendtl.jpg event begins at the begin-
ning of the Fade event, and ends at the end of
the tutplate.jpg event.

Adjusting the Last Alpha Compositor
The last Alpha Compositor is needed for the title
to properly composite over the iron plate. You
need to make it the same length as the end title.
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Adjust the Alpha Compositor:

1. Select the last Alpha Compositor.

2. Hold CTRL, and click the tutendtl.jpg event.

3.  Click Align Selected Left.

4.  Click Make Selected Same Size.

Setting the Image Output Range
Here’s an important step! Be sure to set the range
of your Image Output Event to cover all the
frames in your sequence.

Set the range of the Image Output Event:

1. Double-click the Image Output Event.

2. Set the VP Start time to 0, and the VP End
time to 629.

3. Click OK.

Executing the Video Post Sequence
Your Video Post range bars should now look like
the following figure.

Save your scene and your sequence:

1. Choose File>Save to update the scene (includ-
ing the Video Post sequence).

2.  Click Save Sequence, and click Save to
update the Video Post sequence in a separate
file.

If all seems right, you’re ready to execute the
entire sequence. The animation is over 600

frames long, and it will take awhile to complete.
If you don’t have the time now, you can always
return, reload the scene, choose Render-
ing>Video Post, and proceed from there.

Note: As designed, this Video Post sequence cre-
ates an .avi file over 46 megabytes in size. If you
don’t have the storage capacity for a file of this
size, use any of these options to reduce the size
of the file:

• Reduce the number of rendered frames by
increasing the Every Nth Frame value in the
Execute Video Post dialog. Note that this will
also increase the playback rate of the anima-
tion.

• Reduce the output resolution in the Exe-
cute Video Post dialog.

• Reduce the length of the range bars for var-
ious sequences. If you do this, be sure to
maintain the correct relation between the
start and the end of each range bar.

Execute the sequence:

1.  Click Execute Sequence.

2. Choose Range.

3. Set the start of the range to 0, and the end of
the range to 629.

4. Make sure the output size is set to 320x240.

If you make the resolution larger, all the
images will have to be rescaled, which will
take much longer.

5. Click Render.

When the rendering is completed, choose
File>View File, and choose mytut20b.avi from
the \images directory to play your animation.



3t2tut20.fm    23  Thu Oct  2 15:25:20 1997

Tutorial 20

V
id

eo
 P

o
st

-p
ro

d
uc

ti
o

n
20

 –
 2

3


	The Basics
	Creating a Simple Scene
	Transforms
	Using the Modifier Stack
	Sub-Object Selection
	Shapes
	Loft Objects, Part 1
	Loft Objects, Part 2
	Compound Boolean
	Basic Materials:
	Mapping Coordinates
	Mapping Types
	Using Lights
	Setting Up Environments
	Basic Animation
	Animation Using
	Hierarchy and Forward
	Inverse Kinematics
	Video Post-production

